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Preface

TriStation 1131™ Developer’s Workbench is a software application for developing, testing, and 
documenting safety-critical and process-control applications that execute on Triconex controllers.

New Features in TriStation 1131 v4.1

The following are new features in TriStation 1131 version 4.1:

• MS Windows 2000 and Windows XP compatible.

• Support for new Analog Input and Digital Output (Next Generation IO) modules.

• Support for the Tricon Communication Module (TCM).

• Backup project file is automatically saved after a Download All or Download Changes.

• New feature—Restore Project To Last Download—allows the file which was saved 
after the download to be restored as the project file. 

• Write to File feature for intermediate ST code.

Note For more detailed information about the changes made in each TriStation 1131 v4.1 
release, see the Product Release Notice for TriStation v4.x, available on Triconex 
CustomerNet.

Summary of Sections
• Chapter 1, Project Administration—Explains how to install the TriStation 1131 

software, create a project, set up security, and use libraries of functions and function 
blocks.

• Chapter 2, Application Development—Explains how to develop an application.

• Chapter 3, Controller Configuration—Explains how to configure modules used in the 
installation.

• Chapter 4, TriStation 1131 Communication—Explains how to set up communication 
between a TriStation 1131 PC and Triconex controller.

• Chapter 5, Implementation—Explains how to implement an application on a controller.

• Appendix A, Commands and Properties—Describes TriStation 1131 commands, 
properties, and tools.

• Appendix B, Data Types—Describes data types included with the TriStation 1131 
software.

• Appendix C, TCM Model 4351/4352 Configuration—Explains how to configure the 
older model 4351 or 4352 Tricon Communication Module.

http://customernet.triconex.com
http://customernet.triconex.com
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Related Documents
• SOE Recorder User’s Guide

• TriStation 1131 Libraries Reference

• Enhanced Diagnostic Monitor User’s Guide

• Tricon and Trident Safety Considerations Guides

• Communication Guide for Tricon v9-v10 Systems

• Product Release Notices for specific Tricon and TriStation versions

Product and Training Information

To obtain information about Triconex products and in-house and on-site training, see the 
Triconex Web site or contact your regional customer center.

Web Site

http://www.triconex.com

Technical Support

Customers in the U.S. and Canada can obtain technical support from the Customer Satisfaction 
Center (CSC) at the numbers below. International customers should contact their regional 
support center.

Requests for support are prioritized as follows:

• Emergency requests are given the highest priority

• Requests from participants in the System Watch Agreement (SWA) and customers with 
purchase order or charge card authorization are given next priority

• All other requests are handled on a time-available basis

If you require emergency or immediate response and are not an SWA participant, you may 
incur a charge. Please have a purchase order or credit card available for billing.

Telephone

Toll-free number 866-746-6477, or
Toll number 508-549-2424 (outside U.S.)

Fax

Toll number 508-549-4999

Web Site

http://customernet.triconex.com (registration required)

E-mail

ips.csc@ips.invensys.com

http://customernet.triconex.com
mailto:ips.csc@ips.invensys.com
http://www.triconex.com
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We Welcome Your Comments
To help us improve future versions of Triconex documentation, we want to know about any 
corrections, clarifications, or further information you would find useful. When you contact us, 
please include the following information:

• The title and version of the guide you are referring to

• A brief description of the content you are referring to (for example, step-by-step 
instructions that are incorrect, information that requires clarification or more details, 
missing information that you would find helpful)

• Your suggestions for correcting or improving the documentation

• The version of the Triconex hardware or software you are using

• Your name, company name, job title, phone number, and e-mail address

Send e-mail to us at:

triconextechpubs@ips.invensys.com

Please keep in mind that this e-mail address is only for documentation feedback. If you have a 
technical problem or question, please contact the Customer Satisfaction Center. See Technical 
Support on page xiv for contact information.

Or, you can write to us at:

Attn: Technical Publications
Triconex
15345 Barranca Parkway
Irvine, CA 92618

Thank you for your feedback.

mailto:triconextechpubs@ips.invensys.com


Preface

TriStation 1131 Developer’s Guide, v4.1



TriStation 1131 Developer’s Guide, v4.1

1
Project Administration

Overview 2

Project Administration Steps 3

TriStation 1131 Installation 4

TriStation 1131 Projects 8

Project Creation 14

Project Options 17

TriStation 1131 Options 21

User Access 27

Library Documents 32

Reports 41



2 Chapter 1 Project Administration

TriStation 1131 Developer’s Guide, v4.1

Overview
This figure shows a typical project cycle and the main steps for setting up a TriStation 1131 
project.

- Install TriStation 1131 software 

Set Up the Project ~ 
- Create or open a project 

_-~S~et~p~r~o~je~ct~o~~=io~n~s~ ______ ___ 

- Set TriStation 1131 options 

- Configure user access 

Develop the 
Application 

Test with the 

r ErnulaIDr 

Fix Errors 

I Yes 
Errors? 

No 

Configure the 
Controller 

Set Up TriStatlon 
Communication 

Implement on 
the Controller 
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Project Administration Steps
This list includes steps that can be or should be done during project administration.

Steps See

Install the TriStation1131 software 
(if needed)

• TriStation 1131 Installation on page 4

Create or open an existing project. • Project Creation on page 14

Specify the language to be used as a default. • Specifying Language Options on page 17

Specify whether annotations are 
automatically included.

• Specifying Annotation Options on page 18

Specify monitor colors for displaying 
variables in the emulator and controller.

• Specifying Monitor Colors for BOOL Values 
on page 20

Specify options to be used when you use 
TriStation 1131.

• TriStation 1131 Options on page 21

Specify FBD, LD, and CEM Editor options, 
as needed. (Optional)

• Specifying FBD Editor Options on page 24
• Specifying LD Editor Options on page 25
• Specifying CEM Editor Options on page 26

Configure user access. • User Access on page 27

Add libraries from other projects. (Optional) • Adding Libraries on page 38

View standard reports; add custom reports. • Reports on page 41



4 Chapter 1 Project Administration

TriStation 1131 Developer’s Guide, v4.1

TriStation 1131 Installation
This section explains how to install and uninstall the TriStation 1131 software, and how to verify 
that the software is correctly installed. The installation also installs the TS1131 Install Check 
software.

Topics include:

• System Requirements on page 4

• Upgrading from Previous Versions of TriStation 1131 on page 4

• Installing the TriStation 1131 Software on page 5

• Uninstalling the TriStation 1131 Software on page 6

• Verifying the TriStation 1131 Installation on page 6

System Requirements

The following are the minimum system requirements for TriStation 1131:

• PC running Windows 2000 or XP

• Pentium 233 MHz with 128 MB RAM

• 125 MB free hard drive space

• CD-ROM drive

• Network adapter card

• SVGA monitor running at 1024 x 768 resolution with 64,000 colors

• DLC protocol installed (see Installing DLC or TCP/IP Protocol on a TriStation PC on 
page 243)

Upgrading from Previous Versions of TriStation 1131

If you are upgrading from a previous version of TriStation 1131, please note the following:

• If you have previously installed version 2.x or 3.x of the TriStation 1131 software, you 
do not need to uninstall it before installing version 4.1. 

• If you have previously installed version 4.1.x of the TriStation 1131 software, you do 
not need to uninstall it before installing a later version of 4.1.x. For example, if you have 
version 4.1.419 installed, you do not need to uninstall it before you install version 
4.1.420 or later.

• If you have previously installed version 4.0 of the TriStation 1131 software, you do not 
need to uninstall it before you install version 4.1. You may wish to keep both versions 
of the TriStation software installed on your workstation until you have finished 
converting all your projects to version 4.1 (see Converting Existing Projects to Version 
4.1 on page 11).
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However, uninstalling version 4.0 after you have installed version 4.1 will cause 
version 4.1 to no longer work. To correct this, simply uninstall both 4.0 and 4.1 and then 
reinstall version 4.1.

• Additionally, if you installed other Triconex applications (such as SOE Recorder) after 
you installed TriStation version 4.0, uninstalling version 4.0 may cause other installed 
Triconex applications to no longer work. To correct this, simply uninstall and then 
reinstall the other Triconex applications after you uninstall TriStation version 4.0.

Installing the TriStation 1131 Software

This procedure explains how to install the TriStation 1131 software. The setup program 
provided by Triconex installs all the components of the TriStation 1131 Developer’s Workbench 
on your PC. If you purchased the optional CEMPLE software, it is installed at the same time.

Note If you are installing the TriStation 1131 software on a Windows XP workstation, you 
must also install the DLC protocol. Without this protocol installed, you will be unable to 
open a new or existing project in TriStation. See Installing DLC on Windows XP on 
page 244 for detailed instructions.

The TriStation 1131 software must be installed on a local drive. Do NOT install and run 
TriStation 1131 on a network server.

Procedure

1 Log on as an administrator or as a user with administrator privileges.

2 Close all open applications.

3 Insert the TriStation 1131 CD in the CD-ROM drive.

If the installation starts automatically, go to step 8. Otherwise, go to the next step.

4 From the Start menu, click Settings, and then click Control Panel.

5 Double-click Add New Programs.

6 Click the CD or Floppy button, and then browse to locate the setup.exe file on the CD.

7 Double-click setup.exe to start the installation.

8 Follow the InstallShield Wizard instructions.

Triconex recommends installing the TriStation 1131 software in the default destination 
folder, which is: C:\Program Files\Triconex\TriStation 1131 4.1.

9 To restart your PC after the installation has finished, click Yes. You are not required to 
restart your PC before running the TriStation 1131 software.

10 To complete the installation, click Finish.
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Uninstalling the TriStation 1131 Software

This procedure explains how to uninstall the TriStation 1131 software. 

Procedure

1 Log on as an administrator or as a user with administrator privileges.

2 From the Start menu, click Settings, and then click Control Panel.

3 Double-click Add/Remove Programs, and select TriStation 1131 4.1.

4 Click Change/Remove.

Follow the on-screen instructions to confirm the deletion of the selected application and 
all its components.

Note If you saved projects in the default directory, (C:\Program 
Files\Triconex\TriStation 1131 4.1), the uninstall program does not 
remove them.

5 Click Yes or Yes to All if the Remove Shared File dialog box asks about removing unused 
DLLs.

6 Click Finish to complete the uninstallation process.

Verifying the TriStation 1131 Installation

This procedure explains how to verify the TriStation 1131 software is correctly installed and that 
associated files are not corrupted. 

After installing the software and before downloading an application to the controller, you 
should run the TriStation 1131 Install Check program. The Install Check software is copied to 
your hard drive when you install the TriStation 1131 software.

Note Running TS1131 Install Check is required for safety applications. For more information, 
see the Safety Considerations Guide.

Procedure

1 From the Start menu, select Programs, Triconex, and then Install Check 4.1.

2 Click Run. 

Install Check verifies that all TriStation files are correctly installed. When verification is 
complete, the name, version, and status of each file are displayed in the list. 
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3 Verify that the program is validated by viewing each item in the list. 

The status of each file should be “OK”. If there are files that have “Missing” in the Status 
column, you should re-install TriStation 1131.

4 Click Display Details to view the full path for verified files and expanded error messages 
for any identified problems.
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TriStation 1131 Projects
This section provides an overview of TriStation 1131 projects and related information.

Topics include:

• The Project Workspace on page 8

• Displaying Version Numbers of Projects and Documents on page 9

• Converting Existing Projects to Version 4.1 on page 11

• Adding Audit Comments on page 13

The Project Workspace

The Project Workspace includes the Reports folder. Other project features are accessed from the 
menus.
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Displaying Version Numbers of Projects and Documents

This procedure explains what version numbers are and how they can be viewed. Version 
numbers are used with the project under development (current version), the downloaded 
application (downloaded version), and project elements. Version numbers include a major 
(first) and minor (second) number, separated by a period.

Procedure for Projects

1 On the Project menu, click Project Description.

2 View these properties in the Project Description dialog box.

3 Click OK to close the dialog box.

Property Action

Current Version Displays the version of the project which is under development.

Downloaded Version Displays the version of the project (application) which is 
downloaded to the controller.
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Procedure for Documents

1 Expand the Application Workspace (see The Application Workspace on page 54), and 
right-click a document.

2 From the shortcut menu that appears, select Properties. 

The Document Properties dialog box appears.

3 View this property on the Summary tab.

4 Click OK to close the dialog box.

Property Action

Name Displays the version of the document at the end of the name.
For example, if the document name is displayed as LightEmUp - 
v1.26, the version number is 1.26.
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Converting Existing Projects to Version 4.1

This procedure explains how an existing TriStation 1131 project can be automatically converted 
to version 4.1. Any project created with version 2.x through 3.x can be converted to version 4.1.

Projects created with version 4.0.x can be opened in version 4.1, but once they have been opened 
in v4.1 they can no longer be opened with an earlier version of TriStation 1131.

The programming model for TriStation 4.0 and later is significantly different from versions 3.x 
and earlier. The most significant differences are:

• There are no program instances

• Programs can directly reference tagnames

• Programs cannot use VAR_INPUT, VAR_OUTPUT, or VAR_IN_OUT variables

Procedure for Version 4.0.x Projects

1 Open the TriStation 1131 project to be 
converted.

2 When prompted, click Yes to continue 
the conversion or No to cancel. 

Procedure for Version 2.x or 3.x Projects

1 Open the TriStation 1131 project to be 
converted.

2 When prompted, click Yes to continue 
the conversion or No to cancel. To get 
information about what is converted, 
click Help.

3 If you clicked Yes, you must log in to the 
project as a Level 01 user. 

After you log in, the project is opened 
and a backup is made using this naming 
convention: <project 
name>_<version>_Pre40Cnv.bt2.

4 After completing the conversion, you must perform a Download All (see Using the 
Download All Command on page 316).
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The following table identifies the changes made during a version 2.x or 3.x project conversion.

Table 1 Changes Made During Version 2.x or 3.x Project Conversion

Item Description

Application Snapshot The conversion removes the snapshot of the application which was saved 
during the last download. This means you will not be able to compare the 
current version of the project to the previously downloaded version of the 
project until after the first download.

Application State The state of the application is changed to Download All.

Multiple Program 
Instances

If there are multiple instances of a program, each instance is converted to a 
new program document. The name of each new document is generated by 
appending _# to the program name, where # is a consecutive number 
starting at 1. For example, if there were two instances of program 
TankAlarm, the first instance is named TankAlarm_1, and the second is 
named TankAlarm_2.

Naming Conflicts If renaming a program input or output results in a name conflict with a local 
variable, the name of the local variable is appended with ?Dup? and a 
message is written to the message output view.
You must rename the local variable before compiling the program.

Trident System 
Variables

If a tagname references a Trident system variable, the variable name is 
appended with ?Sys? and a message is written to the message output view.
You must change the names and change the Point Type to memory. One 
way to do this is to replace the dot (period) in the name with an underscore 
and then delete the ?Sys? from the end of the name.
You must also use the system status function blocks (SYS_*) to set the value 
of these variables. The best place to do this is in the first network in your 
program. The reason this must be done is that in this version of TriStation 
1131, Trident system status values are only accessible by using the system 
status function blocks.

Variable Changes In FBD, LD, and CEM programs, input and output variable declarations are 
changed to tagname declarations.
In ST programs, all VAR_INPUT, VAR_OUTPUT, and VAR_IN_OUT 
declarations are changed to VAR_EXTERNAL.
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Adding Audit Comments
This procedure explains how to add comments when you change a program, function, or 
function block. These comments provide an audit trail which can be viewed in reports.

Procedure

1 Close a program, function, or function block that was changed. 

The following dialog box appears, allowing you to describe the changes before the 
element is saved.

2 Enter a comment and click OK.
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Project Creation
This section describes how to create and log on to a TriStation 1131 project.

Topics include:

• Creating a TriStation 1131 Project on page 14

• Adding a Project Description on page 15

• Logging on to an Existing Project on page 16

Creating a TriStation 1131 Project

This procedure explains how to create a TriStation 1131 project. When a new project is created, 
a user name and password are automatically created with the highest level of privileges—Level 
01 (see User Access on page 27). You are automatically logged on as this default user when the 
project is created.

Procedure

1 Open TriStation 1131. On the File menu, click New Project.

2 For the Platform (controller), select Tricon, Tricon Low Density, or Trident.

3 Click OK to continue.
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4 Navigate to the folder you want to save the project in, enter a file name, and click Save.

Note TriStation projects must always be run from a local drive. Projects may be saved to a 
network drive for backup purposes, but you must copy the project to your local drive 
before you open it in TriStation.

Files that are used in TriStation 1131 are copied to the project. After the file creation 
process finishes, you are automatically logged on to the project using the default user 
name (MANAGER) and default password (PASSWORD).

Adding a Project Description

This procedure explains how to add a description to a project. The Project Description dialog 
box displays information about the project, including the version of the project being developed 
and the version of the project downloaded to the controller, which may be different.

Procedure

1 On the Project menu, click Project 
Description.

2 Enter a description of any length for 
the project.

3 Click OK to save.

CAUTION
Do not use the Windows file properties dialog box to maintain descriptive 
information about your project. Changing or adding information to the 
Summary tab in the Windows File Properties dialog box for a TriStation 
project file (.pt2) will prevent TriStation from opening the file. There is no 
way to recover a project file that has been changed in this way.
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Logging on to an Existing Project

This procedure explains how to open and log on to an existing project. Only one project can be 
opened at a time. TriStation projects must always be run from a local drive. A project that has 
been saved to a network drive must be copied to your local drive before you open it.

Note If an existing TriStation project was created by a user with restricted or administrator-
level rights in Windows, other users may be unable to open that project. Windows 
security file access rules apply to all TriStation project files. You must have read/write 
access to a TriStation project, and the folder it is located in, to be able to open the project. If 
you are unable to open a TriStation project created by another user, contact your 
network or system administrator for assistance with changing the access rights for the 
selected project file and/or file location. 

Procedure

1 Open TriStation 1131. On the File menu, click Open Project.

2 Select the folder to look in. Click the project to be opened, and then click Open.

3 Enter a user name and password. The default user name is MANAGER. The default 
password is PASSWORD.

4 Click Log On. The project opens.
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Project Options
Project Options are settings that specify the language, annotation, and monitor settings used 
when new project elements are created. When you create new elements in a project, default 
settings are used unless you specify different settings. For example, the Default Language 
property is set to Function Block Diagram, which means that a new function is automatically 
created in FBD language unless you specify another language.

You can change the default settings when you begin a new project or any time during project 
development. The settings only affect new elements.

Topics include:

• Specifying Language Options on page 17

• Specifying Annotation Options on page 18

• Specifying Monitor Colors for BOOL Values on page 20

Specifying Language Options

This procedure explains how to specify the language and element types used to create new 
programs, functions, and function blocks.

Procedure

1 On the Project menu, click Project Options, and then click the Language tab.



18 Chapter 1 Project Administration

TriStation 1131 Developer’s Guide, v4.1

2 Specify these properties on the Language tab.

3 Click OK to save the settings.

Specifying Annotation Options

Annotations can be used to display descriptive text about a constant, tagname, or variable, 
including information specified in system and user-modifiable macros. 

This procedure explains how to specify whether annotations are automatically included when 
comments and variables are created and whether the value is shown when an application is 
monitored. You can also specify text or macros to be included in annotations.

Procedure

1 On the Project menu, click Project Options, and then click the Annotations tab.

Property Action

Default Language Specify the type of programming language to use when creating a 
program, function, function block, or data type. The default is Function 
Block Diagram.

Enabled Features Select the check box for each feature (programs, functions, function 
blocks, data types, and multiple programs) that can be created in the 
project. The default is selected for all features.
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2 Specify these properties on the Annotations tab.

3 Click OK to save the settings.

Property Action

Annotation on by Default Select the check box to have annotation boxes automatically 
added to variables used with a program, function, or function 
block. The default is cleared.

Monitor Value on by 
Default

Select the check box to have the value of the variable displayed 
when the program or function block is executed. The default is 
cleared.

Alignment Specify how to align the text in an annotation or comment. The 
default is Left.

Border Specify the type of border to include with an annotation or 
comment. The default is Single.

Text Size Specify the point size for text used in the project. The default 
settings are: A (6 points), B (8 points), C (10 points), and D (10 
points.)

Default Macros or Text Specify the default macro or text to be included with a program 
or function variable. 
The program variable defaults are:

Tag Refs: %PGM_TAGNAME
Locals: %PGM_LOCAL

The function and function block variable defaults are:
Input: %FB_INPUT
Output: %FB_OUTPUT
Local: %FB_LOCAL
I/O: %FB_IO

See Using Macros with Annotations and Comments on page 143 
for more information.
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Specifying Monitor Colors for BOOL Values

This procedure explains how to specify what colors are displayed for BOOL True and False 
values when the application is run on the controller or emulator. This feature allows you to 
change the colors to meet an industry or corporate standard.

Procedure

1 On the Project menu, click Project Options, and then click the Monitor Colors tab.

2 Specify these properties on the Monitor Colors tab.

3 Click OK to save the settings.

Property Action

General Monitor Colors Select the color for True and False for BOOL variables and wires.
The default for True is red; False is green.

CEM Monitor Colors Select the color for True and False for cause, effect, and 
intersection cells in a CEM (cause and effect matrix).
The default for True is red; False is white.
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TriStation 1131 Options
TriStation 1131 options include properties that affect the TriStation 1131 interface. All the 
properties included in the Options dialog box have default settings that specify how features are 
initially configured. For example, the Wire Tool property can be specified for right-handed or 
left-handed use.

You can change these settings at any time during project development. The settings you 
configure are saved for your user ID only.

Topics include:

• Specifying Directory Locations on page 22

• Specifying Drawing Colors on page 23

• Specifying FBD Editor Options on page 24

• Specifying LD Editor Options on page 25

• Specifying CEM Editor Options on page 26
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Specifying Directory Locations

This procedure explains how to specify the directory locations for project, library, and report 
files.

Procedure

1 On the Tools menu, click TriStation 1131 Options, and then click the Directories tab. 

2 Specify these properties on the Directories tab.

Note TriStation projects must always be run from a local drive. You should not enter 
directory paths that point to a location on your network.

3 Click OK to save the settings.

Property Action

Project Files Enter the path. The default is:
C:\...My Documents\Triconex\TriStation 1131 
4.1\Projects

Data Files Enter the path. The default is:
C:\...My Documents\Triconex\TriStation 1131 4.1\Data

Temporary Files Enter the path. The default is:
C:\...My Documents\Triconex\TriStation 1131 4.1\Temp

Use Defaults Click the Use Defaults button to return the settings to the default paths.
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Specifying Drawing Colors

This procedure explains how to specify the colors used for items in the programming editors. 
The default drawing colors are based on the Windows color scheme selected in Control Panel. 

Procedure

1 On the Tools menu, click TriStation 1131 Options, and then click the Drawing Colors tab.

2 Specify these properties on the Drawing Colors tab.

3 Click OK to save the settings.

Property Action

Drawing Item Select an item to be shown in a color.

Change Colors Command Click to display a color palette from which to choose a color for 
the selected drawing item.

Default Colors Command Click to change the colors of all items to the default colors. 
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Specifying FBD Editor Options

This procedure explains how to specify Function Block Diagram (FBD) Editor settings that are 
used throughout the project unless changed on a specific FBD function. You can also change the 
Double Space and EN/ENO properties for a specific function.

Procedure

1 On the Tools menu, click TriStation 1131 Options, and then click the FBD Editor tab.

2 Specify these properties on the FBD Editor tab.

3 Click OK to save the settings.

Property Action

Double Space Function 
(Block) Terminals by Default

Select the check box to automatically have the spacing 
doubled between terminals (inputs and outputs) on the 
function block, which creates additional space for annotation. 
The default is cleared.

Enable EN/ENO Terminals 
on Functions by Default

Select the check box to automatically enable EN/ENO 
terminals on functions. The default is cleared.

Left-Handed Wire Tool Select the check box to enable the wire tool for left-handed 
use. The default is cleared.
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Specifying LD Editor Options

This procedure explains how to specify Ladder Diagram (LD) editor settings that are used 
throughout the project unless changed on a specific LD function. You can also change the 
Double Space property for a specific function.

Procedure

1 On the Tools menu, click TriStation 1131 Options, and then click the LD Editor tab.

2 Specify these properties on the LD Editor tab.

3 Click OK to save the settings.

Property Action

Double Space Function 
(Block) Terminals by Default

Select the check box to automatically have the spacing 
doubled between terminals (input and output parameters) on 
the function block, which adds space for annotation. The 
default is cleared.

Compiler Warning When 
Right Power Rail is Missing

Select the check box to display a compiler warning displayed 
if the right (power) rail is missing from a Ladder Diagram 
function. The default is cleared.

Left-Handed Link Tool Select the check box to enable the link tool for left-handed use. 
The default is cleared.
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Specifying CEM Editor Options

This procedure explains how to set the options used as initial settings for all the CEM (cause and 
effect matrix) programs in a project. After a program is created, you can modify these settings 
on a program-by-program basis.

Procedure

1 On the Project menu, click TriStation 1131 Options, and then click the CEM Editor tab.

2 Specify these properties on the CEM Editor tab.

3 Click OK to save the settings.

Property Action

Cause Header Functions On by 
Default

Select the check box to automatically add input and 
function columns. The default is cleared.

Effect Header Functions On by 
Default

Select the check box to automatically add output and 
function columns. The default is cleared.

Intersection Functions On by 
Default

Select the check box to automatically add function 
columns. The default is cleared.

Default Number of Cause Rows Enter the number of rows to include in a new matrix. The 
default is 22.

Default Number of Effect 
Columns

Enter the number of columns to include in a new matrix. 
The default is 25.
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User Access
This section explains how to provide user access to controller and TriStation 1131 operations. 
Access is based on the security level assigned to the user, from the highest level (01) to the lowest 
level (10). 

Each level of security includes default settings for the operation privileges allowed for that level. 
For example, the Manager level (03) includes privileges for operations associated with 
managing a TriStation 1131 project. 

Only users assigned to levels 01, 02, or 03 can access the security controls for controller and 
TriStation operations. 

Each new TriStation 1131 project is created with a default user name (MANAGER) and 
password (PASSWORD). To ensure unauthorized users do not access the project, you should 
create user names and passwords before application development begins.

Note If a TriStation project was created by a user with restricted or administrator-level rights 
in Windows, other users may be unable to access that project. Windows security file 
access rules apply to all TriStation project files. Your network or system administrator 
can assist with changing the access rights for the selected project file and/or file location.

Access to a project can be further restricted by settings on documents and operating parameters. 
If you are trying to edit a user document created by another user, and are unable to do so even 
when you have the correct user level and access privileges, check the document’s access 
property. If it is locked, you must ask the user who created the document to change the access 
property. See Restricting Access to a Document on page 67.

Note If you have a model 4351A or 4352A Tricon Communication Module (TCM) installed in 
your system, access to the Tricon via TriStation can also be controlled via the optional 
TCM client access list. See Controlling Access to the TCM on page 267.

Topics include:

• Managing User Access on page 28

• Adding and Modifying User Access on page 29

• Changing the Security Level for Privileges on page 30

• Restricting Access to a Document on page 67
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Managing User Access

This procedure explains how to manage user access, which includes creating, modifying, and 
deleting a TriStation 1131 user. Only users assigned to security levels 01, 02, or 03 can access the 
Security dialog box and view user access settings.

Procedure

1 On the Project menu, click Security, and then click the Users tab.

2 Perform one of these actions on the Users tab.

Note Unless you have level 01 access, you cannot add or delete users who have the 
same or higher security level as yourself. For example, if you have level 02 access, 
you cannot add or delete users with level 02 or 01 access.

If you have security level 01 access, you can add or delete other level 01 users, 
but you cannot delete yourself.

3 Click OK to save your changes.

Command Action

New To create a new user, click New. See Adding and Modifying User Access on 
page 29 for further instructions.

Modify To modify a user, select a user in the list, and then click Modify. See Adding 
and Modifying User Access on page 29 for further instructions.

Delete To delete a user, select a user in the list, and then click Delete.
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Adding and Modifying User Access

This procedure explains how to add or modify access properties for a TriStation 1131 user.

Procedure

1 On the Project menu, click Security, and then click the Users tab.

• To add a user, click Add.

• To modify a user, click the user name, and then click Modify.

2 Specify these properties in the Add or Modify User dialog box.

3 Click OK to save your changes.

Note Even if you are not changing the password, you must enter a password in the 
Password and Verify Password fields to confirm the other changes to the user’s 
information. You should enter the user’s existing password in these fields. If you 
don’t know the user’s password, you can enter a new password in these fields; 
just be sure to tell the user their new password.

Property Action

Full Name Enter or change the name for the user.

Description Enter or change the description for the user.

Logon Name Enter or change the name to be used to log on to the project.

Password Enter or change the logon password. 

Verify Password Enter the new or changed password again to ensure the password is 
what you intended.

Security Level Select the security level for this user. Level 01 is the highest; level 10 is 
the lowest.
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Changing the Security Level for Privileges

This procedure explains how to change the security level required for privileges to controller 
and TriStation 1131 operations. By default, each operation is assigned a security level, from the 
highest level (01), to the lowest level (10).

Each security level includes a set of privileges for that level, which also includes the privileges 
for lower levels. For example, if the operation is set to level 04, users with level 01, 02, and 03 
privileges also have access to the operation. Only users with level 01, 02 or 03 access can change 
security level privileges.

If a TCM is installed in the Tricon, access to the controller via TriStation can also be managed 
via the optional TCM client access list. For example, even if a user has the correct security level 
privileges to perform a Download All command, if they do not have Read/Write TriStation 
access through the TCM, they will be unable to perform the Download All command. See 
Controlling Access to the TCM on page 267 for more information.

Procedure

1 On the Project menu, click Security, and then click the Privileges tab.

2 Specify these properties on the Privileges tab.

3 Click OK to save your changes.

Property Action

Operation Type Select Controller Operations or TriStation 1131 Operations, depending 
on the operations you want to specify. 

Operations Click the operation, and then select the check box for the level of security 
to be assigned to the operation.
Press Shift and click to select multiple contiguous items.
Press Ctrl and click to select multiple non-contiguous items.
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Note Users with security levels 04–10 cannot perform the following tasks: Security: Add/modify 
users, Security: Change level descriptions, Security: Change level privileges. 

Additionally, you cannot remove privileges from your own security level. For example, if 
you are a level 03 user, you cannot remove privileges from security level 03.

Changing Security Level Names 

This procedure explains how to change the names associated with security levels. If you change 
a name on this tab, it is reflected on the other security tabs. Changing the name does not affect 
the security level assignments.

Only users with level 01, 02, or 03 access can change security level names.

Procedure

1 On the Project menu, click Security, and then click the Level Names tab.

2 Enter the name to associate with each security level on the Level Names tab. These are 
the default names.

3 Click OK to save your changes.

Level Name Level Name

01 Corporate Manager 06 Maintenance Manager

02 Site Manager 07 Maintenance Engineer

03 Project Manager 08 Operations Manager

04 Project Engineer 09 Operator

05 Project Programmer 10 Level 10
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Library Documents
Libraries are collections of project elements (programs, functions, and data types) that can be 
used in a project. This section describes how to create a library that can be added to other 
projects, and how to manage libraries that can include TriStation and user-created project 
elements.

Note Libraries created in TriStation 1131 version 4.1 can be imported to projects developed in 
versions 4.1 or 4.0. Libraries created in version TriStation 4.0 can also be imported to 
projects developed in version 4.1.

These libraries are available:

• TCXLIB: Triconex library for Tricon and Trident controllers

• STDLIB: Industry-standard library for Tricon and Trident controllers

• TR1LIB and TX1LIB: Libraries for Tricon controllers

• TRDLIB: Library for Trident controllers

For more information about the libraries automatically included with a TriStation 1131 project, 
see the TriStation 1131 Libraries Reference. Information about the version numbers of libraries 
included with each TriStation 1131 release can be found in the Product Release Notice for 
TriStation v4.x, available on Triconex CustomerNet.

Topics include:

• Creating a Library of Project Elements on page 33

• Managing Libraries on page 37

• Adding Libraries on page 38

• Updating Libraries on page 39

• Deleting Libraries on page 39

• Verifying a Library Version on page 40

http://customernet.triconex.com
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Creating a Library of Project Elements

This procedure explains how to create a library of project elements (programs, functions, 
function blocks, and data types) that can be imported to another TriStation 1131 project.

The library specification (.lsp) and export library (.lt2) files are created in the imported libraries 
directory. To identify or change this library, see Specifying Directory Locations on page 22. 

The default location is: 

C:\...\My Documents\Triconex\TriStation 1131 4.1\Data

Procedure

1 Open the TriStation 1131 project that contains the elements you want to copy.

2 Expand the Application tree, right-click User Documents, and then click Create Library.

3 Do either of these:

• To create a new library, click Create New Library Specification, click Next, and skip 
to step 5.

• To add elements to an existing library, click Use Existing Library Specification, and 
then click Next.



34 Chapter 1 Project Administration

TriStation 1131 Developer’s Guide, v4.1

4 Navigate to the library directory, and click the library file you want to add elements to.

5 In the list on the left, click the document that you want to include, and then click the 
angle brackets ( >> ) to move the element to the right side. 

To select several documents at the same time, press Ctrl, and click each document. To 
select all the documents, press Ctrl and Shift, and click the top and bottom documents.

6 When you are finished selecting the elements to be included in the library, click Next.
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7 Add information about the library, including a name, description, and major and minor 
version number. You can also specify whether the source code can be viewed or 
restricted from other users. 

If you want to save the library to a path other than the default directory, browse to select 
the path where you want to save the new library files. 

8 Click Next to continue.
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9 Do either of these:

• To save the files as a library, click Save the specification and create the Library. If 
you create a library, a library.lsp file and a library.lt2 file are created (where library is 
the name you selected in step 7).

• To save the specification, but not create the library, click Just save the specification. 
You might want to do this if you are planning to create a project library, but are not 
finished with the documents in the project. If you save just the specification, a 
library.lsp file is created. You can open this file and create the library file based on 
the specifications at a later time.

10 Click Finish.



Library Documents 37

TriStation 1131 Developer’s Guide, v4.1

Managing Libraries

This procedure explains how to manage libraries. TriStation 1131 automatically includes IEC 
libraries with functions, function blocks, and data types that can be copied and sometimes 
modified for a project. You can also add libraries of project elements that were created in other 
TriStation 1131 projects.

Procedure

1 Expand the Application tree, right-click Library Documents, and click Manage.

2 Perform one of these actions in the Manage dialog box. 

Command Action

Add Click to add a new library. See Adding Libraries on page 38 for 
further instructions.

Update Click to update an existing library. See Updating Libraries on 
page 39 for further instructions.

Delete Click to delete an existing library. See Deleting Libraries on 
page 39 for further instructions.

Verify Version Command Click to verify the most current version of the selected library is 
loaded. See Verifying a Library Version on page 40 for further 
instructions.
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Adding Libraries

This procedure explains how to add libraries to a TriStation 1131 project. This allows you to 
update libraries provided by Triconex and to add libraries of project elements from other 
TriStation projects.

Procedure

1 Expand the Application tree, right-click Library Documents, click Manage, and then 
click Add.

2 If the library you want to add is located in a path other than the default directory, browse 
to select the path where the library you want to add is located.

3 Click the library to add, and then click OK. 

4 Click Yes on the Query screen.

The library is added to the project, and is displayed in the list.



Library Documents 39

TriStation 1131 Developer’s Guide, v4.1

Updating Libraries

This procedure explains how to update TriStation 1131 libraries for your project. When you 
request an update, TriStation 1131 compares the library in the project with the most current 
installed library and displays a message indicating the versions of each. You can then update 
the library or cancel the operation.

Procedure

1 Expand the Application tree, right-click Library Documents, and then click Manage.

2 On the Manage screen, click the library to be updated, and then click Update.

3 Click Yes to continue the update process. Click No to cancel.

Deleting Libraries

This procedure explains how to delete a library from a TriStation 1131 project.

Procedure

1 Expand the Application tree, right-click Library Documents, and then click Manage.

2 Click the library to be deleted, and then click Delete. 

3 When prompted, click Yes to confirm deletion of the library. Click No to cancel.
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Verifying a Library Version

This procedure explains how to determine the version of TriStation 1131 libraries used in your 
project.

Procedure

1 Expand the Application tree, right-click Library Documents, and then click Manage.

2 Click the library to be verified, and then click Verify Version. 

A message appears, identifying the library, version, and whether the project library is 
the same as the installed library.

3 Click OK to close the message box.
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Reports
This section describes how to view and print standard TriStation 1131 reports. You can also 
export reports to a variety of formats, which can be saved to disk or sent to an e-mail address.

Standard reports are displayed through the Crystal Reports viewer, which is installed with the 
TriStation 1131 software. Custom reports must be created using Crystal Reports, which can be 
purchased separately.

Topics include:

• Updating the Report Database on page 41

• Viewing and Printing a Report on page 41

• Adding Custom Reports to a Project on page 43

• Exporting Reports on page 43

• Report Database Information on page 44

Updating the Report Database

This procedure explains how to update the report database. This copies project information to 
a database used for generating reports. You should update the report database after making 
changes to a project, and after installing or updating the TriStation 1131 v4.1 software.

Procedure

1 Open the Project Workspace (see The Project Workspace on page 8), and right-click the 
Reports folder.

2 Click Update Reports Database.

The status of the updated operation can be viewed in the status bar at the bottom of the 
TriStation window.

Viewing and Printing a Report

This procedure explains how to view and print a report.

Before You Begin

Before you view a report, you should update the report database if changes have been made to the 
project or if the report database was not updated after installing the TriStation 1131 software.

Procedure

1 Open the Project Workspace and then double-click a report. The report appears in the 
report viewer window.
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Note If the report database was not updated after the TriStation 1131 software was 
installed, a “File Not Found” message will appear. Update the reports database 
(see Updating the Report Database on page 41) and then try viewing the report 
again.

2 Perform any of the following tasks in the report viewer.

Command Action

Print Command Click to print the report being viewed.

Export Report 
Command

Click to export the report data to a file. See Exporting Reports 
on page 43 for further instructions.

Refresh Command Click to refresh the display, which re-loads project data to the 
report. If project information has changed, update the report 
database, and then click Refresh to have the updated data 
displayed in the report.

Size of view Type or select a percentage to change the size of the report 
view.

Search Text 
Command

Click to search for text in the report.
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Adding Custom Reports to a Project

This procedure explains how to add a custom report created in the Crystal Reports software to 
a TriStation 1131 project. Only reports generated in Crystal Reports can be used in TriStation 
1131; Crystal Reports must be purchased separately.

Procedure 

1 In Crystal Reports, create a report and save it in a file with the extension .RPT.

2 Put the .RPT file in the Report Template directory. For more information on directory 
locations, see Specifying Directory Locations on page 22.

The next time you open the project, the report will be included in the Reports list. If the 
report is added while the project is open, you must close and re-open the project to view 
the report in the list.

Exporting Reports

This procedure explains how to export report data in TriStation 1131. You can export reports to 
a variety of file formats, and can save the exported data to a disk or send it to someone via 
Microsoft Mail.

Procedure

1 Open the Project Workspace and then double-click the report you want to export. The 
report appears in the report viewer window.

2 On the report viewer toolbar, click the Export Report button. 

3 Specify these properties in the Export dialog box.

4 Click OK to continue. 

Depending on the format, additional information, such as the characters to use to 
separate and delimit a file, may be requested.

Property Action

Export Format Select the file format. The default is PDF.

Export Destination Select the destination as either Disk file or Microsoft Mail. The 
default is Disk.
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Report Database Information
This section provides information on the dBASE IV relational databases that are used when the 
Crystal Report Engine generates a report in TriStation 1131. In addition to the standard reports, 
you can create custom reports that can be used in TriStation 1131. You must purchase Crystal 
Reports in order to create custom reports.

After a project is opened, the databases are automatically updated with information from the 
project when you print the first report. You can also update the databases by right-clicking the 
Reports folder and clicking Update Reports Database.

Databases include:

• System Definition: Chassis Types (TRHWDCHS.DBF) on page 45

• System Definition: Module Types (TRHWDMOD.DBF) on page 45

• Configuration: Program (TRPRGINS.DBF) on page 45

• Configuration: Instance Variable Connections (TRINSVAR.DBF) on page 45

• Configuration: Tagnames (TRGLBVAR.DBF) on page 46

• Configuration: Operating Parameters (TRSYSOPS.DBF) on page 46

• Configuration: SOE Block Definition (TRSOEBLK.DBF) on page 47

• Configuration: SOE Block Variables (TRSOEVAR.DBF) on page 47

• Configuration: Module Configuration (TRMODCFG.DBF) on page 47

• Configuration: Memory Allocation (TRMALLOC.DBF) on page 47

• Security: Users (SECUSERS.DBF) on page 48

• Security: Levels (SECLVLS.DBF) on page 48

• Security: Operations (SECOPRS.DBF) on page 48

• Project: Information (PRINFO.DBF) on page 48

• Project: Shared Libraries (PRLIBS.DBF) on page 49

• Project: Elements (PRELEMS.DBF) on page 49

• Project: POU Variables (PRPOUVAR.DBF) on page 50

• Project: POU Cross-Reference (PRPOUXRF.DBF) on page 50

• Project: Audit History (PRHIST.DBF) on page 50



Reports 45

TriStation 1131 Developer’s Guide, v4.1

The TRHWDCHS file contains information about the chassis types used in the system.

The TRHWDMOD file contains information about the modules used in the system.

The TRPRGINS file contains information about the programs in the project.

The TRINSVAR file contains information about the variable connections in the program.

Table 2 System Definition: Chassis Types (TRHWDCHS.DBF)

Field Name Field Type Description

CHASTYPE (key) Number Chassis type numerical identifier

CHASDESC String Chassis description

Table 3 System Definition: Module Types (TRHWDMOD.DBF)

Field Name Field Type Description

MODTYPE (key) Number Triconex module identifier

MODDESC String Module description

MODMODEL String Module marketing model number

Table 4 Configuration: Program (TRPRGINS.DBF)

Field Name Field Type Description

PROGNAME String Program name

SEQUENCE Number Execution sequence number

Table 5 Configuration: Instance Variable Connections (TRINSVAR.DBF)

Field Name Field Type Description

INSTNAME (key) String Program execution name. In v4.1, this is the same as 
the program name.

VARPATH String Program variable path

PROGNAME String Program name

VARNAME String Program variable name. In v4.1, this is the same as 
the tagname.

TAGNAME String Tagname

VAROUTPUT Strings W if written by instance; otherwise blank
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The TRGLBVAR file contains information about the tagnames (global variables) in the project.

The TRSYSOPS file contains information about the operating parameter settings in the project.

Table 6 Configuration: Tagnames (TRGLBVAR.DBF)

Field Name Field Type Description

TAGNAME (key) String Tagname

GROUP1 String Group 1 name

GROUP2 String Group 2 name

DESCRIP String Tagname description

LOCATION String Tagname location (same format as in configuration)

MODBUS String Modbus alias number

DATATYP String Data type: BOOL, DINT, REAL, and so on.

DATACLASS String Data class: memory, input, or output.

TYPECLASS String Point memory address. See Memory Address on 
page 382.

APPLICATN String Tagname application type (safety or control)

SHARED String Tagname shared for read state (Yes or No)

RETENTIVE Boolean Retain value indicator

INITVALUE String Initial value of tagname

DECPL Number Decimal places for REAL tagname

MINSPAN Number Lower limit for REAL number in Engineering Units

MAXSPAN Number Upper limit for REAL number in Engineering Units

SYSTEMTAG Boolean Is a system variable

MULTIWRIT Boolean Multiple writes enabled

Table 7 Configuration: Operating Parameters (TRSYSOPS.DBF)

Field Name Field Type Description

CNFGVERS String Configuration version number

NETNODE Number NCM node number (switch setting)

NETALIAS String Network IP alias name

SCANRATE Number Scan rate (in milliseconds)

PSWDREQD Boolean Password required for download

DSBLSTOP Boolean Tricon Keyswitch STOP disabled

DSBLMBWR Boolean Disable Modbus writes to outputs

DSBLRCHG Boolean Disable remote changes

DSBLPNTS Boolean Permit disabling points
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The TRSOEBLK file contains information about the SOE block definitions in the project.

The TRSOEVAR file contains information about the SOE tagnames used in the project.

The TRMODCFG file contains information about the module configuration used in the project.

The TRMALLOC file contains information about how memory is allocated.

Table 8 Configuration: SOE Block Definition (TRSOEBLK.DBF)

Field Name Field Type Description

SOEBLKNUM (key) Number SOE block number

SOEBLKTTL String SOE block title

SOEBUFSIZ Number Event buffer size

SOEBLKTYP String SOE block type

Table 9 Configuration: SOE Block Variables (TRSOEVAR.DBF)

Field Name Field Type Description

SOEBLKNUM (key) Number SOE block number

TAGNAME String Tagname

TRUENAME String Name of TRUE state

FALSENAME Strings Name of FALSE state

TRUECLR String Color of TRUE state

FALSECLR String Color of FALSE state

Table 10 Configuration: Module Configuration (TRMODCFG.DBF)

Field Name Field Type Description

CHASNUM (key) Number Chassis number (1-n)

CHASTYPE Number Chassis type numerical identifier

SLOTNUM Number Module type numerical identifier

MODTYPE Number Module type numerical identifier

Table 11 Configuration: Memory Allocation (TRMALLOC.DBF)

Field Name Field Type Description

DATADESC String Brief (coded) description of memory section

MAXPTS Number Maximum number of points for this type

ALLOCPTS Number Allocated points of this type

FCASTPNTS Number Forecasted points of this type after the next 
download

CURRPTS Number Currently used points of this type
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The SECUSERS file contains information about the users authorized access to the project.

The SECLVLS file contains information about the user’s access (privilege) level in the project.

The SECOPRS file contains information about the level of access required to use TriStation and 
controller operations.

The PRINFO file contains information that is used when reports are printed.

Table 12 Security: Users (SECUSERS.DBF)

Field Name Field Type Description

LOGINNAME (key) String User’s log in name

USERNAME String User’s full name

DESCRIP String User description

PRIVLEVEL Number User’s privilege level

Table 13 Security: Levels (SECLVLS.DBF)

Field Name Field Type Description

PRIVLEVEL (key) Number User’s privilege level

DESCRIP String User description

Table 14 Security: Operations (SECOPRS.DBF)

Field Name Field Type Description

CATEGORY String Operation category name

DESCRIP String User description

PRIVLEVEL Number Minimum privilege level required

Table 15 Project: Information (PRINFO.DBF)

Field Name Field Type Description

PRJNAME String Project name

DESCRIP String Project description

VERSION String Project version number

COINFO1 String Company information 1

COINFO2 String Company information 2

COINFO3 String Company information 3

DBDATE Date Date the report database was updated

DBTIME String Time the report database was updated
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The PRLIBS file contains information about the libraries included in the project.

The PRELEMS file contains information about the elements (programs, functions, function 
blocks, and data types) in the project.

Table 16 Project: Shared Libraries (PRLIBS.DBF)

Field Name Field Type Description

LIBNAME (key) String Library name

DESCRIP String Library description

VERSION String Library version number

Table 17 Project: Elements (PRELEMS.DBF)

Field Name Field Type Description

ELEMNAME (key) String Element name

VERSION String Element version number

CATEGORY String Element category

DESCRIP String Element description

ELEMTYPE String Element type: function, function block, and so on.

LANGUAGE String Language type: Function Block Diagram, Ladder 
Diagram, and so on.

OWNER String Element owner name

USERDEFINE Boolean User defined indicator

LIBRARY Boolean Library indicator

LIBNAME 8 characters Library name

LOCKED Boolean Element locked indicator

READONLY Boolean Element read-only indicator

DRWGTITLE String Drawing title

DRWGNUM Strings Drawing number

DRWGREV String Drawing revision

DRWGCBY String Created by user name

DRWGCDATE Date Created date

DRWGCTIME String Created time

DRWGMBY String Modified by user name

DRWGMDATE Date Modified date

DRWGMTIME String Modified time

DRWGAB String Approved by name

DRWGADT String Approved date
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The PRPOUVAR file contains information about the POUs (program organizational units), 
which include programs, functions, and function blocks.

The PRPOUXRF file contains information about where variables are located in the project.

The PRHIST file contains information about the project history.

APPLICATN String Element application type (safety or control)

Table 18 Project: POU Variables (PRPOUVAR.DBF)

Field Name Field Type Description

VARPATH String POU variable path

POUNAME (key) String POU name

VARNAME ((key) String POU variable name

DESCRIP String Element description

DATATYPE String Data type: BOOL, DINT, REAL, and so on.

DATACLASS String Data class: local, input, output, and so on.

INITVALUE String Initial value of the POU variable

Table 19 Project: POU Cross-Reference (PRPOUXRF.DBF)

Field Name Field Type Description

VARPATH (key) String Program variable path which indicates where the 
variable is used

SEQNO Number Record sequence number 0–n

SHTCOORD String Sheet coordinates of variable on SHTNUM

Table 20 Project: Audit History (PRHIST.DBF)

Field Name Field Type Description

EVENTID String ID of the event

USERNAME String User’s full name

ELEMNAME String Name of element that was changed

COMMENT String Comment on change

DATE Date Date of change

TIME String Time of change

ACTION String Action performed (including version number)

Table 17 Project: Elements (PRELEMS.DBF) (continued)

Field Name Field Type Description
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Overview
This figure shows the main steps for developing a TriStation 1131 application. An application 
can be developed and tested on the emulator before downloading the application to a controller.

Set Up the Project

Test with the
Emulator

Set Up TriStation
Communication

Implement on
the Controller

Develop the
Application

Configure the
Controller

Fix Errors

 - Create programs and functions

 - Restrict access to application elements

 - Restrict access to application points

 - Declare tagnames

 - Build and test application

Errors?

No

Yes
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Application Development Steps
This list includes the steps that can or should be performed during application development.

Step See

Plan the application. • Safety and Control Applications on page 58

Create programs and functions. • User Documents on page 62
• Function Block Diagram and Ladder Diagram 

Development on page 69
• Structured Text Development on page 77
• Cause Effect Matrix Development on page 88

Add annotations and comments. • Preparing an Excel File for Import on page 129

Determine access to a document. • Restricting Access to a Document on page 67

Determine access to points. • Tricon Application Access on page 163
• Trident Application Access on page 168

Declare tagnames. • Tagnames on page 115

Import or export tagnames. • Importing and Exporting Tagnames on 
page 126

Assign Modbus aliases. • Modbus Applications on page 146

Add Peer-to-Peer features. • Peer-to-Peer Applications on page 156

Compile project programs and functions. • Compiling a Program on page 173

Build the application. • Building an Application on page 172
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Application Elements
This section describes the elements of an application and the steps in application development.

Topics include:

• The Application Workspace on page 54

• The Declaration Tree on page 55

• The Implementation Tree on page 55

• Parts of an Application on page 56

• Safety and Control Applications on page 58

• Programming Languages on page 58

The Application Workspace

Application development takes place in the Application Workspace. The folders in this tree 
include the user programs, functions, function blocks, data types, tagnames, and 
implementation settings needed for the application. The tree also includes the TriStation 1131 
library of functions, function blocks, and data types that can be used in the project.
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The Declaration Tree

The Declaration Tree lists the declarations for the currently opened program, function, or 
function block.

The Implementation Tree

The Implementation Tree lists the elements that can be specified for the application, including 
the Execution List (list of programs and scan time), SOE Configuration, and Peer-To-Peer 
Configuration.

Declaration Tree

Implementation Tree
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Parts of an Application

The major elements in an application are programs, functions, function blocks, tagnames, 
variables, implementation information, and controller configuration.

Application

An application includes application elements and configuration information that is built 
(compiled) into executable code and downloaded and run on a Triconex controller.

The maximum number of programs in an application is 250.

Programs

A program is an executable element that includes one or more functions and function blocks. A 
program can invoke functions and function blocks but cannot invoke another program. A 
program is initiated from the Execution List.

The maximum number of variables that can be used in a program is 2,000, which includes local 
variables and tagnames, but not VAR_TEMP variables.

Functions and Function Blocks

A function is an executable element that returns exactly one result. The values in a function exist 
only while the function is executing. 

A function block is an executable element that returns one or more values and retains the values 
derived during one evaluation for use in the next evaluation. For function blocks, a set of input 
values may not yield the same output values. 

The maximum number of variables that can be used in a function or function block is 400, which 
includes input, output, input/output, and local variables, but not VAR_TEMP variables.

TriStation 1131 Libraries

TriStation 1131 includes libraries of functions, function blocks, and data types that are 
automatically included with each project.

For information on specific functions, function blocks, and data types, see the TriStation 1131 
Libraries Reference.

User-Defined Functions

In user-defined functions, if no value is assigned to the function output, the return value is the 
default initial value. If there is not a statement that assigns a value to the function output, a 
compiler error occurs. No error or warning is issued if an assignment to the function output is 
in a conditional statement and is not executed.

Tagnames

A tagname identifies input, output, and memory points that are accessible to all programs in the 
application. In IEC terminology, tagnames are called global variables.
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Variables

A variable is a named area in memory that stores a value or string assigned to that variable.

Data Types

A data type identifies the type of data used in tagnames and variables. TriStation 1131 uses both 
elementary and generic data types. For more information, see Appendix B, Data Types.

• Elementary types are defined by IEC 61131-3 and include: BOOL, DATE, DINT, DT, 
DWORD, INT, LREAD, REAL, STRING, TIME, and TOD. TriStation 1131 also supports 
the derivation of structured, array, and enumerated data types.

• Generic data types are used to organize elementary data types that have similar 
properties and can be used with IEC 61131-3 standard functions that support 
overloaded inputs and outputs. Generic data type names use the prefix ANY.

Implementation Information 

Implementation information includes the Execution 
List, Scan, SOE, and Peer-to-Peer setup. 

Controller Configuration

The controller configuration specifies the 
communication characteristics for memory, module 
configuration, and other hardware-related settings. 
When the application is built, this information is 
required. For more information, see Chapter 3, 
Controller Configuration.

Table 21 Variable Types and Uses

Variable Type Used With

Input Functions and function blocks

In/Out Function blocks

Output Functions and function blocks

Local Functions, function blocks, and programs

Tagname Programs

VAR_TEMP Currently available only in ST programs and function blocks
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Safety and Control Applications

An application can include safety programs only, control programs only, or a combination of 
safety and control programs. Safety applications are the most restrictive type because they are 
designed to take a process to a safe state when predetermined conditions are violated. All 
elements of the application (programs, functions, function blocks, and tagnames) must be 
approved or specified for safety.

Control applications are designed to control a process and can use control, or safety and control 
functions and function blocks. The tagnames must be specified as control tagnames.

This table describes how programs, functions, function blocks, and tagnames can be used in 
safety and control applications.

Programming Languages

TriStation 1131 supports programming languages for developing, testing, and documenting 
applications that run on a Triconex controller.

TriStation 1131 supports these programming languages:

• Function Block Diagram Language (FBD)

• Ladder Diagram Language (LD)

• Structured Text Language (ST)

• CEMPLE (Cause and Effect Matrix Programming Language Editor)

The Function Block Diagram, Ladder Diagram, and Structured Text languages comply with the 
IEC 61131-3 International Standard on Programming Languages for Programmable Controllers. 
CEMPLE is an optional language that can be purchased separately from Triconex.

Function Block Diagram Language

Function Block Diagram (FBD) language is a graphical language that corresponds to circuit 
diagrams. The elements used in this language appear as blocks wired together to form circuits. 
The wires can communicate binary and other types of data between FBD elements. In FBD, a 

Table 22 Safety and Control Usage

Application Elements Use

Programs Safety programs cannot use control functions, function blocks, or 
tagnames.
Control programs cannot use safety tagnames.

Functions and Function Blocks Can be safety and control, or control.
Library functions and function blocks are designated as approved 
for use in safety and control or control applications. These 
designations cannot be changed.

Tagnames Can be safety or control. If Shared Read is selected, a safety 
program can read a control tagname and vice-versa.
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group of elements visibly interconnected by wires is known as a network. An FBD diagram can 
contain one or more networks.

Figure 1 Sample FBD Network

Ladder Diagram Language

Ladder Diagram (LD) language is a graphical language that uses a standard set of symbols to 
represent relay logic. The basic elements are coils and contacts which are connected by links. 
Links are different from the wires used in FBD because they transfer only binary data between 
LD symbols, which follow the power flow characteristics of relay logic. Function blocks and 
function elements which have at least one binary input and output can be used in LD diagrams.

Figure 2 Sample Ladder Diagram
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Structured Text Language

Structured Text (ST) language is a general purpose, high-level programming language, similar 
to PASCAL or C. Structured Text is particularly useful for complex arithmetic calculations, and 
can be used to implement complicated procedures that are not easily expressed in graphical 
languages such as FBD or LD.

ST allows you to create Boolean and arithmetic expressions as well as structured programming 
constructs such as conditional statements (IF...THEN...ELSE). Functions and function blocks can 
be invoked in ST.

Figure 3 Sample Structured Text Code
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CEMPLE (Cause and Effect Matrix Programming Language Editor)

CEMPLE™, which stands for Cause and Effect Matrix Programming Language Editor, is a 
Triconex language based on cause and effect matrix methodology, which is commonly used in 
the process control industry. A cause and effect matrix is frequently used for applications such 
as fire and gas systems for which the programming logic is simple, but the volume of inputs and 
outputs that need to be controlled is high. A matrix is readily understood by a broad range of 
plant personnel from process control engineers to maintenance operators.

CEMPLE allows you to associate a problem in a process with one or more actions that must be 
taken to correct the problem. The problem is known as a cause and the action is known as an 
effect. In a typical matrix, a cause is represented by a row in the matrix and an effect is 
represented by a column. An X in the intersection of a cause row and an effect column 
establishes a relationship between the cause and the effect.

Figure 4 Sample CEMPLE Matrix
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User Documents
This section describes the how to create and specify user documents, which include programs, 
functions, function blocks, and data types. Topics include:

• Creating a User Document on page 62

• Copying User or Library Documents on page 63

• Specifying Document Summary Information on page 65

• Specifying Document Attributes on page 66

• Restricting Access to a Document on page 67

• Changing a Document Owner on page 68

Note If you are trying to edit a user document created by another user, and are unable to do 
so even when you have the correct user level and access privileges, check the 
document’s access property. If it is locked, you must ask the user who created the 
document to change the access property. See Restricting Access to a Document on 
page 67.

Creating a User Document

This procedure explains how to create a user document. A user document can be a program, 
function, function block, or data type.

Procedure

1 Expand the Application tree, right-click the User Documents folder, and then click New 
Document.
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2 Specify these properties in the New Document dialog box.

3 Click OK. The document is opened in the specified programming language.

Copying User or Library Documents

You can make copies of user documents you have created, as well as library documents. This 
can help you reduce development time by using an existing document as the basis for a new 
document.

Copying a User Document

This procedure explains how to copy a user document.

Procedure

1 Expand the Application tree, right-click the document to be copied, and click Copy.

If the document is open in TriStation, the Copy command will be unavailable. Close the 
document and then repeat step 1.

2 On the Edit menu, click Paste.

3 Enter the name for the new document, and click OK.

Property Action

Name Enter a descriptive name for the document.

Document Type Click the type of document to create. The default is Program.

Language Click the language type to use. The default is Function Block Diagram.

Application Type Click the type of application the document is to be used in. The default 
is Control.
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Copying a Library Document

This procedure explains how to make a copy of an existing library document. Only functions 
and data types can be copied; function blocks cannot be copied. 

Procedure

1 Expand the Application tree, open the Library Documents folder and locate the function 
or data type you want to copy.

2 Right-click on the function or data type, and select Copy.

If the document is open in TriStation, the Copy command will be unavailable. Close the 
document and then repeat steps 1 and 2.

3 In the Application tree, right-click the User Documents folder and select Paste.

4 Enter a name for the copied document, and then click OK.

The new function or data type is now located in the appropriate folder in the User 
Documents folder.
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Specifying Document Summary Information

This procedure explains how to specify summary information for a document.

Procedure

1 Expand the Application tree, right-click a document (program, function, function block, 
or data type) and click Properties.

2 Specify these properties on the Summary tab.

3 Click OK to save your changes.

Property Action

Name Displays the name of the document and version number.

Internal ID Displays an internal number used to identify the document.

Owned by Displays the name of the owner. To change, click Change Owner.

Created Displays the date and time the document was created.

Modified Displays the date and time the document was last modified.

Compiler Displays the date and time the document was last compiled.

Category Enter a name to be used to categorize the document. Documents can be 
organized and displayed by categories.

Description Enter a description for the document.

Document Access Select the type of access to allow for this document. The default is 
Read/Write. See Restricting Access to a Document on page 67.

Change Owner 
Command

Click the Change Owner button to change the owner of the document. 
See Changing a Document Owner on page 68.
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Specifying Document Attributes

This procedure explains how to specify document attributes, which include the type of 
application the document can be used in, and whether the document can be used in a CEM 
program.

Procedure

1 Expand the Application tree, right-click a document (program, function, function block, 
or data type) and click Properties. Click the Attributes tab.

2 Specify these properties on the Attributes tab.

3 Click OK to save your changes.

Property Action

Application Type Specify whether this document can be used in Safety, Control, 
or Safety and Control applications. The default is Control.

Cause Effect Matrix Support Select the check box for each type that is supported. Specify 
the number of inputs and outputs, if needed. Only available 
for functions and function blocks. See Enabling User-Defined 
Functions and Application-Defined States on page 97.

Enable Color Monitoring Select the check box if you want a color displayed for BOOL 
inputs and outputs when the application is run on the 
controller or emulator.
Only available for programs written in FBD, LD, or CEM.
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Restricting Access to a Document

This procedure explains how to restrict access to a document by setting the Access property. The 
most restrictive setting is for Read, which means anyone with a lesser security level than yours 
cannot change it. The least restrictive setting is for Read/Write, which means all users can read 
and change the document. You can also Lock the document to prevent editing by unauthorized 
users.

To change the setting for this property, you must have a User Security level that includes 
Change Access Attributes. See User Access on page 27 for more information.

Procedure

1 Expand the Application tree, right-click a document (program, function, function block, 
or data type), and click Properties. 

 

2 On the Summary tab, select the access type for this document. The default value is 
Read/Write. 

3 Click OK to save your changes.
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Changing a Document Owner

This procedure explains how to change the owner of a document, which determines whether 
other users can change the element. Normally, the owner of a document is the user who created it. 

To change the setting for this property, your user security level must:

• include the Elements: Change Access Attributes privilege

• be the same or greater than the security level of the user you want to assign as owner

See User Access on page 27 for more information about user security levels.

Procedure

1 Expand the Application tree, right-click a document (program, function, function block, 
or data type), and click Properties.

2 On the Summary tab, click Change Owner. 

3 In the Users dialog box, select the user who is to become owner of this element.

4 Click OK. 

The Owned By property in the Document Properties dialog box displays the name of the 
new owner.
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Function Block Diagram and Ladder Diagram 
Development

This section explains how to use Function Block Diagram (FBD) and Ladder Diagram (LD) 
languages to develop programs, functions, and function blocks. Topics include:

• Using the FBD Editor on page 69

• Using the LD Editor on page 70

• Function and Function Block Graphics on page 71

• Selecting Library Elements on page 72

• Specifying Function Properties on page 73

• Specifying Function Block Properties on page 74

• Specifying Function Block Application Usage on page 75

• Using a Space Saver Function Block on page 76

Using the FBD Editor

The Function Block Diagram (FBD) editor allows you to develop programs and functions by 
using a graphical language that corresponds to circuit diagrams. Toolbar commands are 
described in detail in Appendix A, Commands and Properties.

Figure 5 Function Block Diagram Editor Elements

1 Declaration Tree 6 Output Variable 11 Comment 16 Zoom to Fit

2 Selection Tools 7 I/O Variable 12 Horizontal Network 17 Previous Sheet

3 Function (Block) 8 Tagname 13 Vertical Network 18 Sheet Manager

4 Local Variable 9 Constant 14 Auto Name 19 Next Sheet

5 Input Variable 10 Wire Tool 15 Zoom

21 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19
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Using the LD Editor

The Ladder Diagram (LD) editor allows you to develop programs and functions by using a 
graphical language that corresponds to relay logic. Toolbar commands are described in detail 
in Appendix A, Commands and Properties.

Figure 6 Ladder Diagram Editor Elements

1 Declaration Tree 7 Input 13 Link Tool 19 Zoom to Fit

2 Selection Tools 8 Local Variable 14 Comment 20 Previous Sheet

3 Function (Block) 9 Output Variable 15 Horizontal Network 21 Sheet

4 Contact 10 I/O Variable 16 Vertical Network 22 Next Sheet

5 Coil 11 Tagname 17 Auto Name

6 Right Power Rail 12 Constant 18 Zoom

3 5 6 7 8 9 10 11 12 13 14 15 16 17 18 1921 4 20 21 22
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Function and Function Block Graphics

In FBD and LD languages, each function and function block is graphically represented on the 
logic sheet. For more information on specific functions and function blocks, see the TriStation 
1131 Libraries Reference.

Figure 7 Function and Function Block Elements

Table 23 Function Block Graphic Elements

Item Description

Instance name Identifies the specific implementation of a function block type.
For function blocks only.

Names of terminals Identify the input and output parameters used with the function block.

Terminals Locations where variables are attached.

Evaluation order Identifies the order in which the function is executed in the program. 

Type name Identifies the function block type.

Evaluation order 
in program

Input terminals

Names of input 
terminals

Output terminals

Type name (CSCHED)

Instance name for 
the function block

Output terminal
names

Input terminals

Evaluation order 
in program

Output terminal

Function Block

Function 
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Selecting Library Elements

This procedure explains how to select a library element to include in a project program or 
function. TriStation 1131 includes libraries of functions, function blocks, and data types that can 
be used in a project. Many of these elements include the source code, which can be copied to a 
program or function.

Procedure

1 Expand the Application tree, create or open a program. 

2 Click the Select Function (Block) Tool Element button .

3 Select the function or function block to be inserted, click OK, and then click on the logic 
sheet to place the element.

4 To insert another function or function block of the same type, click the Function (Block) 

Tool , then click on the logic sheet to place the element.

5 To select a different function or function block, repeat steps 2 and 3.

Note You can easily create your own function by making a copy of an existing library 
function, and then modifying it to suit your needs. See Copying a Library Document on 
page 64.
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Specifying Function Properties

This procedure explains how to specify properties for functions.

Procedure

1 Expand the Application tree and open a program or function. 

2 Double-click the graphic of the function whose properties you want to define.

3 Specify these properties on the Function tab. 

4 Click OK to save your changes.

Property Action

Number of Inputs If the Number of Inputs fields is enabled, the function is extensible, 
which means the number of inputs can be changed. To add inputs, enter 
the number of inputs and click Apply.

Invert Input If an input is inverted, the value is changed to the opposite value (True 
to False, or False to True) when the function is executed. Only available 
for BOOL inputs.
To invert the value for a specific BOOL value, select the input and then 
select the Invert Selected Input check box.

Invert Output If an output is inverted, the value is changed to the opposite value (True 
to False, or False to True) when the function is executed. Only available 
for BOOL outputs.
To invert the value for the output, select the Invert Output check box.

Width Click + or – to increase or decrease the width of the selected function 
graphic on the logic sheet.

EN/ENO To include an input and output parameter that detects errors in FBD 
and LD logic, select the EN/ENO check box.
Required in functions and function blocks used in LD programs.

Double Space Select the check box to have space in the function graphic on the logic 
sheet doubled between the inputs and outputs.
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Specifying Function Block Properties

This procedure explains how to specify properties for function blocks.

Function blocks must have at least one BOOL input and one BOOL output. All input, output, 
and local variables in a function block persist from one execution of a function block to the next 
execution. Consequently, the same function block invoked with the same inputs may not return 
the same outputs.

Any function block previously declared can be used in the declaration of another function block 
or program. The scope of an instance of a function block is local to the function block or program 
that declares the instance.

Procedure

1 Expand the Application tree and open a program or function block. 

2 Double-click the graphic of the function block.

3 Specify these properties on the Function Block tab. 

4 Click OK to save your changes.

Property Action

Instance Name Enter a name for this specific implementation of the function block.

Invert Input/Output If an input or output is inverted, the value is changed to the opposite 
value (True to False, or False to True) when the function is executed. 
Only available for BOOL inputs.
To invert the value for a specific BOOL value, select the input or 
output and then select the Invert Input/Output check box.

Width Click + or – to increase or decrease the width of the selected function 
block graphic on the logic sheet.

EN/ENO Only available with functions.

Double Space Select the check box to have space in the function block graphic on 
the logic sheet doubled between the inputs and outputs. The default 
is cleared.
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Specifying Function Block Application Usage

This procedure explains how to specify the Usage property for function blocks, which 
determines how the function block is used in a program. You can specify the usage for user-
defined function blocks, but you cannot change the settings for TriStation 1131 library function 
blocks.

Procedure

1 Expand the Application tree and expand the User Documents folder. 

2 Right-click a function block, click Properties, and then click the Usage tab.

3 Specify one of these settings on the Usage tab.

4 Click OK to save your selection.

Setting Action

Space Saver Use when a single instance can be executed more than once per scan to 
reduce memory usage and increase performance. 
For more information on specific requirements for using a function block as 
a space saver, see Space Saver on page 428.

Exactly Once Use when each instance should be executed exactly once per scan.

Only Once Use when each instance should be executed only once per scan, but does not 
need to be executed every scan.

Internal State Use when a single instance can be executed more than once per scan.
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Using a Space Saver Function Block

This procedure explains how to use a function block as a space saver. The Space Saver setting 
means a single instance can be executed more than once per scan to reduce memory usage and 
increase performance.

For user-defined function blocks, you can specify this setting. For Triconex Library function 
blocks, the setting cannot be changed.

Procedure

1 Declare only one instance of the function block and use that same instance throughout 
your program. On a function block diagram, just use the same instance name repeatedly.

2 To prevent mistakes, connect a value to every function block input. If you forget to 
connect an input, then you must search for a previous execution of the function block to 
see the input value because the function block remembers the input value from one 
execution to the next if the input is not connected.

3 Do not use the function block instance more than once in a network—the result is a 
WG0014 warning because the diagram could be ambiguous.
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Structured Text Development
This section explains how to use Structured Text (ST) language to write a program, function, 
function block, or data type. Structured Text is a high level language that has been specifically 
developed for industrial control applications.

For more information, see Programming Industrial Control Systems Using IEC 1131-3, by R.W. 
Lewis, London: Short Run Press Ltd., 1998.

Topics include:

• Using the ST Editor on page 78

• Defining an Enumeration Data Type on page 79

• Defining an Array Data Type on page 79

• Defining a Structured Data Type on page 80

• Declaring a VAR CONSTANT on page 81

• Declaring a VAR_TEMP on page 82

• Declaring a VAR_EXTERNAL on page 83

• Declaring Local Variables in ST on page 84

• Declaring Input and Output Variables in ST on page 84

• Using ForLoop and Exit Statements on page 85

• Using a CASE Statement on page 86

• VAR_IN_OUT Function Parameters on page 87
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Using the ST Editor

The Structured Text (ST) editor allows you to develop programs and functions by writing code. 
This figure shows the logic sheet and commands. Toolbar commands are described in detail in 
Appendix A, Commands and Properties.

Figure 8 Structured Text Editor Elements

The ST compiler allows you to insert tabs, spaces, and comments between keywords and 
identifiers wherever a space is required. Each statement must be terminated with a semi-colon 
(;) separator. Comments must be preceded by (* and followed by *), as shown in this example:

(* this is a comment *)

Note You can easily add code to your ST program by copying and pasting code from existing 
library or user documents. To do so, while viewing the code you want to copy, select the 
code, right-click on it, and select Copy. Then, return to your ST program, right-click 
where you want to add the code, and select Paste.

1 Read-Only 3 Replace Text 5 Larger Font 7 Type Over

2 Find Text 4 Line Numbers 6 Smaller Font 8 Auto Indent

1 2 3 4 5 6 7 8
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Defining an Enumeration Data Type

An enumerated data type is a data type that allows different states of a value to be given 
different names.

Syntax Example
TYPE ENUM_COLORS:

(YELLOW, RED, GREEN);
END_TYPE 

In this example, the value of a variable of type ENUM_COLORS is YELLOW, RED, or GREEN. 
Any other value is an error. The default initial value is YELLOW. The order for comparison 
increases from left to right.

Example
PROGRAM ST_Enumerations
VAR

MY_COLORS : ENUM_COLORS := GREEN;
END_VAR

if (MY_COLORS = GREEN)then
MY_COLORS := RED;

elsif (MY_COLORS = RED)then
MY_COLORS := YELLOW;

elsif (MY_COLORS = YELLOW)then
MY_COLORS :=GREEN;

end_if;

(* The following statement causes an error *)
(* MY_COLORS := 6; *)

END_PROGRAM

Defining an Array Data Type

An array is a group of data objects with identical attributes, which is sometimes referred to as 
multi-element variables. 

• Arrays can have one or two levels, and be up to 32 KB maximum. 

• The maximum number of array elements is 256,000. 

• An array index must be in the range of -2,147,483,648 to +2,147,483,647.

Syntax Example
TYPE ARRAY_DINTS :

ARRAY[1..6,1..20] OF DINT;
END_TYPE
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Example

For each array, the default initial value is the one defined for the array type. In this example, 
array type A has 10 elements of type INT.

TYPE A:
ARRAY [0 .. 9] OF INT ;

END_TYPE

Example

In this example, a variable declaration specifies a variable V of type A.

VAR V : A ; END_VAR

This means the array elements are referenced by the expressions:

V[0], V[1], . . , V[9]

The default initial values are 0 (zero).

Example

An index can be an expression of type ANY_INT, for example, V [I + 1].

For an array with more than one dimension, the sub-range is replaced with a comma-separated 
list of sub-ranges, and the array index is replaced with a comma-separated list of array indexes.

Defining a Structured Data Type

A structured data type is derived by defining a structure from existing data types by using 
elements of other specified types, which are accessed by their specified names. A structure can 
have a maximum of 400 elements.

Syntax Example
TYPE STRUCT_SENSOR :
   STRUCT

INPUT:DINT;
STATUS:BOOL;
HIGH_LIMIT:REAL;
ALARM_COUNT:INT;

   END_STRUCT;
END_TYPE

Each structured declaration consists of an element name followed by a colon, followed by a type 
specification. The default initial value of each structured element is the one defined for the 
structured type. In this example, the structured type called STRUCT_SENSOR has four 
structure elements: element INPUT of type DINT, element STATUS of type BOOL, element 
HIGH_LIMIT of type REAL, and element ALARM_COUNT of type INT.

If a variable declaration specifies a variable V of type STRUCT_SENSOR (VAR V : 
STRUCT_SENSOR ; END_VAR), then the four structure elements are referenced by the 
expressions V. INPUT, V.STATUS, and so on. The default initial values are 0, False (0), 0.0, and 0. 
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Declaring a VAR CONSTANT

A VAR CONSTANT is a named constant, which is appropriate for safety applications because 
the value cannot be changed in a program.

Syntax Example
VAR CONSTANT

StartUp_Speed: REAL : 12.3;
Gear_Ratio:INT : 12;

END_VAR

Program Example
PROGRAM ST_Constants
VAR CONSTANT

MILLISECS_IN_SEC : DINT := 1000;
END_VAR
VAR

TIMER_MILLISECS, TIMER_SECS : DINT;
GET_CALENDAR : TR_CALENDAR;

END_VAR
GET_CALENDAR(CI := TRUE);
TIMER_SECS := GET_CALENDAR.SECOND;
TIMER_MILLISECS := TIMER_SECS * MILLISECS_IN_SEC;
(* The following statement causes an error because MILLISECS_IN_SEC 
*is a VAR CONSTANT*)
(* MILLISECS_IN_SEC := 999; *)

END_PROGRAM
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Declaring a VAR_TEMP

A VAR_TEMP is a variable which is appropriate for safety applications because the variables are 
placed in a temporary memory area (not local memory) which is cleared when the program, 
function, or function block terminates. A VAR_TEMP variable provides no persistence. During each 
scan, it is automatically initialized to zero at the start of the program, function, or function block.

Syntax Example
VAR_TEMP

RESULT : REAL;
END_VAR;

Function Block Example
FUNCTION_BLOCK ST_VarTemp
VAR_TEMP

(* These 4 bytes will not be counted 
   as LOCAL variables *)
TEMP_SUM : REAL;
IS_ROUNDUP : BOOL;

END_VAR

VAR_INPUT
INP_1, INP_2, INP_3: REAL ;
FORCE_ROUNDUP: BOOL ;

END_VAR

VAR_OUTPUT
OUT_SUM : DINT ;
OUT_BOOL : BOOL ;

END_VAR

VAR
LOC_ROUNDUP : BOOL := FALSE;

END_VAR

TEMP_SUM := INP_1 + INP_2 + INP_3;
IS_ROUNDUP := (LOC_ROUNDUP OR FORCE_ROUNDUP);
if (IS_ROUNDUP) then
    TEMP_SUM := CEIL(TEMP_SUM);
    LOC_ROUNDUP := FALSE;
else
    TEMP_SUM := FLOOR(TEMP_SUM);
    LOC_ROUNDUP := TRUE;
end_if;

OUT_SUM := REAL_TO_DINT(TEMP_SUM);
OUT_BOOL := IS_ROUNDUP;

END_FUNCTION_BLOCK
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Declaring a VAR_EXTERNAL

A VAR_EXTERNAL (also known as a global variable) allows access to tagnames (also known 
as tagname declarations in TriStation 1131).

Syntax Example
VAR_EXTERNAL

TagName_1, Tagname_5, Tagname_9 : BOOL;
END_VAR

Program Example
PROGRAM ST_VarExternal

VAR_EXTERNAL
TagName_1, Tagname_5, Tagname_9 : BOOL;

END_VAR

if (Tagname_1) then
Tagname_1 := FALSE;

else
Tagname_1 := TRUE;

end_if;

if (Tagname_5) then
Tagname_5 := FALSE;

else
Tagname_5 := TRUE;

end_if;

if (Tagname_9) then
Tagname_9 := FALSE;

else
Tagname_9 := TRUE;

end_if;

END_PROGRAM
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Declaring Local Variables in ST

A local variable is declared within function blocks using the VAR..END_VAR construct. Local 
variables in a program or function block are initialized with initial values (the default is zero) at 
startup. Function block instances are actually local variables and are declared as such.

Syntax Example
VAR

UpCount : INT:= 100; (* Declares initial value to be 100 *)
Reset : BOOL;        (* Declares Boolean variable Reset *)
UpCounter : CTU;     (* Declares instance of CTU function block*)

END_VAR

Declaring Input and Output Variables in ST

Input and output variables are declared using the VAR_INPUT ... END_VAR and 
VAR_OUTPUT...END_VAR constructs. All input variables must be declared before any output 
variables can be declared.

Function Block Example
FUNCTION_BLOCK AVERAGE
(* Variable Declarations *)
VAR_INPUT

RESET : BOOL ;        (* 1 = reset, 0 = calculate *)
CURRENT_VALUE : DINT ;(* Current Value from UPDOWN *)

END_VAR
VAR_OUTPUT

STATUS : BOOL ; (* State => 1 = resetting, 0 = calculating *)
XOUT : DINT ;   (* Avg Output = Current_Value Divided by MAX_COUNT *) 

END_VAR
(* Your execution statements here *)
END_FUNCTION_BLOCK
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Using ForLoop and Exit Statements

The ForLoop and Exit statements allow a set of statements to be repeated depending on the 
value of an iteration variable. 

Program Example
PROGRAM ST_ForLoop

VAR
MY_ARRAY : ARRAY_DINTS;
COUNT : DINT;
IDX_1, IDX_2 : INT;

END_VAR

for IDX_1 := 1 to 6 do
for IDX_2 := 1 to 20 do
    MY_ARRAY[IDX_1,IDX_2] := COUNT;
      (* This statement causes an error because IDX_1 is being used
       * as the counter for the ForLoop structure *)
      (* IDX_1 := 20; *)
end_for;
if (COUNT = 100) then

exit;
end_if;

end_for;

COUNT := COUNT + 1;

END_PROGRAM
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Using a CASE Statement

The CASE statement allows a selected statement to be executed depending on the value of an 
expression that returns an integer result. Only numerical values can be used for the reference 
items in the CASE statement. If variables are used, TriStation rejects the code.

Allows up to 5,000 selection statements.

Program Example
PROGRAM ST_Case

VAR
SETTING : DINT := 0;
SPEED :REAL := 0.0;

END_VAR

if (SETTING > 10) then
SETTING := 0;

end_if;
SETTING := SETTING + 1;

(*Select a SPEED based on the value of SETTING *)
case SETTING of

1: SPEED := 5.0;
2: SPEED := 7.5;
3,4,5:SPEED := 12.0;
6: SPEED := 15.0;
7,8:SPEED := 18.0;
9: SPEED := 21.0;
10:SPEED := 25.0;

else
SPEED := 0.0; 

end_case;

END_PROGRAM
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VAR_IN_OUT Function Parameters

The VAR_IN_OUT function parameters allow more than one input and more than one output 
in a function block. 

Syntax Example
VAR_IN_OUT

INOUT_1, INOUT_2, INOUT_3 : DINT ;
END_VAR

Function Example
FUNCTION ST_VarInOut : BOOL

VAR_IN_OUT
INOUT_1, INOUT_2, INOUT_3 : DINT ;

END_VAR

if (INOUT_1 > 64000) then
INOUT_1 := 0;

end_if;
INOUT_1 := INOUT_1 + 1;

if (INOUT_2 > 64000) then
INOUT_2 := 0;

end_if;
INOUT_2 := INOUT_2 + 2;

if (INOUT_3 > 64000) then
INOUT_3 := 0;

end_if;
INOUT_3 := INOUT_3 + 3;

ST_VarInOut := TRUE;

END_FUNCTION

CAUTION
You should not use the VAR_IN_OUT variable in a safety application. 
Safety standards (such as IEC 61508) recommend limiting the use of 
pointers in safety applications; VAR_IN_OUT is used as a pointer in 
TriStation 1131. 

To automatically check for the use of VAR_IN_OUT in your safety 
application, set the Application Type to Safety for the programs included 
in the application (for more information, see Application Type on 
page 320).
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Cause Effect Matrix Development
This section explains how to use the Cause Effect Matrix (CEM) language to create a program 
based on a cause and effect matrix. Topics include:

• CEMPLE Overview on page 88

• Using the CEM Editor on page 90

• Setting up a CEM Program on page 93

• Using User-Defined Functions and Application-Defined States on page 96

• Specifying Local Variables, Tagnames, and Constants in a CEM Program on page 98

• Working with Cells, Rows, and Columns in a CEM Program on page 99

• Editing the Title Block on page 106

• Managing Views on page 107

• Variables and Constants on page 108

CEMPLE Overview

CEMPLE is an optional TriStation 1131 language editor that automates the process of creating 
a program based on a cause and effect matrix. Cause and effect matrix is a methodology that is 
commonly used in the process control industry to define alarms, emergency shutdown 
strategies, and mitigation actions.

A matrix created in CEM language can be as basic or complex as your situation requires. In a 
basic matrix, causes are identified as True or False inputs related to one or more effects through 
the intersections between them. The state of a cause (True or False) determines the state of the 
related effect. If more than one cause is related to an effect, the state of the effect is based on how 
the matrix is evaluated. You can specify the matrix evaluation as a de-energize-to-trip (fail-safe) 
or energize-to-trip system. In a typical de-energize-to-trip system, if one of the inputs changes 
to False, the related outputs also change to False. In an energize-to-trip system, the reverse is 
true; if one of the inputs changes to True, the related outputs also change to True.

For more complex processes, CEM language allows you to add functions or function blocks to 
causes, intersections, and effects. This feature can be used for many purposes; for example, to 
accept non-Boolean input and convert to Boolean output, to set timers before evaluating the 
input, and to pass additional input variables to output variables.

CEM language includes these features:

• Ability to specify up to 99 causes, 99 effects, and 1,000 intersections 

• Ability to invoke functions and function blocks to evaluate cause, intersection, and 
effect states

• Choice of de-energize-to-trip or energize-to-trip matrix evaluation

• Automatic conversion of matrix to Function Block Diagram language

• Customized view monitoring of active causes, intersections, and effects

• Multiple levels of undo and redo editing
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Matrix Planning

Planning includes determining the causes (problems) to be monitored, and determining how 
the matrix is to be evaluated. 

Restrictions and Limitations

• No more than 99 causes, 99 effects, and 1,000 intersections.

• Variables with a variable type of In/Out (VAR_IN_OUT) are not allowed in CEM 
programs, function blocks that are invoked by matrix programs, or any safety program 
or function block.

Matrix Evaluation Options

When planning a matrix, you must determine how the matrix is evaluated when it includes multiple 
causes and effects. If the matrix is based on an energize-to-trip system, such as a fire suppression 
system, an OR evaluation is typically used because the normal state of inputs is False. If one of the 
inputs changes to True, the related outputs also change to True. The default setting is OR.

If the matrix is based on a de-energize-to-trip (fail-safe) system, an AND evaluation is typically 
used because the normal state of inputs is True. If one of the inputs changes to False, the related 
outputs also change to False. This is why it is typically used with systems that are designed to 
be fail-safe.

How a Matrix is Evaluated

When a matrix is executed, the states of causes, effects, and intersections are evaluated in a 
specific order. The states of causes, intersections, and effects are saved in internal variables. An 
internal Move function moves the cause state to the intersection state, and then to the effect 
state. The order of evaluation is shown and described in this figure.

Figure 9 CEMPLE Matrix Evaluation Steps

3. For each column from the left to the right, an effect state 
is determined based on the intersection state and the 
function associated with the effect.

2. For each intersection from 
the bottom to the top, a state is 
determined based on the cause 
state and intersection function. 
For typical AND evaluations, all 
cause states must be True for 
the intersection state to be True 
and one False state makes the 
output False.
For typical OR evaluations, all 
cause states must be False for 
the intersection state to be 
False and one True state makes 
the output True.

1. For each cause from the top 
row to the bottom, a state is 
determined based on the 
inputs and function associated 
with the cause.
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Using the CEM Editor

The CEM editor allows you to create a TriStation 1131 program based on a cause and effect 
matrix. The editor includes the following areas:

• Matrix: Identifies causes, effects, and the intersections between them. Can also include 
inputs, outputs, functions, and function blocks related to causes, effects, and 
intersections.

• FBD Network: Displays the Function Block Diagram (FBD) related to the cause, effect, 
or intersection that you select in a matrix. It also allows you to specify properties and to 
invert the values of variables.

• Variable Detail Table: Displays the inputs and outputs of an FBD network that are 
generated when a cause, effect, or intersection is selected. It also allows you to specify 
variable type and data type.

This figure depicts the areas in the CEM Editor.

Figure 10 CEMPLE Editor Elements

Matrix rows and columns

Variable Detail Table FBD Network
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Matrix

The matrix area of the CEM editor includes the rows, columns, and intersections of a matrix. In 
a basic matrix that does not use functions, causes can be directly related to effects through 
intersections. In a more complex matrix, such as this figure, functions can be included for 
causes, effects, and intersections. When functions are included, the inputs and outputs of those 
functions can be specified in the matrix.

Figure 11 CEMPLE Matrix Elements

FBD Network

The FBD Network area of the CEM editor displays the Function Block Diagram (FBD) related to 
the cause, effect, or intersection that you select in the matrix. The FBD network uses internal 
Boolean variables to save and move results to associated cells so that causes and effects can be 
evaluated. When you create a cause, intersection, or effect, an internal variable is automatically 
created for each.

The CEM editor uses internal variables to store and move results between cells. Although you 
cannot directly access the internal variables, you can create variables and copy the values to 
those variables. You can also specify properties and invert values of variables.

If you select a cause, effect, or intersection that does not contain a function, or if you make 
multiple selections, the FBD network cannot display appropriate information.

Effect items

Cause items

Intersections
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Figure 12 FBD Network Area in CEMPLE Editor

Variable Detail Table

The Variable Detail Table area of the CEM editor displays the inputs and outputs of an FBD 
Network that are generated when a cause, effect, or intersection is selected. This figure shows 
the names, variable types, and data types related to the function block.

Figure 13 Variable Detail Table in CEMPLE Editor

FBD Network area
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Setting up a CEM Program
The following sections describe how to set default options that apply to CEM programs.

Specifying CEM Editor Options

This procedure explains how to set the options used as initial settings for all the CEM (cause and 
effect matrix) programs in a project. After a program is created, you can modify these settings 
on a program-by-program basis.

Procedure

1 On the Tools menu, click TriStation 1131 Options, and then click the CEM Editor tab.

2 Specify these properties on the CEM Editor tab. 

3 Click OK to save the settings.

Property Action

Cause Header Functions On 
by Default

Select the check box to have input and function columns 
added. The default is cleared.

Effect Header Functions On 
by Default

Select the check box to have output and function columns 
added. The default is cleared.

Intersection Functions On by 
Default

Select the check box to have function columns added. The 
default is cleared.

Default Number of Cause 
Rows

Enter the number of rows to include in a new matrix. The 
default is 22.

Default Number of Effect 
Columns

Enter the number of columns to include in a new matrix. 
The default is 25.
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Specifying CEM Element Options

This procedure explains how to specify whether functions are used in a specific CEM program, 
and how the matrix is evaluated.

Procedure

1 Expand the Application tree, double-click a program, click the Document menu, and 
then click Options.

2 Specify these properties in the CEM Element Options dialog box.

3 Click OK to save the settings.

Property Action

Enable Cause Header 
Functions

Select the check box to add an input and function column to the 
cause header. The default is selected.

Enable Effect Header 
Functions

Select the check box to add an output and function column to the 
effect header. The default is selected.

Enable Intersection 
Functions

Select the check box to add a function column to the intersection. 
The default is selected.

Enable Floating Text in 
Intersection Cells

Select the check box to allow the name of the function or function 
block to be displayed in a neighboring cell if that cell is empty. 
This is useful when the name of the function or function block is 
long. The default is cleared.

Evaluation Options Specify how the matrix is to be evaluated when it includes 
multiple intersections between a cause and effect. The default is 
OR.
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Specifying Monitor Colors and Names

This procedure explains how to specify the colors that are displayed for True and False BOOL 
values when an application is monitored on the Controller and Emulator Panels.

Procedure

1 On the Project menu, click Project Options, and then click the Monitor Colors tab.

2 Under CEM Monitor Colors, select the color for True and False for cause, effect, and 
intersection cells in a CEM (cause and effect matrix).

The default for True is red; False is white.

3 Click OK to save your changes.
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Using User-Defined Functions and Application-Defined States

This section describes how user-defined functions and application-defined states can be used in 
a CEM program.

User-Defined Functions

User-defined functions must be enabled before they can be used in a CEM program. (Triconex-
supplied functions and function blocks do not have to be enabled.) When you enable a function, 
it is validated to ensure it can be used in that part of the matrix. For example, a function used in 
an intersection must have a Boolean primary input and Boolean primary output. If not enabled, 
the function is not available for selection.

Application States

User-defined functions can include a variable that stores application states and that is evaluated 
in the same way as the cause, intersection, and effect internal variables. This means you can 
include application information that is evaluated with an AND or OR operation when the 
matrix is run. Application state inputs and outputs must be a DWORD data type, which is a 
32-bit string.

This figure shows an example of using a variable to store the application state.

Figure 14 Using a Variable to Store Application State

For the cause function 
block, the second 
output is the 
application state.

For the intersection 
function block, the 
second input and 
output of the function 
is the application state. 

For the effect function 
block, the second 
input and output of the 
function is the 
application state.
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Enabling User-Defined Functions and Application-Defined States

This procedure explains how to enable user-defined functions and application-defined states 
for a specific matrix. If a user-defined function is not enabled, it cannot be used in a matrix.

Procedure

1 Expand the Application tree, right-click the user-defined function, click Properties, and 
then click the Attributes tab.

2 Specify these properties on the Attributes tab.

3 Click OK to save the settings.

4 In the Application tree, double-click the function to open it on a logic sheet.

5 On the Document menu, click Compile.

The compile process determines whether the function can be used.

Property Action

Application Type Click either Control or Safety and Control.

Supports Use in Cause Rows 
with... Inputs

Select the check box to enable the function for use in cause 
rows, and then select the required number of inputs. The 
default is cleared.

Supports Use in Effect 
Columns With... Outputs

Select the check box to enable the function for use in effect 
columns, and then select the required number of outputs. 
The default is cleared.

Supports Use in Intersections Select the check box to enable the function for use in 
intersections. The default is cleared.

Supports Application Defined 
States

Select the check box to enable the function to add a variable 
to store the application defined state. The default is cleared.
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Specifying Local Variables, Tagnames, and Constants in a CEM Program

This procedure explains how to specify local variables, tagnames, and constants in a CEM 
program. When functions are used with causes or effects, the inputs and outputs to the 
functions must be specified as variables or constants. 

In/Out variables (VAR_IN_OUT) are not allowed in CEM programs, function blocks that are 
invoked by CEM programs, or any safety program or function block.

Procedure

1 Expand the Application tree, expand User Documents, and double-click a CEM 
program.

2 Select or type the name in the Input or Output columns, or in the Var/Const column in 
the Variable Detail Table.

Specifying Properties in the Variable Detail Table

This procedure explains how to modify properties in the Variable Detail Table, which is located 
in the lower left part of the CEM program.

Procedure

1 Expand the Application tree, and open a CEM program.

2 Specify these properties in the Variable Detail Table.

If the changes are valid, the declaration is changed. If not, a message displays explaining 
why the declaration was not changed.

Property Action

Var/Const Enter a variable or constant name. 

Var Type Select Local or Tagname.

Data Type Select a data type. 

Description Enter a description for the variable or constant.
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Working with Cells, Rows, and Columns in a CEM Program
The following sections describe how to work with the cells, rows, and columns that make up a 
CEM program matrix. 

Selecting and Editing Cells in a CEM Program

This table and figure explain how to select one or more cells in a CEM program.

Figure 15 Selecting CEMPLE Matrix Cells

This table explains how to edit cells in a matrix.

To ... Do This ...

Select a single cell Click anywhere in the cell.

Select contiguous (adjacent) cells Click the first cell, hold down the shift key, and click the 
last cell in the area.

Select discontiguous (non-adjacent) cells Click a cell, hold down the Ctrl key, and click the rows or 
column.

To ... Do This ...

Enter edit mode Click directly over the text in an editable cell. 

Complete a cell entry Press the tab key or Enter to complete a cell entry and move the cursor to 
the next cell to the right.

Move to the next cell Press the tab key or Enter to move the cursor to the next cell to the right.

Delete the contents of a 
cell or group of cells

Select a cell or group of cells (but do not place in edit mode) and press the 
delete key.

Click here 
to select all 
causes

Click here 
to select 
one cause

Click here to select all 
intersections in a row

Click here to select 
all effects

Click here to 
select one effect

Click here to select 
all intersections

Click here to 
select all 
intersections in a 
column
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Displaying and Sizing Cells from the Matrix

This table describes how to change the display and size of cells in a matrix. You can also make 
changes by using commands on the View menu. These actions do not affect the matrix 
evaluation.

To drag or double-click a cell boundary, you must use the double-arrow cursor, which is only 
active in the gray cells of a matrix.

Inserting Columns

This procedure explains how to insert columns in a CEM program.

Procedure

1 Expand the Application tree, open a CEM program, 
and do either of these:

• Click the Insert Columns button  on the 
toolbar

• Click the Edit menu, and then click Insert 
Columns

2 Enter the number of columns to insert.

3 Select the column and click Before or After to specify where the column is to be inserted.

4 If you do not want the column to be displayed, clear the Make visible on all managed 
views check box.

5 Click OK. The new column is inserted in the location you specified.

To ... Do This ...

Change width of column Drag the column boundary left or right.

Restore size of column Drag the column boundary to the left so that the column is almost 
hidden, then release the button.

Change height of row Drag the row boundary up or down.

Restore default size of row Drag the row boundary upward until the row is almost hidden, then 
release the button.

Hide a column Drag the column boundary to the left until it meets the nearest 
boundary.
For an effect column, double-click the thickened column boundary. 

Unhide a column For a cause column, double-click the boundary between the currently 
displayed columns and the hidden column.

Hide a row Drag the row boundary upward until it meets the nearest boundary.

Unhide a row Double-click the thickened row boundary. 
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Inserting Rows

This procedure explains how to insert rows in a CEM program.

Procedure

1 Expand the Application tree, open a CEM program, 
and do either of these:

• Click the Insert Rows button  on the toolbar

• Click the Edit menu, and then click Insert Rows

2 Enter the number of rows to insert.

3 Select the row and click Before or After to specify 
where the row is to be inserted.

4 If you do not want the column to be displayed, clear 
the Make visible on all managed views check box.

5 Click OK. The new row is inserted in the location you specified.

Deleting Columns

This procedure explains how to delete columns in a CEM program. Column numbers are 
identified at the top of the column as shown in this figure.

Figure 16 CEMPLE Matrix Column Numbers

Procedure

1 Expand the Application tree, open a CEM program, 
and do either of these:

• Click the Delete Columns button  on the 
toolbar

• Click the Edit menu, and then click Delete 
Columns

2 Enter the number of columns to delete and the 
starting column number.

The selected column (E01 in this example), and the x columns to the right of the selected 
column will be deleted, where x is the number of columns to delete.

3 Confirm your selections, and then click OK. The selected columns are deleted.

Column numbers are 
located here.
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Deleting Rows

This procedure explains how to delete rows in a CEM program. Row numbers are identified to 
the left of the row as shown in this figure.

Figure 17 CEMPLE Matrix Row Numbers

Procedure

1 Expand the Application tree, open a CEM program, 
and do either of these:

• Click the Delete Rows button  on the toolbar

• Click the Edit menu, and then click Delete Rows

2 Enter the number of rows to delete and the starting 
row number.

The selected row (C01 in this example), and the x 
columns below the selected row will be deleted, where x is the number of rows to delete.

3 Confirm your selections, and then click OK. The selected rows are deleted.

Row numbers are 
located here.
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Sizing and Hiding Columns

This procedure explains how to size and hide columns in a CEM program.

Procedure

1 Expand the Application tree, open a CEM program, and do either of these:

• Click the Size/Hide Columns button  on the toolbar

• Click the View menu, and then click Size/Hide, and then Columns

2 Specify these properties in the Size/Hide Columns dialog box.

3 Click OK to save your changes.

Property Action

Number of columns to 
adjust

Enter the number of columns you want to resize.

Adjust starting from 
column

Select the starting column.

New size Select and then enter the new size for the column.

Size to Content Select to automatically size the column to its content.

Restore Default Sizes Select to restore the column to the default size.

Hide or Unhide Select Hide or Unhide. If hidden, the column is not displayed, 
but it is used in the matrix evaluation.
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Sizing and Hiding Rows

This procedure explains how to size and hide rows in a CEM program.

Procedure

1 Expand the Application tree, open a CEM program, and do either of these:

• Click the Size/Hide Rows button  on the toolbar

• Click the View menu, and then click Size/Hide, and then Rows

2 Specify these properties in the Size/Hide Rows dialog box.

3 Click OK to save your changes.

Property Action

Number of rows to 
adjust

Enter the number of rows you want to resize.

Adjust starting from 
row

Select the starting row.

New size Select and then enter the new size for the row. 

Restore Default Sizes Select to restore the row to the default size. 

Hide or Unhide Select Hide or Unhide. If hidden, the row is not displayed, but it is 
used in the matrix evaluation.
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Sizing and Hiding the Comment Column

This procedure explains how to size and hide the comment column in a CEM program.

Procedure

1 Expand the Application tree and open a CEM program. From the View menu, click 
Size/Hide, and then Comment Column.

2 Specify one of these properties in the Size/Hide Comment Column dialog box.

3 Click OK to save your changes.

Property Action

Restore Default Size Select to restore the comment column to its default size.

New size Select and then enter the new size for the column.

Hide or Unhide Select Hide or Unhide. If hidden, the column is not displayed.
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Editing the Title Block

This procedure explains how to edit information in the title block, which is included when the 
CEM program is printed. 

Procedure

1 Expand the Application tree, open a CEM program, click the Sheets menu, and then click 
Edit Sheet Title.

2 Enter text to describe the matrix.

3 Click OK to save your changes.
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Managing Views

This procedure explains how to save, load, and remove views of CEM programs. 

A view is a display of a selected portion of the matrix. You can create a view by hiding or 
showing columns and rows on the matrix, either by using menu commands or by dragging 
columns and rows on the matrix. Saving the view allows you to load it at anytime.

Procedure

1 Expand the Application tree and open a CEM program.

2 Change the view by showing or hiding columns and rows. Use commands on the View 
menu or drag columns and rows on the matrix. 

3 On the View menu, click Manage Views.

4 Perform one or more of these actions in the View Manager dialog box.

Command Action

Load Select a view and click Load to have it displayed.

Save Click to save the currently displayed view.

Remove Select a view and click Remove to delete the view from the list.

Restore All Defaults Click to restore the current view to show all causes and effects.

Close Click to save your changes and close the View Manager dialog box.

Cancel Click to close the View Manager dialog box without saving your 
changes.
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Variables and Constants
This section explains how to create variables and constants in FBD, LD, and CEM languages. For 
information on tagnames (global variables), see Tagnames on page 115.

The maximum number of tagnames and variables in a program is 2000.

Topics include:

• Declaring Variables on page 108

• Specifying Variable Properties on page 109

• Specifying Variable Annotation Properties on page 110

• Naming Multiple Variables on page 111

• Changing Multiple Variables on page 112

• Creating Constants on page 113

Declaring Variables 

This procedure explains how to declare input, output, in/out, and local variables in FBD, LD, 
and CEM languages. Variables store values and must be declared in order to be used in a 
program or function.

Procedure

1 Create a variable by doing either of the following:

• On the toolbar, click the icon for the variable, and then click on the logic sheet (FBD 
or LD only).

• On the program or function Declarations tree, right-click the folder for the type of 
variable to be declared, and click New Declaration.

The Item Properties dialog box for the variable appears.
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2 Specify these properties on the Declaration tab.

Specifying Variable Properties

This procedure explains how to specify properties for variables. Properties affect the selected 
occurrence of the variable. For example, when you add an annotation to a variable, it affects 
only the selected variable.

Procedure

1 Expand the Application tree and then open a program or function.

2 On the logic sheet, double-click the icon that represents the variable.

3 Specify these properties on the Variable tab.

Property Action

Name Enter a name for the variable. Use only alphanumeric characters and 
underscores. No symbols or spaces are allowed.

Data Type Select a data type; must be BOOL, DINT, or REAL. Required.
If the variable is dragged to a function terminal, the Data Type is 
automatically set to the correct type for the function.

Initial Value Specify a value to be used on the first scan. Must agree with the Data 
Type.

Description Enter a description for the variable. (Optional)

Var Type Select the type of variable. Required.
For programs, can be Local only.
For functions, can be Input, Output, In/Out, or Local.

Property Action

Variable Name To change the selected variable to a different variable, select the 
variable name and click Apply.
To create a new variable, enter a new name, and click Apply.
To change the name of all the variables with this name, click 
Declaration and change the name of the variable. 
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4 Click Apply to save your changes. 

Specifying Variable Annotation Properties

This procedure explains how to specify text and macros to be included with an annotation. 

Annotations are available only in FBD and LD programs.

Procedure

1 Expand the Application tree and then open a program or function.

2 On the logic sheet, double-click the icon that represents the variable.

3 On the Variable tab, select the Annotate check box and then click the Annotation tab.

4 Specify these properties on the Annotation tab.

Data Type Displays the data type that was set on the Declaration tab.
If the variable has not been declared, the Data Type is undefined.

Width Click + or – to increase or decrease the width of the variable icon on 
the logic sheet.

Annotate Select the check box to add an annotation to the variable. The 
default is cleared. See Specifying Variable Annotation Properties 
on page 110 for more information about annotations.

Declarations 
Command

Click to view the Declaration tab for the variable. See Declaring 
Variables on page 108 for more information.

Auto Name Command Click to view the Automatic Naming dialog box. See Naming 
Multiple Variables on page 111 for more information.

Property Action

Property Action

Annotation Text Enter text or copy macros to be used in the annotation.
To copy a macro, see Using Macros with Annotations and 
Comments on page 143.
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5 Close the Properties dialog box to save your changes to the Annotation tab.

Naming Multiple Variables

This procedure explains how to name multiple variables by specifying a format. Variables can 
be named by row, column, and selection order. The variables must exist before they can be 
named.

Procedure

1 Expand the Application tree and open a program or function logic sheet. On the logic 
sheet, hold the Shift key. 

To have variables named based on the selection order, click them in the order in which 
you want them named.

2 On the Tools, menu, click Auto Name Selected Items.

3 Specify these properties in the Automatic Naming dialog box.

Include Monitor Value in 
Annotation

Select this check box to display the value of the variable in the 
annotation when the element is run on the controller or emulator.
Available only in programs. 

Macros Command Click to display the list of macros that can be added. 
To copy a macro, click the macro and press Ctrl+C. Click OK to 
close the Edit Macro dialog box. 
To paste the macro in the Annotation tab, press Ctrl+V.

Property Action
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4 Click OK to apply the formatted name to the selected variables.

Changing Multiple Variables

This procedure explains how to change size and annotation settings for multiple variables on a 
logic sheet.

Procedure

1 On a logic sheet, select the variables you want to change by pressing the Shift key while 
you click the variables. 

2 Double-click one of the selected variables. The Item Properties dialog box appears.

3 Specify these properties on the Variable or Annotation tabs.

Property Action

Formatted Name Specify whether to use theater numbering, which uses letters, or normal 
numbering, which uses numbers. 

Start Value and 
Increment

Enter the starting value for the first variable and the number to use 
when incrementing each successive variable.

Name Order Select the order in which to name variables.
• Rows—Names are applied vertically, from left to right.
• Columns—Names are applied horizontally, from top to bottom.
• Selection Order—Names are applied based on the order in which 

they were selected.

Property Action

Variable Name To change all the variables to the same variable, select or enter the 
name.
To undo this change, press Ctrl+Z.

Width Click the + button to increase the width of the variable graphics.
Click the – button to decrease the width of the variable graphics.
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4 Close the Properties dialog box to save your changes to the Annotation tab.

5 If necessary, undo the changes you just made by pressing Ctrl+Z. Multiple levels of 
undo are available.

Creating Constants

This procedure explains how to create constants in FBD, LD, and CEM languages. A constant is 
a value that can be used in a program or function.

Procedure

1 Expand the Application tree, and open a program or function. 

2 On the toolbar, click , and then click in the logic sheet.

3 Specify these properties on the Constant tab.

4 Click the Apply to save your changes.

Annotate To add the same annotation to each variable, select the Annotate 
check box, click the Annotation tab, and then enter or copy the text 
or macro.

Auto Name Command To automatically name the selected variables based on a pattern, 
click and specify the pattern. See Naming Multiple Variables on 
page 111.

Property Action

Property Action

Use Local Time Enter the value for the constant.

Data Type Select the data type; must be appropriate for the Value property.

Width Click the + button to increase the width of the constant graphic.
Click the – button to decrease the width of the constant graphic.

Annotate To add an annotation to the constant, select the Annotate check box, 
click the Annotation tab, and then enter or copy the text or macro.

Auto Name 
Command

To automatically name the selected constants based on a pattern, click 
and specify the pattern. See Naming Multiple Variables on page 111.
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Specifying Constant Annotation Properties

This procedure explains how to specify text and macros to be included with a constant 
annotation. This can be used only in FBD and LD development.

Procedure

1 On a logic sheet, double-click a constant. 

The Item Properties dialog box appears.

2 On the Constant tab, select the Annotate check box and then click the Annotation tab.

3 Specify these properties on the Annotation tab.

Property Action

Annotation Text Enter text or copy macros to be used in the annotation.

Macros Command Click to copy a macro. See Using Macros with Annotations and 
Comments on page 143.
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Tagnames
This section describes tagnames. Tagname is the term commonly used when referring to input 
points (sensors) and output points (final elements). In TriStation 1131, tagnames are references 
to physical tagnames (labels) on the connected field devices or to memory points which are 
locations in the controller memory. In IEC terminology, tagnames are called global variables.

For Modbus or DDE communication, tagnames must be assigned an alias number that allows 
read or read/write access. An alias number is a five-digit identifier which defines the data type 
and location of a point in the controller memory.

For Peer-to-Peer, OPC, or TSAA applications, tagnames can be accessed by the tagname—an 
alias number is not needed.

Topics in this section include:

• Declaring Tagnames on page 115

• Assigning an Alias Number, Alias Type, and Physical Address on page 117

• Scaling a REAL Point on page 120

• Specifying Display Options for Tagnames on page 121

• Creating Multiple Tagnames on page 122

• Renaming a Tagname on page 123

• Deleting Tagnames on page 123

• Changing Multiple Tagnames on page 124

• Inserting a Column into the Tagnames Table on page 125

• Deleting a Column from the Tagnames Table on page 125

Declaring Tagnames

This procedure explains how to declare tagnames for points. Tagnames describe the type of 
point (input, output, or memory) and the properties associated with the point. You can declare 
tagnames before or after writing programs. Tagnames must be declared before downloading 
the application to the controller.

Procedure 

1 Create a tagname by doing any of these:

• On the toolbar, click the tagname tool , click on the logic sheet, enter a new 
name, and then click the Declarations button.

• Right-click the Tagname Declarations folder, and click New Tagname.

• Right-click the Declarations tree, and click New Tagname.
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2 Specify these properties on the Declaration tab.

3 Click Apply to save your changes.

Property Action

Tagname Enter a name for the tagname.

Data Type Select a data type. The default is BOOL.

Group 1 and Group 2 Enter the names of the groups this tagname belongs to.

Description Enter a description for the tagname.

Initial Value Enter the value to be used for the tagname when the system starts up.

Application Type Specify whether the tagname is to be used in a Safety or Control 
application. The default is Control.

Shared Read Select the check box to allow a different Application Type to read 
the tagname. The default is cleared.

Retentive Select the check box to have the value of the tagname retained if a 
power failure occurs. The default is cleared.
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Assigning an Alias Number, Alias Type, and Physical Address

This section includes procedures for assigning information to a tagname, including assigning 
an alias number and physical address to input or output points, and assigning an alias number 
and alias type to memory points.

Before You Begin

For input and output points, the I/O hardware configuration must be completed before a 
physical address or alias number can be assigned. For more information, see Tricon Hardware 
Allocation on page 184 or Trident Hardware Allocation on page 192.

Procedure for Input and Output Points

1 Open an input or output point by doing either of these:

• On the Tagname Declarations or Declarations tree, double-click a tagname.

• Double-click a tagname on a logic sheet, and then click the Declarations button.

2 Click the Point Assignment tab.

3 Enter a physical address by doing either of these:

• Enter the number representing the Physical Address (for example: 01.06.05), then 
go to step 6.

• Click the Browse button  to select an address from a list of related modules, 
then go to step 4.

4 On the Browse Available Points screen, select the module, and then click the point to be 
assigned.
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5 Click OK to return to the Point Assignment tab.

6 Specify the Alias Number assignment as follows:

• For Tricon, the default alias number must be used.

• For Trident, the alias number can be user-specified (within the range), system-
specified based on a default range, or not aliased. For alias number information, see 
Alias Number on page 317.

7 To allow the point to be written to multiple times from programs in the application, 
select the Enable Multiple Writes check box.

8 To save your changes and have a memory address assigned, click Apply. 

To cancel your changes and restore the original settings, click Restore before clicking 
Apply. Once you click Apply, you cannot revert to the original settings.
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Procedure for Memory Points

1 Open a memory point by doing either of these:

• On the Tagname Declarations or Declarations tree, double-click a tagname.

• Double-click a tagname on a logic sheet, and then click the Declarations button.

2 Click the Point Assignment tab.

3 Specify these properties on the Point Assignment tab.

4 To save your changes and have a memory address assigned, click Apply. 

To cancel your changes and restore the original settings, click Restore before clicking 
Apply. Once you click Apply, you cannot revert to the original settings.

Property Action

Alias Type To allow a memory point to be accessed from a remote device, select 
Read Aliased or Read/Write Aliased. The default is unaliased.

Alias Number Specify the alias number assignment as follows:
• For Tricon, the default alias number must be used.
• For Trident, the alias number can be user-specified (within the 

range), or system-specified based on a default range. For alias 
number information, see Alias Number on page 317.

The default is Default alias. See the note in Assigning Alias Numbers to 
Tagnames on page 147 for additional information.

Memory Address The memory address identifies the location in the controller memory 
and is displayed after the alias number is set.

Enable Multiple 
Writes

Select the check box to allow the point to be written to multiple times 
from programs in the application.
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Scaling a REAL Point

This procedure explains how to scale a point, which allows the value of a REAL point to be 
scaled to an integer so it can be transmitted through Modbus communication protocol. The 
integer is derived from a formula that includes values specified on the Scaling tab and values 
for the Modbus minimum and maximum range on the Tricon TCM and EICM, and Trident MP 
and CM Setup screens. For information on the formula, see How REAL Numbers are Scaled to 
Integers on page 150.

Procedure

1 Open a tagname by doing either of these:

• On the Tagname Declarations or Declarations tree, double-click a tagname.

• Double-click a tagname on a logic sheet, and then click the Declarations button.

2 Click the Scaling tab.

3 Specify these properties on the Scaling tab.

4 To save your changes, click Apply. 

To cancel your changes and restore the original settings, click Restore before clicking 
Apply. Once you click Apply, you cannot revert to the original settings.

Property Action

Minimum Value 
(Min Span)

Enter the minimum value to be used to scale the REAL number to an 
integer; must be less than the maximum value. The default is -32768.0.

Maximum Value 
(Max Span)

Enter the maximum value to be used to scale the REAL number to an 
integer; must be more than the minimum value. The default is 32767.0.

Precision Enter the number of decimal points to be used. The default is blank.

Disable Scaling To allow scaling of REAL numbers to integers, do not select this check 
box. Scaling cannot be disabled on the Tricon. The default is cleared. 
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Specifying Display Options for Tagnames

This procedure explains how to specify monitor display options used when the tagname is 
displayed in the Controller or Emulator Panel. This setting also affects the display of tagnames 
in SOE Recorder. For more information, see the SOE Recorder User’s Guide.

Procedure

1 Open a tagname by doing either of these:

• On the Tagname Declarations or Declarations tree, double-click a tagname.

• Double-click a tagname on a logic sheet, and then click the Declarations button.

2 Click the Display tab.

3 Specify these properties on the Display tab.

4 To save your changes, click Apply. 

To cancel your changes and restore the original settings, click Restore before clicking 
Apply. To use the default settings, click Get Defaults at any time.

Property Action

Monitor Display Options Enter the name and color to be displayed when the state of the 
tagname is True or False.
The default name is TRUE; the default color is red.
The default name is FALSE; the default color is green.
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Creating Multiple Tagnames

This procedure explains how to create multiple tagnames by specifying a naming pattern.

Procedure

1 Expand the Application tree, right-click the Tagname Declarations folder, and click New 
Tagnames (plural).

2 Specify these properties on the New Tagnames screen.

3 Click OK to create the tagnames.

Property Action

Formatted Name Specify whether to use theater numbering, which uses letters, 
or normal numbering, which uses numbers.

Start Value and Increment Enter the starting value for the first tagname and the number 
to use when incrementing each successive tagname.

How Many Enter the number of tagnames you want to create.
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Renaming a Tagname

This procedure explains how to rename a tagname. 

Procedure

1 On the Tagname Declarations or Declarations tree, right-click a tagname, and then click 
Rename.

2 Enter the new name and press Enter.

If the tagname already exists, a message is displayed and you must enter another name.

Deleting Tagnames

This procedure explains how to delete a tagname. 

Procedure

1 On the Tagname Declarations or Declarations tree, right-click a tagname, and then click 
Delete.

If the tagname is already in use, a message warns you that deleting the tagname may 
result in unresolved tagnames or that the tagname is in use.

If you deleted the tagname from the 
Tagname Declarations tree, the message 
is similar to this screen:

If you deleted the tagname from the 
program Declarations tree, the message 
is similar to this screen:

2 To cancel, click No or Cancel. To confirm deletion of the tagname, click Yes or OK. This 
action cannot be undone.
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Changing Multiple Tagnames 

This procedure explains how to change the properties of multiple tagnames by using a tabular 
view of the tagnames. The tabular view shows a subset of the tagname properties which can be 
sorted or changed by inserting or deleting columns. Tagnames can then be sorted by different 
properties. For example, alias numbers can be added to a group of tagnames by sorting them, 
selecting the tagnames, and then making the changes.

Procedure

1 Expand the Application tree. Right-click the Tagname Declarations folder, and click 
Display Tabular View.

The tagnames and properties are displayed in a table. You can change the size of the 
columns and the properties that are displayed. 

2 Perform any of these actions.

Action Description

Sort by property Click the column heading of the property you want to sort by, or right-
click the column heading and select Sort Ascending or Sort Descending.

Select multiple 
tagnames

To select a contiguous group, click a tagname, hold the Shift key, and 
click the last tagname. 
To select a non-contiguous group, click the top tagname, hold the Ctrl 
key, and click all the other tagnames to be selected. 

Change multiple 
tagnames

Sort and select the tagnames to be changed. In the Tagname Declarations 
tree, right-click on one of the selected tagnames, and then click Item 
Properties. Make changes to the properties and click Apply. The changes 
are applied to all the tagnames in the selection.
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Inserting a Column into the Tagnames Table

This procedure explains how to insert a column into the Tagnames table. This action displays 
an additional tagname property in the table. By inserting columns, you can customize the table 
to display properties that are useful to you.

You can reorder the columns by clicking a column heading and dragging it to another location.

Procedure

1 Expand the Application tree, right-click the Tagname Declarations folder, and click 
Display Tabular View.

2 Right-click in the column heading to the right of where you want to insert another 
column, and then select Insert Column.

3 Select the name of the column to be inserted, and then click OK.

Deleting a Column from the Tagnames Table

This procedure explains how to delete a column from the Tagnames table. This action removes 
the column from the table so you can display another column. For example, you might want to 
view colors set for False by adding the False Color column and then sorting by the column. 

The Tagname column cannot be deleted.

Procedure

1 Expand the Application tree, right-click the Tagname Declarations folder, and click 
Display Tabular View.

2 Right-click in the heading of the column you want to delete, and then select Delete This 
Column.

The column is removed from the table. 

Note You can add a deleted column to the table again at any time; see Inserting a 
Column into the Tagnames Table on page 125.
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Importing and Exporting Tagnames
This section explains how to import and export tagnames using a file with point information. 
Topics include:

• Exporting Tagname Properties on page 126

• Format of an Exported Tagname File on page 127

• Preparing an Excel File for Import on page 129

• File Format Requirements for Tagname Import on page 130

• Import Options and Validation Criteria on page 132

• Importing Tagname Properties on page 133

Exporting Tagname Properties

This procedure explains how to export tagname properties to a file. File formats you can export 
to include: 

• dBase (dbf)

• Microsoft Access (mbd)

• Microsoft Excel (xsl)

• Comma delimited text file (txt or csv)

• Matrikon OPC XML Data file (xml)

Procedure 

1 Expand the Application tree, right-click the Tagname Declarations folder, and click 
Export.

2 Select the location, file name, and file type to save the tagname information.

3 Click Export. 

If you enter a file name longer than eight characters, you are warned that you may need 
to rename the file if you want to import it to a TriStation 1131 project.
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Format of an Exported Tagname File

The exported file includes these columns.

Table 24 Exported Tagname File Format

Point Property Description

TAGNAME The tagname for the point. Must be 31 characters or less to be a valid IEC 61131-
3 identifier.

DESCRIP The description for the point.

GROUP1 The Group1 description.

GROUP2 The Group2 description

ALIASTYPE The alias type for the point:
U = Unaliased
R = Read-only aliased
W = Read/Write aliased

ALIASNUM The alias number for the point.
For Tricon, from 0 to 49999
For Trident, from 0 to 42000

TAGTYPE The data type:
D = Discrete (BOOL)
I = Integer (DINT)
R = Real (REAL)

TAGCLASS The data class:
I = Input
O = Output
M = Memory

INITVALUE The initial value:
For BOOL, True or False
For DINT, an integer value
For REAL, a real value 

RETENTIVE Retentive flag: if R, the value is retained if a power outage shuts down the 
controller.

N = Non-retentive
R = Retentive

IOP IOP number (1) (Trident)

SLOT Slot number (1 - 6) (Trident)

POINT Point number (1 - 32) (Trident)

CHASSIS Chassis number (0 - 15) (Tricon)

SLOT Slot number (0 - 8) (Tricon)
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POINT Point number (0 - 64) (Tricon)

MIN SPAN The lower limit for REAL in Engineering Units; the default is –32767.00.
The range is –3.402823466e+38 to +3.402823466e+38.
Must be less than the MAX SPAN value.

MAX SPAN Upper limit for REAL in Engineering Units; the default is 32767.00.
The range is –3.402823466e+38 to +3.402823466e+38.
Must be greater than the MAX SPAN value.

DECPL Decimal places for displaying Real variables. (Corresponds to the Precision 
property and Min/Max Accuracy field in the Import Wizard.)

SCALING Scaling flag: if S, real numbers are scaled.
N = Non-scaling
S = Scaling

For more information, see Disable Scaling on page 344.

APPLICATION Application flag: 
C = Control
S = Safety

SHARED Shared for Read flag: Y = Yes, N = No

FALSE STATE Text. For example, False or Zero.

TRUE STATE Text. For example, True or Zero.

FALSE COLOR Black, Red, Green, Blue, Cyan, Yellow, Pink, and White are allowed.

TRUE COLOR Black, Red, Green, Blue, Cyan, Yellow, Pink, and White are allowed.

Table 24 Exported Tagname File Format

Point Property Description
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Preparing an Excel File for Import

This procedure explains how to prepare a Microsoft Excel file if you created the file from scratch 
or renamed a previously exported file. This procedure does not have to be performed if you 
exported tagnames to an Excel file, modified the contents, but did not change the file name.

Procedure

1 Open an Excel file that contains tagname data.

2 Ensure the data is formatted as follows:

• All cells must have the Format setting as Text.

• The Tagname, Data Type, and Point Type cells are required.

• The values in these cells must be numeric and must begin with a single quotation 
mark (’): Alias Number, Initial Value, Chassis, Slot, Point, Min Span, Max Span, and 
Display Precision.

3 Select the range of data cells to be included by selecting the headings and cells. Do not 
select empty records.

4 On the Insert menu, click Name, then 
Define. 

5 In the Define Name dialog box, enter 
the new name (in this example, 
NewTagnames) in the text box, and 
then click Add.

6 Select the names to delete (in this 
example, tagnames), click Delete, 
and then click OK.

Ensure the Refers to range reference 
at the bottom of the screen includes 
information. If it is blank, repeat step 3 through step 6.

7 To verify the table name was created, click the Name Box list box.

All the records (columns and rows) should be highlighted. If not, repeat steps 4 and 5.

8 Save the file. The file is ready to be imported.

Name Box
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File Format Requirements for Tagname Import

This section describes the requirements for database or text files with tagnames to be imported 
into a TriStation 1131 project.

Note You cannot delete existing tagname information by importing a database or text file with 
blank fields where the existing data resides. Importing a file only updates or creates 
tagname data. Blank fields for existing tagnames are ignored, so that any existing 
information will remain as-is. Blank fields may be imported for new tagnames only; see 
the following table for instructions. 

However, you can create a “blank” field for an existing tagname by typing spaces to 
replace the existing data. The field will then appear blank. After the import is complete, 
you can remove the spaces from the field to create a true blank field by editing the 
tagname’s properties; see Changing Multiple Tagnames on page 124.

Table 25 General File Requirements

Item Database File Text File

Filename Must be 8 characters or less. Must be 8 characters or less.

Table or 
Lines

Each row must contain columns 
mapped to these point properties:

• Tag Name
• Tag Type
• Tag Class

Must have a consistent format; the same 
number of fields in each line.
Each line must contain fields mapped to 
these point properties:

• Tag Name
• Tag Type
• Tag Class

Columns or 
Fields

Can include more columns than the 
number of fields to be imported, but 
no more than one column can be 
mapped to each point property. 
Column headings can be any name.
Blank numeric fields and blank string 
fields are allowed for new tagnames 
only (in .DBF or .XLS files).

Must be delimited by commas with no 
spaces before or after.
Can include more than 22 fields, but only 22 
fields can be mapped.
Blank fields (for new tagnames only) must be 
represented as follows:

• For a blank numeric field, use two 
commas with no spaces between.

• For a blank string field, use two 
quotation marks with no spaces 
between.
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Table 26 Import Data Requirements

Point Property Description

TAGNAME The tagname for the point. Must be 31 characters or less to be a valid IEC 61131-
3 identifier. Can be any string of letters, digits, and underscores provided that 
the first character is not a digit and there are not two or more underscore 
characters together.

DESCRIP The description for the point; cannot be more than 131 characters.

GROUP1 The Group1 description; cannot be more than 63 characters.

GROUP2 The Group2 description; cannot be more than 63 characters.

ALIAS TYPE The alias type for the point:
U = Unaliased
R = Read-Only aliased
W = Read/Write aliased

ALIAS NUMBER The alias number for the point.
For Tricon, from 0 to 49999
For Trident, from 0 to 42000

TAG TYPE The data type:
D = Discrete (BOOL)
I = Integer (DINT)
R = Real (REAL)

TAG CLASS The data class:
I = Input
O = Output
M = Memory

INITIAL VALUE The initial value:
For BOOL, True or False
For DINT, an integer value
For REAL, a real value 

RETENTIVE FLAG Retentive flag: if R, the value is retained if a power outage shuts down the 
controller.

N = Non-retentive
R = Retentive

IOP IOP number (1) (Trident)

SLOT Slot number (1 - 6) (Trident)

POINT Point number (1 - 32) (Trident)

CHASSIS Chassis number (0 - 15) (Tricon)

SLOT Slot number (0 - 8) (Tricon)

POINT Point number (0 - 64) (Tricon)
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Import Options and Validation Criteria

When importing tagname information from a database or file, you can specify whether to 
update, add, or update and add new tagnames.

Adding New Points

If the imported tagname includes a tagname, tag type (BOOL, DINT, or REAL), tag class (input, 
output, or memory), and alias type (R for Read, W for read/write, or U for no alias), the tagname 
is imported. If the tagname matches an existing tagname or is invalid in any way, a message is 
displayed alerting you of the problem or error when the import operation is complete, but the 
tagname is still imported.

Updating Existing Points

If the imported tagname matches a tagname, tag type (BOOL, DINT, or REAL), and tag class 
(input, output, or memory), the tagname is updated. All fields, with the exception of the 

MIN SPAN The lower limit for REAL in Engineering Units; the default is –32767.00.
The range is –3.402823466e+38 to +3.402823466e+38.
Must be less than the MAX SPAN value.

MAX SPAN Upper limit for REAL in Engineering Units; the default is 32767.00.
The range is –3.402823466e+38 to +3.402823466e+38.
Must be greater than the MAX SPAN value.

DISPLAY 
PRECISION

Decimal places to display MIN SPAN and MAX SPAN properties. Limited to 
125 digits.

REAL values are set to 1.
BOOL and DINT values are set to 0.

SCALING Scaling flag: if S, real numbers are scaled.
N = Non-scaling
S = Scaling

For more information, see Disable Scaling on page 344.

APPLICATION Application flag:
C = Control
S = Safety

SHARED READ Shared for Read flag: Y = Yes, N = No

FALSE STATE Text. For example, False or Zero.

TRUE STATE Text. For example, True or Zero.

FALSE COLOR Black, Red, Green, Blue, Cyan, Yellow, Pink, and White are allowed.

TRUE COLOR Black, Red, Green, Blue, Cyan, Yellow, Pink, and White are allowed.

Table 26 Import Data Requirements (continued)

Point Property Description
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TAGNAME field (see below), can be updated for an existing tagname. If an updated value is 
invalid in any way, a message is displayed alerting you of the error when the import operation 
is complete, but the attribute is still changed to the new value.

Updating the TAGNAME field for an existing tagname will create a new tagname. The existing 
tagname will be retained. For example, if you update the TAGNAME field for the tagname 
Counter1 by changing it to Counter10, after the import process is complete, you will have two 
tagnames: Counter1 AND Counter10.

Importing Tagname Properties

This procedure explains how to import tagname properties from a file.

Procedure

1 Expand the Application tree, right-click Tagname Declarations, and click Import.

Note The project you are importing tagnames into must be in the Download All state. 
If the project is not in the Download All state, the Import menu option is 
disabled. Use the Change State to Download All Command on page 326 to 
change the project state before continuing this procedure.

2 Click Select Import Data File and go to the folder that contains the file.
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If the file is not displayed, you may need to change the type of file to match the extension 
used in the file to be imported.

3 Click the file name and click Select. Click Next to continue.

4 On the Link Data Fields screen, match the source fields to the tagname properties by 
clicking a field in the list on the left, and a tagname property in the list on the right, and 
then clicking Link.

The following required tagname properties must be linked before continuing:

• Data Type

• Point Type

• Tag Name 

5 Once fields and properties are linked, click Next.

6 On the Select Import Options screen, select options as needed.



Importing and Exporting Tagnames 135

TriStation 1131 Developer’s Guide, v4.1

7 Click Next to continue.

8 Read the Review Your Request screen. Click Finish to continue, or Back to make changes. 

9 Review the status of the records on the Data Import Validation Result screen.

• If there are errors, close the screen, edit the data, and then go back to step 1 to 
import the file again.

• If you selected the Validate option on the Select Import Options screen and there 
are no errors, click Commit Records to import the data. This action cannot be 
undone.
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This table describes the status of the imported records. 

Note If you opened the Tagnames table before you imported new tagnames, you need to close 
the Tagnames table and then open it again in order to see the newly imported tagnames 
in the table.

Status Description

Ignored The import record is mapped to an existing point that has the same properties, 
so the import record is being ignored.

Added A new record is being added to the configuration.

Error The import record has been rejected due to one or more errors.

Updated The import record is updating properties of an existing point.
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Annotations and Comments
This section describes how to use annotations and comments in an FBD or LD program or 
function. Topics include:

• Adding Annotations on page 137

• Specifying Annotation Properties on page 139

• Adding a Comment on page 140

• Specifying Comment Style on page 141

• Picking and Dropping Elements for Comments on page 142

• Editing Comment Fields on page 143

• Using Macros with Annotations and Comments on page 143

• Editing Macro Text on page 145

Adding Annotations

This procedure explains how to add an annotation to a constant, tagname, or variable. 
Annotations can be used to display descriptive text, including information specified in system 
and user-modifiable macros. You can also display the value of a variable during program 
execution in the emulator or controller.

To have annotations automatically included for all new elements, see Specifying Annotation 
Options on page 18 and Using Macros with Annotations and Comments on page 143.

Procedure

1 Expand the Application tree, and open an FBD or LD program or function. 

2 Double-click the graphic for a constant, tagname, or variable. 

The Item Properties dialog box appears.

3 Select the Annotate check box. For constants, the check box is on the Constant tab. For 
tagname references and variables, the check box is on the Variable tab.

4 Click the Annotation tab.
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5 To add text, enter the text in the annotation area.

6 To add a macro:

• Click Macros. The Edit Macros dialog box appears.

• Select a macro to be added. To change the value of a macro identified by a pencil 
icon, double-click the macro, enter the value, and click OK.

• With the macro selected, press Ctrl+C to copy the macro.

• Click OK to close the Edit Macros dialog box.

• Click in the annotation area, and press Ctrl+V to paste the macro.

7 For variables, select the Include Monitor Value in Annotation check box to display the 
value of the variable in the Controller or Emulator Panel.
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Specifying Annotation Properties

This procedure explains how to specify text and macros to be included with an annotation. 

Procedure

1 Expand the Application tree, and open an FBD or LD program or function. 

2 On the logic sheet, double-click an annotation. 

The Item Properties dialog box appears, with the Annotation tab selected.

3 Specify these properties on the Annotation tab.

Property Action

Annotation Text Enter the text and/or macros to be used in the annotation.

Include Monitor Value in 
Annotation

Select the check box to display the value of the variable in the 
annotation when the element is run on the controller or emulator.

Macros Command Click to add macros to the annotation. See Using Macros with 
Annotations and Comments on page 143.
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Adding a Comment

This procedure explains how to add comment text in FBD and LD programs. Comments are 
used to add information about operations performed by a program, function, or function block. 
There is no limitation on the number of comment boxes per program or their placement on a 
logic sheet. If you draw a comment box around a project element it is ignored when you compile 
the element.

Procedure

1 Expand the Application tree, and open an FBD or LD program or function. 

2 On the toolbar, click the icon for comments .

3 On the logic sheet, click and drag to create the comment box. 

4 Double-click the comment box to display the Comment properties.

5 Specify these properties on the Comment tab.

Property Action

Comment Text Enter the text to be included as a comment. Can include text and 
macros.

Alignment Select how to align the text. The default is left.

Text Size Select the point size for the text; from 3 to 24 points.

Border Select whether to include a border around an annotation or comment 
box.The default is single.

Macros Command Click to view macros that can be included with the comment text.
To copy, click the macro and press Ctrl + C.
To paste, return to the Comment tab and press Ctrl + V.
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Specifying Comment Style

This procedure explains how to specify style features used with comments. 

Procedure

1 Expand the Application tree, and open an FBD or LD program or function. 

2 Double-click a comment, and then click the Style tab.

3 Specify these properties on the Style tab.

Property Action

Expand Macros Select this check box to display the value of the macro when the 
application is run on the emulator or controller. For example, if 
expanded, the macro %DATE_CREATED displays the month, day, 
and year when the project was created. The default is cleared.

Enable Macro Editing Select this check box to list the user-modifiable macros on the Edit 
Fields tab, which allows you to edit the value for the macro. The 
default is cleared.

Move Behind Logic 
Elements

Select this check box to move the selected comment box behind a 
logic element. This affects the appearance of the logic sheet only; it 
does not affect the execution of the logic element. 
Move the comment box to the desired position before selecting this 
option. Once this option is selected, the comment box cannot be 
moved. 
To move the comment box after this option has been selected, 
double-click the comment box to access the Properties dialog box, 
and then clear this option.
The default is cleared.
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Picking and Dropping Elements for Comments

This procedure explains how to pick up and drop elements from a comment box. Elements in 
comment boxes are ignored when you compile the program. You can also remove captured 
elements from a comment by selecting the comment and dropping the elements back onto the 
logic sheet. This is useful for isolating logic during testing or troubleshooting.

Note To use the Pickup and Drop commands, the Move Behind Logic Elements option cannot 
be selected. For more information about this option, see Specifying Comment Style on 
page 141.

Procedure

1 Expand the Application tree, and open an FBD or LD program or function. 

2 Double-click a comment, and then click the Pickup/Drop tab.

3 Specify these commands on the Pickup/Drop tab.

Command Action

Pickup 
Command

To pick up elements to include in the comment, click and drag the comment 
box so it entirely covers the elements to be captured. Double-click the 
comment, click the Pickup/Drop tab, and then click Pickup.

Drop 
Command

To remove elements from the comment, double-click the comment box, click 
the Pickup/Drop tab, then click Drop.
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Editing Comment Fields

This procedure explains how to modify the comment text if the comment includes a macro that 
can be edited and the macro is enabled for editing.

Procedure

1 Expand the Application tree, and open an FBD or LD program or function. 

2 Double-click a comment, and then click the Edit Fields tab.

3 Select a field and then click Modify.

4 Change the text used for the macro.

5 Click OK to save the change.

Using Macros with Annotations and Comments

This procedure explains how to use macros in an annotation or comment. Macros are 
placeholders for text or information supplied by the system or by you. The value is displayed 
when the element is run on the controller or emulator.

Macros can be used only in FBD and LD development.

There are two types of macros:

• System macros are values supplied by the system and cannot be changed. For example, 
the %CREATED_ BY macro includes the user ID of the person who created the element. 
You cannot change values for these macros.

• User-modifiable macros, identified by a pencil icon , are values you can specify. For 
example, the %APPROVED_NAME macro can include any name you enter.

CAUTION
When you change the value of a macro, you change it for ALL annotations 
and comments in the project that use the macro.
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Procedure

1 Expand the Application tree, and open an FBD or LD program or function. 

2 Do either of these:

• For a comment, double-click the comment, and click the Macros button.

• Double-click a variable or tagname reference. Click the Annotation tab, then click 
the Macros button.

3 If needed, select the check boxes for project, document, or sheet to view the macros 
available for those elements.

4 Do any of the following:

• To change the value of a user-modifiable macro, identified by a pencil icon , 
select the macro, click Modify and then make the change.

• To copy a macro to an annotation or comment, select the macro and copy it by 
pressing Ctrl+C. 

5 Click OK to close the Edit Macros dialog box. You are returned to the Item Properties 
dialog box.

6 To add the copied macro to the annotation or comment, click inside the text area and 
paste the macro by pressing Ctrl+V. 
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Editing Macro Text

This procedure explains how to edit text associated with a macro. You can include text and 
macros that supply information from the system.

Procedure

1 Expand the Application tree, and open an FBD or LD program or function. 

2 Double-click a comment, constant, tagname, or variable. 

The Item Properties dialog box appears.

3 Click the Edit Fields tab, select the field to be changed, and then click Modify. 

4 Enter the text to be used when the macro is displayed.

5 Click OK to save.
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Modbus Applications
This section describes information related to developing a Modbus application. Modbus is an 
industry-standard master/slave communication protocol that is traditionally used for energy 
management, transfer line control, pipeline monitoring, and other industrial processes. 

Tricon Functionality

A Tricon controller with an EICM or TCM can operate as a Modbus master, slave, or both. A 
DCS typically acts as the master, while the Tricon acts as a slave. The master can also be an 
operator workstation or other device that is programmed to support Modbus devices.

The Tricon controller has serial ports on the EICM, and network and serial ports on the TCM 
that provide options for communication with a Modbus devices. Each serial port can operate in 
a point-to-point configuration with a single Modbus device, or in a multi-point configuration 
with several Modbus devices connected to a serial link.

Trident Functionality

The Trident controller has serial ports on the CM and MP that provide options for 
communication with a Modbus devices. Each CM and MP port can operate in a point-to-point 
configuration with a single Modbus device. In addition, each CM port can operate in a multi-
point configuration with several Modbus devices connected to a serial link.

Topics include:

• Assigning Alias Numbers to Tagnames on page 147

• How Tricon Transmits REAL Values With Special Alias Numbers on page 148

• Tricon Special Alias Numbers on page 149

• How REAL Numbers are Scaled to Integers on page 150

• Scaling REAL Values to Integers on page 153

• How Trident REAL Values are Transmitted Without Scaling on page 154

• Disabling Scaling of REAL Values for Trident Tagnames on page 155
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Assigning Alias Numbers to Tagnames

This procedure explains how to assign an alias number for input, output, and memory points.

Procedure

1 Open a tagname by doing either of these:

• On the Tagname Declarations tree, double-click a tagname.

• Double-click a tagname on a logic sheet, and then click the Declaration button.

2 Click the Point Assignment tab.

3 Specify these properties on the Point Assignment tab.

Property Action

Alias Type For memory points, specify either Read Aliased, or Read/Write 
Aliased. (Input and output points can only be Read Aliased.)

Alias Number For aliased memory points, specify either User alias or Default 
alias. If User alias, enter a number within the range, and then click 
Apply.

• For Tricon, if the User alias number is valid, the default alias 
number is changed for the memory address.

• For Trident, if the User alias number is valid, the memory 
address that corresponds to the alias number is displayed.

Physical Address For input and output points, the physical address must be 
specified before an alias number can be assigned.

Memory Address The memory address is displayed once you click Apply. It cannot 
be changed.

Enable Multiple Writes Select the check box to allow the point to be written to multiple 
times in a scan. The default is cleared.
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Note When you select Default alias as the alias number for memory point tagnames, 
these aliases can be automatically reassigned under certain circumstances. For 
example, if another tagname using the Default alias setting is deleted, the next 
time you build the application, TriStation will re-use the alias number of the 
deleted tagname. 

You can avoid this behavior by always using the User alias setting to define your 
own alias numbers and keep control of assigned aliases.

4 To set the alias number, click Apply. To cancel your changes and restore the original 
settings, click Restore before clicking Apply. Once you click Apply, you cannot revert to 
the original settings.

How Tricon Transmits REAL Values With Special Alias Numbers

This section explains how the Tricon controller transmits REAL values for tagnames by using 
special alias numbers which map one 32-bit REAL value into two 16-bit Modbus integers. One 
Modbus integer is mapped to the 16 most significant bits and the other Modbus integer is 
mapped to the 16 least significant bits in the REAL number.

The Modbus master can also read and write values by using a scaled value in an alias number.

Reading REAL Values

This figure shows a Modbus master reading a REAL value from two consecutive special aliases 
which correspond to a REAL alias. The Tricon controller splits the 32-bit REAL value into two 
16-bit integers and places them in the special aliases to be read by the Modbus master.

Figure 18 Modbus Master Reading REAL Values from the Tricon

Writing REAL Values

This figure shows a Modbus master writing a REAL value to the Tricon controller by 
transmitting two 16-bit integer values to two consecutive special aliases. The controller 
concatenates the two 16-bit integers to form a 32-bit REAL value.
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Figure 19 Modbus Master Writing REAL Values to the Tricon

Tricon Special Alias Numbers

This table lists the special alias numbers used for read and write operations with REAL 
tagnames. The Most and Least columns refer to the most significant and least significant bits.

Variable Type Aliases Special Aliases

Most Least Most Least

Input REAL,
Read Only

32001 34001 34002 - or - 44001 44002

32002 34003 34004 - or - 44003 44004

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

32120 34239 34240 - or - 44239 44240

Memory REAL, 
Read Only

33001 35001 35002 - or - 45001 45002

33002 35003 35004 - or - 45003 45004

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

34000 36999 37000 - or - 46999 47000

Memory REAL, 
Read/Write

41001 42001 42002

41002 42003 42004

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

42000 43999 44000
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How REAL Numbers are Scaled to Integers

This section explains how 32-bit REAL scaled numbers are transmitted in Modbus protocol, 
which uses 16-bit integers.

If a REAL value is scaled, these operations occur:

• When a Modbus master writes a 16-bit integer to a Triconex slave, the controller scales 
the integer to a 32-bit REAL number before using it in the TriStation application.

• When a Modbus master reads a 32-bit REAL variable from a Triconex slave, the 
controller scales the REAL variable to a 16-bit integer before transmitting it.

Scaled REAL numbers use a formula that includes the value of the tagname, the Minimum 
Value (Min Span) and Maximum Value (Max Span) for the tagname, and the Modbus minimum 
(Modbus Min) and maximum (Modbus Max) range set for the Modbus Range property.

Scaling Integer Values to REAL Values

This figure shows how a Modbus master writes an integer value to the Triconex controller, 
where it is scaled to a REAL value.

Figure 20 How Triconex Controller Scales a Integer Value to a REAL Value

Scaling an integer to a REAL value uses this formula:

This figure shows how scaling is done. Values above the Max Span or below the Min Span are 
clamped to the respective limit. The same principle applies to values outside the Modbus range.

Real Value (MaxSpan – MinSpan)
(Modbus Max – Modbus Min)
------------------------------------------------------------------------- (Modbus Value – Modbus Min) Minspan+×=
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Figure 21 Scaling an Integer Value to a REAL Value

To avoid division by zero, do not set Modbus Max equal to Modbus Min—the REAL value 
result is undefined. For the Trident or Tricon v9.6 and later controllers, the result is one of the 
floating point standard special numbers: NAN (not a number: -1.#IND) or infinity (1.#INF).

Scaling REAL Values to Integer Values

This figure shows how a Modbus master reads a REAL value which has been scaled to an 
integer.

Figure 22 How the Modbus Master Reads a REAL Value Scaled to an Integer Value

Scaling a REAL value to an integer value uses this formula:

This figure shows how scaling is done. Values above the Max Span or below the Min Span are 
clamped to the respective limit. The same principle applies to values outside the Modbus range.

Modbus Value (Modbus Max – Modbus Min)
(Maxspan – MinSpan)

------------------------------------------------------------------------- (Real Value – MinSpan)× ModbusMin+=
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Figure 23 Scaling a REAL Value to an Integer Value

To avoid division by zero, do not set Max Span equal to Min Span—the resulting Modbus value 
is undefined. Typically, for a Triconex controller, the result is -1.
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Scaling REAL Values to Integers

This procedure explains how to scale a REAL value to an integer. Scaling may be needed to 
transmit numbers through Modbus protocol, which uses 16-bit integer numbers. Numbers are 
scaled by using minimum (Min Span) and maximum (Max Span) values for the point and 
minimum and maximum values for the Modbus Range.

Procedure

1 Open a tagname by doing either of these:

• On the Tagname Declarations tree, double-click a tagname.

• Double-click a tagname on a logic sheet, and then click the Declaration button.

2 Click the Scaling tab.

3 Specify these properties on the Scaling tab.

4 Click Apply to save your changes.

5 On the Setup dialog box for the communication module, specify the Modbus minimum 
and maximum range. See the following sections for detailed instructions:

• Configuring Tricon EICM Ports on page 201
• Configuring TCM Serial Ports on page 208
• Configuring Trident MP Serial Ports on page 219
• Configuring Trident CM Serial Ports on page 221

Property Action

Minimum Value 
(Min Span)

Enter the minimum value to be used to scale the REAL number to an 
integer; must be less than the maximum value. The default is -32768.0.

Maximum Value 
(Max Span)

Enter the maximum value to be used to scale the REAL number to an 
integer; must be more than the minimum value. The default is 32767.0.

Precision Enter the number of decimal points to be used. The default is blank.

Disable Scaling To allow scaling of REAL numbers to integers, do not select this check 
box. Scaling cannot be disabled on the Tricon. The default is cleared. 
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How Trident REAL Values are Transmitted Without Scaling

This section explains how 32-bit REAL unscaled numbers are transmitted in Modbus protocol, 
which uses 16-bit integers. This applies only to Trident controllers.

If a REAL value is not scaled, these operations occur:

• A Modbus master reads the least significant 16 bits of a 32-bit number which is derived 
from the integer and decimal parts of a 32-bit REAL value.

• A Modbus master writes a REAL value as two consecutive 16-bit integer aliases which 
the Trident concatenates to form a 32-bit REAL value.

• A Modbus slave sends the least significant 16 bits of a 32-bit number. 

This figure shows the standard format for REAL values, which adheres to the IEE Standard for 
Binary Floating-Point Arithmetic. For more information, see IEE Std 754-1985.

Figure 24 Standard Format for REAL Values
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Disabling Scaling of REAL Values for Trident Tagnames

This procedure explains how to disable scaling on a specific REAL tagname. Scaling cannot be 
disabled for Tricon. The default setting is to use scaling.

Procedure 

1 Expand the Application tree, and double-click a tagname which is a REAL data type and 
is not to be scaled. 

The Item Properties dialog box appears.

2 Click the Scaling tab.

3 On the Scaling tab, select the Disable Scaling check box to ensure the point is not scaled. 
The default is cleared.

4 Click OK to apply and save.
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Peer-to-Peer Applications
This section explains how to use Peer-to-Peer communication to allow Triconex controllers to 
send and receive information from each other. Peer-to-Peer communication is performed 
through Send and Receive function blocks included in the application.

For information on the Send and Receive function blocks used for Peer-to-Peer communication, 
see the TriStation 1131 Libraries Reference.

If you have a TCM installed, also see Configuring TCM Peer-To-Peer Ports on page 210.

Topics include:

• Peer-to-Peer Data Transfer Time on page 156

• Estimating Memory for Peer-to-Peer Data Transfer Time on page 157

• Allocating Peer-to-Peer Memory on page 158

Peer-to-Peer Data Transfer Time

In a Peer-to-Peer application, data transfer time includes the time required to initiate a send 
operation, send the message over the network, and have the message read by the receiving 
node. Additional time (at least two scans) is required for a sending node to get an 
acknowledgment from the MPs that the message has been acted on. 

These time periods are a function of the following parameters of the sending and receiving 
controllers:

• Scan time

• Configuration size

• Number of bytes for aliased variables

• Number of Send function blocks, Receive function blocks, printing function blocks, and 
Modbus master function blocks

• Number of controllers on the Peer-to-Peer network

Send function blocks require multiple scans to transfer data from the sending controller to the 
receiving controller. The number of send operations initiated in a scan is limited to five. The 
number of pending send operations is limited to 10. 

A typical data transfer time (based on a typical scan time) is 1 to 2 seconds, and the time-out 
limit for a Peer-to-Peer send (including three retries) is 5 seconds. Consequently, the process-
tolerance time of the receiving controller must be greater than 5 seconds. Process-tolerance time 
is the maximum length of time that can elapse before your control algorithms fail to operate 
correctly. If these limitations are not acceptable, further analysis of your process is required. 
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Estimating Memory for Peer-to-Peer Data Transfer Time

This procedure explains how to estimate memory for Peer-to-Peer data transfer time between a 
pair of Triconex controllers. The more memory allocated for aliased points, the slower the 
transfer time.

Procedure

1 On the sending controller, expand the Controller tree, and double-click Configuration. 
On the Configuration tree, click Memory Allocation.

2 Find the bytes allocated for BOOL, DINT, and REAL points:

• On the Configuration tree, click Memory Points, Input Points, or Output Points. 
Double-click the graphic for the point type.

• Add the number of bytes allocated for all BOOL input, output, and aliased memory 
points. Enter the number in step 1 of the following worksheet. Do the same for 
DINT and REAL points and enter the results in step 1.

3 On the receiving controller, get the BOOL, DINT, and REAL points and enter the 
numbers in step 3. Follow the instructions on the following worksheet to estimate the 
transfer time.

Steps Point 
Type

Allocated 
Bytes Operation Result

1. Enter the number of bytes for each 
point type on the sending controller and 
divide or multiply as indicated. Add the 
results.

BOOL _________ ÷ 8 = _________

DINT _________ x 4 = _________

REAL _________ x 4 = _________

Total bytes of aliased points TBS = _________

2. Multiply the total bytes sending (TBS) from step 1 by 0.01 TS = _________

3. Enter the number of bytes for each 
point type on the receiving controller and 
divide or multiply as indicated. Add the 
results.

BOOL _________ ÷ 8 = _________

DINT _________ x 4 = _________

REAL _________ x 4 = _________

Total bytes of aliased points TBR = _________

4. Multiply the total bytes receiving (TBR) from step 3 by 0.01 TR = _________

5. Get the scan time of the sending node in milliseconds by 
viewing the Scan Time in the Execution List. SS = _________

6. Get the scan time of the receiving node in milliseconds by 
viewing the Scan Period in the Execution List. SR = _________

7. Multiply the larger of TS or SS by 2. _________

8. Multiply the larger of TR or SR by 2. _________

9. Add the results of step 7 and 8 to get the data transfer time DT= _________

10. If the number of pending send requests in the application is 
greater than 10, divide the number of send requests by 10. _________
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Allocating Peer-to-Peer Memory

This procedure explains how to allocate memory for Peer-to-Peer functions, which is based on 
the maximum number of Send and Receive numbers you specify. To save memory and 
minimize scan time, you should use the lowest possible numbers.

The maximum number does not have to be the same for Sends and Receives. For example, a 
TriStation application might need to send messages to three applications, but need to receive 
messages from only one application. 

A change in Peer-to-Peer allocation requires a Download All (see Using the Download All 
Command on page 316).

Procedure

1 Expand the Application tree, double-click Implementation, and then click Peer-to-Peer 
Configuration.

2 Set these properties by clicking the up and down arrows.

• Maximum Number of Peer-to-Peer Sends

• Maximum Number of Peer-to-Peer Receives

3 If you want to change the settings for an application running on the controller, you must 
build the application and perform a Download All.

11. Multiply the results of steps 9 and 10 to get the adjusted data 
transfer time.

Adjusted 
DT _________

12. Compare the adjusted DT to the process-tolerance time to determine if it is 
acceptable.

Steps Point 
Type

Allocated 
Bytes Operation Result
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SOE Development
This section explains how to enable sequence of events collection in a project. Events can be 
retrieved from a Triconex controller by using the SOE Recorder software. For more information, 
see the SOE Recorder User’s Guide. 

Topics include:

• Displaying the SOE Configuration on page 159

• Defining SOE Block Properties on page 160

• Assigning Event Variables to SOE Blocks on page 161

• Specifying a Trip Variable on page 162

Displaying the SOE Configuration

This procedure explains how to view the SOE Configuration screen, which displays the SOE 
blocks that have been configured.

Procedure

1 Expand the Application tree, double-click Implementation, and click SOE 
Configuration.

2 To change the SOE block properties, see Defining SOE Block Properties on page 160.
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Defining SOE Block Properties

This procedure explains how to define the properties of an SOE block, which is required if you 
are using sequence of events in an application.

Defining SOE block properties is related to the general task of controller configuration and can 
be completed at the same time. You can define SOE blocks to provide continuous event 
information to external devices on a network, or you can define them for limited operation 
when your controller is not on a network.

Procedure

1 Click the Application tree, and double-click Implementation. 

2 Expand the SOE Configuration tree, and double-click a block number.

3 Specify these settings on the SOE Block Definition tab.

4 Click Apply to save your changes.

5 Repeat steps 2 and 3 for all the blocks to be configured.

Property Action

 SOE Block Type Select the Block Type. The default is unassigned. 

SOE Block Name Enter a title for the block.

SOE Buffer Size Enter a buffer size. The default is 0.
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Assigning Event Variables to SOE Blocks

This procedure explains how to assign event variables to an SOE block, which is required if you 
are using sequence of events in an application.

Event variables must be of type BOOL and their states can be displayed with names and colors 
that you define. You can designate one variable in a TriStation project as the trip variable that 
notifies the operator when a trip occurs.

Note For Tricon, if you define a block for use with the Advanced Communication Module 
(ACM), the Foxboro I/A Series system assigns the event variables. The only additional 
configuration you can do is to specify a type of External and a buffer size. For more 
information, see the Tricon Communication Guide.

Before You Begin

Before you can assign event variables, you must define SOE block properties (see Defining SOE 
Block Properties on page 160).

Procedure

1 Open the Application tree, and double-click Implementation. 

2 Click the SOE Configuration branch. The tagnames and block assignments, if any, are 
listed in a pane to the right of the tree.

3 To assign a tagname to one or more SOE Blocks, double-click the row for the tagname. 
The Item Properties dialog box appears.

4 To assign the tagname to specific blocks, select the block number check box. If the 
number is disabled, it means the block has not been defined.

Note If you add tagnames after opening the SOE Configuration screen, you must close 
and re-open the SOE Configuration screen to have the new tagnames displayed.

5 Continue to assign tagnames to blocks as needed.

6 After assigning all the event variables, save the project so the tagnames are available 
when specifying a trip variable.
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Specifying a Trip Variable

This procedure explains how to designate a trip variable, which is optional if you are using 
sequence of events in an application.

In an application used for safety shutdown, a trip variable is an aliased tagname whose state 
transition causes SOE Recorder to automatically create a trip snapshot. An application can have 
only one trip variable, but it can apply to all blocks. If an application requires several variables 
related to trip conditions, these variables must be evaluated in combination to determine the 
final state of the trip variable.

Before You Begin

You must define at least one SOE block and assign an event variable to the block (see Defining 
SOE Block Properties on page 160 and Assigning Event Variables to SOE Blocks on page 161).

Procedure

1 Open the Application tree, and double-click Implementation. 

2 Double-click SOE Configuration. The Item Properties dialog box appears.

3 Specify these settings on the SOE Trip Variable tab.

Property Action

Trip Tagname Select the Trip Tagname from the list of event variable names, and then 
select a Trip State of True or False.

Trip State Select True or False.

Time After Trip Set the Time After Trip in minutes. The minimum time is two minutes; 
the maximum time is ten minutes.

Time Before Trip Set the Time Before Trip in minutes.The minimum time is two minutes; 
the maximum time is ten minutes. 
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Tricon Application Access
This section explains how to restrict connection access to a Tricon controller and how to restrict 
or allow write access to output and memory points in the downloaded application. Topics 
include:

• Restricting Access to a Tricon Controller on page 163

• What Affects Tricon Write Access from External Devices on page 164

• Restricting Write Access to Tricon Points on page 166

• Allowing Write Access to Tricon Points on page 167

Restricting Access to a Tricon Controller

This procedure explains how to restrict access to a Tricon controller from a TriStation PC. If 
access is restricted, only users with access privileges can disable points or download changes to 
the controller.

Note If you have a a model 4351A or 4352A TCM installed, you can also use the optional TCM 
client access list to restrict access to the Tricon on a per-client basis. See Controlling 
Access to the TCM on page 267.

Procedure

1 Expand the Controller tree, and double-click Configuration. 

2 On the Configuration tree, click Operating Parameters.

3 Specify these properties on the Operating Parameters screen.

Property Action

Password Required for 
Connection

Select the check box to restrict access by requiring a password 
when connecting to the controller. The default is cleared.

Password Enter the password required to access the controller. The default 
is PASSWORD.
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The settings you selected are used when the application is built.

What Affects Tricon Write Access from External Devices

This section describes the system properties, communication properties, and function blocks 
that affect read and write access to memory and output points on a Tricon controller.

These types of read and write access are possible:

• Input, output, and memory points can be read by any external device that can 
communicate with a Tricon controller.

• Write access to input points is not allowed from any external device.

• Write access to a output or memory point is allowed or restricted based on the system, 
communication, application, and point settings.

This table describes write access to Tricon points from external devices.

Disable Stop on 
Keyswitch

Select the check box to prevent the keyswitch from halting the 
application if it is turned to Stop. The default is cleared.

Disable Remote Changes 
to Outputs

Clear the check box to allow remote devices to write to output 
points. The default is selected.

Allow Disabling of Points Select the check box to allow the TriStation PC to disable points 
while the application is running on the controller. The default is 
cleared.

Property Action

Table 27 Tricon Write Access

Property or Feature Description

Tricon keyswitch A system setting that determines write access to output and memory 
points unless overruled by the GATENB function block in the 
application.

• Restricts write access when set to the Run position.
• Allows write access when set to the Remote or Program position.

GATENB A Tricon function block that programmatically allows write access to a 
specified range of aliased memory points when the keyswitch is in the 
Run position.

GATDIS A Tricon function block that programmatically restricts remote write 
access for all ranges of aliased memory points that were previously 
enabled by GATENB.

Disable Remote Changes 
to Outputs

A system setting on the Operating Parameters screen that determines 
write access to output points.
When selected, external devices cannot write to output points, no matter 
what other settings are made.
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Privilege A Tricon ACM and NCM module setting that determines whether 
network devices using DDE, OPC, or TSAA communication have write 
access to output points and read/write aliased memory points.

• For Tricon ACM, the default it Read.
• For Tricon NCM, the default is Read/Write.
• The Tricon EICM, TCM, HIM, and SMM modules do not have this 

property.

Port Write Enabled A Tricon TCM setting that determines whether TriStation, TSAA, or 
Modbus have write access to the selected port. The default value is 
cleared, meaning the port is read-only.
The Tricon EICM, ACM, NCM, HIM, and SMM modules do not have 
this property.

TCM Client Access List An optional Tricon TCM feature that gives you the ability to control 
which clients can access TCM resources, the protocols they can 
use, and the level of access each client has. See Controlling Access 
to the TCM on page 267.

Prohibit Writes A Tricon SMM module setting that determines whether Honeywell 
devices have write access to output points and read/write aliased 
memory points.
The default is cleared, which means write access is allowed.

Point Assignment A tagname setting that determines whether the output and memory 
point is assigned a Read or Read/Write alias number.

• For output points, all alias numbers are Read/Write.
• For memory points, alias numbers can be Read or Read/Write.

Table 27 Tricon Write Access (continued)

Property or Feature Description
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Restricting Write Access to Tricon Points

This procedure explains how to restrict external devices from writing to output or memory 
points. Input, output, and memory points can be read by any external device that can 
communicate with the Tricon controller. Input points cannot be written to.

When the Tricon keyswitch is turned to Run, external devices cannot write to points unless the 
GATEB function block is used programmatically to allow write access to a range of aliased 
memory points.

Procedure

1 Expand the Controller tree, and double-click Configuration. 

2 On the Configuration tree, click Operating Parameters.

3 Ensure the Disable Remote Changes to Outputs check box is selected. The default is 
selected.
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Allowing Write Access to Tricon Points

This procedure explains how to allow external devices to write to memory and output points. 
Input points can be read, but cannot be written to. External devices must use supported 
communication protocols (Modbus, TSAA, OPC, and DDE) to communicate with the controller.

Procedure

1 Expand the Controller tree, and double-click Configuration. 

2 On the Configuration tree, click Operating Parameters.

3 Clear the Disable Remote Changes to Outputs check box. The default is selected.

4 Do one of the following: 

• If the external devices are communicating through an ACM or NCM, ensure the 
Privilege property for the module is set to Read/Write. See Privilege on page 402. 
The default for Tricon ACM is Read; for Tricon NCM the default is Read/Write.

• If the external devices are communicating through a TCM, ensure the Port Write 
Enabled property for the selected port and protocol is selected, or that the TCM 
client access list is configured to allow read/write access for the selected client 
using the appropriate protocol. See Port Write Enabled on page 400 or Controlling 
Access to the TCM on page 267.

5 Ensure the output or memory point is assigned a Read/Write alias number. See 
Assigning an Alias Number, Alias Type, and Physical Address on page 117.
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Trident Application Access
This section explains how to restrict connection access to a Trident controller and how to restrict 
or allow write access to output and memory points in the downloaded application. Topics 
include:

• Restricting Access to a Trident Controller on page 168

• What Affects Trident Write Access from External Devices on page 169

• Restricting Write Access to Trident Points on page 170

• Allowing Write Access to Trident Points on page 171

Restricting Access to a Trident Controller

This procedure explains how to restrict access to a Trident controller from a TriStation PC. If 
access is restricted, only users with access privileges can disable points or download changes to 
the controller.

Procedure

1 Expand the Controller tree, and double-click Configuration. 

2 On the Configuration tree, open the Hardware Allocation node, and then double-click 
the MP. 

The Item Properties dialog box appears.

3 Click Setup. 

The MP Setup dialog box appears.
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4 Specify these properties on the Operating Parameters tab.

The settings you selected are used when the application is built.

What Affects Trident Write Access from External Devices

This section describes the system properties, communication properties, and function blocks 
that affect read and write access to memory and output points on a Trident controller.

These types of read and write access are possible:

• Input, output, and memory points can be read by any external device that can 
communicate with a Trident controller.

• Write access to input points is not allowed from any external device.

• Write access to a output or memory point is allowed or restricted based on the system, 
communication, application, and point settings.

This table describes write access to Trident points from external devices.

Property Action

Password Required for 
Connection

Select the check box to restrict access by requiring a password 
when connecting to the controller. The default is cleared.

Password Enter the password required to access the controller. The default 
is PASSWORD.

Restart on Power Up Select the check box to have the application restarted after a 
power failure. The default is cleared.

Disable Remote Changes 
to Outputs

Clear the check box to allow remote devices to write to output 
points. The default is selected.

Allow Disabling of Points Select the check box to allow the TriStation PC to disable points 
while the application is running on the controller. The default is 
cleared.

Use Local Time Clear the check box if you do not want to use local time. The 
default is checked.

Table 28 Trident Write Access

Property or Feature Description

Disable Remote Changes to 
Outputs

A system setting on the MP Operating Parameters tab that 
determines write access to output points.
When selected, external devices cannot write to output points, 
no matter what other settings are made.

SYS_SET_REMOTE_WRT_ENBL A Trident function block that programmatically allows or 
restricts write access to output or memory read/write aliased 
points when used in an application.
To allow write access, the Disable Remote Changes to Outputs 
property cannot be selected.
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Restricting Write Access to Trident Points

This procedure explains how to restrict external devices from writing to memory and output 
points. Input, output, and memory points can be read by any external device that can 
communicate with the Triconex controller. Input points cannot be written to.

The SYS_SET_REMOTE_WRT_ENBL function block can be used programmatically to override 
the Disable Remote Changes to Outputs setting and allow write access to a range of aliased 
output or memory points.

Procedure

1 On the Configuration tree, open the Hardware Allocation node, and then double-click 
the MP. The Item Properties dialog box appears.

2 Click Setup. The MP Setup dialog 
box appears.

3 On the Operating Parameters tab, 
ensure the Disable Remote 
Changes to Outputs check box is 
selected.

Privilege A Trident CM module setting that determines whether network 
devices using DDE, OPC, or TSAA communication have write 
access to output points and read/write aliased memory points.

• For Trident CM, the default is Read/Write.
• This setting does not affect Modbus access.

Point Type A tagname setting that determines whether the output and 
memory point is assigned a Read or Read/Write alias number.

• For output points, all alias numbers are Read/Write.
• For memory points, alias numbers can be Read or 

Read/Write.

Table 28 Trident Write Access (continued)

Property or Feature Description
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Allowing Write Access to Trident Points

This procedure explains how to allow external devices to write to memory and output points. 
Input points can be read, but cannot be written to. External devices must use supported 
communication protocols (Modbus, TSAA, OPC, and DDE) to communicate with the controller.

Procedure

1 On the Configuration tree, open the Hardware Allocation node, and then double-click 
the MP. The Item Properties dialog box appears.

2 Click Setup. The MP Setup dialog box appears.

3 If the external devices are communicating through an Open Network port on the 
Communication Module, ensure the Privilege property on the Network tab is set to 
Read/Write. 

See Configuring Trident CM Network Ports on page 220. The default is Read/Write.

4 Ensure the output or memory point is assigned a Read/Write alias number. See 
Assigning an Alias Number, Alias Type, and Physical Address on page 117.



172 Chapter 2 Application Development

TriStation 1131 Developer’s Guide, v4.1

Building an Application
This section includes information on how to build an application, which must be done before 
testing. If you try to download an application before building it, TriStation 1131 tries to build it 
and then download it. If the build has errors, the download does not continue.

Topics include:

• Specifying the Program Order and Scan Time on page 172

• Compiling a Program on page 173

• Building or Rebuilding an Application on page 174

Specifying the Program Order and Scan Time

This procedure explains how to specify the programs and order of execution in the application. 
You can also set the scan time of the application, which determines the number of milliseconds 
that is taken to execute the application once.

The maximum number of programs in an application is 250.

Procedure

1 On the Application Tree, double-click Implementation. 

2 On the Implementation tree, double-click Execution List.

3 Specify these properties on the Execution List screen.
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Compiling a Program

This procedure explains how to manually compile a program, which can be done before 
building an application. Programs are automatically compiled when you build an application.

Procedure

1 On the Project menu, click Compile All User Documents. 

The Message View automatically opens and displays the status of the compile process.

2 If there are errors, fix them before building the application.

Property or Button Action

Scan Time Enter the number of milliseconds anticipated for the scan. The 
actual scan time is determined after the application is 
downloaded and run on the controller. For more information, 
see the Enhanced Diagnostic Monitor application. The default 
is 200 milliseconds.

New (insert) button Click to add a program to the list. 

Delete button Click to delete the selected program from the list. 

Move Up button Select a program and then click to move a program up in the 
execution order.

Move Down button Select a program and then click to move a program down in 
the execution order.

Browse button To add or change a program, double-click a program, then 
enter the name, or click the Browse button to select a name 
from the available programs.
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Building or Rebuilding an Application

This procedure explains how to use the Build Application command or Rebuild Application 
command to build an application. If the programs in the application have not been compiled, 
the Build Application command compiles them and then attempts to build the application.

Errors and warnings are displayed in the Message View. Errors must be resolved before an 
application can be downloaded, but warnings do not affect online execution. Typically, 
warnings refer to unused points in an application. 

Procedure

1 On the Project menu, click Build Application or Rebuild Application.

2 Check the Message View for errors. If there are no errors, the build is successful.

3 If there are errors, click each error message to locate the location of the error.

4 Correct the errors, compile the affected user documents, and then build or rebuild the 
application.

Note When you build a CEM program, intermediate FBD and ST code is generated. This code 
is useful for understanding and debugging the CEM program. To view the intermediate 
code, from the Document menu, select View Intermediate FBD or View Intermediate ST.
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Overview
This figure shows the main steps for configuring the controller and their typical order in the 
project cycle. The controller must be configured before an application can be downloaded and 
implemented on a controller.

Set Up the Project

Test with the
Emulator

Set Up TriStation
Communication

Implement on
the Controller

Develop the
Application

Configure the
Controller

Fix Errors

 - Set operating parameters

 - Allocate memory and hardware

 - Configure communication to external devices

 - Set up Time Synchronization (optional)

Errors?

No

Yes
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Controller Configuration Steps
This list includes the steps that can or should be done during controller configuration. 
Controller configuration must be completed before an application is downloaded to the 
controller.

Description See

Set the operating parameters. Operating Parameters on page 180

Allocate memory and hardware. Memory Allocation on page 183
Tricon Hardware Allocation on page 184
Trident Hardware Allocation on page 192

Configure communication to external 
devices.

Tricon Communication Configuration on page 197
Trident Communication Configuration on page 216

Set up time synchronization. Tricon Time Synchronization on page 224
Trident Time Synchronization on page 235
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The Controller Workspace
This section explains the Controller Workspace, which is where you specify the configuration 
for the project. 

Topics include:

• The Controller Tree on page 178

• The Configuration Tree on page 179

• The Controller and Emulator Panels on page 179

The Controller Tree

The Controller tree includes the elements (operating parameters, communication settings, 
memory allocation, and hardware allocation) that can be configured. The tree also includes the 
Controller and Emulator Panels used to emulate and run an application.
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The Configuration Tree

The Configuration tree includes operating parameters (Tricon only), communication, memory 
allocation, hardware allocation, and Control and Status Attributes (Trident only).

The Controller and Emulator Panels
The Controller and Emulator Panels display programs running in emulation or in the controller.

Configuration 
tree (Trident)

Configuration 
tree (Tricon)

Controller and 
Emulator tree



180 Chapter 3 Controller Configuration

TriStation 1131 Developer’s Guide, v4.1

Operating Parameters
This section explains how to specify operating parameters, which are settings that affect the 
general operation of the controller.

Topics include:

• Setting Tricon Operating Parameters on page 180

• Setting Trident Operating Parameters on page 182

Setting Tricon Operating Parameters

This procedure explains how to specify Tricon operating parameters, which include settings to 
restrict access to the controller from a TriStation PC and from remote devices.

Procedure

1 Expand the Controller tree, double-click Configuration, and then click Operating 
Parameters.

2 Specify these properties on the Operating Parameters screen.

Property Action

Password Required for 
Connection

Select the check box to require a password to be used to connect 
from the TriStation PC to the controller. If selected, enter a 
password. The default is cleared.

Password If a password is required, enter the password. Not case-sensitive.

Disable Stop on 
Keyswitch

Select the check box to prevent the STOP keyswitch from halting 
the application running on the controller. The default is cleared.
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Disable Remote 
Changes to Outputs

Select the check box to prevent external devices, such as a DCS, 
from writing to output tagnames in the TriStation 1131 application. 
The default is selected.

Allow Disabling of 
Points

Select the check box to allow points to be disabled from TriStation 
1131. The default is selected.

Enable Tricon Node 
Time Synchronization

Select the check box to allow the controller to participate in time 
synchronization across the Peer-to-Peer network as a master node 
or a slave node (see Configuring Triconex Time Synchronization on 
the TCM on page 233).

Property Action
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Setting Trident Operating Parameters

This procedure explains how to specify Trident operating parameters, which include settings to 
restrict access to the controller from a TriStation PC and from remote devices.

Procedure

1 On the Configuration tree, open the Hardware Allocation node, and then double-click 
the MP. The Item Properties dialog box appears.

2 Click Setup. The MP Setup dialog box appears.

3 Specify these properties on the Operating Parameters tab.

4 Click OK to save.

Property Action

Password Required for 
Connection

Select the check box to restrict access by requiring a password 
when connecting to the controller. The default is cleared.

Password Enter the password required to access the controller. The default 
is PASSWORD.

Restart on Power Up Select the check box to have the application restarted after a 
power failure. The default is cleared.

Disable Remote Changes 
to Outputs

Clear the check box to allow remote devices to write to output 
points. The default is selected.

Allow Disabling of Points Select the check box to allow the TriStation PC to disable points 
while the application is running on the controller. The default is 
cleared.

Use Local Time Clear the check box if you do not want to use local time. The 
default is selected.
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Memory Allocation
This section explains how to allocate memory, which includes specifying the memory used for 
input, output, and memory points.

Allocating Memory for Points

This procedure explains how to change the amount of memory used for input, output, and 
memory points in the application. Initially, the amount of memory for input and output points 
is determined by the number and type of I/O modules configured in the TriStation project. The 
amount of memory for memory points is set when a TriStation project is created. You can 
change these allocations at any time before building and downloading the application.

Procedure

1 Expand the Controller tree, double-click Configuration, and then expand Memory 
Allocation.

2 Double-click the type of point you want to change.

3 Move the slider up or down to change the memory allocated for the selected point.

4 Repeat for all points to be changed.

CAUTION
After an application is downloaded to a controller, changes to memory 
allocation require a Download All (see Using the Download All 
Command on page 316).
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Tricon Hardware Allocation
This section explains how to configure the hardware allocation for a Tricon controller. Topics 
include:

• Determining Tricon Chassis Power Usage on page 184

• Adding or Deleting a Tricon Chassis on page 185

• Changing the Tricon MP Model on page 186

• Inserting and Removing Tricon Modules on page 186

• Configuring a Tricon AI Single-Ended or Differential Module on page 187

• Configuring a Tricon DO Module on page 188

• Configuring a Tricon PI Module on page 190

• Adding a Tricon Thermocouple Module on page 191

Determining Tricon Chassis Power Usage

This procedure explains how to display the amount of power used by a Tricon chassis. 

For more information, see the Tricon Planning and Installation Guide.

Procedure

1 Expand the Controller tree, double-click Configuration, and then click Hardware 
Allocation.

The Chassis Power Usage screen shows information about the logic power used by each 
chassis.
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• Total Power Supply: Shows the maximum logic power that the chassis can 
support.

• Total Power Used: Shows how much logic power is being used by the current 
configuration of modules in a chassis.

• Available: Shows the amount of available (unused) logic power.

2 If the Available power is negative, delete one or more modules from the chassis and add 
them to another chassis in the configuration.

3 Recheck the power usage for the chassis to ensure the logic power is acceptable. If 
acceptable, the physical installation must be changed to match the logical configuration 
in TriStation.

Adding or Deleting a Tricon Chassis

This procedure explains how to add or delete a Tricon chassis from the controller configuration. 
Each controller configuration includes a main chassis, usually called HD_MAIN (High-Density 
chassis) or LD_MAIN (Low-Density chassis). Additional chassis in a a configuration are 
expansion chassis (HD_EXP) or remote chassis (HD_RXM).

Procedure

1 Expand the Controller tree, double-click Configuration, and then double-click 
Hardware Allocation. The Item Properties dialog box for the chassis appears.

2 Take either of these actions.

Commands Actions

Add Click to add a chassis. Select the type of chassis from the list that appears.

Delete Select a chassis and then click Delete.
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Changing the Tricon MP Model

This procedure explains how to change the model of Tricon MPs in the TriStation configuration. 
If you install different model MPs in the controller, you must logically configure the change in 
the TriStation project. This change requires a Download All.

When you change MPs, TriStation saves the configuration and attaches the Tricon library that 
supports the installed MPs. Before saving the configuration, you are allowed to back up your 
project.

Procedure

1 Expand the Controller tree, double-
click Configuration, and expand 
Hardware Allocation. 

The Insert Module dialog box appears.

2 Double-click the chassis whose model 
you want to change, and then click 
Replace MPs. 

3 Click the model of MPs that are 
installed in the Tricon, and then click 
OK.

4 Click OK to save the project.

5 To finish the process, you must build the application and download it to the controller.

Inserting and Removing Tricon Modules

This procedure explains how to add and delete modules from a configuration. If a module is 
deleted, you must use the Download All command to download the application to the 
controller. 

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the chassis that you want to add or remove a module from.

3 Do one of the following:

• Click an empty slot, and then click 
Insert. On the Insert Module screen, 
select the type of module to insert, 
and then click OK.

• Click the module to be removed 
from the configuration, and then 
click Remove. This cannot be 
undone.
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Configuring a Tricon AI Single-Ended or Differential Module

This procedure explains how to configure a Tricon Analog Input Single-Ended (model 3720) or 
Differential (model 3721) module1. For both modules, the resolution type and field power 
monitoring status can be specified. For the Differential module, the input type can also be 
specified.

Procedure

1 Expand the Controller tree, click Configuration, and expand Hardware Allocation. 

2 Expand the chassis where the module is installed, double-click the slot where the 
module is installed, and then click Setup.

 

3 Specify these properties in the AI Setup dialog box.

1. The model 3720 and 3721 AI modules are compatible only with Tricon v10.2 and later systems.

WARNING
Changing the resolution type on model 3720 and 3721 AI modules will 
cause all input points on the module to change. A change from high to 
low resolution (or vice-versa) results in a value change by a factor of four. 
You must modify your application to take this change into account.

During a download change operation, the implementation of the logic 
change will occur before the implementation of the range change on the 
modules. This may result in a mismatch between the range the 
application expects and the actual range from the module. All points 
should be bypassed during a resolution change to prevent any 
unintended application problems.
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4 Click OK to save your changes.

Configuring a Tricon DO Module

This procedure explains how to configure a Tricon Digital Output (model 3625) module2, which 
allows you to specify how each point is configured.

Procedure

1 Expand the Controller tree, click Configuration, and expand Hardware Allocation.

2 Expand the chassis where the module is installed, double-click the slot where the 
module is installed, and then click Setup.

Property Action

Resolution Type Select the resolution to be used for the point. Available with Single-
Ended and Differential AI modules.

• Standard Resolution: Data resolution is 12 bits, which is 4095 counts 
at the maximum range of 5 volts. For a Differential AI module, 
Standard Resolution cannot be selected if Bipolar Input is selected.

• High Resolution: Data resolution is 14 bits, which is 16383 counts at 
the maximum range of 5 volts.

The default is Standard Resolution. 

Differential AI 
Input Type

Select the input type for the point. Only available with the Differential AI 
module.

• Unipolar Input: 0 to 5 volts (with 6% over-range).
• Bipolar Input: -5 to 5 volts (with 6% under-range and over-range). 

Available only if High Resolution is selected.
The default is Unipolar Input.

Field Power 
Monitoring

Select whether the module should monitor field power at the termination 
panel. When field power monitoring is On, the module will report when 
field power at the term panel goes in or out of range. 
Applicable only if you are using a term panel that passes field power to 
the module.
The default is Off.
If you are not using a term panel that passes field power to the module, 
you must select Off. If you select On, and the term panel does not support 
field power monitoring, you will see Field Power faults on the module.
For more information about external term panels, see the Tricon Field 
Terminations Guide.

2. The model 3625 DO module is compatible only with Tricon v10.2 and later systems.



Tricon Hardware Allocation 189

TriStation 1131 Developer’s Guide, v4.1

3 Select the tagname to be configured, and then specify these properties in the DO Setup 
dialog box.

4 Continue to select tagnames and specify settings as needed.

5 Click OK to save your changes.

Property Action

DO Point 
Options

Select the option to be used for the DO point.
• Not Used: Provides the same fault detection as for Non-Supervised 

points, except reporting of benign field fault conditions is 
suppressed. Points configured as Not Used will be energized if the 
application commands them on.

• Non-Supervised: Provides detection of all internal faults and limited 
external faults associated with the field device or wiring.

• Supervised: Provides detection of all internal faults and detection of 
all external faults associated with field device or wiring.

The default is Non-Supervised.

Shorted Point 
Alarm Threshold

Enter the number of ohms below which values are alarmed as a shorted 
load. Typical threshold values are 10 to 48 ohms. 
The available range is 0 to 65,535. The default is 10.
Only available if the points are supervised.

Open Point 
Alarm Threshold

Enter the number of ohms above which values are alarmed as an open 
load. Typical threshold values are 480 to 3200 ohms. 
The available range is 0 to 65,535. The default is 2400.
Only available if the points are supervised.
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Configuring a Tricon PI Module

This procedure explains how to configure a Tricon Pulse Input or Enhanced Pulse Input 
module, which are used for speed and RPM inputs. Each point can be independently 
configured.

Procedure

1 Expand the Controller tree, click Configuration, and expand Hardware Allocation.

2 Expand the chassis where the module is installed, double-click the slot where the 
module is installed, and then click Setup.

3 Select the tagname to be configured, and then specify these properties in the Pulse Input 
Setup dialog box.

4 Continue to select tagnames and specify settings as needed.

5 Click OK to save your changes.

Property Action

Rate Type Select the type of rate applied to pulse input signals: Speed or RPM.

Maximum RPM Enter the revolutions per minute for the pulse input device; used 
with RPM. 

Maximum Speed Enter the speed for the pulse input device; used with Speed rate 
type.

Pulses Per Revolution Enter the number of pulses per revolution of the measuring 
shaft; used with RPM rate type.

Scale Factor Enter the scaling value to convert pulse input signals into 
engineering units. For:

• Pulses per second, set to 0.016667.
• Pulses per minute, set to 1.0 (default).
• Pulses per hour, set to 60.0
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Adding a Tricon Thermocouple Module

This procedure explains how to specify the type of Tricon thermocouple module, which must 
match the module that is installed in the system. Because these modules come in a variety of 
configurations, select carefully. For more information, see the Tricon Planning and Installation 
Guide.

Procedure

1 Expand the Controller tree, click Configuration, and expand Hardware Allocation.

2 Expand the chassis where the module is installed, double-click the thermocouple 
module slot, and then click Insert.

3 From the module list, select the type of thermocouple module installed in the Tricon, as 
indicated by these properties.

4 Click the type of module installed in the controller, and click OK. There are no other 
properties to specify.

Property Description

Model 3706/A/AN or 3708/E/EN

Type E, J, K, T Specifies the thermocouple type installed.
For 3706, J, K, or T.
For 3708, E, J, K, or T.

Degree conversion dgC is converted to Celsius.dgF is converted to Fahrenheit.

UpS (upscale)
DnS (downscale)

Specifies value returned if voltage is out-of-range, or burnout occurs.
• Upscale returns +32,767.
• Downscale returns –32,767.

For model 3708E only.

Points For model 3706, 32 points.
For model 3708, 16 points.
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Trident Hardware Allocation
This section explains how to configure the hardware allocation for a Trident controller. Topics 
include:

• Specifying Trident MP Module Properties on page 192

• Displaying Trident MP Attribute Properties on page 193

• Inserting Trident Modules on page 194

• Removing Trident Modules on page 195

Specifying Trident MP Module Properties

This procedure explains how to specify properties on the Trident MP Module tab. The 
properties that are displayed vary depending on the module.

Procedure

1 On the Controller tree, double-click Configuration.

2 On the Configuration tree, open the Hardware Allocation node, and then double-click 
an MP. 

The Item Properties dialog box appears.

3 Specify these properties on the Module tab.

Property Action

Model Select the model used in the physical system.

Description Enter a description, if desired.

Node Name Displays the node name and number.

Scan Time Displays the scan time, if it has been specified.
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4 Click Confirm to save your changes.

Note You cannot specify point properties for a Trident MP. 

Displaying Trident MP Attribute Properties

This procedure explains how to display MP attribute properties (status and control attributes).

Procedure

1 On the Controller tree, double-click Configuration.

2 On the Configuration tree, open the Hardware Allocation node, and then double-click 
an MP. The Item Properties dialog box appears.

3 Click the Attributes tab.

These properties are displayed on the Attributes tab.

Remote Access to Aliased 
Tagnames

Select to have remote access only to aliased tagnames.

Remote Access to All 
Tagnames

Select to have remote access to all aliased tagnames.

Setup Click to specify properties for operating parameters, network 
ports, and serial ports.

Property Action

Property Description

Tagname The name of the status or control attribute.

Data Type The data type.

Location The memory location for the attribute. 

Description The description of the attribute.
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Inserting Trident Modules

This procedure explains how to insert Trident modules in a configuration.

If a Trident Communication Module (CM) is added to a configuration after the application has 
been downloaded to the controller, you must use the Download All command to download the 
change.

Procedure

1 On the Controller tree, 
double-click Configuration.

2 On the Configuration tree, 
open the Hardware Allocation 
node, and then click the MP 
slot. 

3 On the Tools menu, click 
Insert Module. The Insert 
Module dialog box appears.

4 Select the type of module you 
want to add to the 
configuration, and click OK. 

The mouse pointer changes to 
look like this: 

5 Click on the configuration pane to add the module to the configuration.

6 Configure the module using the instructions specific to that module:

• Configuring a Trident PI Module on page 195

• Trident Communication Configuration on page 216

Configuration 
pane

Module being 
added
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Removing Trident Modules

This procedure explains how to remove modules from a Trident configuration.

If a Trident Communication Module (CM) is removed from a configuration after the application 
has been downloaded to the controller, you must use the Download All command to download 
the change.

Procedure

1 On the Controller tree, double-click Configuration.

2 On the Configuration tree, click Hardware Allocation. 

3 On the configuration pane, click the icon that represents the module, and then press the 
Delete key.

Configuring a Trident PI Module

This procedure explains how to configure a Trident PI module, which is used for speed and 
RPM inputs. Each point can be independently configured.

Procedure

1 On the Controller tree, double-click Configuration.

2 On the Configuration tree, expand the Hardware Allocation node, and then expand the 
MP node the PI module is installed in. 

3 Double-click the PI module, and then click Setup.

4 Select the tagname to be configured, and then specify these properties in the Pulse Input 
Setup dialog box.
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5 Continue to select tagnames and specify settings as needed.

6 Click OK to save your changes.

Property Action

Field Power Select Field Power Present if the installed system has field power 
connected to the Pulse Input Baseplate. The default in Field Power 
Absent.

Field Maximum Power Enter the maximum range for field power in volts. The default is 
33 volts.

Field Minimum Power Enter the minimum range for field power in volts. The default is 0 
volts.

Rate Type Select Speed or RPM to specify the type of rate applied to pulse 
input signals.

Triggering Mode Select Rising Edge or Falling Edge depending on the installation.

Number of Gear Teeth Enter the number of gear teeth that are counted in each revolution.
The PI Point Options property must be specified as RPM to enable 
this property.

Scale Factor Specifies how to convert pulse input signals into engineering units. 
For:

Pulses per second, set to 0.016667.
Pulses per minute, set to 1.0 (default).
Pulses per hour, set to 60.0
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Tricon Communication Configuration
This section explains how to configure Tricon communication modules for communication with 
external devices. For information on connecting a TriStation PC to a Triconex controller, see 
TriStation PC Setup on page 242.

Topics include:

• Specifying the Tricon Default Connection on page 197

• Configuring Tricon ACM Ports on page 199

• Configuring Tricon NCM Ports on page 203

• Configuring Tricon EICM Ports on page 201

• Configuring Tricon NCM Ports on page 203

• Configuring Tricon SMM Ports on page 204

• Configuring TCM Ports on page 205

Specifying the Tricon Default Connection

This procedure explains how to specify the default connection setting in the Connect To dialog 
box, which appears when you establish communication between a TriStation PC and a 
controller. The connection setting—Network or Serial Connection—is an initial setting and can 
be changed when you use the Connect command.

Procedure

1 Expand the Configuration tree, double-click Configuration, and then click TriStation 
Communication.
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2 Specify these properties on the TriStation Communication screen.

3 To complete the connection, you must configure a Tricon ACM, EICM, NCM, or TCM 
module.

Property Action

Select Connections If using ACM or NCM select the Network Connection check box.
If using EICM, select the Serial Connection check box.
If using TCM, select the Network Connection check box, the Serial 
Connection check box, or both.

Node Number For a network connection, enter the node number. Click the browse 
button to select the node from a list.

Node Name For a network connection, enter the node name.

UDP Base Port 
Number

Enter the UDP port to use for the TriStation connection. The default is 
1502.
Available only when a TCM is installed.

IP Address For a network connection, enter the IP address.

Serial Port For a serial connection, select the TriStation PC port that is connected 
to the controller.

Baud Rate Select the data transmission speed. The default is 9600.
Available only when a TCM is installed.

Default Connection If only one Selected Connection is checked, the default connection is 
set based on it.
If both network and serial connections are set, you must specify the 
default connection setting.
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Configuring Tricon ACM Ports

This procedure explains how to configure ports on a Tricon ACM, which support these 
connections:

• On NET 1, a network connection to a Foxboro Intelligent Automation (I/A) Series DCS

• On NET 1, time synchronization with a Foxboro Intelligent Automation (I/A) Series 
DCS

• On NET 2, a network connection to a TriStation PC or other network devices

• On NET 2, time synchronization with the Tricon master node

You can install primary and redundant ACM modules in either chassis 1 or chassis 2.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the ACM slot, and then click Setup.

3 For a NET 1 connection, specify these properties on the ACM Setup screen.

Property Action

SOE Block Name If using SOE, specify the block number.

Privilege Specify Read/Write to allow external devices to read and write 
points. The default is Read.

Redundant Mode Select the check box to specify that a redundant ACM is installed.

Time Synchronization Select On NET 1 enable time synchronization with external source 
to allow time synchronization with the I/A DCS.
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4 For a NET 2 connection, specify these properties on the ACM Setup screen.

5 Click OK to save your changes.

Configuring Tricon HIM Ports

This procedure explains how to configure ports on a Tricon HIM, which supports a connection 
between a Tricon controller and a Honeywell control system. 

Procedure

1 Expand the Controller tree, double-click 
Configuration, and expand Hardware 
Allocation. Double-click the HIM slot, and 
then click Setup.

2 Specify these properties on the HIM Setup 
screen.

3 Click OK to save your changes.

Property Action

Redundant Mode Select the check box to specify that a redundant module is installed. 

Used/Not Used Select Used to specify the slots that have an installed ACM module.
To enable the right slot, select the Redundant Mode check box 
(above).

Privilege Specify Read/Write to allow external devices to read and write 
points. The default is Read.

IP Address If using a default IP address, leave blank.
If not, enter the IP address that identifies the controller on the 
network. This must be the same IP address as entered on the 
TriStation Communication screen (see Specifying the Tricon 
Default Connection on page 197).

IP Subnet Mask If the controller is on a subnet, enter the subnet address.

Default Gateway IP 
Address

If needed, enter an IP address to be used as the default for a 
gateway.

Time Synchronization Select NET 2 to enable time synchronization with the Tricon Master 
controller.

Property Action

Base 
AddressBase 
Address

Enter a number between 5 and 31 to specify the block address for the 
HIM based on the Data Hiway memory map. The default is 5.

Number of 
Extended Block

Enter a number which identifies a pair of HIM blocks consisting of a base 
block and a secondary block (which is offset from the 6-bit block address 
by 32). The default is 4.
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Configuring Tricon EICM Ports

This procedure explains how to configure ports on a Tricon EICM, which supports these serial 
connections:

• To a TriStation PC using TriStation 1131 protocol

• To an external device using Modbus protocol (master, slave, and master/slave)

• To a Centronics printer

You can install an EICM module in either chassis 1 or the first expansion chassis. 

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the EICM slot, and then click Setup.

3 Specify these properties in the EICM Setup dialog box.

Property Action

Port Selection For TriStation 1131 or Modbus communication, select ports 1–4 or 
6–9. For a printer connection, select ports 5 or 10. 

Protocol For TriStation 1131, select TriStation.
For Modbus, select the specific Modbus protocol.

Modbus Slave Address Enter the number of the slave address, which can be 1–247.
Only available with Modbus slave and Modbus slave/master 
protocols.

Baud Rate Select the rate, which must be the same as other slaves on the 
network. The default is 9600.
The total rate for all four ports must be less than or equal to 57,600.
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4 Click OK to save your changes.

Data Bits Set as needed; must be the same as other Modbus slaves.
Modbus slave can use 7 or 8 bits.
Modbus master and master/slave must use 8 bits. 

Stop Bits Select either 1 Bit or 2 Bits to specify whether to send 1 or 2 bits to 
indicate that the transmission of a byte of data is complete.

Parity Must use the same setting as other Modbus slaves.

Handshake If set to Hardware, see Setting Signal Delays for Tricon EICM on 
page 422.

Modbus (Minimum 
and Maximum) Range

Set minimum between 0 and 32767; maximum between 1 and 
32767.

Rows and Columns Type the number of characters for the printer; only available with 
port 5 and 10. Rows can be 0–255; columns can be 0–255. 

SOE Block Name The SOE block name. Reserved for future use.

Property Action
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Configuring Tricon NCM Ports

This procedure explains how to configure ports on a Tricon NCM, which supports these 
connections:

• On NET 1, a network connection to other Triconex controllers using the Peer-to-Peer 
protocol and Triconex Time Synchronization

• On NET 2, a network connection to a TriStation PC or other external devices

• Serial connection between a Tricon NCMG module and a Global Positioning System 
(GPS) interface

You can install a primary and redundant module in one logical slot.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware Allocation. 

2 Double-click the NCM slot, and then click Setup.

3 Specify these properties in the NCM Setup dialog box.

4 Click OK to save your changes.

Property Action

Installed/Not Installed Select to indicate which slots have modules installed. Available 
for the right slot only when the module is installed in a 
redundant (non-COM) slot.

Privilege Select Read or Read/Write.

IP Address Enter the IP address for the NCM.

Select the check box to synchronize time with a GPS. The default 
is cleared.

Time Synchronization Select the check box to synchronize time with the Tricon master 
node. The default is cleared.
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Configuring Tricon SMM Ports

This procedure explains how to configure ports on a Tricon Safety Manager Module (SMM), 
which supports a connection between a Tricon controller and a Honeywell Universal Control 
Network (UCN).

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the SMM slot, and then click Setup.

3 Specify these properties in the SMM Setup dialog box.

4 Click OK to save your changes.

Property Action

UCN Node Number Enter the UCN node number.

SOE Block Enter 15 or 16, which are Modified External blocks reserved for 
the SMM.

Prohibit Writes Select the check box to prevent Honeywell workstations from 
writing to memory and output points. The default is cleared. 

Enable UCN Test 
Mode

Should only be selected if requested by Honeywell factory test 
personnel. The default is cleared.

Time Synchronization Select the check box to enable time synchronization with the UCN. 
The default is cleared.
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Configuring TCM Ports

Note The information and procedures in this section apply only to model 4351A and 4352A 
TCMs. If you have an older model 4351 or 4352 TCM installed in your system, please see 
Appendix C, TCM Model 4351/4352 Configuration.

A single Tricon v10 system3 supports a maximum of four TCMs, which must reside in two 
logical slots. You cannot mix model 4351A/4352A TCMs and 4351/4352 TCMs in the same 
system, even if they are installed in different chassis. See the Planning and Installation Guide for 
Tricon v9-v10 Systems for detailed TCM installation guidelines.

TCM models 4351A (Copper)/4352A (Fiber) support the following protocols on network and 
serial ports. 

To configure specific types of ports, see these topics:

• Configuring TCM Network Ports on page 206

• Configuring TCM Serial Ports on page 208

• Configuring TCM Peer-To-Peer Ports on page 210

• Configuring TCM Modbus TCP Ports on page 212

• Configuring TCM Routing on page 214

For additional information on configuring the TCM, see these topics:

• Tricon Time Synchronization on page 224 for instructions on configuring the TCM to 
synchronize time. 

3. TCMs can be installed only in Tricon v10.x systems. They cannot be installed in Tricon v9.x or earlier 
systems.

Protocol Network Ports Serial Ports

TriStation NET 1, NET 2 Port 4

TSAA (UDP/IP) NET 1, NET 2 —a

a. — means the protocol is not available on this port.

Peer-to-Peer (UDP/IP) NET 1, NET 2 —

Peer-to-Peer (DLC) NET 1 —

Modbus Slave (ASCII or RTU) — Any port

Modbus Master (RTU) — Any port

Modbus Master or Slave (TCP) NET 1, NET 2 —

GPS Time Synchronization — Port 1

Triconex Time Synchronization via DLC NET 1 —

Triconex Time Synchronization via UDP/IP NET 1, NET 2 —

SNTP Triconex Time Synchronization NET 1, NET 2 —

Network Printing using Jet Direct NET 1, NET 2 —
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• Controlling Access to the TCM on page 267 for instructions on controlling access to the 
TCM on a per-client level.

• Configuring a Tricon TCM Port for Printing on page 278 for instructions on configuring 
the TCM for use with a printer.

Note Once TCM ports have been configured, but prior to downloading the configuration to the 
controller, you can change the existing TCM model to a different model TCM without 
losing your port settings (see Inserting and Removing Tricon Modules on page 186). 
Note that you can switch only from a 4351A to a 4352A, or vice-versa; you cannot switch 
from a 4351A or 4352A to a 4351 or 4352.

However, once the configuration has been downloaded to the controller, you cannot 
change the TCM model installed in the Tricon without downloading a new 
configuration. 

Configuring TCM Network Ports

This procedure explains how to configure network ports on a Tricon TCM.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The Enhanced TCM Setup dialog box appears.

3 Specify these properties on the Network tab.
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4 Click OK to save your changes.

Note Changes to TCM IP addresses are not effective until the existing connection is closed and 
a new connection is opened. Once a connection is opened, it remains open until you 
close it, even if the IP address is changed via a download change operation.

Property Action

Slot Selection Select the slot where the TCM module you want to configure is 
installed.

Not Installed, 
Installed

Click Installed to enable configuration of the module. Clicking Not 
Installed resets all options to their default state and makes them 
unavailable for configuration. The default is Not Installed.

Transceiver Mode Select the communication mode. The default is Auto-Negotiate.
If you have a model 4352A TCM with fiber connectors, you must 
select 100 Mbps as the communication mode. The 4352A module 
cannot connect at 10 Mbps.

IP Address Enter the IP Address for the port. NET 1 and NET 2 cannot use the 
same IP address. 
The default values are:

• NET 1: 192.168.0.x 
• NET 2: 192.168.1.x

where x is the node number.

IP Subnet Mask If needed, enter the IP address for the subnet. The default is 
255.255.255.0.

Default Gateway IP 
Address

If needed, enter the IP address for the default gateway. The default is 
0.0.0.0.

TriStation Port 
Number

Enter the UDP port to use for the TriStation connection. The default is 
1502. See UDP Base Port Number on page 438 for additional 
information.

TSAA Port Number Enter the UDP port to use for TSAA connections, including DDE 
Server, SOE Recorder, and OPC Server. The default is 1500. See UDP 
Base Port Number on page 438 for additional information.

Port Write Enabled Select this check box if you want to allow TSAA writes to this port. 
Applies to all TSAA connections on this port. The default is cleared 
(the port is read-only).
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Configuring TCM Serial Ports

This procedure explains how to configure serial ports on a Tricon TCM.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The Enhanced TCM Setup dialog box appears.

3 Click the Serial Ports tab.

4 Specify these properties.

Property Action

Port Selection Click the port to be configured. Ports can be configured only for a 
slot with an installed module.

Port Write Enabled Available only if Modbus Slave (ASCII or RTU) is selected as the 
communication protocol. Select this check box if you want to 
allow Modbus writes to this slave port. The default is cleared (the 
port is read-only).
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5 Click OK to save your changes.

Note Even if port 4 is set to Not Configured (the default value), it can still be used to connect 
to the Tricon via TriStation. This is useful when you are unable to connect via a network 
connection.

Protocol Select the communication protocol for the port:
• All ports can use Modbus Master, Modbus Slave ASCII, 

Modbus Slave RTU.
• Only port 1 can use GPS. This port is automatically configured 

for GPS when you enable time synchronization. See Using a 
Tricon TCM to Synchronize Time on page 229.

• Only port 4 can use TriStation.

Modbus Slave Address If you selected Modbus Slave RTU or ASCII, enter the number of 
the Modbus slave device. The default is 1.

Baud Rate Enter the communication rate for the port. The default is 9600.

Data Bits Select 8 or 7 bits. The default is 8. Available only with Modbus 
Slave ASCII.

Stop Bits Select 1 or 2 bits. The default is 1 bit. 

Parity Select the type of parity for the port. The default is Odd.

Transceiver Mode Select RS-485 or RS-232. The default is RS232. On port 4 when 
TriStation is selected as the protocol, RS-485 is not available.

Handshake Select None or Hardware; the default is None.

Termination Options Select the type of termination used with cables. Only available 
with RS-485 Transceiver Mode. The default is None.

FP Ordering Select the order to be used with floating point numbers. The 
default is Low 16 Bits First.

Modbus (Minimum and 
Maximum) Range

Enter the minimum and maximum values to be used for the 
Modbus data range. The default minimum is 0. The default 
maximum is 32,767.

Master Logical Port Enter the port number that the TCM will use in Modbus Master 
functions to access the port. Only available for Modbus Master.

Property Action
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Configuring TCM Peer-To-Peer Ports

This procedure explains how to configure the IP addresses for controllers communicating on a 
Peer-to-Peer network through a Tricon TCM.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The Enhanced TCM Setup dialog box appears.

3 Click the Peer-to-Peer tab.

4 Under Slot Selection, select the module (slot) you want to configure Peer-to-Peer ports for.

5 Select a node (controller), and specify these properties.

6 Click Update to apply the new settings for the selected node. 

Property Action

Destination UDP Port Enter the UDP port number for each controller to be 
communicated with on the Peer-to-Peer network. This must be 
the same number that the controller uses as its UDP Base Port 
Number.

Network Click the network port that the selected node is connected to. The 
default is NET 1.

IP Address Enter the IP address for the controller.
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7 Repeat steps 4 through 6 for each node to be included in the network. 

Note If necessary, click Reset All to reset all node settings for the selected slot to their 
default, unconfigured state.

8 Once all nodes have been configured, specify these properties (applicable to all nodes on 
the Peer-to-Peer network).

9 Click OK to save your changes.

Property Action

UDP Base Port Number For each network port, enter the UDP base port number for the 
controller. Enter 0 to disable Peer-to-Peer over UDP/IP on the 
network.
The default is 1503 on NET 1 (meaning Peer-to-Peer is enabled on 
NET 1) and 0 on NET 2 (meaning Peer-to-Peer is disabled on NET 
2). UDP port numbers must be unique. See UDP Base Port 
Number on page 438 for reserved values.

Enable Communication 
with Tricon V8 and V9 
Peer-to-Peer Systems

Select the check box to enable communication with Tricon version 
8 and 9 systems. The default is cleared. Available only for a 
module installed in the left slot.
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Configuring TCM Modbus TCP Ports

This procedure explains how to configure Modbus TCP ports on a Tricon TCM, which enables 
Modbus communication through network ports.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The Enhanced TCM Setup dialog box appears.

3 Click the Modbus TCP tab.

4 Under Slot Selection, select the module (slot) you want to configure Modbus TCP ports for.

5 Select a port and specify these properties.

Property Action

Protocol Select the communication protocol for the port. Options include 
Modbus TCP Master and Modbus TCP Slave Net.

Port Write Enabled Available only if Modbus TCP Slave is selected as the 
communication protocol. Select this check box if you want to allow 
Modbus writes to this slave port. The default is cleared (the port is 
read-only).

Master Logical Port Enter the number of the Modbus Master node. Available only with 
Modbus TCP Master protocol. 

TCP Port Number Enter the number for the TCP port. The default is 502. 
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6 Click OK to save your changes.

Network Click the network that the selected port is connected to. The default 
is NET 2.

IP Address If the port uses Modbus Master protocol, enter the IP address of the 
slave node.
If the port uses Modbus Slave protocol, enter either of these:

• To accept communication from any Modbus Master, leave the 
IP address as 0.0.0.0.

• To accept communication only from a defined Modbus Master, 
enter the specific master IP address.

FP Ordering Select the ordering to use for floating point numbers. The default is 
Low 16 Bits First.

Modbus (Minimum 
and Maximum) Range

Enter the minimum and maximum for the modbus data range. 
Available only with Modbus TCP Slave Net.

Property Action
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Configuring TCM Routing

This procedure explains how to configure routing on a Tricon TCM. Up to 10 different routes 
can be configured for each network; each slot (module) has two networks (NET 1 and NET 2).

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The Enhanced TCM Setup dialog box appears.

3 Click the Routing tab.

4 Select the module (slot) you want to configure routing for.

5 Select the network (NET 1 or NET 2) you want to configure routing for.

6 Select a destination route and then specify these properties.

Property Action

Destination IP 
Address

Enter the IP address which is used if the controller is not on the same 
subnet as other devices.

Destination IP 
Subnet Mask

Enter the IP address of the subnet mask.
If the gateway address is on NET 2, then the subnet mask must be the 
same as the NET 2 subnet mask defined on the Network tab. If the 
gateway address is on NET 1, then the subnet mask must be the same as 
the NET 1 subnet mask defined on the Network tab. See Configuring 
TCM Network Ports on page 206.
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7 Click Update Destination to apply the settings. 

Note If necessary, click Reset All to change all destination settings for the selected slot 
to their default, unconfigured state.

8 Click OK to save your changes.

Destination 
Gateway IP 
Address

Enter the IP address of the gateway to which the controller is connected. 
The gateway address must always be on NET 1 or NET 2. 

Property Action
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Trident Communication Configuration
This section explains how to configure Trident communication modules for communication 
with external devices. For information on connecting a TriStation PC to a Triconex controller, 
see TriStation PC Setup on page 242. Topics include:

• Specifying the Trident Default Connection on page 216

• Configuring Trident MP Network Ports on page 218

• Configuring Trident MP Serial Ports on page 219

• Configuring Trident CM Network Ports on page 220

• Configuring Trident CM Serial Ports on page 221

• Configuring Trident CM Routing on page 223

See Trident Printing on page 280 for instructions on configuring the Trident for use with a 
printer.

Specifying the Trident Default Connection

This procedure explains how to specify the default connection setting on the Connect To dialog 
box, which appears when you establish communication between a TriStation PC and a 
controller. The connection setting—Network or Main Processor Connection—is an initial 
setting and can be changed when you use the Connect command.

Procedure

1 Expand the Controller tree, double-click Configuration, and then click TriStation 
Communication.
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2 Specify these properties on the TriStation Communication screen.

3 To complete the connection, you must configure a Trident MP or CM module.

Property Action

Select Connections To connect through the CM, select the Network Connection check box.
To connect through the MP, select the Main Processor Connection 
check box.

Node Number Enter the node number for the controller. Click the browse button to 
select the node from a list.

Node Name Enter the name for the controller.

IP Address For a network connection, enter the IP address.

Main Processor 
Connection Setup

For an MP connection, select the MP that is connected to the 
TriStation PC. The default is left.

NIC Index Enter the number of the network interface card index in the TriStation 
PC. Needed only for a MP connection.

Default Connection If only one connection type is selected under Select Connections, the 
default connection is set based on it.
If both network and MP connections are selected, you must specify 
the default connection setting.
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Configuring Trident MP Network Ports

This procedure explains how to configure network ports on a Trident MP, which supports 
network connections to a TriStation PC.

Each port must be configured separately and can operate independently with different Modbus 
Masters. Or, they can operate as redundant serial ports, connected to redundant ports of the 
same Modbus Master.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the MP slot, click Setup, and then click the Network Ports tab.

3 Specify these properties on the Network Ports tab.

4 Click OK to save your changes.

Property Action

Mode Set to TriStation; cannot be changed.

Transceiver Port Set to RJ-45; cannot be changed.

Transceiver Mode Select half or full duplex depending on the installation.
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Configuring Trident MP Serial Ports

This procedure explains how to configure serial ports on a Trident MP, which supports serial 
connections using Modbus slave RTU protocol.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the MP slot, click Setup, and then click the Serial Ports tab.

3 Specify these properties on the Serial Ports tab.

Property Action

Port Selection Select the port to be configured.

Protocol Only Modbus Slave RTU is available.

Modbus Slave Address Enter the slave address of the serial port on the MP Baseplate. 

Baud Rate Select the rate used in the installation.

Data Bits Set at 8 bits; cannot be changed. 

Stop Bits Select 1 Bit or 2 Bits.

Parity Select a parity option.

Transceiver Mode Select RS-232 or RS-485, depending on the physical 
connection.
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4 Click OK to save your changes.

Configuring Trident CM Network Ports

This procedure explains how to configure network ports on a Trident CM, which supports these 
connections:

• To a TriStation PC

• To a Peer-to-Peer network of Triconex controllers

• To an external device or network

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the CM, click Setup, and then click the Network tab.

3 Specify these properties on the Network tab.

Handshake Set to none; cannot be changed.

Wire Type Set to 4 wire; cannot be changed.

Modbus (Minimum and 
Maximum) Range

Enter a minimum value (0 is default) and maximum value 
(32,767 is maximum).

Signal Delays Set to 0; cannot be changed.

Copy Current Setup to Other 
Serial Ports Command

Click to have the settings for the selected port copied to the 
other ports.

Property Action
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4 Click OK to save your changes.

Configuring Trident CM Serial Ports

This procedure explains how to configure serial ports on a Trident CM, which support 
connections using Modbus slave, master, and master/slave protocols.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the CM slot, click Setup, and then click the Serial Ports tab.

Property Action

Slot Selection Select the slot to be configured.

Mode Select either Open Network or Peer-to-Peer for either NET 1 or 
NET 2. 
You cannot use the same mode on both ports.

Privilege Select Read Only to restrict access from external devices. Not 
available with Peer-to-Peer. The default is Read/Write.

Transceiver Port Select the type of port used.

Transceiver Mode Select the mode used.Not available with Peer-to-Peer. 

IP Address Enter the IP address of the controller. Not available with Peer-to-
Peer. 

IP Subnet Mask Enter the subnet mask, if needed. Not available with Peer-to-Peer.

Default Gateway IP 
Address

Enter the default gateway, if needed. Not available with Peer-to-
Peer.

Time Synchronization Select to enable time synchronization on NET 1 or NET 2.
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3 Specify these properties on the Serial Ports tab.

4 Click OK to save your changes.

Property Action

Port Selection Select the port to be configured.

Protocol Select the protocol to use.

Modbus Slave Address Enter the slave address of the serial port on the MP Baseplate. Not 
used with Master protocol.

Baud Rate Select the rate used in the installation.

Data Bits Select 7 or 8 bits; only available with slave ASCII protocol. Set to 8 
bits for all other protocols.

Stop Bits Select 1 Bit or 2 Bits.

Parity Select the parity option.

Transceiver Mode Select RS-232 or RS-485, depending on the physical connection.

Handshake Select Hardware to use signal delays to determine if the connection 
is valid.

Wire Type Select 2 or 4 wire, depending on the installation.

Modbus (Minimum 
and Maximum) Range

Enter a minimum value (0 is default) and maximum value (32,767 
is maximum). Only available with Modbus.

Signal Delays Enter the number of milliseconds to adjust timing of the data 
transmission.



Trident Communication Configuration 223

TriStation 1131 Developer’s Guide, v4.1

Configuring Trident CM Routing

This procedure explains how to configure routing information for network communication on 
a Trident CM. This procedure is optional depending on your network configuration. For more 
information, see your network administrator.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the CM slot, click Setup, and then click the Routing tab.

3 Specify these properties on the Routing tab.

4 Repeat for each route required on your network.

5 Click OK to save your changes.

Property Action

Slot Selection Select the slot to configure.

Destination IP Subnet Mask Enter the address for the subnet mask.

Destination Gateway IP 
Address

Enter the address for the gateway.

Destination IP Address Enter the destination address.
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Tricon Time Synchronization
This section explains how to use the Time Synchronization communication protocol with Tricon 
controllers. Time synchronization enables a network of Triconex controllers to synchronize time 
with each other or with external devices, such as a DCS or the Global Positioning System (Tricon 
only).

Topics include:

• About Tricon Time Synchronization on page 224

• Using a Tricon ACM to Synchronize Time on page 225

• Using a Tricon NCM to Synchronize Time on page 226

• Using a Tricon NCMG to Synchronize Time on page 227

• Using a Tricon SMM to Synchronize Time on page 228

• Using a Tricon TCM to Synchronize Time on page 229

About Tricon Time Synchronization
This table summarizes the ways Tricon controller time can be synchronized to an external 
device or to the Tricon master node in a Peer-to-Peer network.

Table 29 Tricon Time Synchronization

Module Time Synchronization Options

ACM • To a Foxboro DCS.
• To the Tricon master node in a Peer-to-Peer network.

ACM or NCM • To an OPC client. For more information, see the Tricon Communication Guide. 
• By writing aliased data to the TIMESET or TIMEADJ function blocks in a 

TriStation 1131 application. For assistance with the specialized programming 
that is required, contact Triconex Technical Support.

• To the Tricon master node in a Peer-to-Peer network.

NCMG • To the GPS (Global Positioning System).
• To the Tricon master node in a Peer-to-Peer network.

SMM • To the Honeywell Universal Control Network (UCM).

TCM • To the GPS (Global Positioning System).
• To SNTP.
• To the Tricon master node in a Peer-to-Peer network (Triconex Time 

Synchronization).
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Using a Tricon ACM to Synchronize Time

This procedure explains how to use a Tricon ACM to enable time synchronization based on:

• The Foxboro I/A Series nodebus system time

• The Tricon master node in a Peer-to-Peer network

Procedure

1 Expand the Configuration tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the ACM slot, and then click Setup.

3 Specify these properties on the ACM Setup screen.

4 Click OK to save your changes.

Property Action

Privilege For synchronization on NET 2, specify Read/Write. The default is 
Read.

Time Synchronization • Select On NET 1 enable time synchronization with external 
source to allow time synchronization with a Foxboro I/A DCS.

• Select NET 2 to enable time synchronization with the Tricon 
Master node (controller).



226 Chapter 3 Controller Configuration

TriStation 1131 Developer’s Guide, v4.1

Using a Tricon NCM to Synchronize Time

This procedure explains how to use a Tricon NCM to enable time synchronization with the 
Tricon master node in a Peer-to-Peer network.

Procedure

1 Expand the Configuration tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the NCM slot, and then click Setup.

3 Select the On NET 1 enable time synchronization with Tricon Master Node check box.

4 Click OK to save your changes.
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Using a Tricon NCMG to Synchronize Time

This procedure explains how to use a Tricon NCMG to enable time synchronization through the 
Global Positioning System (GPS) by using the Trimble Acutime 2000 Synchronization Kit. If the 
Tricon NCMG is in a Peer-to-Peer network, it can be used as the master node for time 
synchronization of the controllers on the network.

For information on installing the kit, see the Tricon Communication Guide.

Procedure

1 Expand the Configuration tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the NCMG slot, and then click Setup.

3 Specify these properties on the NCM Setup screen.

4 Click OK to save your changes.

CAUTION
To ensure the accuracy of GPS time adjustments, the Tricon clock must be 
set to within 10 minutes of the correct local time.

Property Action

Global Positioning 
System Installed

Select this check box to enable time synchronization through the 
GPS.
If selected, other controllers can also be synchronized to the Tricon 
master controller. 

Time Synchronization For a network of Triconex controllers, select the On NET 1 enable 
time synchronization with the Tricon Master Node check box.
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Using a Tricon SMM to Synchronize Time

This procedure explains how to configure a Tricon SMM module to synchronize time based on 
the Honeywell Universal Control Network (UCM).

For more information, see the SMM User’s Guide.

Procedure

1 Expand the Configuration tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the SMM slot, and then click Setup.

3 Select the Enable time synchronization with external source check box.

4 Click OK to save your changes.
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Using a Tricon TCM to Synchronize Time

The information in this section explains how to enable time synchronization on a TCM. Time 
synchronization can be enabled using the following protocols:

• GPS
• SNTP
• Triconex Time Synchronization via DLC (NET 1 only) or UDP/IP (NET 1 or NET 2) on 

a Peer-to-Peer network

In a redundant network of Triconex controllers that each have two TCMs installed, you can 
implement redundant time synchronization by configuring time synchronization for both TCM 
modules (both left and right slots). Time synchronization can be enabled only for a single logical 
slot.

If the TCM is installed in the COM slot, you configure time synchronization only for the left slot 
(there is no redundancy when installed in the COM slot).

Note The following procedures apply only to model 4351A and 4352A TCMs. If you have an 
older model 4351 or 4352 TCM installed in your system, please go to Appendix C, TCM 
Model 4351/4352 Configuration.

Topics include:

• Configuring GPS Time Synchronization on the TCM on page 229

• Configuring SNTP Time Synchronization on the TCM on page 231

• Configuring Triconex Time Synchronization on the TCM on page 233

Configuring GPS Time Synchronization on the TCM

This procedure explains how to configure a TCM to enable time synchronization through the 
Global Positioning System (GPS) by using the Trimble Acutime 2000 Synchronization Kit. For 
information on installing the kit, see the Tricon Communication Guide for v9-v10 Systems.

If the TCM is in a Peer-to-Peer network, it can also be used as the master node for time 
synchronization of other controllers on the network. In this configuration, the master node TCM 
synchronizes time with the GPS, and any slave nodes on the Peer-to-Peer network synchronize 
their time with the master TCM. In this way, all nodes on the Peer-to-Peer network are 
synchronized with GPS time.

If the TCM is acting as a slave node on a Peer-to-Peer network, it cannot be configured for GPS 
time synchronization. Slave nodes synchronize their time only to the master node on the Peer-
to-Peer network, and reject all other time change requests.

GPS time synchronization uses Serial Port 1 on the TCM. 

CAUTION
To ensure the accuracy of GPS time adjustments, the Tricon clock must be 
set to within 10 minutes of the correct local time.
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Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The Enhanced TCM Setup dialog box appears.

3 Click the Time Sync tab.

4 Under Slot Selection, click Left Slot. You must configure the module in the left slot first.

5 Under Time Synchronization Configuration, select GPS.

If you previously configured Port 1 to use a Modbus protocol, selecting GPS will reset 
Port 1 to use the GPS protocol. See Configuring TCM Serial Ports on page 208 for more 
information.

6 (Optional) If you have a redundant TCM installed in the right slot, under Slot Selection, 
click Right Slot, and then select GPS Redundant.

Note The module in the right slot can be configured only if it has been installed (see 
Configuring TCM Network Ports on page 206) and if the module in the left slot 
has already been configured for GPS time synchronization.

7 Click OK to save your changes.

Enabling the TCM as a Master Node for Triconex Time Synchronization (Optional)

If you also want the TCM to be able to act as a master node for time synchronization of other 
controllers on a Peer-to-Peer network (using Triconex Time Synchronization) do the following:

1 In the Configuration tree, click Operating Parameters (see Operating Parameters on 
page 180).

2 Select the Enable Tricon Node Time Synchronization check box. 
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Configuring SNTP Time Synchronization on the TCM

This procedure explains how to configure TCM time synchronization to an SNTP server.

If the TCM is in a Peer-to-Peer network, it can also be used as the master node for time 
synchronization of other controllers on the network. In this configuration, the master node TCM 
synchronizes time with the SNTP server, and any slave nodes on the Peer-to-Peer network 
synchronize their time with the master TCM. In this way, all nodes on the Peer-to-Peer network 
are synchronized with SNTP time.

If the TCM is acting as a slave node on a Peer-to-Peer network, it cannot be configured for SNTP 
time synchronization. Slave nodes synchronize their time only to the master node on the Peer-
to-Peer network, and reject all other time change requests.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. The 
Enhanced TCM Setup dialog box appears.

3 Click the Time Sync tab.

4 Under Slot Selection, click Left Slot. You must configure the module in the left slot first.

5 Select these properties.

Property Action

Time Synchronization 
Configuration

Select SNTP. The default is None. 

SNTP Master Network Click the network the SNTP server is located on. 

SNTP Master IP Address Enter the IP address of the SNTP server to synchronize time 
with.
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6 (Optional) If you have a redundant TCM installed in the right slot, under Slot Selection, 
click Right Slot, and then select these properties.

Note The module in the right slot can be configured only if it has been installed (see 
Configuring TCM Network Ports on page 206) and if the module in the left slot 
has already been configured for SNTP time synchronization.

7 Click OK to save your changes.

Enabling the TCM as a Master Node for Triconex Time Synchronization (Optional)

If you also want the TCM to be able to act as a master node for time sychronization of other 
controllers on a Peer-to-Peer network (using Triconex Time Synchronization) do the following:

1 In the Configuration tree, click Operating Parameters (see Operating Parameters on 
page 180).

2 Select the Enable Tricon Node Time Synchronization check box. 

Property Action

Time Synchronization 
Configuration

Select SNTP Redundant.

SNTP Master Network Click the network the SNTP server is located on. This can be 
different than the master network selected for the left slot.

SNTP Master IP Address Enter the IP address of the SNTP server to synchronize time 
with.
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Configuring Triconex Time Synchronization on the TCM

In a Peer-to-Peer network, Triconex Time Synchronization can be used to synchronize time 
across controllers on a network. The controller with the lowest node number serves as the 
master node.

The master node can also synchronize its time with a GPS or an SNTP server. In this 
configuration, the master node synchronizes time with the GPS or SNTP server, and any slave 
nodes on the Peer-to-Peer network synchronize their time with the master node. In this way, all 
nodes on the Peer-to-Peer network are synchronized with GPS or SNTP time.

Note Currently, when a Trident controller is on a Peer-to-Peer network using Triconex Time 
Synchronization, with a Tricon TCM acting as a master node, the Trident will not 
correctly synchronize its time to the master node.

Configuring a Master Node

This procedure describes how to configure the TCM as a master node on the Peer-to-Peer 
network when GPS or SNTP time synchronization is not being used.

If you want the master node to synchronize to a GPS or SNTP server, use the procedures in the 
these sections:

• Configuring SNTP Time Synchronization on the TCM on page 231

• Configuring GPS Time Synchronization on the TCM on page 229

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. The 
Enhanced TCM Setup dialog box appears.

3 Click the Time Sync tab.

4 Under Time Synchronization Configuration, select None.

5 Click OK to save your changes.

6 In the Configuration tree, click Operating Parameters (see Operating Parameters on 
page 180).

7 Select the Enable Tricon Node Time Synchronization check box. 

This allows the controller to participate as a master node in time synchronization across 
the Peer-to-Peer network.

Configuring a Slave Node

This procedure describes how to configure the TCM as a slave node on the Peer-to-Peer 
network.
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Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The Enhanced TCM Setup dialog box appears.

3 Click the Time Sync tab.

4 Under Slot Selection, click Left Slot. You must configure the module in the left slot first.

5 Specify these properties.

Note If you have a redundant TCM installed in the right slot, Time Synchronization 
Configuration is automatically set to Peer-to-Peer and cannot be changed.

6 Click OK to save your changes.

7 In the Configuration tree, click Operating Parameters (see Operating Parameters on 
page 180).

8 Select the Enable Tricon Node Time Synchronization check box. 

This allows the controller to participate as a slave node in time synchronization across 
the Peer-to-Peer network.

Property Action

Time Synchronization 
Configuration

Select Peer-to-Peer. The default is None. 

Peer-to-Peer Master 
Network

Click the network you want to enable Triconex Time 
Synchronization for. The default is NET 2.This property applies 
to the modules installed in both the left and right slots 
simultaneously. 
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Trident Time Synchronization
This section explains how to use the Time Synchronization communication protocol with 
Trident controllers. Time synchronization enables a network of Triconex controllers to 
synchronize time with each other or with external devices.

Topics include:

• About Trident Time Synchronization on page 235

• Using a Trident CM to Synchronize Time on page 236

About Trident Time Synchronization
This table summarizes the ways Trident controller time can be synchronized to an external 
device or to the Trident master node in a Peer-to-Peer network.

Table 30 Trident Time Synchronization

Module Time Synchronization Feature

CM • To an OPC client. For more information, see the Tricon Communication Guide. 
• By writing aliased data to the TIMESET or TIMEADJ function blocks in a TriStation 

application. For assistance with the specialized programming that is required, 
contact Technical Support.

• To the Trident master node.

MP • By writing aliased data to the TIMESET or TIMEADJ function blocks in a TriStation 
application. For assistance with the specialized programming that is required, 
contact Technical Support.
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Using a Trident CM to Synchronize Time

This procedure explains how to use a Trident CM to synchronize Trident controllers to the 
master node in a Peer-to-Peer network.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the CM slot, click Setup, and then click the Network tab.

3 Specify this property on the CM Setup screen.

4 Click OK to save your changes.

Property Action

Time Synchronization • Select the On NET 1 enable time synchronization with Tricon 
Master Node check box.

• Select the On NET 2 enable time synchronization with Tricon 
Master Node check box.
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Trident System and Module Attributes
Trident system and module attributes are variables that can be used to monitor status and control 
Trident operations. You can add an alias number so the variable can be read or written to. 

Specifying an Alias Number for a Trident Attribute
This procedure explains how to specify an alias number for a system or module attribute, which 
allows you to read or write to the attribute.

Procedure

1 Expand the Controller tree and double-click Configuration. 

2 Expand Status Attributes and double-click the attribute to be assigned an alias.

3 Click Get Default, or enter a number for the Modbus Alias and click Confirm Alias.

The alias number is assigned to the attribute.
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Overview
This figure shows the main steps for setting up TriStation 1131 communication and the typical 
order in the project cycle. Communication setup can be done anytime before implementation.

Set Up the Project

Test with the
Emulator

Set Up TriStation
Communication

Implement on
the Controller

Develop the
Application

Configure the
Controller

Fix Errors

Errors?

 - Establish the physical connection

 - Configure the connection to the TriStation PC

 - Set node and IP address of the controller
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TriStation 1131 Communication Steps
This checklist includes the items that can be or should be performed to set up communication 
between a TriStation PC and a Triconex controller.

Description See

Connect to a Tricon EICM Tricon Serial Connection on page 246

Connect to a Tricon ACM, NCM or TCM Tricon Network Connection on page 249

Connect to a Trident MP Trident MP Network Connection on page 256

Connect to a Trident CM Trident CM Network Connection on page 261

Configure user access to the Tricon TCM Controlling Access to the TCM on page 267

Set up printing Tricon Printing on page 273
Trident Printing on page 280
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TriStation PC Setup
This section explains the setup required for a network connection from the TriStation PC. Topics 
include:

• Installing a NIC Card in a TriStation PC on page 242

• Installing DLC or TCP/IP Protocol on a TriStation PC on page 243

Installing a NIC Card in a TriStation PC

This procedure explains how to install a network interface card (NIC) in a TriStation PC to be 
connected to a Tricon ACM, NCM, or TCM, or to a Trident MP or CM.

Procedure – Tricon TCM

1 Install the network interface card by following the manufacturer’s instructions. Do not 
change the factory default settings on the NIC card.

2 Do one of the following:

• If the network interface card has an RJ-45 connector, you can connect it to the NET 1 
or NET 2 port on the TCM (model 4351/4351A) via a router or hub using a patch 
cable.

• If the network interface card has a MTRJ (fiber) connector, you can connect it to the 
NET 1 or NET 2 port on the TCM (model 4352/4352A) via a router or hub using a 
patch cable.

• If the network interface card does not have the appropriate connector for your TCM 
model, connect the network interface card to a media converter that is connected to 
the NET 1 or NET 2 port.

Note See the Communication Guide for Tricon v9–v10 Systems for more information 
about the differences between the TCM model 4351/4351A (copper) and model 
4352/4352A (fiber).

3 Run the diagnostics provided with the network interface card according to the 
manufacturer’s instructions.

Procedure – Tricon ACM or NCM

1 Install the network interface card by following the manufacturer’s instructions. Do not 
change the factory default settings on the NIC card.

2 Do one of the following:

• If the network interface card has a BNC connector, you can connect it directly to the 
NET 2 port. 

• If the network interface card does not have a BNC connector, connect the network 
interface card to a media converter that is connected to the NET 2 port.

3 Run the diagnostics provided with the network interface card according to the 
manufacturer’s instructions.
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Procedure – Trident MP or CM

1 Install the network interface card by following the manufacturer’s instructions. Do not 
change the factory default settings on the NIC card.

2 Connect the network interface card directly to an MP port on the Trident controller or to 
an Ethernet hub.

3 Run the diagnostics provided with the network interface card according to the 
manufacturer’s instructions.

Installing DLC or TCP/IP Protocol on a TriStation PC

These procedures explain how to install DLC or TCP/IP protocol on a TriStation PC. 

• The DLC protocol is required for Trident MP connection, and for using TriStation on a 
Windows XP workstation.

• The TCP/IP protocol is required for Tricon ACM, NCM, TCM, and Trident CM 
connection.

Installing TCP/IP or DLC on Windows 2000

1 On the Start menu, click Settings, then click Network and Dial-up Connections.

2 Right-click the network connection where you want to install the protocol, then click 
Properties.

3 Do one of the following:

• On the Networking tab, if the protocol is checked on the list of installed 
components, it means the protocol is installed and you are finished with this 
procedure.

• If the protocol is not checked, go to the next step to continue the installation.

4 Click Install, click Protocol, then click Add.

5 On the Select Network Protocol screen, click the protocol on the Network Protocol list, 
and then click OK.

6 Verify the check box for the protocol is checked, and then click OK.

Installing TCP/IP on Windows XP

1 On the Start menu, click Control Panel, and then double-click Network Connections.

2 Right-click the network connection where you want to install the protocol, then click 
Properties.

3 Do one of the following:

• On the General tab, if the TCP/IP protocol is checked on the list of installed 
components, it means the protocol is installed and you are finished with this 
procedure.

• If the TCP/IP protocol is not checked, go to the next step to continue the 
installation.
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4 On the General tab, click Install.

5 In the Select Network Component Type dialog box, click Protocol, and then click Add. 

6 Click the TCP/IP protocol, and then click OK.

Installing DLC on Windows XP

Installing the DLC protocol on a Windows XP workstation is a 3-step process.

Note If you have already installed the DLC protocol on your workstation, you can configure 
it to start automatically each time you start your workstation by changing a registry 
value. Go to HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\Dlc, and 
then change the Start value to 1.

Step 1: Download the DLC Protocol Installation Program

1 Open your Internet browser, and enter the following URL in the address field: 
http://www.microsoft.com/downloads/

2 In the Search for a Download section, perform a search for “DLC Protocol” and then go 
to the download page for the DLC protocol for Windows XP.

3 Follow the instructions on the download page to start the download process.

4 When prompted, save the dlc.exe file to your local drive. 

5 When the download is complete, double-click the self-extracting dlc.exe file to unzip the 
five DLC protocol files. 

Save the files to a location on your local drive that will be easy to remember (for example, 
C:\DLC).

Step 2: Modify the .INF File

1 Go to the location where you saved the DLC protocol files in step 4 of the previous 
section. 

2 Right-click on NetDLC.inf, and select Open with from the shortcut menu that appears. 
Then select Notepad from the Open with dialog box and click OK. The .inf file opens in 
Notepad.

3 Scroll down until you see the following section:

4 Change the value for StartType from 3 to 1. This ensures that the DLC protocol will start 
automatically each time you start your workstation.

5 Save the file and then exit Notepad.
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Step 3: Configure the DLC Protocol Network Connection

1 Go to the location where you saved the DLC protocol files in Step 1. 

2 Double-click install.cmd to start the installation script. 

3 On the Start menu, click Control Panel, and then double-click Network Connections.

4 Right-click the network connection where you want to install the protocol, then click 
Properties.

5 On the General tab, click Install.

6 In the Select Network Component Type dialog box, click Protocol, and then click Add. 

7 Click the DLC Protocol, and then click OK.

8 Once installation is complete, you can close the Network Connections dialog box.
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Tricon Serial Connection
This section explains how to make a direct (point-to-point) serial connection between a Tricon 
EICM or TCM and a TriStation PC. You cannot use both an EICM and TCM module in the same 
Tricon system. Additionally, the TCM can be used only with a Tricon v10 controller.

By default, both the EICM and the TCM use port 4 for the TriStation connection. Triconex 
strongly recommends you use the default setting. If port 4 on the EICM fails, port 1, 2, or 3 can 
be used by changing settings on the module switch block. If port 4 on the TCM fails, you can 
connect to TriStation using the NET 1 or NET 2 port; see the Communication Guide for Tricon v9–
v10 Systems for more information.

Topics include:

• Connecting a Tricon Serial Port to a TriStation PC on page 246

• Configuring a Tricon Serial Connection on page 247

Connecting a Tricon Serial Port to a TriStation PC
This procedure explains how to connect a Tricon EICM or TCM serial port to a TriStation PC.

Triconex provides a serial cable that has a 9-pin connector on each end. If the COM port on the 
PC has a 25-pin connector, you can use a Triconex 25-pin to 9-pin adapter. If you need other 
parts, you can purchase them from another manufacturer. For more information, see the 
Communication Guide for Tricon v9–v10 Systems.

Procedure

1 Connect one end of the serial cable to a serial port on the EICM or TCM. This is typically 
port 4.

2 Connect the other end of the serial cable to a COM port on the TriStation PC. The COM 
port is typically numbered COM1, COM2, COM3, or COM4.

Figure 25 Connecting a Tricon Serial Port to the TriStation PC
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Configuring a Tricon Serial Connection

This procedure explains how to configure a Tricon EICM or TCM serial port that is connected 
to a TriStation PC.

Procedure

1 Expand the Controller tree, double-click Configuration, and then click TriStation 
Communication.

2 Specify these properties on the TriStation Communication screen.

Note The data displayed on the screen is used by TriStation only to connect to a Tricon 
communication port. The data that you enter will not be downloaded to the 
Tricon controller.

3 On the Configuration tree, expand Hardware Allocation, double-click EICM or TCM, 
and then click Setup.

Property Action

Serial Connection Select this check box.

Node Name Enter the name of the Tricon controller. You can use a default name, or 
enter your own user-defined name. The default names are TRINODE01 
through TRINODE31.

Serial Port Select the COM port on the TriStation PC to which the serial cable is 
connected.

Baud Rate Specify the data transmission speed. The default is 9600. 
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4 Specify these properties in the EICM dialog box or the Serial Ports tab of the Enhanced 
TCM Setup dialog box.

5 Click OK.

Property Action

Port Select the port that the TriStation PC is attached to. The default TriStation 
connection is port 4. 
For TCM, you must select port 4, as this is the only serial port supported 
for TriStation connection.

Protocol Select TriStation. 
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Tricon Network Connection
This section explains how to make a network connection between a ACM, NCM, or TCM 
communication module and a TriStation PC. This can be a direct connection from the 
communication module to the PC, or a connection through a router, hub, or media converter. A 
router or hub is not required if you do not need to connect any additional devices besides the 
TCM and the PC. You cannot use both an NCM and TCM module in the same Tricon system.

To set up the connection, you must:

• Install a network interface card and the TCP/IP protocol on the PC.

• Set the node number of the controller.

• Connect the PC to a network port on the communication module.

• Configure the connection in the TriStation 1131 project. 

For instructions on installing a network interface card and the TCP/IP protocol on the TriStation 
PC, see TriStation PC Setup on page 242.

Topics in this section include:

• Directly Connecting an ACM or NCM Network Port to a TriStation PC on page 250

• Connecting a TCM Network Port to a TriStation PC Using a Router or Hub on page 251

• Connecting a Tricon Network Port Using a Media Converter on page 252

• Configuring the TriStation Network Connection on page 254

Note If you are connecting the TCM or EICM to the TriStation PC via serial port, see Tricon 
Serial Connection on page 246.

CAUTION
The node setting (on the ACM or NCM module or the 3008 MP Front 
Panel) must match the node number specified in the TriStation project. 
See the Planning and Installation Guide for Tricon v9-v10 Systems for 
instructions on changing the MP node setting.
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Directly Connecting an ACM or NCM Network Port to a TriStation PC 

This procedure explains how to directly connect an ACM or NCM to a TriStation PC if the 
network interface card in the PC has a BNC connector.

The connection requires a 10Base2 coaxial cable. Triconex provides an accessory kit that 
includes a 10Base2 coaxial cable, BNC T-connectors, and 50-ohm terminators for unused 
connectors (see the Communication Guide for Tricon v9-v10 Systems for more information). 

Procedure

1 To each end of a 10Base2 cable, attach a BNC T-connector and a terminator.

2 Attach one of the T-connectors to a BNC connector on NET 2 of the communication 
module. An NCM is used as an example in the following figure.

3 Attach the other T-connector to the BNC connector on the network interface card in the 
TriStation PC.

Figure 26 Directly Connecting an ACM or NCM to a TriStation PC

4 Terminate the BNC connectors on all communication modules that are installed in the 
Tricon controller.

5 To terminate an unused BNC connector, you can attach a T-connector with 50-ohm 
terminators on each end to produce a 25-ohm parallel resistance. Ask your network 
administrator for information about other termination methods.
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Connecting a TCM Network Port to a TriStation PC Using a Router or Hub

This procedure explains how to connect a TCM to a TriStation PC if the network interface card 
in the PC has an RJ-45 connector or a MTRJ fiber connector. You must use an Ethernet router or 
hub between the Tricon and the TriStation PC.

The RJ-45 connection requires twisted-pair straight-through cables. The fiber connection 
requires 62.5/125 um multimode fiber cables. See the Communication Guide for Tricon v9–v10 
Systems for more information about the required cables and how some may be purchased from 
Triconex. 

Procedure

1 Attach one end of the first cable to the NET 2 port on the TCM. 

2 Attach the other end of the first cable to the connector on the Ethernet router or hub.

3 Attach one end of the second cable to the connector on the network interface card in the 
TriStation PC. 

4 Attach the other end of the second cable to the connector on the router or hub.

Figure 27 Connecting a TCM (Copper or Fiber) to a TriStation PC Using a Router or Hub

If the correct cable is connected to the TCM and the TCM is installed in a powered Tricon 
chassis, the green LED indicator turns on. If the LED indicator is not on, there is a problem with 
the physical cable connection.
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Connecting a Tricon Network Port Using a Media Converter

This procedure explains how to connect an ACM, NCM, or TCM to a TriStation PC if the 
network interface card in the PC requires a media converter because it does not have the 
appropriate connector.

• The connection to an ACM or NCM requires a 10Base2 cable, a media converter, and 
another appropriate cable, such as a twisted-pair cable.

• The connection to a TCM (model 4352/4352A - Fiber) requires a 62.5/125 um 
multimode fiber cable, a media converter, and another appropriate cable, such as a 
twisted-pair cable. 

Procedure for Connecting an ACM or NCM

1 To each end of a 10Base2 cable, attach a BNC T-connector and a terminator.

2 Attach one of the T-connectors to a BNC connector on the NET 2 port on the 
communication module. 

3 Attach the other T-connector to a BNC connector on the media converter.

For the TriStation PC, you can use a 10BaseT or 100BaseTX twisted-pair cable for faster 
communication.

4 Attach one end of the twisted-pair cable to an RJ-45 connector on the network interface 
card in the TriStation 1131 PC.

5 Attach the other end of the twisted-pair cable to an RJ-45 connector on the media 
converter.

Figure 28 Connecting an ACM or NCM to the TriStation PC Using a Media Converter
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Procedure for Connecting a TCM (Model 4352/4352A - Fiber)

1 Attach one end of the fiber cable to the NET 1 or NET 2 port on the TCM.

2 Connect one end of the twisted-pair cable to the RJ-45 connector on the network 
interface card in the TriStation PC. 

3 Attach the other end of the twisted-pair cable to an RJ-45 connector on the media 
converter.

4 Attach the other end of the fiber cable to a MTRJ fiber connector on the media converter.

Figure 29 Connecting a TCM (Model 4352/4352A) to the TriStation PC Using a Media Converter

If the correct cable is connected to the TCM and the TCM is installed in a powered Tricon 
chassis, the green LED indicator turns on. If the LED indicator is not on, there is a problem with 
the physical cable connection.
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Configuring the TriStation Network Connection

This procedure explains how to configure an ACM, NCM, or TCM network connection to a 
TriStation PC.

Before You Begin

Before beginning this procedure, you must determine which IP address to use for the 
communication module. Typically, you can get an IP address from your network administrator 
or Information Technology department.

Procedure

1 In TriStation 1131, expand the Controller tree, and double-click Configuration. 

2 On the Configuration tree, click TriStation Communication.

3 Specify these properties on the TriStation Communication screen.

Note The data displayed on the screen is used by TriStation only to connect to a Tricon 
communication port. The data that you enter will not be downloaded to the 
Tricon controller.

Property Action

Network Connection Select the Network Connection check box.

Node Number For the ACM and NCM, enter the number represented on the 
rotary switches. For TCM, enter the number represented by the 
Network Node Address setting on the MP front panel.
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4 On the Configuration tree, click the chassis that contains the ACM, NCM, or TCM. 

5 Double-click the module to open the Properties dialog box, and then click Setup.

6 Specify these properties on the ACM, NCM, or TCM Network Setup screen.

7 Click OK.

Node Name Enter a name containing eight or fewer characters to identify the 
Tricon controller.

IP Address Enter the physical address of the controller on the network. 

Property Action

Installed 
(NCM and TCM)
Used (ACM)

Select this property for all installed modules.

IP Address If using a default IP address, leave blank.
If not, enter the IP address that identifies the controller on the 
network. This must be the same IP address entered on the 
TriStation Communication screen.

IP Subnet Mask If using a default IP Subnet Mask, leave blank.
For ACM or TCM, get the subnet mask from your network 
administrator. 
For NCM, do not change the default setting (eight zeroes).

Property Action
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Trident MP Network Connection
This section explains how a Trident MP can be used for a network connection to a TriStation PC 
which uses the DLC protocol. This can be a direct connection from the MP to the PC, or a 
connection through a hub on a network.

To set up the connection you must install a network interface card and DLC protocol on the PC. 
For more information, see TriStation PC Setup on page 242. For information on setting the node 
number of the controller, see the Trident Communication Guide. For instructions on connecting 
and configuring the connection, see procedures in this section.

Topics in this section include:

• Directly Connecting a Trident MP to a TriStation PC on page 257

• Connecting a Trident MP to a TriStation PC Using a Hub on page 258

• Configuring a Trident MP Connection to a TriStation PC on page 259

CAUTION
The node setting which is physically set on the MP Baseplate must match 
the node number specified in the TriStation project.
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Directly Connecting a Trident MP to a TriStation PC

This procedure explains how to directly connect a TriStation PC to a network port on a Trident 
MP Baseplate using a 10BaseT cross-over cable.

Procedure

1 Attach one end of the cross-over cable to one of the RJ-45 connectors on the MP 
Baseplate. This is typically MP A, as shown in the figure.

2 Attach the other end of the cross-over cable to the network interface card in the PC.

Figure 30 Connecting the TriStation PC to a Trident Main Processor
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Connecting a Trident MP to a TriStation PC Using a Hub

This procedure explains how to connect a Trident MP to a TriStation PC using a 10BaseT 
straight-through cable and a hub.

Procedure

1 Attach at least one 10BaseT straight-through cable from an RJ-45 connector on an MP 
Baseplate to the hub.

Note Using more than one cable provides redundancy for the TriStation connection. If 
you use only one cable during live operation, you have to unplug it and move it 
to another RJ-45 connector if the original connection fails.

2 Attach the network interface card in the TriStation PC to the hub using another 10BaseT 
straight-through cable.

Figure 31 Connecting the TriStation PC to the Trident Main Processor Using a Hub
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Configuring a Trident MP Connection to a TriStation PC

This procedure explains how to configure a Trident MP connection to a TriStation PC.

Procedure

1 Expand the Controller tree, and double-click Configuration. 

2 On the Configuration tree, click TriStation Communication.

3 Specify these properties on the TriStation Communication screen.

4 On the Configuration tree, expand Hardware Allocation, and then double-click the Main 
Processors (MP/IOP1).

5 In the Properties dialog box, click Setup. 

Property Action

Main Processor 
Connection

Select the Main Processor Connection check box.

Node Number Enter the number specified on the address plug on the MP Baseplate. 

Node Name Enter a name with eight or fewer characters to identify the Trident 
controller.

Main Processor 
Setup

Select Left, Middle, or Right to specify which MP port is connected to the 
TriStation PC.

NIC Index Enter the index position of the network interface card in the TriStation PC. 
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6 In the MP Setup dialog box, click the Network Ports tab.

7 For the port that is physically connected to TriStation PC (Left, Middle, or Right) specify 
the Transceiver Mode to match the installed hardware.

8 Click OK to save your changes.
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Trident CM Network Connection
This section explains how to configure a CM connection to the TriStation PC.

To set up the connection you must install a network interface card and TCP/IP protocol on the 
PC. For more information, see TriStation PC Setup on page 242. For information on setting the 
node number of the controller, see the Trident Communication Guide. For instructions on 
connecting and configuring the connection, see the procedures in this section.

Topics include:

• Directly Connecting a Trident CM to a TriStation PC on page 262

• Connecting a Trident CM to a TriStation PC Using a Hub on page 263

• Configuring a Trident CM Connection on page 264

CAUTION
The node setting which is physically set on the MP Baseplate must match 
the node number specified in the TriStation project.
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Directly Connecting a Trident CM to a TriStation PC

This procedure explains how to directly connect a Trident CM to a TriStation PC using a cross-
over cable.

For a NET 1 port, you must use a 10BaseT cable. For a NET 2 port, you can use either a 10BaseT 
or 100BaseTX cable. On the CM baseplate, you can attach the cable to an RJ-45 connector or to a 
MAU. For information about MAUs, see the Trident Communication Guide.

Procedure

1 Attach one end of a cross-over cable to a NET 1 or NET 2 connector on the CM baseplate, 
as shown in this example.

2 Attach the other end of the cross-over cable to the network interface card in the 
TriStation PC.

Figure 32 Connecting the TriStation PC Directly to a Trident CM
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Connecting a Trident CM to a TriStation PC Using a Hub

This procedure explains how to connect a Trident CM to a TriStation PC using a straight-
through cable and a hub.

For a NET 1 port, you must use a 10BaseT cable. For a NET 2 port, you can use either a 10BaseT 
or 100BaseTX cable. On the CM baseplate, you can attach the cable to an RJ-45 connector or to a 
MAU. For information about MAUs, see the Trident Communication Guide.

Procedure

1 Attach one end of a straight-through cable to a NET 1 or NET 2 connector on the CM 
baseplate.

2 Attach the other end of the straight-through cable to a network hub, as shown in the 
example below.

3 Connect the TriStation PC to the hub using another straight-through cable.

Figure 33 Connecting the TriStation PC to a Trident CM Using a Hub
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Configuring a Trident CM Connection

This procedure explains how to configure a Trident CM connection to a TriStation PC.

Before You Begin

Before you begin this procedure, you must determine the IP address to use for the CM. If the 
connection goes through a gateway or a router, you also need IP addresses for those devices. 
Typically, you can get the necessary IP addresses from your network administrator or 
Information Technology department.

Procedure

1 Expand the Controller tree, and double-click Configuration. 

2 On the Configuration tree, click TriStation Communication.

3 Specify these properties on the TriStation Communication screen.

Property Action

Network Connection Select the Network Connection check box.

Node Number Enter the number specified on the address plug on the MP baseplate.

Node Name Enter a name that contains eight or fewer characters to identify the 
Trident controller.

IP Address Enter the IP address.

NIC Index Enter the index position of the network interface card in the 
TriStation PC. 
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4 On the Configuration tree, double-click the CM (COM: CM). 

5 In the Properties dialog box, click Setup.

6 Specify these properties for the NET 1 or NET 2 port, depending on which is connected 
to the TriStation PC.

Property Action

Slot Selection Select Left Slot or Right Slot, depending on which slot contains the 
module that is connected to the TriStation PC.

Mode For the TriStation connection, select Open Network.
For each CM on a baseplate, you can select Open Network for either NET 
1 or NET 2, but not for both ports.

Privilege Select Read or Read/Write to specify access privileges for external 
devices on the network.
A TriStation application must use the Privilege option in conjunction 
with the MP.REMOTE_WRT_ENBL control attribute (and possibly other 
write controls) to enable writes by external devices.

Transceiver Port Select RJ-45 or MAU depending on the type of CM baseplate port to 
which you have physically attached the TriStation cable.

Transceiver 
Mode

Select the Auto mode if the TriStation cable can auto-negotiate to either 
10 or 100 megabits per second.
If your cable operates at only one speed, select the appropriate speed 
from the list.
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7 Click OK to save your changes.

IP Address If using the default node number, do not change this property (leave 
blank).
If using a different node number, enter the IP address that identifies the 
controller on the network. This must be the same address you entered in 
step 2.

IP Subnet Mask Get the subnet mask from your network administrator.

Default Gateway 
IP Address

If the CM connection to the TriStation PC goes through a default 
gateway, enter the IP address of the gateway.

Time 
Synchronization

Select None. This property does not apply to TriStation communication.

Property Action
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Controlling Access to the TCM 
The model 4351A and 4352A Tricon Communication Modules (TCMs) give you the ability to 
control who can access TCM resources through the module’s network ports, and the level of 
access each user has. 

What Are TCM Resources?

A resource is any service or information provided by the TCM through the supported 
communications protocols. Examples of these resources include:

• Access to the controller via TriStation (ability to perform a Download Change or 
Download All)

• Access to Tricon diagnostic information via the Enhanced Diagnostic Monitor

• Access to information provided in applications such as SOE Recorder or DDE Server 
that use the TSAA protocol

• Access to any other applications that use the TSAA protocol

How Is Access Controlled?
Access is controlled via client IP addresses. You can control access for a single IP address (one 
client), or for a group of IP addresses (a group of clients). 

If you want to group clients into a single access list entry, they must be physically separated in 
a sub-network, and a subnet mask must be used to group them in the access list. A subnet mask 
of 255.255.255.255 restricts an access list entry so that it applies only to the specific IP address 
identified in the entry. A subnet mask of 255.255.255.0 applies an access list entry to any client 
on the same subnet as the IP address identified in the entry. Other subnet masks may also be 
used, depending on your network structure.

For example, if you want two clients with IP addresses of 192.168.1.134 and 192.168.1.65 to share 
the same access permissions, and there are no other clients on the same subnet, you can group 
them in the access list by setting the IP address for a single entry as 192.168.1.x and the subnet 
mask to 255.255.255.0.

For each IP address or group of IP addresses, you can set the access level, the protocols the client 
can use to access the TCM, and the network ports the client can use to access the TCM.

What Are Access Levels? 

There are three levels of access: 

• Deny Access: Prevents all access to resources provided by the TCM. Connections to the 
Tricon are not allowed.

• Read Only: Allows client to connect to the Tricon and view information provided via 
the TCM. Does not allow the client to change any settings or perform certain 
commands.
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• Read/Write: Full access. Allows client to view information provided by the TCM, 
change settings, and perform all commands (including Download Change or 
Download All for TriStation). This access level should only be provided to trusted 
clients.

Access levels are configured by adding entries to the Client Access List. A maximum of 10 
entries can be provided in the access list. 

The same access level is applied to all selected protocols in a single access list entry. If you want 
to provide different access levels for a selected client depending on which protocol they are 
using, you will need to create two separate entries in the access list, one for each protocol.

Access levels apply to all users using the PC assigned the IP address entered in the access list. 
This means if multiple users are using the same PC, they will all have the same access rights. For 
example, every user using TriStation on a PC with a particular IP address would have the same 
access rights to the TCM. Individual user access should be controlled via workstation security; 
TCM access is controlled only at the IP address level.

Note If you choose not to enable access list control, you can still manage read/write access to 
specific ports using the Port Write Enabled property. See Port Write Enabled on page 400.

Sample Access List and Resulting Access Control

The following table is a sample access list, with the access control scenarios that would result if 
it was enabled on the TCM.

CAUTION
Once you enable TCM client access control by selecting the Enable Access 
List check box, you must configure at least one client with TriStation 
Read/Write access. 

Failure to do so will prevent you from connecting to the Tricon again after 
your next download, and you will be unable to make any further changes 
to the application running on the controller, including changes to the 
TCM access control list. 

If all TriStation clients are accidentally locked out of Read/Write access, 
you can connect via a TriStation serial connection to reconfigure the 
access list. See Configuring a Tricon Serial Connection on page 247.
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Table 31 Sample TCM Access Control List

Entry IP Address Subnet Mask Protocol Network Access Level Resulting Access Control Scenario

1 206.216.1.12 255.255.255.0 TriStation NET 2 Read/Write A client with an IP address of 206.216.1.12 (or any client on the 
same subnet) attempting to access the TCM using the 
TriStation protocol on NET 2 would be granted Read/Write 
access. 

2 206.216.1.12 255.255.255.0 TSAA NET 2 Read Only A client with an IP address of 206.216.1.12 (or any client on the 
same subnet) attempting to access the TCM using the TSAA 
protocol on NET 2 would be granted Read Only access. 

3 192.168.1.05 255.255.255.255 TriStation NET 1
NET 2

Deny Access A client with an IP address of 192.168.1.05 attempting to access 
the TCM using the TriStation protocol on NET 1 or NET 2 
would be denied access. 

4 192.168.1.09 255.255.255.255 TSAA NET 1
NET 2

Deny Access A client with an IP address of 192.168.1.09 attempting to access 
the TCM using TSAA on NET 1 or NET 2 would be denied 
access. 

5 192.168.1.05 255.255.255.0 TSAA NET 1 Read Only A client with an IP address of 192.168.1.05 (or any client on the 
same subnet) attempting to access the TCM using TSAA on 
NET 1 would be granted Read Only access. 

6 192.168.1.05 255.255.255.0 TriStation NET 2 Read Only A client with an IP address of 192.168.1.05 (or any client on the 
same subnet) attempting to access the TCM using the 
TriStation protocol on NET 2 would be granted Read Only 
access. a

a. If a client with the specific IP address of 192.168.1.05 attempts to access the TCM using the TriStation protocol on NET 2, the TCM will deny access. 
This is because the TCM evaluates the access control list beginning from the top, and continuing through the list until it encounters an entry that 
applies to the IP address requesting access. In this case, entry 3 specifically denies access to a client with the IP address of 192.168.1.05, so the TCM 
will deny access and not evaluate the list any further.

7 192.168.1.09 255.255.255.0 TriStation NET 1 Read/Write A client with an IP address of 192.168.1.09 (or any client on the 
same subnet) attempting to access the TCM using the 
TriStation protocol on NET 1 would be granted Read/Write 
access. 

8 0.0.0.0 0.0.0.0 All All Deny Access Access is denied for all IP addresses not included in entries 
1–7, using any protocol on NET 1 or NET 2.

9 NULL NULL NULL NULL NULL None
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Configuring the Access List

This section describes how to enable access control on the TCM and configure the access list for 
your selected clients. This applies only to model 4351A and 4352A TCMs; it does not apply to 
model 4351 or 4352 TCMs.

When configuring the access list, take care to organize your entries so that the most specific are 
at the top, and the least specific are at the bottom. The last entry in the list should be used to 
define the access level for unspecified clients.

The TCM evaluates the access control list from top (Entry 1) to bottom (Entry 10). The first match 
that the TCM makes (between the client’s network parameters and those listed in an access list 
entry) determines which entry is used to authorize or deny access. If no match is found, the TCM 
automatically denies all access.

Once you have enabled access control and configured the access list, you must perform a 
Download Change for the access control to take effect.

Note After a Download Change or Download All has been performed so that access control 
on the TCM is enabled, all existing connections will remain connected, even if the client’s 
access has been changed to Read Only or Deny Access. The new access levels will not 
take effect until the client disconnects and attempts to reconnect. 

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The Enhanced TCM Setup dialog box appears.

3 Click the Access List tab.



Controlling Access to the TCM 271

TriStation 1131 Developer’s Guide, v4.1

4 Specify these properties.

Property Action

Slot Selection Select the slot where the TCM module you want to configure an 
access list for is installed.
In most cases, you should create identical access lists for the 
modules in both slots.

Enable Access List 
Command

Click to enable access control for this TCM. If cleared, access 
control will be disabled and all users can access TCM resources. 
The default is cleared.

Client Access List Click on the entry for the client you want to configure or change.

Client IP Address Specify the IP address of the client that you want to allow, restrict, 
or deny access to the TCM.
Can be used in conjunction with the Client IP Subnet Mask 
property to create groups of IP addresses with the same access 
levels. 

Client IP Subnet Mask This property allows you to group IP addresses, so that you can 
create a single entry in the client access list for all IP addresses on 
the subnet. 
If needed, enter the IP address for the subnet. The default is 
255.255.255.0.

Permission Click the level of access to the TCM you want to provide for the 
selected client.
If the application includes safety-critical outputs, you should not 
set this property to Read/Write.
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5 Click Update Client Entry to save the settings for the selected client. 

6 Repeat steps 4 and 5 for each client to be included in the access list. 

Note If necessary, click Reset Client Entry to reset the settings for the selected client to 
the default, unconfigured state. Click Reset All to reset all entries in the access list 
to the default, unconfigured state.

7 If a TCM is installed in the right slot, repeat steps 4 through 6 for that module. 

In most cases, you should configure identical access lists for the modules in both slots.

8 Click OK to save your changes.

Protocol Select the protocol(s) that the selected client can use to access the 
TCM. The OPC protocol is not currently supported.

Network Select the network(s) on which the selected client can access the 
TCM. 

Property Action
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Tricon Printing
A Tricon controller can print brief ASCII text messages if a communication port is connected to 
a printer and the TriStation application includes standard print function blocks.

Print messages are typically used for alarms, status, and maintenance. A sample alarm message 
might include the name of an analog input point, its time stamp and value, and a statement that 
the value is out of range. If the Tricon system includes numerous controllers or is connected to 
a DCS, alarms are typically displayed on an operator workstation.

To print from a Tricon controller with a TCM, you must connect a TCM Ethernet port to a print 
server that is connected to a printer, configure these devices in the TriStation project, and use 
print function blocks in the TriStation application.

To print from a Tricon controller with an EICM, you must connect an EICM parallel port to a 
Centronics-compatible printer, configure the port in the TriStation project, and use print 
function blocks in the TriStation application.

Topics include:

• Affect of Printing on Scan Time on page 273

• Connecting a Tricon EICM Port to a Printer on page 274

• Configuring a Tricon EICM Port for Printing on page 275

• Connecting a TCM to Printing Devices on page 276

• Connecting a TCM to Printing Devices Using a Hub on page 277

• Configuring a Tricon TCM Port for Printing on page 278

See the Communication Guide for Tricon v9–v10 Systems for more information about the types of 
devices that can be used for printing from the Tricon.

Affect of Printing on Scan Time

Each time a message is printed, the print function blocks in the TriStation application are 
executed and the scan time increases. Typically, the print function blocks are subject to 
conditional execution, which means they are not executed every scan. When you set the scan 
time in TriStation, make sure it includes the execution time for all conditional statements in the 
application.

If the scan time is not long enough, the execution of all conditional statements (when the 
conditions are True) could result in scan-time overruns. You can minimize this problem by 
limiting the amount of printer output. An alternative is to use a PC event logger such as the 
Triconex SOE Recorder. For more information, see the SOE Recorder User’s Guide.
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Connecting a Tricon EICM Port to a Printer

This procedure explains how to set up a Centronics-compatible printer and connect it directly 
to a Tricon EICM parallel port.

You can use a standard PC printer cable with a maximum cable length of 5 to 6 meters (15 to 20 
feet), depending on the quality of the cable

Procedure

1 If the printer package has an installation program, copy the program to the TriStation PC.

2 Follow the instructions, and run the diagnostic routine, if available.

You do not need the printer driver that may have come with the package.

3 Connect one end of the cable to the printer, and connect the other end to port 5 or 10 on 
the EICM. (Other EICM ports cannot be used for printing.)

4 Go to the next section to configure the EICM port for printing.

Figure 34 Connecting an EICM to a Centronics-Compatible Printer
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Configuring a Tricon EICM Port for Printing

This procedure explains how to configure a Tricon EICM port that is connected to a Centronics-
compatible printer. 

Procedure

1 In TriStation, open your project, expand the Controller tree, and double-click 
Configuration. 

2 On the Configuration tree under Hardware Allocation, double-click EICM, and then 
click Setup.

3 Specify these properties on the EICM Setup screen.

4 Click OK.

Property Action

Port Selection Select Port 5 or Port 10. Other ports cannot be used for printing.

Protocol Select Printer from the Protocol list.

Rows Enter the number of lines (rows) to be displayed on a page.

Columns Enter the number of characters per line.
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Connecting a TCM to Printing Devices

This procedure explains how to directly connect a TCM to an HP JetDirect-compatible print 
server and printer.

You can use standard communication cables for these connections.

Procedure

1 If the print server and printer packages have installation programs, install them on the 
TriStation PC.

2 Follow the instructions, and run the diagnostic routines if available.

You do not need the printer drivers that came with the packages.

3 Record the IP address of the print server. You will need the IP address when configuring 
the TCM printer.

Connect the printer to the print server, and connect the print server to a TCM Ethernet 
port (NET 1 or NET 2).

Figure 35 Connecting a Tricon TCM to a Printer and Print Server
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Connecting a TCM to Printing Devices Using a Hub

This procedure explains how to connect a TCM to an HP JetDirect-compatible print server and 
printer by using a hub. You can use standard communication cables for these connections.

You do not need to install the printer drivers that may have come with the print server and 
printer packages.

Procedure

1 If the print server and printer packages have installation programs, install them on the 
TriStation PC.

2 Follow the instructions that came with the packages, and run the diagnostic routines, if 
available.

3 Record the IP address of the print server. You will need the IP address when configuring 
the TCM printer.

Connect the printer to the print server, and connect the print server to a hub. Connect 
the hub to a TCM Ethernet port (NET 1 or NET 2). 

Figure 36 Connecting the Tricon TCM to a Printer Server and Printer Using a Hub
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Configuring a Tricon TCM Port for Printing

This procedure explains how to configure a Tricon TCM port that is connected to a Centronics-
compatible printer. You do not need the printer driver that may have come with the printer package.

Note The following procedure applies only to model 4351A and 4352A TCMs. If you have an 
older model 4351 or 4352 TCM installed in your system, please see Appendix C, TCM 
Model 4351/4352 Configuration.

Procedure

1 In TriStation, open your project, expand the Controller tree, double-click Configuration, 
and expand Hardware Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. The 
Enhanced TCM Setup dialog box appears.

3 Click the Printer tab.

4 Specify these properties for the module installed in the Left Slot.

5 If a module is also installed in the Right Slot, repeat step 4 for that module.

6 Click OK.

Property Action

Printer Number Enter the number for the printer; can only be 5 or 10. Both slots cannot 
have the same printer number. The default is 0, meaning a printer is not 
configured.

Line Width Enter the number of characters to be printed on a line. The valid range is 
80–132 characters. The default is 80 characters.

TCP Port 
Number

Enter the number of the TCP port for the print server. The default is 9100 
for an HP printer.

Network Click the network that the print server is connected to. The default is NET 2.

IP Address Enter the IP address of the print server.
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About Function Blocks for Printing

A TriStation application must use print function blocks to send messages to a printer. 

Each print function block has a PRINTER parameter which specifies the port number where the 
printer cable is connected. For a Tricon EICM or TCM port, the PRINTER parameter must be 5 
for a left EICM or TCM port, or 10 for a right EICM or TCM port. (Other EICM or TCM ports 
cannot be used for printing.) The PRINTER parameter must be the same number as is defined 
in TriStation.

Each time a message is printed, the print function blocks in the TriStation application are 
executed and the scan time increases.

This table lists the print function blocks in the Tricon Library.

See the TriStation Libraries Reference for more detailed information about the print function 
blocks.

Print Function Block Purpose

PRINT_BOOL Prints a three-character field containing either Off or On.

PRINT_CDT Prints the current date and time.

PRINT_CRLF Prints a new line (carriage return and line feed).

PRINT_CTOD Prints the current time of day.

PRINT_DINT Prints a DINT value.

PRINT_REAL Prints a REAL value.

PRINT_STRING Prints a string of text.

PRINTR_FLUSH Clears the print buffer.
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Trident Printing
A Trident controller can print brief ASCII text messages if a communication port is connected 
to a printer and the TriStation application includes standard print function blocks.

Print messages are typically used for alarms, status, and maintenance. A sample alarm message 
might include the name of an analog input point, its time stamp and value, and a statement that 
the value is out of range. If the Trident system includes numerous controllers or is connected to 
a DCS, alarms are typically displayed on an operator workstation.

To print from a Trident controller, you must connect a CM Ethernet port to a print server that is 
connected to a printer; configure these devices in the TriStation project; and use print function 
blocks in the TriStation application.

Topics include:

• Affect of Printing on Scan Time on page 280

• Devices for Trident Printing on page 280

• Directly Connecting a Trident CM to Printing Devices on page 281

• Connecting a Trident CM to Printing Devices Using a Hub on page 282

• Configuring a Trident CM for Printing Devices on page 283

Affect of Printing on Scan Time

Each time a message is printed, the print function blocks in the TriStation application are 
executed and the scan time increases. Typically, the print function blocks are subject to 
conditional execution, which means they are not executed every scan. When you set the scan 
time in TriStation , make sure it includes the execution time for all conditional statements in the 
application.

If the scan time is not long enough, the execution of all conditional statements (when the 
conditions are True) could result in scan-time overruns. You can minimize this problem by 
limiting the amount of printer output. An alternative is to use a PC event logger such as the 
Triconex SOE Recorder. For more information, see the SOE Recorder User’s Guide.

Devices for Trident Printing

At a minimum, the printing devices you can use with a Trident controller are an HP JetDirect-
compatible print server and a line printer for ASCII text. You can also use a router or a hub.

Print Server and Cables

A print server that is connected to a Trident CM must use the HP JetDirect print protocol and 
operate at speeds of 10 or 100 megabits per second. Standard communication cables are suitable 
for this connection. 

You can purchase communication cables from other manufacturers. You must purchase print 
servers elsewhere because Triconex does not supply them. Black-box cables and Hewlett-
Packard print servers are examples of dependable network printing devices.
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Triconex has tested these Hewlett-Packard print servers and can recommend them.

• HP JetDirect Ex Plus

• HP JetDirect 500X Series, model J3265A

Printers

You must select a printer that is compatible with your print server. The Trident controller prints 
ASCII text only, which does not include formatting or graphics, so a Centronics-compatible 
printer is adequate. Laser printers are also suitable.

For more information, see the Trident Communication Guide.

Directly Connecting a Trident CM to Printing Devices

This procedure explains how to directly connect a Trident CM to an HP JetDirect-compatible 
print server and printer.

You can use standard communication cables for these connections.

Procedure

1 If the print server and printer packages have installation programs, install them on the 
TriStation PC.

2 Follow the instructions, and run the diagnostic routines if available.

You do not need the printer drivers that came with the packages.

3 Connect the printer to the print server, and connect the print server to a CM Ethernet 
port (NET 1 or NET 2).

Figure 37 Connecting a Trident CM to a Printer and Print Server
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Connecting a Trident CM to Printing Devices Using a Hub

This procedure explains how to connect a Trident CM to an HP JetDirect-compatible print 
server and printer by using a hub. You can use standard communication cables for these 
connections.

You do not need to install the printer drivers that may have come with the print server and 
printer packages.

Procedure

1 If the print server and printer packages have installation programs, copy the programs 
to the TriStation PC.

2 Follow the instructions that came with the packages, and run the diagnostic routines, if 
available.

3 Connect the printer to the print server, and connect the print server to a hub. Connect 
the hub to a CM Ethernet port (NET 1 or NET 2). 

Figure 38 Connecting the Trident CM to a Print Server and Printer Using a Hub
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Configuring a Trident CM for Printing Devices

This procedure explains how to configure a Trident CM port that is connected to a print server 
and printer.

Procedure

1 Expand the Controller tree, and double-click Configuration. 

2 On the Configuration tree, expand Hardware Allocation, double-click CM (COM: CM), 
and then click Setup.

3 Specify these properties on the CM Setup Network tab.

4 Click the Printer tab.

Property Action

Slot Selection Select Left Slot or Right Slot depending on where the CM is installed on 
the baseplate.

Mode For the NET 1 or NET 2 port, whichever is connected to the printer, select 
the Open Network mode.
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5 Specify these properties on the CM Setup Printer tab.

6 Click OK to save the configuration.

Property Action

Not Configured 
or Configured

Select Configured for the slot in which the CM is installed.

Printer Number Enter a number from 1 to 10. This must be the same number that is 
declared for the PRINTER parameter in print function blocks.

Line Width Enter the maximum printable line width for your printer, based on the 
manufacturer’s specifications.
The most typical line widths are 80 characters and 132 characters.

TCP Port 
Number

Enter the TCP/IP Port number that was defined by the manufacturer of 
the print server.

IP Address Enter the 32-bit IP address of the print server on the network.
If the print server is not on the same subnet as the controller, you must 
specify the destination address on the Routing tab of the CM Setup 
dialog box.
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IP Addresses
When communication between a TriStation PC and a Triconex controller occurs over a network, 
the IP address of the controller must be specified on the communication module.

If the controller is not part of a larger network, it may be possible to use the default IP address 
set when the TriStation project is downloaded (assuming the correct node number and default 
IP address are specified in the project).

If you cannot use a default address, there are other ways to set an IP address on a network. All 
begin with asking the network administrator for the intended IP addresses. The easiest way is 
to use a Reverse ARP (RARP) server that has been programmed in advance with the intended 
addresses. Other ways include temporary connection of the TriStation PC to a non-Ethernet 
module during downloading.

All the procedures for setting the IP address are based on the assumption that the controller 
includes at least one communication module with an Ethernet port connected to a network. 

To use the procedures, you should know how to:

• Connect the Triconex controller to a network

• Connect the TriStation PC to the controller

• Configure the TriStation project with the node number of the controller and the IP 
address

For more information, see the Communication Guide for Tricon v9–v10 Systems.

Note Typically, Triconex controllers are located on their own subnet which is connected to a 
larger network such as a DCS. Your network administrator can set up the subnet for 
compatibility with the Triconex default IP addresses and can program any routers that 
lie between the DCS and the Triconex subnet with addressing information about the 
Triconex controllers.

Topics include:

• Using the Default IP Address for TriStation Communication on page 286

• Setting an IP Address Using a RARP Server on page 287

• Setting a Tricon IP Address Using an EICM or TCM on page 288

• Setting a Trident IP Address Using an MP Connection on page 289

• Setting a Trident IP Address Using a CM Connection on page 290

• Specifying a Trident CM Default Gateway on page 291

• Specifying a Trident CM for Network Routing on page 292

• Testing a Network Connection on page 292
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Using the Default IP Address for TriStation Communication

This procedure explains how to use the default IP address for network communication between 
a controller and a TriStation PC.

Procedure

1 Connect the controller to the network using the NET 2 port on the ACM, NCM, or TCM, 
or the NET 1 or NET 2 port on the CM.

2 Power up the controller.

3 Connect the TriStation PC to the network, or directly to a NET 2 port on the ACM, NCM, 
or TCM, or an Ethernet port on the CM (Trident).

4 In the TriStation project, expand the Controller tree, double-click Configuration, and 
then click TriStation Communication.

5 On the TriStation Communication screen, verify the IP Address is:

• 192.168.1.1 (Tricon ACM, NCM, or TCM)

• 192.168.1.1 (Trident CM NET 1)

• 192.168.2.2 (Trident CM NET 2)

If the controller includes two communication modules, the default address applies to 
both modules.

Note The left and right modules in ACM or NCM slots (Tricon) and the Left CM and 
Right CM (Trident) use the same 48-bit physical MAC address and cannot be 
connected to the same network.

6 On the Controller tree, click Configuration. 

7 Expand Hardware Allocation, click the slot where the communication module is 
installed, and then click Setup. 

If a communication module is not installed, insert a communication module, and then 
click Setup. 

8 In the Setup dialog box, enter the same IP address specified on the TriStation 
Communication screen.

9 If the controller includes a redundant communication module, enter the same IP address 
for the other slot.

10 On the Controller tree, click the Controller Panel. From the Commands menu, click 
Connect.

11 Wait about 40 seconds for the module to reset and become active.

When the module is active, the Active indicator is green.

12 On the Commands menu, click Download All to download the TriStation 1131 project 
to the controller. 

13 On the TriStation PC, from the Start menu, click the MS-DOS Command Prompt.

14 Type the command ping followed by the IP address to be tested. 
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For example, for an IP address of 206.32.216.43, enter this:

ping 206.32.216.43

If the network connection is made, the reply includes the IP address followed by byte 
and time information.

If the connection is not okay, the reply is Request timed out.

Note If you receive a Request timed out reply, check your network cable and port connections 
to verify they are securely connected, verify your configuration settings are correct, and 
then retry the ping command.

Setting an IP Address Using a RARP Server

This procedure explains how to set the IP address of a communication module using a RARP 
server on the local network. To use this procedure, the network administrator must program the 
RARP server with the intended IP address for the controller. If this is not possible, use another 
method to set the IP address.

Procedure

1 Give the network administrator the MAC address, which is:

40-00-00-00-00 (Tricon)

40-00-00-00-x-03 (where x is the Trident controller node number).

2 Ask the network administrator for the IP address that is to be used for the controller.

3 Connect the controller to the network through a network port on the communication 
module. 

4 Power up the controller.

During initialization, the communication module sends a request to the RARP server for 
an IP address that has been mapped to its own 48-bit MAC address.

Note The left and right modules in ACM or NCM slots (Tricon) and the Left CM and 
Right CM (Trident) use the same 48-bit physical MAC address and cannot be 
connected to the same network.

5 On the TriStation PC, from the Start menu, click the MS-DOS Command Prompt.

6 Enter the command ping followed by the IP address to be tested. For example, for an IP 
address of 206.32.216.43, enter this:

ping 206.32.216.43

If the network connection is made, the reply includes the IP address followed by byte 
and time information.

If the connection is not okay, the reply is Request timed out.

Note If you receive a Request timed out reply, check your network cable and port 
connections to verify they are securely connected, verify your configuration 
settings are correct, and then retry the ping command.
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7 Connect the TriStation PC to the network, or directly to a network port on the 
communication module.

8 In the TriStation project, expand the Controller tree, click Configuration, and then click 
TriStation Communication.

9 On the TriStation Communication screen, specify the Node Number of the controller 
and the intended IP address.

10 On the Commands menu, click Connect. Wait until the connection is made.

11 On the Commands menu, click Download All to download the TriStation project to the 
controller.

Setting a Tricon IP Address Using an EICM or TCM

This procedure explains how to set the IP address of the Triconex controller by initially 
connecting the TriStation PC to an EICM or TCM serial port, and downloading the TriStation 
project. After the address is set, you can disconnect the TriStation PC from the EICM or TCM 
serial port, and reconnect it to a NET 2 port on the ACM, NCM, or TCM.

Procedure

1 Ask the network administrator for the IP address to be used for the ACM, NCM, or 
TCM.

2 Connect the TriStation PC to a serial port on the EICM or TCM.

3 Connect the controller to the network using a NET 2 port on the ACM, NCM, or TCM. 

4 In the TriStation project, configure the following:

• The EICM or TCM serial port and NET 2 Ethernet ports

• The node number and node name of the controller

• The intended IP address 

5 Power up the controller.

6 On the Controller tree, click Controller Panel. 

7 On the Command menu, click Connect To.

8 On the Connect To screen, select the Serial Port option and the COM port to which the 
TriStation cable is connected.

9 Connect to the Triconex controller and download the TriStation project.

The ACM, NCM, or TCM initializes (resets) and accepts the IP address that you specify 
in the TriStation project.

10 On the TriStation PC, from the Start menu, click the MS-DOS Command Prompt.

11 Enter the command ping followed by the IP address to be tested. For example, for an IP 
address of 206.32.216.43, enter this:

ping 206.32.216.43

If the network connection is made, the reply includes the IP address followed by byte 
and time information.
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If the connection is not okay, the reply is Request timed out.

Note If you receive a Request timed out reply, check your network cable and port 
connections to verify they are securely connected, verify your configuration 
settings are correct, and then retry the ping command.

12 If the IP address is set, you can disconnect the TriStation PC from the EICM or TCM 
serial port, and connect it to a NET 2 port or to the network.

Setting a Trident IP Address Using an MP Connection

This procedure explains how to set the IP address of the Trident controller by initially 
connecting the TriStation PC to an MP port and downloading the TriStation project. After the 
address is set, you can disconnect the TriStation PC from the MP port, and reconnect it to a 
network port on the CM.

Procedure

1 Ask the network administrator for the IP address to be used for the controller.

2 Connect the TriStation PC to a TriStation port on the MP Baseplate.

3 Connect the controller to the network through a network port on the CM. 

4 In the TriStation project, configure the following:

• The MP and CM ports

• The node name and node number of the controller

• The intended IP address 

5 Power up the controller.

6 On the Controller tree, click Controller Panel. 

7 On the Command menu, click Connect To.

8 On the Connect To screen, click Main Processor Module Port and Left, Middle, or Right 
for the MP port to which the TriStation cable is connected.

9 After connecting to the controller, download the TriStation project.

The CM initializes (resets) and accepts the IP address you specified in the TriStation 
project.

10 On the TriStation PC, from the Start menu, click the MS-DOS Command Prompt.

11 Enter the command ping followed by the IP address to be tested. For example, for an IP 
address of 206.32.216.43, enter this:

ping 206.32.216.43

If the network connection is made, the reply includes the IP address followed by byte 
and time information.

If the connection is not okay, the reply is Request timed out.

12 If the IP address is set, you can disconnect the TriStation PC from the MP port, and 
connect it to a network port on the CM or to the network.



290 Chapter 4 TriStation 1131 Communication

TriStation 1131 Developer’s Guide, v4.1

Setting a Trident IP Address Using a CM Connection

This procedure explains how to set the IP address for a Trident CM by temporarily configuring 
a default IP address for the CM, and assigning a default IP address to the TriStation PC.

Procedure

1 Ask the network administrator for the IP address to be used for the CM.

2 Connect the Trident controller to the network using a network port (NET 1 or NET 2) on 
the CM.

3 Connect the TriStation PC to a network port on the CM, using a direct or network 
connection.

4 On the TriStation PC, use Windows procedures to set the IP address of the PC to either 
of the following:

• 192.168.1.x if the PC is physically connected to a NET 1 port, where x is any unused 
host number.

• 192.168.2.x if the PC is physically connected to a NET 2 port, where x is any unused 
host number.

5 Wait for the TriStation PC to reset.

6 Open the TriStation project. 

7 Expand the Configuration tree, click Configuration, and then click TriStation 
Communication.

8 Specify the node name, node number, and the default IP address of the controller.

9 Use the Network tab on the CM Setup screen to specify the intended IP address for the 
Ethernet port that is connected to the network.

10 Power up the Trident controller.

11 On the Controller tree, click Controller Panel. On the Command menu, click Connect To.

12 On the Connect To screen, click the Serial Port option and the COM port to which the 
TriStation cable is connected.

13 Verify that Communication Module Port is selected and the default IP address is 
displayed.

14 Connect to the controller and download the TriStation project. Wait for the download to 
complete.

After the download is complete, TriStation displays the message, Connection failed. The 
default IP address you specified in the node definition is invalid, and the intended IP 
address of the CM is set.

15 On the TriStation PC, use Windows procedures to set the IP address of the PC to its 
actual address on the network.

16 On the TriStation PC, from the Start menu, click the MS-DOS Command Prompt.

17 Enter the command ping followed by the IP address to be tested. 
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For example, for an IP address of 206.32.216.43, enter this:

ping 206.32.216.43

If the network connection is made, the reply includes the IP address followed by byte 
and time information.

If the connection is not okay, the reply is Request timed out.

18 In the TriStation project, change the default IP address to the newly set IP address of the 
TriStation Communication screen.

19 Use the Controller Panel to reconnect the TriStation project to the controller.

20 After the IP address is set on the network, you must reconfigure the IP address in the 
TriStation project, and assign a valid IP address to the TriStation PC.

Specifying a Trident CM Default Gateway

This procedure explains how to set the address of a default gateway for a controller that must 
communicate with devices on another network. A default gateway is a router that forwards all 
messages not addressed to stations within the local subnet.

Procedure

1 Expand the Controller tree and double-click Configuration.

2 On the Configuration tree, click Hardware Allocation to display the modules that are 
configured for this system.

3 Double-click the CM icon to open the Properties dialog box, and click Setup to display 
the configuration options for the CM.

4 On the Network tab, select Left Slot or Right Slot depending on which CM you are 
configuring.

5 For NET 1 or NET 2 (depending on which one is connected the network), select Open 
Network from the list under Mode.

6 Under Default Gateway Address, enter the IP address of the default gateway that is 
connected to the local subnet.
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Specifying a Trident CM for Network Routing

This procedure explains how to specify routes to destinations outside the local network for 
controllers that do not have access to a default gateway.

Each route must include an IP address for the destination, a subnet mask, and a gateway 
address. 

Procedure

1 Expand the Controller tree and double-click Configuration.

2 On the Configuration tree, click Hardware Allocation to display the modules that are 
configured for this system.

3 Double-click the CM icon to open the Properties dialog box, and click Setup to display 
the configuration options for the CM.

4 Click the Routing tab and enter an IP address under Destination Address, Subnet Mask, 
and Gateway Address for each route that you need to specify.

Testing a Network Connection

This procedure explains how to test a connection from a Triconex communication module to a 
network by using the ping command from an MS-DOS command prompt.

The test is performed on the TriStation PC. Before doing the test, you must have set the IP 
address of the communication module on the network.

Procedure

1 On the TriStation PC, from the Start menu, click the MS-DOS Command Prompt.

2 Type the command ping followed by the IP address to be tested. For example, for an IP 
address of 206.32.216.43, enter this:

ping 206.32.216.43

If the network connection is made, the reply includes the IP address followed by byte 
and time information.

If the connection is not okay, the reply is Request timed out.
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Overview
This figure shows the main steps for implementing an application, which is the last step in a 
TriStation project.
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Implementation Steps
This list includes steps for testing and maintaining an application.

Step See

Test on the emulator • Downloading to the Emulator on page 297
• Monitoring Variables on the Emulator on page 298
• Monitoring the Program Execution on page 299
• Adding Annotation for Variables on page 300

Test on the controller • Downloading to the Controller on page 302
• Monitoring Variables on the Controller on page 303
• Monitoring the Program Execution on page 304
• Adding Annotation for Variables on page 300
• Displaying Hardware Allocation Exceptions on page 308

Maintain an application • Steps for Downloading Changes on page 310
• Planning and Controlling Changes on page 311
• Commands Required with Application Changes on page 312
• Disabling (Forcing) Points on page 313
• Using the Download Changes Command on page 314
• Using the Download All Command on page 316
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Controlling the Operational Mode

This section describes the operational modes available on a controller. Although the 
functionality is the same for Tricon and Trident, the method of executing the mode may be 
different. This table describes the mode and method.

Table 32 Tricon and Trident Operational Modes

Mode Description

Run Controller runs the downloaded application with read-only capability.
Attempts to write to program variables by TriStation, Modbus masters, or external 
devices are rejected, however, an application may call gated access functions to enable 
external writes during a designated window of time. For more information, see the 
GATDIS and GATENB function blocks in the TriStation Libraries Reference.

• For Tricon, the keyswitch must be set to RUN and the Run command used.
• For Trident, the Run command must be used and the Set Programming Mode option 

must be set to Disable Programming Control Operations.

Program Controller allows application loading, verification, and write access.
Allows Download All and Download Changes commands from TriStation. Also allows 
writes to program variables by Modbus masters and external devices.

• For Tricon, the keyswitch must be set to PROGRAM.
• For Trident, the Set Programming Mode option must be set to Enable Programming 

and Control Operations. (This is the default setting.)

Halt Controller stops running the application and retains the values of tagnames.
• For Tricon, the Halt command is used.
• For Trident, the Halt command or the SYS_APP_HALT function can be used.

Stop Controller stops reading inputs, forces non-retentive digital and analog outputs to zero, 
and halts the application.
Retentive outputs return to the value they had before the Stop was issued. Stop mode is 
recommended for installation and service of process-related equipment, but is not 
required for service of the controller.

• For Tricon, the keyswitch must be set to STOP.
• For Trident, the Stop command must be used.

Remote Controller runs the downloaded application and allows writes to program variables by 
TriStation, Modbus masters, and external devices. 
Download All and Download Changes by TriStation are not allowed.

• For Tricon, the keyswitch must be set to PROGRAM.
• For Trident, the Set Programming Mode option must be set to Enable Programming 

and Control Operations. (This is the default setting.)
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Emulator Testing
This section describes how to test an application on the emulator, which can be done without 
physically connecting to a controller or field instruments. Although the physical connections 
and logical configuration do not need to be completed, it is a good practice to do so before 
testing on the controller.

Topics include:

• Downloading to the Emulator on page 297

• Monitoring Variables on the Emulator on page 298

• Monitoring the Program Execution on page 299

• Adding Annotation for Variables on page 300

Note Under certain conditions, an application may appear to work correctly during emulator 
testing, but will not work when downloaded to the controller. The emulator is designed 
only to check your application code; it does not check the application against any 
restrictions imposed by the specific controller you will be downloading to. 

For example, the size of your application is not emulated exactly due to code differences 
between the emulator and a controller. Thus, an application that appears to download 
correctly to the emulator may be unable to be downloaded to the controller, due to size 
restrictions imposed by the controller.

Additionally, many function blocks in the controller library (TR1LIB, TRDLIB, or 
TX1LIB) are not emulated. One exception is TR_CALENDAR, which is emulated using 
the local time on your PC. Also, the print function blocks print to TriStation’s output 
window.

Downloading to the Emulator

This procedure explains how to use the Download All command to load an application to the 
emulator, which allows you to test an application without connecting to a controller. The 
Download Changes command cannot be used with the emulator.

Procedure

1 Open the Controller workspace, expand the Configuration tree, and double-click 
Emulator Panel.

2 Click Connect  .

3 Click Download All  .
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Monitoring Variables on the Emulator

This procedure explains how to monitor and test values for variables on the emulator.

Procedure

1 To connect and download an application, see Downloading to the Emulator on 
page 297.

2 If needed, drag variables to be tested onto the emulator sheet. 

3 Double-click a variable to view its Item Properties dialog box and make changes to its 
value.

4 For the Set Value property, enter a test value and click Confirm. The value is applied to 
the selected variable.

5 Continue to monitor the program execution.
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Monitoring the Program Execution

This procedure explains how to display the program execution, which shows the program 
executing on the emulator.

Procedure

1 To connect and download an application, see Downloading to the Emulator on 
page 297.

2 On the emulator tree, expand Programs, and click the program you want to monitor.

3 Click Display Program Document . 

4 To view the program execution, click Run  or Single Step .

5 To quit running the program, click Disconnect .

Figure 39 Sample Program Running on the Emulator

False Value 
in Green

True Value 
in Red
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Adding Annotation for Variables

This procedure explains how to add an annotation to a variable, which allows you to specify 
information displayed while the program is executing. The annotation can include text and 
macros.

Procedure

1 To connect and download an application, see Downloading to the Emulator on 
page 297.

2 If needed, drag variables to be tested onto the sheet. 

3 Double-click a variable, and select the Annotate check box on the Variable tab.

4 Click the Annotation tab.

5 Click the Macros button to change the macro identified with the annotation.

6 To copy a macro, click the macro name and press Ctrl+C. To paste the macro, close the 
Edit Macros dialog box, click in the Annotation area, and press Ctrl+V. You can also 
enter text with the macros.

7 Continue testing, as needed.
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Controller Testing
This section explains how to test on the controller, which is usually done when the controller is 
physically connected to field instruments either in a test facility that simulates the system 
(Factory Acceptance Test) or at the site while the control process is offline (Site Acceptance Test). 
The logical hardware configuration in TriStation must be completed and must match the 
physical configuration.

Topics include:

• Downloading to the Controller on page 302

• Monitoring Variables on the Controller on page 303

• Monitoring the Program Execution on page 304

• Adding Annotation for Variables on page 305

• Determining the Scan Surplus on page 306

• Displaying Hardware Allocation Exceptions on page 308
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Downloading to the Controller

This procedure explains how to use the Download All command to load an application to the 
controller. A best practice is to rebuild the application before downloading it.

This procedure can be used for testing when the controller is connected to simulation field 
devices or the control process is offline. This procedure can also be used to run the application 
when the control process is online.

Procedure

1 Open the Controller workspace, expand the Configuration tree, and double-click the 
Controller Panel.

2 On the Commands menu, click Connect .

The Connect To screen shows the default communication setting. If needed, change the 
connection setting and click OK. For more information, see Specifying the Tricon Default 
Connection on page 197 or Specifying the Trident Default Connection on page 216.

3 Enter the connection password if required.

4 Do one of the following:

• For Tricon, ensure the keyswitch is turned to PROGRAM. This is the factory setting.

• For Trident, ensure the mode is Enable Programming and Control Operations. This 
is the default setting. (To view this setting, on the Commands menu, click Set 
Programming Mode, and then click Enable Programming and Control Operations.)

5 On the Commands menu, click Download All . 

If the download is successful, a backup file of the project is automatically created with 
the major version, minor version, time stamp, and the extension DWLD. For example, 
EXCOUNTR_333_1_4120e077.DWLD. If needed, this file can be restored by using the 
Restore Project To Last Download Command on page 410.

6 To start the application, click Run .

7 Do one of the following:

• For Tricon, turn the keyswitch to RUN (to start the program on the controller) or to 
REMOTE (to start the program and allow external devices to write to tagnames or 
aliases).

• For Trident, set the mode to Run and disable Download commands by doing this: 
On the Commands menu, click Set Programming Mode, and then click Disable 
Programming and Control Operations.
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Monitoring Variables on the Controller

This procedure explains how to monitor and enable or disable variables while the application 
is running on the controller. 

Procedure

1 To connect and download an application, see Downloading to the Controller on 
page 302 and Monitoring the Program Execution on page 304.

2 Drag the function blocks and variables you want to monitor to the sheet.

3 On the Commands menu, click Run  or Single Step .

Note When you click Single Step, the application executes for one scan only. As a 
result, Modbus Master and Peer-to-Peer behavior can be unpredictable when 
Single Step is applied.

4 To enable or disable a variable, double-click the variable and click Enable or Disable.

5 Continue testing, as needed.

Note While monitoring variables on the controller, you may occasionally see a question mark 
(?) instead of the variable’s actual value. This is normal and should resolve itself within 
the next few scans. 

The question mark appears only when TriStation does not know the actual value of the 
variable. This can occur in situations when the list of variables is being updated (for 
example, when you’ve scrolled down the variables list, or resized the sheet view) and 
TriStation doesn’t have enough communications bandwidth to display all the new 
values in one scan. 

CAUTION
Monitoring and disabling variables should only be done if the controller 
is not connected to a live system or if maintenance is being performed.
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Monitoring the Program Execution

This procedure explains how to display the program execution, which shows the program 
executing on the controller. 

Procedure

1 To connect and download an application, see Downloading to the Controller on 
page 302.

2 On the controller tree, expand Programs, and click the program you want to test.

3 Click Display Program Document . 

4 To view the program execution, click Run  or Single Step .

Note When you click Single Step, the program executes for one scan only. As a result, 
Modbus Master and Peer-to-Peer behavior can be unpredictable when Single 
Step is applied.

5 To quit running the program, click Disconnect .

Figure 40 Sample Program Running on the Controller

False Value 
in Green

True Value 
in Red
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Adding Annotation for Variables

This procedure explains how to add an annotation to a variable, which allows you to specify 
information displayed while the program is executing. The annotation can include text and 
macros.

Procedure

1 To connect and download an application, see Downloading to the Controller on 
page 302.

2 If needed, drag variables to be tested onto the sheet.

3 Double-click a variable, and select the Annotate check box on the Variable tab.

4 Click the Annotation tab.

5 Click the Macros button to change the macro identified with the annotation.

6 To copy a macro, click the macro name and press Ctrl+C. To paste the macro, close the 
Edit Macros dialog box, click in the Annotation area, and press Ctrl+V. You can also 
enter text with the macros.

7 Continue testing, as needed.
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Determining the Scan Surplus

This section explains how to determine the scan surplus, which indicates whether the actual 
scan time required to execute the application uses less time or more time than the requested scan 
time in the project. When the actual time is less, the scan surplus is positive, which means the 
scan time setting can be decreased. When actual time is more, the scan surplus is negative, 
which means the scan time should be increased to ensure that communication errors do not 
occur. For more information, see Setting the Scan Time for a Downloaded Application on 
page 307.

The Triconex Enhanced Diagnostic Monitor (sold separately) displays information to determine 
scan surplus, including the requested Scan Time, Actual Scan Time, and Scan Surplus for an 
application. For more information, see the Help documentation for the Enhanced Diagnostic 
Monitor.

Positive Scan Surplus

A positive scan surplus means the application executes in less time than the requested scan time. 
For example, if the requested scan time is 150 milliseconds, and the actual scan time is 100 
milliseconds, there is a positive scan surplus of 50 milliseconds.

• If the surplus is 20 milliseconds or 10 percent of the actual scan time, do nothing.

• If the surplus is greater than 20 milliseconds or 10 percent of the actual scan time, 
decrease the number for the scan time. In this example, the scan time could be set to 130 
milliseconds.

Negative Scan Surplus

A negative scan surplus means the actual scan time is greater than the requested scan time. For 
example, if the requested scan time is 150 milliseconds, and the actual scan time is 200 
milliseconds, there is a negative scan surplus of 50 milliseconds.

• If the surplus is negative, increase the number for the requested scan time by the 
negative amount plus 20 milliseconds. In this example, the scan time should be set to 
220 milliseconds.

Process Safety Time Requirements

You should determine the Process Safety Time (PST) required by the application. The PST is the 
period of time during which the process could shift from a safe operating condition to a 
dangerous condition. The scan time for an application should be half the PST. For example, a 
burner management system has a PST of 1 second, which means the scan time should be 500 
milliseconds.
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Setting the Scan Time for a Downloaded Application

This procedure explains how to set the scan time for a downloaded application running in the 
controller. (The emulator does not provide real-time information on scan time.) This should be 
done if the scan time set in the project is less than the actual scan time required to run the 
application. For more information, see Determining the Scan Surplus on page 306.

If you need a faster scan time than the low end of the range, you must redesign the application 
or the process. 

Procedure

1 On the Controller tree, double-click the Controller Panel and download the application.

2 On the Commands menu, click Set Scan Time.

3 Specify this property on the Set Scan Time screen.

Note To guarantee that the controller provides a deterministic response time, the scan 
time should always be set to a value greater than the I/O poll time (the 
maximum time needed by the controller to obtain data from the input modules). 
You can view the I/O poll time on the System Overview screen in the Enhanced 
Diagnostic Monitor (sold separately). For more information, see the Help 
documentation for the Enhanced Diagnostic Monitor.

4 Click OK to save your changes.

This is the Tricon 3008 screen. This is the Trident screen.

Property Action

Enter the scan time in 
milliseconds

Enter the number of milliseconds for the scan time used while the 
application is running in the controller. The number must be in the 
minimum to maximum range.

• For Tricon 3006/3007, the range is 20 to 500 milliseconds.
• For Tricon 3008, the range is 20 to 450 milliseconds.
• For Trident, the range is 10 to 450 milliseconds. The minimum 

must be equal to or larger than the poll times.
This setting does not affect the requested scan time for the project. 
To change the requested scan time in the project, you must set the 
scan time on the Implementation screen. 
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Displaying Hardware Allocation Exceptions

This procedure explains how to display hardware allocation exceptions, which indicate that the 
hardware configuration in the project does not match the physical hardware configuration.

Procedure

1 Download an application to the controller.

If the logical and physical configurations do not match, the Hardware Allocation 
Exception dialog box appears.

2 Differences identified with an asterisk must be fixed in the project before the application 
can be download. Other differences may allow you to download the application.

Identifier Description

Asterisk (*) A red asterisk identifies a module mismatch, which means the module 
specified in the hardware configuration for the project is different from the 
module in the physical system.
This error must be fixed by changing the hardware configuration in the 
project.

Empty slot An empty slot error indicates either of these:
• The hardware configuration specifies a module that is empty in the 

controller.
• The controller contains a module that is not included in the hardware 

configuration.
The application can be downloaded.
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Maintenance
This section explains how to plan and manage changes to an application running on a controller 
attached to a live system.

Topics include:

• Steps for Downloading Changes on page 310 

• Planning and Controlling Changes on page 311 

• Commands Required with Application Changes on page 312 

• Disabling (Forcing) Points on page 313

• Using the Download Changes Command on page 314

• Using the Download All Command on page 316

WARNING
Changing a safety-critical application that is running on a controller 
should be avoided because an error in the application could cause a trip 
or unpredictable behavior.
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Steps for Downloading Changes

This list includes steps for making changes to an application running on a controller.

WARNING
• For a safety-critical application running on a live system, you must use 

extreme caution because a configuration error in the changed 
application could cause unpredictable behavior or a trip.

• When a Download Changes command is issued, the scan time is 
doubled for one scan immediately following the command. For 
example, if the normal scan time is 100 ms, the scan following a 
Download Changes would be 200 ms.

Step See

Verify the TriStation software is 
correctly installed.

• Verifying the TriStation 1131 Installation on 
page 6

Plan for the change. • Planning and Controlling Changes on 
page 311.

Determine whether a Download All or 
Download Changes is required.

• Commands Required with Application 
Changes on page 312.

Review the hardware configuration. If 
needed, correct the hardware 
configuration to match the physical 
configuration.

• See the Hardware Module Configuration 
report. See Reports on page 41.

Compare the current project with the last 
downloaded.

• Compare Project to the Last Downloaded 
Command on page 330

Test on the emulator. • Emulator Testing on page 297

Ensure the scan time has a surplus • Determining the Scan Surplus on page 306

Download the changed application. • Using the Download Changes Command on 
page 314.

• Using the Download All Command on 
page 316

Backup the project and copy it to another 
storage medium.

• Backup Project Command on page 322
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Planning and Controlling Changes

This section describes recommended procedures for planning and controlling changes to an 
existing application. All changes to an application should be controlled by a change control 
board or the equivalent, and should comply with strict control procedures.

Recommended Procedure

1 Generate a change request defining all changes to the application and the reasons for the 
changes, then obtain approval for the changes from the board.

2 Develop a specification for changes, including a test specification, then obtain approval 
for the specification from the board.

3 Make the appropriate changes to the application, including those related to design, 
operation, or maintenance documentation.

4 Verify the application in the controller matches the last downloaded application. See 
Verify Last Download to the Controller Command on page 441. If the applications do 
not match, contact Triconex Technical Support.

5 Print the Hardware Module Configuration report to compare the current configuration 
with the last one downloaded to the controller.

6 Print all user documents and thoroughly check all changed networks in each document 
to ensure the changes do not affect other parts of the application.

7 Test the new application on the emulator and write a test report.

8 Review and audit all changes and the test results with the board.

9 When approved by the board, download the changes to the controller.

10 Save the downloaded application and back up the appropriate files on a CD or other 
storage medium.

11 Archive two copies of the PT2 (project) file and all associated documentation.
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Commands Required with Application Changes

After an application is downloaded to a controller, the state is set to accept changes to the project 
which are allowed with the Download Changes command. If a change requires the Download 
All command, it is either disabled or a message advises you to change the state or cancel the 
change. For example, a program cannot be deleted unless the state is changed to Download All.

This table identifies whether a Download All or Download Changes command is required.

Table 33 Commands Required with Changes

Component Command Required

Chassis Download All: Required if a chassis is added, deleted, or the type is changed.

Functions and 
function blocks

Download All: Required if a function or function block is modified or deleted.
Download Changes: Allowed if a function or function block is added.

IP Address Download Changes: Allowed, but not advised, if the IP address of a 
communication module is changed.

Memory allocation Download All: Required if memory allocation is increased.

Modules Download All: Required if modules are deleted or moved in the 
configuration.
Download Changes: Allowed if a module is added and the chassis has 
empty slots, and there is sufficient memory allocated for the points.

Node Number Download All: Required if the address plug and node number configuration 
are changed.

Number of Send or 
Receive function 
blocks

Download All: Required if the number of send or receive function blocks is 
increased or decreased.

Operating 
Parameters

Download All: Required if the Allow Disabling of Points property is 
changed.
Download Changes: Allowed if these properties are changed: Disable 
Remote Changes to Outputs, Password Required for Connection, Restart on 
Power-Up (Trident only), Scan Time, and Use Local Time.

Programs Download All: Required if a program is deleted from an application.
Download Changes: Allowed if a program is added to an application and 
there is sufficient memory.

Tagnames Download Changes: Allowed if tagnames are added, modified, or deleted. 
Tagnames can also be disconnected or connected to different points, if there 
is enough memory allocated for the required point types. Points must be 
enabled.

Variables Download All: Required if changes to the Data Type or Alias Type require 
additional memory allocation.
Download Changes: Allowed if changes to the Data Type or Point Type do 
not require additional memory allocation. Points must be enabled. Also 
allowed if the variable Name, Description, or Initial Value is added or 
changed.
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Disabling (Forcing) Points

This procedure explains how to disable points on an application running on a controller, which 
should be used with care. When a point is disabled, inputs from field instruments do not change 
the value of the point. Disabling points is typically used when field instruments need to be 
replaced or repaired.

For Tricon v9.x, a maximum of 64 points can be disabled at any one time. For Tricon v10.x, a 
maximum of 256 points can be disabled.

Procedure

1 Expand the Configuration tree, and click Controller Panel. 

2 On the Commands menu, click the Connect command, and enter the connection 
password if required.

3 Double-click a point to be disabled, and click Disable.

Only one point can be disabled at a time.

4 Repeat step 3 until all desired points have been disabled.

WARNING
• A project should not contain disabled points unless there is a specific 

reason for disabling them, such as initial testing or maintenance.
• Disabling points can increase the scan time.
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Using the Download Changes Command

This procedure explains how to use the Download Changes command to download changes to 
an application that has been downloaded and is running on a controller. For information on 
changes that are allowed with this command, see Download Changes Command on page 349.

These warnings should be reviewed before proceeding.

Adding an I/O Module

If the application uses the following function blocks, the changed application should include 
logic to accommodate the behavior.

• For Tricon, the IOMAIN and IOBAD parameters of the TR_MP_STATUS function block 
turn off.

• For Trident, the parameters for the SYS_IO_STATUS, SYS_IOP_STATUS, and 
SYS_SYSTEM_STATUS function blocks turn off.

For more information, see the Tricon or Trident Safety Considerations Guide.

WARNING
• Changing a safety-critical application that is running on a controller 

should be avoided because an error in the application could cause a 
trip or unpredictable behavior.

• If the application has a negative Scan Surplus, do not use the 
Download Changes command because it could cause a trip or 
unpredictable behavior.

• When a Download Changes command is issued, the scan time is 
doubled for one scan immediately following the command.

• If the IP Address is changed, the Fault indicator on the communication 
module turns on during the reset, which temporarily compromises the 
TMR status of the controller.

• If an I/O module is added, the TMR status of the controller is 
temporarily compromised for as much as 8 to 16 scans. For more 
information, see Adding an I/O Module below.

• If the AI module type for models 3703 or 3704 is changed, the TMR 
status of the controller is temporarily compromised for as much as 8 to 
16 scans.

• If the DO module type for models 3611, 3613, 3614, 3615, or 3617 is 
changed, the TMR status of the controller is temporarily compromised 
for as much as 8 to 16 scans.

• If in doubt about the effect of this command, contact Technical 
Support.
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Procedure

1 Expand the Configuration tree, and double-click the Controller Panel.

2 On the Commands menu, click Connect , and enter the connection password if 
required.

3 On the Commands menu, click Download Changes .

If the download is successful, a backup file of the project is automatically created with 
the major version, minor version, time stamp, and the extension DWLD. For example, 
EXCOUNTR_333_1_4120e077.DWLD. If needed, this file can be restored by using the 
Restore Project To Last Download Command on page 410.

The changes are made while the application is running.
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Using the Download All Command

This procedure explains how to use the Download All command to download a changed 
application to a controller. For information on changes that require this command, see 
Download All Command on page 348.

Procedure

1 Expand the Configuration tree, and double-click the Controller Panel.

2 On the Commands menu, click Connect .

3 If needed, change the connection setting. Click OK.

4 If required, enter the connection password.

5 If needed, change the state to Download All. On the Commands menu, click Change 
State to Download All.

6 Click Halt to stop the application.

7 For Tricon, turn the keyswitch to PROGRAM.

8 For Trident, ensure the mode is Enable Programming and Control Operations, by doing 
this:

On the Commands menu, click Set Programming Mode, and then click Enable 
Programming and Control Operations. (This is the default setting.)

9 Click Download All .

If the download is successful, a backup file of the project is automatically created with 
the major version, minor version, time stamp, and the extension DWLD. For example, 
EXCOUNTR_333_1_4120e077.DWLD. If needed, this file can be restored by using the 
Restore Project To Last Download Command on page 410.

10 Click Run  to start the application running on the controller.

11 For Tricon, turn the keyswitch to RUN.

WARNING
Using the Download All command requires the current application 
running on the controller to be halted.
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A
Commands and Properties

This appendix provides descriptions of TriStation commands and properties.

Add Program to Execution List Command

The Add Program to Execution List command places the cursor inside the Program Execution 
List box, which allows you to enter or select a program to be added to the list. 

Applies To
Application

Location
Application tree > Implementation > Edit menu

Alias Number

The Alias Number property identifies the range of five-digit alias numbers that can be assigned 
to the point. For Trident, the alias number can be set within a default range or within a larger 
allowable range. 

This table identifies Tricon and Trident ranges.

Table 34 Alias Number Information

Bin Data 
Type

Variable 
Type

Message 
Type

Tricon 
Range

Trident 
Default 
Range

Trident 
Allowable 
Range

Bin 
Size

0 BOOL Output Read/Write 00001 - 02000 00001 - 04999 00001 - 09999 2048

1 BOOL Memory Read/Write 02001 - 04000 05000 - 09999 00001 - 09999 2016

2 BOOL Input Read 10001 - 12000 10001 - 14999 10001 - 19999 4096

3 BOOL Memory Read 12001 - 14000 15000 - 19999 10001 - 19999 2016

4 DINT Input Read 30001 - 31000 30001 - 32499 30001 - 39999 1024

5 DINT Memory Read 31001 - 32000 32500 - 34999 30001 - 39999 1000

6 REAL Input Read 32001 - 32120 35000 - 37499 30001 - 39999 120
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Applies To
Communication

Location
Application tree > Tagnames > Item Properties > Point Assignment tab

Alias Type

The Alias Type property identifies whether the memory point has an alias number and whether 
the point is read or read/write. Settings include:

• Unaliased: Means the point cannot be read or written to.

• Read aliased: Means the point can be read by an external device. If specified, you can 
accept the default alias, or enter a number for the alias.

• Read/write aliased: Means the point can be read or written by an external device. If 
specified, you can accept the default alias, or enter a number for the alias.

Applies To
Communication

Location
Application tree > Tagnames > Item Properties > Point Assignment tab

Alignment

The Alignment property specifies how the text for an annotation or comment is aligned in the 
comment box; either left, center, or right. The default is left.

Applies To
Comments

Locations
Item Properties > Comment tab
Project menu > Project Options > Annotations tab

7 REAL Memory Read 33001 - 34000 37500 - 39999 30001 - 39999 1000

10 DINT Output Read/Write 40001 - 40250 40000 - 42499 40001 - 49999 512

11 DINT Memory Read/Write 40251 - 41000 42500 - 44999 40001 - 49999 750

12 REAL Memory Read/Write 41001 - 42000 45000 - 49999 40001 - 49999 1000

13 DINT Memory Read 38000 - 39630 n/a n/a 1630

14 BOOL Memory Read 18001 - 19999 n/a n/a 2000

Table 34 Alias Number Information (continued)

Bin Data 
Type

Variable 
Type

Message 
Type

Tricon 
Range

Trident 
Default 
Range

Trident 
Allowable 
Range

Bin 
Size
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Allow Disabling of Points

The Allow Disabling of Points property specifies whether points can be disabled from the 
TriStation PC. A TriStation PC cannot write to disabled points, however, external devices such 
as Modbus masters can write to disabled points unless you disable external device writes. 

The default is cleared, which means points cannot be disabled from the TriStation PC.

Once you have selected this property, you must rebuild the application and perform a 
Download All to apply your changes to the controller. See Building or Rebuilding an 
Application on page 174 and Using the Download All Command on page 316.

Applies To
Memory and Output Points

Locations
Tricon Controller tree > Configuration > Operating Parameters
Trident Controller tree > Configuration > MP Setup > Operating Parameters tab

Annotate

The Annotate property specifies whether to add an annotation, which is similar to a comment, 
to a variable. If selected, an annotation box is attached to the bottom of an input, output, 
input/output, or local variable. You can change the size of the annotation box.

An annotation can include any of the following:

• The monitor value (value of the variable as the configuration executes)

• The default macro for the particular type of variable

• Other standard macros

• User-modified macros

• Text that you type in

The default is cleared, which means an annotation is not included. If Annotate is cleared, no 
properties are available to view when the application is run on the controller or emulator.

Applies To
Variables

Location
Item Properties > Constant tab

Annotation on by Default

The Annotation on by Default property specifies whether to automatically add annotation 
boxes to variables used with a program or function block. Annotations allow you to include 
information that is displayed at the bottom of an input, output, input/output, or local variable. 
If you enable annotation for the project, the annotation display is automatically added to all the 
variables in the project. 
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The default is cleared, which means annotation is not automatically added.

Applies To
Variables

Location
Project menu > Project Options > Annotations tab

Application Type

The Application Type property determines whether an application element (program, function, 
function block, or tagname) is used with safety, control, or safety and control applications.

The default is Control.

Applies To
Programs, Functions, Function Blocks, and Tagnames

Locations
Item Properties > Application tab
Declarations > Application tab

Apply Command

The Apply command allows you to save and apply changes you have entered. For example, if 
you enter an initial value of 2 for a BOOL tagname and click Apply, a message indicates that the 
value and data type are not compatible.

Applies To
Validation of application elements 

Location
Item Properties > Constants or Point Assignment tab

Table 35 Application Types

Setting Description

Safety An application that is designed to take a process to a safe state when 
predetermined conditions are violated. Also referred to as an Emergency 
Shutdown System (ESD), Safety Instrumented System (SIS), and Safety Interlock 
System.
Applies to programs and tagnames.

Control An application that controls a process. Cannot be used in Safety programs. 
Applies to programs, functions, function blocks, and tagnames.

Safety or Control An application that includes a mixture of safety and control components.
Applies to functions and function blocks.
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Auto Indent Command

The Auto Indent Command toggles to allow you to use automatic indentation or set your own 
indentation in Structured Text code.

Applies To
ST programs and functions

Location
Auto Indent button, or View menu

Auto Name Command

The Auto Name command names more than one 
variable or constant according to a pattern that you 
specify. You can specify a name, starting value, and 
incremental value. You can also specify the order in 
which to apply the names to the selected elements. 

Properties include:

• Formatted Name on page 364

• Start Value and Increment on page 428

• Name Order on page 387

Applies To
Variables

Locations
Auto Name button, or Tools menu
Item Properties > Constants or Selected tab

Auto Scroll Delay

The Auto Scroll Delay property specifies how many milliseconds to delay scrolling while 
scrolling through the Structured Text. 

Applies To
ST Language

Location
View menu > Set Editor Options
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Backup Project Command

The Backup Project command saves a copy of the open project elements and settings, and 
creates a backup file named <project_name>.bt2.

Procedure

1 On the File menu, click Backup Project.

2 Specify the folder to save the file to. Use the suggested name or specify a new one. The 
file extension (.bt2) does not have to be included in the name.

3 Click Save.

Applies To
Project

Location
File menu

Base Address

For Tricon, the Base Address property specifies the block address for the Tricon HIM based on 
the Data Hiway memory map. Must be an integer between 5 and 31; the default is 5.

Applies To
Tricon HIM

Location
Controller tree > Configuration > HIM Setup

Baud Rate

The Baud Rate property specifies the data transmission speed. Settings include:

• For Tricon EICM: 19200, 9600, 4800, 2400, or 1200.

• For Tricon TCM: 115200, 57600, 38400, 19200, 9600, 4800, 2400, or 1200.

• For Trident: 115200, 57600, 38400, 19200, 9600, 2400, or 1200.

The default is 9600.

Applies To
Tricon EICM, Tricon TCM, Trident MP, Trident CM

Locations
Tricon Controller tree > Configuration > Hardware Allocation > EICM Setup
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Serial 
Ports tab
Tricon Controller tree > Configuration > TriStation Communication
Trident Controller tree > Configuration > Hardware Allocation > MP or CM Setup > Serial Ports tab
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Block Type
See SOE Block Type on page 426.

Border

The Border property specifies whether to include a border around an annotation or comment 
box. The border property can be specified for the project, or for individual annotations and 
comments.

Options include None, Single, and Double. The default is Single.

Applies To
Annotations, Comments

Locations
Item Properties > Comment tab
Project menu > Project Options > Annotations tab

Build Application Command

The Build Application command builds an application by compiling programs in the execution 
list that have been modified since the last time they were compiled. The command then links 
the object code, library routines, and configuration elements to create an executable application.

Each successive time you use the Build Application command, it compiles and links only 
documents and items that have changed since the last build.

After using the Build Application command several times, you should use the Rebuild 
Application command. A rebuild compiles and links all documents and items in the application, 
not just the ones that have changed since the last build.

Applies To
Application

Location

Build Application button, or Project menu

Category

The Category property specifies a name for a category that can be associated with documents 
(programs, functions, function blocks, and data types). By adding a category name, you can sort 
elements by type.

Applies To
Documents

Location
Right-click a document > Document Properties > Summary tab
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Cause Effect Matrix Support

The Cause Effect Matrix Support properties specify whether and how a function or function 
block can be used in a CEM program. For user-defined functions, function blocks, and data 
types, you can specify the setting. (For TriStation 1131 Library elements, the setting cannot be 
changed.) 

Settings include:

• Supports use in cause rows with ... inputs

• Supports use in effect columns with ... outputs

• Supports use in intersections

• Supports application defined states

The default is cleared for all options.

Applies To
Functions and function blocks used in CEM programs

Location

Application tree > right-click a function or function block > click Attributes tab

Cause Header Functions On by Default

The Cause Header Functions On by Default property specifies whether an input and function 
column are automatically included in the cause header when a CEM program is created. The 
default is cleared.

Applies To
CEM programs

Location
Tools menu > TriStation 1131 Options > CEM Editor tab

CEM Monitor Colors
The CEM Monitor Colors property specifies the colors to display for cause, effect, and 
intersection cells in a CEM program. These colors are used when the application is run on the 
controller or emulator. 

The default for True is red. The default for False is white.

Applies To
CEM programs

Location
Project menu > Project Options > Monitor Colors tab
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CEM Editor Options

The CEM Editor Options properties specify the initial settings used when a CEM program is 
created. Settings on individual CEM programs can be changed by setting the CEM Element 
Options on page 325. 

Properties include:

• Cause Header Functions On by Default on page 324

• Effect Header Functions On by Default on page 351

• Intersection Functions On by Default on page 373

• Default Number of Cause Rows on page 339

• Default Number of Effect Columns on page 339

Applies To

CEM programs

Location

Tools menu > TriStation 1131 Options > CEM Editor tab

CEM Element Options

The CEM Element Options properties specify the settings for a specific CEM program. For 
information on specifying initial properties, see Specifying CEM Element Options on page 94. 

Properties include:

• Enable Cause Header Functions on page 353
• Enable Effect Header Functions on page 354
• Enable Intersection Functions on page 355
• Enable Floating Text in Intersection Cells on page 355
• Evaluation Options on page 358

Applies To

CEM programs

Location

Open a CEM program > click the Document menu > click Options
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Change Colors Command

The Change Colors command displays a color palette that allows colors to be used when an 
element is displayed on a logic sheet.

Applies To
Project elements

Location
Tools menu > TriStation 1131 Options > Drawing Colors tab

Change Owner Command

The Change Owner command allows you to change the owner of a document. Normally, the 
owner of a document is the user who created it. 

Applies To
Programs and functions

Location
Right-click an element > Item Properties > Change Owner

Change State to Download All Command

The Change State to Download All command 
changes the download state so that the 
Download All command can be used when 
the application is downloaded. You cannot 
reverse this command. Before changing the 
state, you may want to make a backup copy of 
the application so that you can use it if you 
decide that a Download All command is not 
needed. 

This command is only available after an application has been downloaded to the controller. If 
the project is opened in a newer version of TriStation, this screen may be displayed to indicate 
that changes, such as adding new libraries, will require a Download All.

Applies To
Downloaded application

Location
Project menu

WARNING
The Download All command should not be used if the application on the 
controller is running on a live system. If needed, the system should be 
taken offline while the download is done.



327

TriStation 1131 Developer’s Guide, v4.1

Choose Another Tagname Command

The Choose Another Tagname 
command allows you to select a 
tagname and specify a different 
tagname to replace it. If there is more 
than one occurrence of the selected 
tagname, all occurrences are changed to 
the specified name. 

Applies To
Tagnames in FBD editor

Location
FBD editor > right-click a tagname in the Tagname Declarations tree

Clear History Command

The Clear History command deletes the history of actions, which is a listing of all changes made 
to a project. Each item includes the date, element, user, action, and comment for the change.

Applies To
Project

Location
Project menu

Client IP Address

The Client IP Address property specifies the IP address of the client that you want to allow, 
restrict, or deny access to the TCM. Also see IP Address on page 374.

Can be used in conjunction with the Client IP Subnet Mask property to create groups of IP 
addresses with the same access levels. 

Applies only to a model 4351A or 4352A Tricon Communication Module (TCM).

Applies To
Communication

Location

Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Access 
List tab
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Client IP Subnet Mask

The Client IP Subnet Mask property allows you to group IP addresses, so that you can create a 
single entry in the TCM client access list for all IP addresses on the subnet. Also see IP Subnet 
Mask on page 375. Applies only to a model 4351A or 4352A Tricon Communication Module 
(TCM).

Applies To
Communication

Location

Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Access 
List tab

Client Protocols

The Protocols property in the TCM client access list specifies the protocol(s) that the selected 
client can use to access the TCM. Applies only to a model 4351A or 4352A Tricon 
Communication Module (TCM).

Applies To
Communication

Location

Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Access 
List tab

Close Project Command

The Close Project command closes an open project and prompts you to save it if changes have 
been made.

Applies To
Project

Location
File menu

Table 36 TCM Client Access Protocols

Protocol Description

TSAA Stands for Triconex System Access Application, which is a protocol that 
enables client/server communication between Triconex controllers and PCs. 
OPC Server and DDE Server use TSAA protocol to exchange data with 
Triconex controllers. TSAA protocol can be used to write programs for 
accessing controller tagnames.

OPC Not supported by TriStation in this release.

TriStation A Triconex master/slave protocol in which the master (a TriStation 1131 PC) 
communicates with the slave (a Triconex controller) over an Ethernet network. 
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Coil Tool Command

The Coil Tool Command allows you to add a coil, which represents the state of an output variable.

Applies To

LD program or function

Location

Coil Tool button, or Tools menu > Select Tools

Coil Type

The Coil Type property represents the output state of a coil used in an LD program or function.

Applies To

LD program or function

Location
Item Properties > Selected tab

Table 37 Coil Type Symbols and Descriptions

Coil Type Symbol Description

Normal (Momentary) (  ) The state of the left link is copied to the associated Boolean 
variable and to the right link.

Negated (Momentary) ( /  ) The inverse of the state of the left link is copied to the associated 
Boolean variable and to the right link.

Positive Transition ( P ) The state of the associated Boolean variable is On from one 
evaluation to the next if the left link changes from Off to On.

Negative Transition ( N ) The state of the associated Boolean variable is On from one 
evaluation to the next if the left link changes from On to Off.

Set (Latch) ( S ) The associated Boolean variable is set to On if the left link is in 
the On state and remains On until reset by the RESET coil.

Reset (Unlatch) ( R ) The associated Boolean variable is reset to Off if the left link is in 
the On state and remains Off until set by the SET coil.
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Comment Tool

The Comment Tool allows you to draw a text box for a non-executable comment, and then type 
text inside the box.

Applies To
Logic sheets in user documents, test sheets in the Controller and Emulator Panels

Locations

Comment Tool button

Application tree > User Documents tree > Tools menu > Select Tool command
Configuration tree > Controller or Emulator Panel > Tools menu > Select Tool command

Communication Command

The Communication command displays the Communication screen on the Controller tree.

Applies To
Communication

Location

Communication button, or Controller tree > View menu > Go to > Communication

Compare Project to the Last Downloaded Command

The Compare Project to Last 
Download command allows you to 
compare the changes made in the new 
application to-be-downloaded with 
the application already downloaded 
to a controller. You can view the 
comparison online, or print a report. 
Differences between the project and 
the downloaded application are 
identified with a red asterisk (*). 

This report should be run for all 
safety applications.

Click each tab to compare differences. 
A red asterisk marks differences.

Applies To
Application and configuration elements

Location
Project menu
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Compile Command

The Compile command compiles the selected document and displays any errors.

Applies To

Programs, functions, and function blocks

Location

Compile button, or Document menu

Compile All User Documents Command

The Compile All User Documents command compiles all the user-created documents in a 
project.

Applies To

Application

Location

Project menu

Compiler Warning When Right Power Rail is Missing

The Compiler Warning When Right Power Rail is Missing property specifies whether to display 
a warning if the right rail is missing on a Ladder Diagram program. 

The default is cleared, which means a warning is not displayed if the right rail is missing.

Applies To

Ladder Diagram programs

Location
Tools menu > TriStation 1131 Options > LD Editor tab

Connect Command

The Connect command attempts to connect the TriStation PC to the controller or emulator, 
depending on whether the command is issued from the Controller or Emulator Panel.

When the Connect Command is issued from the Controller Panel, a screen allows you to change 
some default connection settings.
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Applies To
Communication modules, controller

Location

Connect button, or Controller or Emulator Panel > Command menu 

Contact Command

The Contact command allows you to add a contact to a Ladder Diagram. After adding a contact, 
you can specify the Contact Type.

Applies To

Ladder Diagrams

Location

Contact Tool button, or Tools menu > Select Tools

Contact Type

The Contact Type property specifies the type of a contact used in a Ladder Diagram.

Table 38 Connect Properties for Communication Modules

Communication 
Module Properties that can be set

Tricon EICM or NCM Serial or Network port settings.

Tricon TCM Serial or Network port settings, TriStation UDP Port Number, and Baud 
Rate (for serial connection only).

Trident MP or CM Serial or Network port settings.

Table 39 Contact Type Symbols and Descriptions

Contact Type Symbol Description

Normally Open —| |— The state of the left link is copied to the right link if the state of 
the Boolean variable is On.

Normally Closed —|  / |— The state of the left link is copied to the right link if the state of 
the Boolean variable is Off.

Positive 
Transition

—| P |— The state of the right link is On from one evaluation to the next 
when the associated variable changes from Off to On while the 
state of the left link is On.

Negative 
Transition

—| N |— The state of the right link is On from one evaluation to the next 
when the associated variable changes from On to Off while the 
state of the left link is On.
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Applies To

Contacts in Ladder Diagram programs

Location

Item Properties > Variable tab > Contact Type area

Continuous Refresh Command

The Continuous Refresh command continuously displays the current values of variables on test 
sheets or on the program document display. The default is On.

Applies To
Controller or Emulator Panel

Locations
Continuous Refresh button
Controller tree > Controller or Emulator Panel > Commands menu

Copy Command

The Copy command copies the selected items from the current tree or sheet and places them on 
the clipboard.

Applies To
Test sheets and elements in Controller or Emulator Panel
User documents and elements on logic sheets

Location
Copy button, or Edit menu

Copy Current Setup to Other Serial Ports Command

The Copy Current Setup to Other Serial Ports command copies the settings for the selected serial 
port to the other serial ports.

Applies To

Trident MP serial ports

Location

Trident Controller tree > Configuration > Hardware Allocation > MP Setup > Serial Ports tab
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Current Version

The Current Version property identifies the current version of the project under development. 
This is how the version is determined:

• The version of a newly created project is 1.0.

• If it is changed and saved after being downloaded to the controller, the minor number 
is increased by 1. For example, 1.1.

• If the state is changed to Download All, the major number is increased by 1 and the 
minor number is changed to 0. For example, version 1.1 is changed to 2.0.

Applies To

Projects

Location

Project menu

Cut Command

The Cut command deletes the selected items from the current tree or sheet and places them on 
the clipboard, erasing the previous clipboard contents.

Applies To
Test sheets and elements in Controller and Emulator Panels
User documents and elements on logic sheets

Location

Cut button, or Edit menu

Data Bits

The Data Bits property specifies whether the data format includes 7 or 8 data bits. To set this 
property, you must use Modbus slave or Modbus slave ASCII protocol. The default is 8 bits.

Applies To
Tricon EICM, Tricon TCM
Trident CM

Locations
Tricon Controller tree > Configuration > Hardware Allocation > EICM Setup
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Serial 
Ports tab
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Serial Ports tab
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Data Files

The Data Files property specifies the path name for documents including user libraries, 
configuration files, and custom report templates. The default path name and file extension is: 

C:\My Documents\Triconex\TriStation 1131 4.1\Data

Applies To

Project

Location

Tools menu > TriStation 1131 Options > Directories tab

Data Type

The Data Type property specifies the kind of data that can be stored in the variable. For more 
information about TriStation data types, see Appendix B, Data Types.

This table identifies the data types available for variables.

Applies To

Constants, local variables, and tagnames

Location
Item Properties > Constant or Declaration tab

Declarations Command

The Declarations command displays a dialog box that allows you to declare an input, output, 
in/out, local, or tagname declaration. Variables must be declared to be used in programs and 
functions.

Applies To

Variables

Location
Double-click a variable or right-click the Tagname Declarations folder

Table 40 Variable Data Types

Variables Data Types

Tagnames BOOL, DINT, REAL

Constants and local variables DATE, DT, DWORD, INT, LREAD, STRING, TIME, TOD
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Default Colors Command

The Default Colors command returns the colors of drawing items to the default colors. The color 
settings on your PC affect the default colors. This table describes the drawing items for which 
colors can be changed.

Applies To
Logic sheets in user documents
Test sheets in Controller and Emulator Panels

Location

Tools menu > TriStation 1131 Options > Drawing Colors tab

Default Connection

The Default Connection property specifies the initial setting used when the Connect dialog box 
is displayed. This setting can be changed in the Connect dialog box before connecting to the 
controller. This property is only available when both types of connections are selected in the 
Select Connections area. Default settings are:

• For Tricon, the default is Network Connection.

• For Trident, the default is Main Processor.

Applies To

Application, controller, modules

Location

Configuration tree > TriStation Communication

Table 41 Drawing Item Default Colors

Drawing Item Default Color

Element background Medium gray

Element text and border Black

Selected element background Dark blue

Selected element text White

Sheet background White

Sheet background (read-only documents) Medium gray

Zone division lines Medium gray
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Default Gateway IP Address

The Default Gateway IP Address property specifies the IP address of the gateway to which the 
controller is connected. Typically, this information is available from a network administrator or 
Information Technology department.

Applies To
Communication

Locations
Tricon Controller tree > Configuration > Hardware Allocation > ACM Setup
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > 
Network and Routing tabs
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Network or 
Routing tab

Default Language

The Default Language property specifies the programming language to use initially when 
creating a user document. The default is Function Block Diagram. 

Options include:

• Function Block Diagram

• Ladder Diagram

• Structured Text

• Cause Effect Matrix

Applies To

User documents

Location

Project menu > Project Options > Language tab

Default Macros or Text

The Default Macros or Text property specifies a default macro or text to include with a variable 
in a program, function, or function block.

Variable Program Defaults Function Defaults

Tag Refs %PGM_TAGNAME

Local variables %PGM_LOCAL %FB_LOCAL

I/O variables %PG_IO %FB_IO
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Default Macros for Annotations

The default macros used with annotations vary depending on the element and variable type. 
For example, the %PGM_TAGNAME macro expands to include the tagname 
(P1.WATER_LOW), location on controller (03.04.13), and alias number (10018).

Macros Used in the Default Macros

Macros beginning with %TAG cannot be modified.

Applies To

Annotations and Comments

Location

Item Properties > Annotation or Comment tab > Macros button

Table 42 Default Macros for Annotations

Macro Name Default Value Used With Sample Expanded 
Macro

%PGM_TAGNAME %TAG_MEMORYADDRESS%
TAG_ALIAS

Program 
Externals

P1.WATER_LOW
03.04.13 10018

%PGM_LOCAL %WHERE_USED Program Locals PROCESS_COUNT
1(C7) 3(D5) 4(A2)

%FB_INPUT <no default> Function Inputs <no default>

%FB_OUTPUT <no default> Function 
Outputs

<no default>

%FB_IO <no default> Function 
Inputs/Output

<no default>

%FB_LOCAL <no default> Function Locals <no default>

Table 43 %TAG Macros Used in the Default Macros

Macro Name Description

%PGM_TAGNAME The name of the point to which the program variable is connected.

%TAG_MEMORY
ADDRESS

The location of the point to which the program variable is connected. This 
only applies to physical input and output points and is displayed in this 
format:

• For Tricon: CC.SS.PP; where CC is the chassis, SS is the slot, and PP is the 
point. For memory points, an empty string is returned.

• For Trident: ii.ss.pp; where ii is the I/O processor number, ss is the 
module baseplate address plug number, and pp is the point number.

%TAG_ALIAS The Modbus alias of the point to which the program variable is connected. If 
the point has no alias, an empty string is returned.
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Default Number of Cause Rows

The Default Number of Cause Rows property specifies the number of rows added when a 
matrix is created using the CEM editor. The default is 22.

Applies To

CEM programs

Location
Tools menu > TriStation 1131 Options > CEM Editor tab

Default Number of Effect Columns

The Default Number of Effect Columns property specifies the number of columns added when 
a program (matrix) is created using the CEM editor. The default is 25.

Applies To
CEM programs

Location
Tools menu > TriStation 1131 Options > CEM Editor tab

Delete Command

The Delete command deletes the selected item. 

Applies To

Project elements

Location
Edit menu

Delete Columns Command

The Delete Columns command displays a dialog box that allows you to specify the number of 
columns to delete in a CEM program and the beginning column position.

Applies To
CEM programs

Location
Delete Columns button, or Edit menu
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Delete Rows Command

The Delete Rows command displays a dialog box that allows you to specify the number of rows 
to delete and the beginning row position.

Applies To
CEM programs

Location
Delete Rows button, or Edit menu

Delete Unreferenced Tagnames Command

The Delete Unreferenced Tagnames command removes tagnames that are not used in programs 
or functions.

Applies To
Tagnames

Location
Application tree > Tagname Declarations 

Description

The Description property specifies descriptive text about the selected item. The maximum 
number of characters is 131, which can include A to Z, and 0 to 9. The underscore character 
( _ ) can also be used, but not as the first character in the description. To include this text in an 
annotation or comment, use the %DESCRIPTION macro.

Applies To
Project elements

Locations
Item Properties > Selected or Declarations tab
Project menu > Security > New or Modify > Add User or Modify User

Destination IP Address

The Destination IP Address property specifies an IP address which is used if the controller is not 
on the same subnet as other devices.

Applies To
Communication

Locations
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Routing tab
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Routing tab
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Destination Gateway IP Address

The Destination Gateway IP Address property specifies the IP address of the gateway device 
which is used if the controller is not on the same subnet as other devices.

Applies To
Communication

Locations
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > 
Network and Routing tabs
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Routing tab

Destination IP Subnet Mask

The Destination IP Subnet Mask property specifies the binary pattern that is matched with the 
IP address to turn part of the host ID address field into a field for subnets.

Applies To
Communication

Locations
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Routing tab
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Routing tab

Destination UDP Port

The Destination UDP Port property specifies the port number for other controllers on a Peer-to-
Peer network.

Applies To
Peer-to-Peer communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Peer-
to-Peer tab

Differential AI Input Type

The Differential AI Input Type property specifies the input type for an analog input point. Only 
available with AI model 3721. Options include:

• Unipolar: 0 to 5 volts with 6% over-range.

• Bipolar: -5 to 5 volts with 6% under-range and over-range.

For detailed range information, see Resolution Type on page 408.

The default is Unipolar.
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Applies To

Analog input points

Location

Controller tree > Configuration > Hardware Allocation > Differential AI Setup

Directories
See:

• Data Files on page 335

• Project Files on page 403

• Temporary Files on page 431

Disable OVD on All Modules Command

For Tricon, the Disable OVD on All Modules command disables Output Voter Diagnostics 
(OVD) on the points of all digital output modules in a controller (except Supervised DO 
modules, which cannot have OVD disabled). The application must be running on a controller 
to use this command.

For Trident, OVD is disabled for individual points by using the SYS_OVD_INHIBIT function. 
For more information, see the TriStation 1131 Libraries Reference.

The default OVD state is enabled for all digital output points.

Applies To
Application

Location
Controller tree > Controller Panel > Commands menu

WARNING
A safety application may not disable the output voter diagnostic.
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Disable OVD on Module... Command

For Tricon, the Disable OVD on Module... command disables Output Voter Diagnostics (OVD) 
for all points on specified digital output modules in the controller. The application must be 
running on a controller to use this command.

OVD cannot be disabled for points on a Supervised Digital Output module.

For Trident, OVD is disabled for individual points by using the SYS_OVD_INHIBIT function. 
For more information, see the TriStation 1131 Libraries Reference.

The default OVD state is enabled for all digital output points.

Applies To
Application, modules

Location
Controller tree > Controller Panel > Commands menu

Disable Programming and Control Operations
Trident only. See Set Programming Mode Command on page 418.

Disable Remote Changes to Outputs

The Disable Remote Changes to Outputs property specifies whether external devices can write 
to output points in the TriStation application. If selected, external devices cannot write to output 
points regardless of the settings for other properties. You should select this check box if the 
application includes safety-critical outputs.

The default is selected, which means output points cannot be changed by external devices.

Applies To
Application

Locations
Tricon Controller tree > Configuration > Operating Parameters
Trident Controller tree > Configuration > Hardware Allocation > MP Setup > Operating 
Parameters tab

WARNING
A safety application may not disable the output voter diagnostic.
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Disable Scaling 

For Trident, the Disable Scaling property specifies whether REAL numbers are scaled to 
integers when they are transmitted from a Trident controller. For Tricon, REAL values are 
always scaled.

The default is cleared, which means real numbers are not scaled.

Applies To
Modbus communication 

Location
Application tree > Tagname Declarations> Item Properties > Scaling tab

Disable Stop on Keyswitch

For Tricon, the Disable Stop on Keyswitch property specifies whether to logically disable the 
STOP position of the keyswitch on the Tricon Main Chassis so that the application is not stopped 
if the key is turned to the STOP position. If selected, setting the keyswitch to STOP does not halt 
the application.

The default is cleared, which means that the application is stopped if the keyswitch is turned to 
STOP.

Applies To
Application

Location
Controller tree > Configuration > Operating Parameters

Disconnect Command

The Disconnect command disconnects an application from the controller or emulator.

Applies To
Communication

Locations
Disconnect button
Controller tree > Controller or Emulator Panel > Commands menu

Setting Description

Selected Two consecutive 16-bit aliases are assigned to each REAL tagname so that IEEE 754 
single-precision, floating-point representation is used. This option is available 
because Modbus has a 16-bit size limitation. Only the first alias of the two is 
displayed in the Modbus Alias field of the Declaration tab. 

Cleared Only one alias is used.
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Display Program Document Command

The Display Program Document command allows you to monitor the execution (power flow) 
of an FBD program or LD program while an application is emulated in TriStation or run online 
on a controller.

You can perform monitoring using the default colors or custom colors, which you can change 
online using the Project Options command. After changing the monitor colors, you must 
perform a Download Changes operation for the new colors to take effect. 

Applies To

Programs

Locations
Display Program Document button
Controller tree > Controller or Emulator Panel > Commands menu

Display Report Command

The Display Report command displays a selected report.

Applies To
Reports

Location
Project tree > Report viewer toolbar

Display Tabular View Command

The Display Tabular View command displays tagnames in a table format, which allows you to 
change multiple tagnames at a time. To make sorting and changing easier, you can also change 
the columns that are displayed and the order in which they are displayed.

Properties include: tagname, point type, alias type, data type, point address, description, S/C (safety 
or control), retain (Retentive), alias #, Min Span, Max Span, Group 1, Group 2, and initial value. 

Applies To

Tagnames

Location

Application tree > right-click Tagname Declarations folder
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DO Point Options

The DO Point Options property specifies the type of fault detection used for the point. Each 
point can be specified with one of these options. 

Available only with the 3625 digital output module.

Applies To
Tricon DO Points

Location
Controller tree > Configuration > Hardware Allocation > DO Setup

Document Access

The Document Access property specifies whether the document can be read, read and written 
to (changed), or is locked. Settings include:

• Read: Any user can read the document, which means it can be viewed.

• Read/Write: Any user can read or change the document.

• Lock: Only users with the same or higher security level can read and write the 
document. 

The default is Read/Write.

Applies To
Programs, functions, function blocks, and data types

Location
Right-click a document > Properties > Summary tab

Table 44 DO Point Options

Option Description

Not Used Fault detection is the same as for Non-Supervised points, except reporting of 
benign field fault conditions is suppressed.
Points configured as Not Used will be energized if the application commands 
them on.

Non-Supervised Fault detection includes:
• Detection of all internal faults, including those in the output circuitry.
• Detection of external faults associated with the field device or wiring—

limited to loss of field power and shorted loads under most conditions.
Non-supervised is the default.

Supervised Fault detection includes:
• Detection of all internal faults, including those in the output circuitry.
• Detection of all external faults associated with field device or wiring, such as, 

loss of power, shorted loads, open loads, and so on.
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Document Type

The Document Type property specifies whether a document is a program, function, function 
block, or data type.

Applies To
Document

Location

Project menu > New Document

Double Space

The Double Space property specifies whether to display double spaces between the terminals (inputs 
and outputs) on a function or function block, which provides additional space for annotations and 
comments. This setting specifies spacing on an individual function or function block.

The default is cleared, which means the terminals are single spaced.

Applies To
Functions and function blocks

Location
Item Properties > Function tab > Terminals > Double Space

Double Space Function (Block) Terminals by Default

The Double Space Function Block Terminals property specifies whether to display double space 
between the terminals (inputs and outputs) on a function or function block, which allows space 
for annotations and comments. This setting affects all new functions and function blocks created 
in a project.

The default is cleared, which means the terminals are single spaced by default.

Applies To
Functions and function blocks

Location
Tools menu > TriStation 1131 Options > FBD Editor tab and LD Editor tab

CAUTION
If you select Double Space after input and output variables have been 
attached to the function or function block, the variables will have to be 
reattached.
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Download All Command

The Download All command downloads an application to the controller or emulator.

Applies To
Application

Locations
Download All button
Controller > Controller or Emulator Panel > Commands menu

WARNING
A Download All command requires that the application on the controller 
is halted.

Table 45 Download All Required

Component Description

Chassis Required if adding, changing (the type), or deleting a chassis.
To avoid a Download All after the initial download, include the 
maximum number of chassis in the application before downloading the 
application.

Functions and function 
blocks

Required if changing or deleting a function or function block.

Memory allocation Required if changing memory allocation.

Modules Required if moving or deleting modules in the configuration.

Node Number Required if changing the address plug and node number configuration. 

Number of Send or 
Receive function blocks

Required if increasing or decreasing the number of send or receive 
function blocks.

Operating Parameters Required if changing the Allow Disabling of Points property.

Programs Required if changes to a program exceed available memory. Required if 
deleting a program.

Tagnames Required if importing tagnames from an Excel or database file. Required 
if changes to tagnames require additional memory allocation.

Variables Required if changes to variables require additional memory allocation.
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Download Changes Command

The Download Changes command downloads changes made to an application, while an 
application is running on the controller. This command is only available on the Controller Panel.

Applies To
Application changes

Locations
Download Changes button
 Controller tree > Controller Panel > Commands menu

WARNING
• Changing a safety-critical application that is running on a controller 

should be avoided because an error in the application could cause a 
trip or unpredictable behavior.

• For additional warnings, see Using the Download Changes Command 
on page 314.

Table 46 Download Changes Allowed

Element Description

Functions and 
function blocks

Allowed if adding a function or function block, but not if changing or deleting an 
existing function or function block.

IP Address Allowed, but not advised, if the IP address of a communication module is changed.

Modules Allowed if adding a module to an empty slot, which has sufficient memory 
allocated for the points. Not allowed if moving or deleting modules.

Operating 
Parameters

Allowed if changing these properties:
Disable Remote Changes to Outputs
Password Required for Connection
Restart on Power-Up (Trident only)
Scan Time
Use Local Time

Programs Allowed if adding or changing a program and there is sufficient memory. Not 
allowed if deleting a program.

Tagnames Allowed if adding, changing, or deleting tagnames. 
Tagnames can also be disconnected or connected to different points, if there is 
enough memory allocated for the required point types. 
Points must be enabled.

Variables Allowed if changing variable properties does not require additional memory 
allocation. 
If the Initial Value is changed, the value is not used until the application is stopped 
and restarted. 
Points must be enabled.
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Downloaded Version

The Downloaded Version property identifies the version of the application (project) that is 
downloaded and running on the controller.

Applies To

Projects

Location

Project menu

Drawing Item

The Drawing Item property specifies the colors to use to with elements on logic sheets.

Applies To
Logic sheets

Location
Tools menu > TriStation 1131 Options > Drawing Colors tab

Drop Command

The Drop command drops all the logic elements enclosed by the comment box so they are not 
part of the comment.

To drop, double-click the comment box, click the Pickup/Drop tab, and click Drop.

Applies To
Comments

Location
Item Properties > Pickup/Drop tab 

Edit...Macros Commands

The Edit Document Macros, Edit Project Macros, and Edit Sheet Macros commands allow you 
to specify text for macros that can be used in annotations and comments.

Applies To
Documents

Location
Document, Project, and Sheets menu
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Edit Sheet Title Command

The Edit Sheet Title command displays a dialog box that allows you to enter a title for the logic 
sheet. 

Applies To

Logic sheets

Location

Sheets menu

Edit Title Block Command

The Edit Title Block command displays a dialog box that allows you to add information to the 
title block that is used when the CEM program is printed.

Applies To
CEM programs

Location
Sheets menu

Edit/View Source Command

The Edit/View Source command displays the source code for the selected element. The source 
code can be edited only for user-created functions and function blocks.

Applies To
CEM programs

Location
Application tree > User Documents > open a CEM program > right-click in the FBD Network

Effect Header Functions On by Default

The Effect Header Functions On by Default property specifies whether an output and function 
column are automatically included in the effect header when a CEM program is created. The 
default is cleared.

Applies To

CEM programs

Location

Tools menu > TriStation 1131 Options > CEM Editor tab
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EN/ENO

The EN/ENO property specifies whether to include EN (an input parameter) and ENO (an 
output parameter) in the function.

• For the FBD language, the parameters are optional.

• For the LD language, the parameters are required.

Usage

• If EN/ENO is visible on any function in a network, then EN/ENO must be visible on 
every function in the network.

• If there is more than one function with EN/ENO visible in a network, then for every 
function except the last function, you must connect the ENO output directly to the EN 
input of the next function.

• You must not connect an ENO output to more than one EN input.

Applies To

Functions

Location
Item Properties > Function tab

Parameter Description

EN An input parameter that enables invocation of the function and carries power from the 
left power rail.

• If True, the function was called and ENO indicates whether the function detected 
an error.

• If False, the function was not called and the value of ENO is set to False.

ENO An output parameter that indicates whether the function detected an error and 
connects either to the EN input of the next function or to the ground rail.

• If True, the function did not detected any errors.
• If False, the function detected an error, and evaluation of the network stops—the 

return value is not written to any variable.
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Enable Access List Command

The Enable Access List command turns on user access control for the TCM, so that client access 
list settings are used to determine which IP addresses can access the TCM, and whether that 
access is read-only, read/write, or denied. Applies only to a model 4351A or 4352A Tricon 
Communication Module (TCM).

Applies To
Communication

Location

Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Access 
List tab

Enable All Disabled Points Command

The Enable All Disabled Points command enables all disabled points on an application running 
on the controller.

Applies To
Application, tagnames

Location
Configuration tree > Controller or Emulator Panel > Commands menu

Enable Cause Header Functions

The Enable Cause Header Functions property specifies whether an input and function column 
are included in a cause header of a CEM program. The default is cleared, which means cause 
header functions are not included.

Applies To
CEM programs

Location
Application tree > open a CEM program > Document menu > Options

Enable Color Monitoring

The Enable Color Monitoring property specifies whether color is used when the application is 
run on the controller or emulator. The default is cleared, which means that color monitoring is 
not used.

Applies To

Programs

Location

Document Properties > Attributes tab
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Enable Communication with Tricon V8 and V9 Peer-to-Peer Systems

The Enable Communication with Tricon V8 and V9 Peer-to-Peer Systems property specifies 
whether communication is enabled with these systems.

Applies To

Peer-to-Peer communication

Location

Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Peer-
to-Peer tab

Enable Effect Header Functions

The Enable Effect Header Functions property specifies whether an output and function column 
are included in an effect header of a CEM program. The default is cleared, which means effect 
headers are not included.

Applies To
CEM programs

Location
Application tree > open a CEM program > Document menu > Options

Enable EN/ENO Terminals on Functions by Default

The Enable EN/ENO Terminals on Functions by Default property specifies whether to 
automatically include EN (BOOL input) and ENO (BOOL output) parameters that detect and 
isolate errors in FBD and LD logic. The default is cleared, which means EN/ENO terminals are 
not automatically included.

Applies To

Functions

Location

Tools menu > TriStation 1131 Options > FBD Editor tab
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Enabled Features

The Enabled Features property specifies whether to allow programs, functions, function blocks, 
data types, and multiple program to be created in the project. Options include:

• Programs

• Functions

• Function Blocks

• Data Types

• Multiple Programs

The default is all options are selected, which means all options are enabled.

Applies To

Programs, functions, function blocks, data types, multiple programs

Location

Project menu > Project Options > Language tab

Enable Floating Text in Intersection Cells

The Floating Text Functions property allows the name of the function or function block to be 
displayed in a neighboring cell of the CEM matrix if it is empty. This may be useful if the name 
of the function or function block is long. The default is cleared.

Applies To
CEM programs

Location
Application tree > open a CEM program > Document menu > Options

Enable Intersection Functions

The Intersection Functions property specifies whether a function column is included in the 
intersection of a CEM matrix. The default is cleared, which means intersection functions are not 
included.

Applies To
CEM programs

Location
Application tree > open a CEM program > Document menu > Options
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Enable Macro Editing

The Enable Macro Editing property specifies whether you can change the value for a user-
modifiable macro. 

User-modifiable macros are identified with a pencil graphic  on the Edit Macros screen. 

The default is cleared, which means the macro value cannot be changed.

Applies To

Annotations and Comments

Location

Item Properties > Style tab

Enable Multiple Writes

The Enable Multiple Writes property specifies whether a tagname can be written to multiple 
times from programs in the application. If this property is not selected and the tagname is 
written to more than once, an error is displayed when the program is compiled.

The default is cleared, which means the tagname can only be written to once in an application.

Applies To

Tagnames

Location

Application tree > double-click a tagname > Point Assignment tab

Enable OVD on All Modules Command

For Tricon, the Enable OVD on All Modules command enables Output Voter Diagnostics (OVD) 
on the points of all digital output modules in a controller.

The default OVD state is enabled for all digital output points.

Applies To

Application, modules

Location

Tricon Controller tree > Controller Panel > Commands menu

WARNING
A safety application may not disable the output voter diagnostic.
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Enable OVD on Module... Command

For Tricon, the Enable OVD on Module... 
command enables Output Voter Diagnostics 
(OVD) for all points on specified digital output 
modules in the controller. The default OVD state 
is enabled for all digital output points.

Applies To

Application, modules

Location

Tricon Controller tree > Controller Panel > 
Commands menu

Enable Programming and Control Operations
For Trident only. See Set Programming Mode Command on page 418. 

Enable Time Synchronization with External Source
See Time Synchronization on page 433.

Enable Tricon Node Time Synchronization

For Tricon, the Enable Tricon Node Time Synchronization parameter enables the controller to 
participate in time synchronization across the Peer-to-Peer network as a Triconex Time 
Synchronization master or slave node. 

The default value is cleared, which means the controller will not synchronize time across the 
Peer-to-Peer network. See also Time Synchronization on page 433.

Applies To
Communication

Location
Controller tree > Configuration > Operating Parameters
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Enable UCN Test Mode

For Tricon, the Enable UCN Test Mode property specifies whether UCN test mode is enabled 
on the Tricon SMM module. The default is cleared.

Applies To

Tricon SMM

Location

Tricon Controller tree > Configuration > Hardware Allocation > SMM Setup

Enlarge Font Size Command

The Enlarge Font Size command increases the size of the font for the entire ST program or function.

Applies To

ST programs and functions

Location

Larger Font button, or View menu

Evaluation Options

The Evaluation Options property specifies how a matrix is evaluated when it includes multiple 
intersections between a cause and effect. The evaluation can be based on AND or OR logical 
processing. The default is OR.

OR Evaluation

If the matrix is based on an energize-to-trip system, such as a fire suppression system, an OR 
evaluation is typically used because the normal state of inputs is False. If one of the inputs 
changes to True, the related outputs also change to True.

AND Evaluation

If the matrix is based on a de-energize-to-trip (fail-safe) system, an AND evaluation is typically 
used because the normal state of inputs is True. If one of the inputs changes to False, the related 
outputs also change to False. This is why it is typically used with systems that are designed to 
be fail-safe.

Applies To
CEM programs

Location
Application tree > open a CEM program > Document menu > Options
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Exactly Once

The Exactly Once setting indicates that each function block instance should be executed exactly 
once per scan because the function block contains internal data that must be updated exactly 
once per scan.

For user-defined function blocks, you can specify this setting.

For Triconex Library function blocks, the setting cannot be changed.

Applies To
Library and user-defined function blocks 

Location
Document Properties > Usage tab

Exit Command

The Exit command closes the current project and quits the TriStation 1131 application.

Applies To

Project

Location

Edit menu 

Expand Macros

The Expand Macros property specifies whether the values or the name of the macro displays. If 
selected, the value displays. For example, the macro %DATE_CREATED displays the month, 
day, and year when the project was created.

The default is cleared, which means the name, not the value, of the macro is displayed.

Applies To

Annotations and Comments

Location

Item Properties > Style tab
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Export Command

The Export command specifies a database or text file to export points to. If the file is to be 
imported back to TriStation, the filename must be eight characters or less.

Applies To

Tagnames

Location

Right-click the Tagname Declarations folder

Export Destination

The Export Destination property specifies the destination to use when exporting a report file. 

Settings include Disk file and Microsoft Mail. The default is Disk file.

Applies To

Reports

Location

Export Report button on Project tree > Reports toolbar

Export Format

The Export Format property specifies the format to use when exporting a report file. Formats 
include:

The default is PDF.

Applies To

Reports

Location

Export Report button on Project tree > Reports toolbar

Acrobat Format (PDF) Excel 8.0 (XLS) (Extended)
Character-separated values Paginated Text
Comma-separated values (CSV) Rich Text (Exact) Format
Excel 5.0 (XLS) Tab-separated text
Excel 5.0 (XLS) (Extended) Tab-separated values
Excel 7.0 (XLS) Text
Excel 7.0 (XLS) (Extended) Word for Windows document
Excel 8.0 (XLS) XML
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Export Report Command

The Export Report command exports the viewed report to a file format and destination you 
specify.

Applies To

Reports

Location

Export Report button on Project tree > Reports toolbar

FBD Editor Options

The FBD Editor options include:

• Double Space Function (Block) Terminals by Default

• Enable EN/ENO Terminals on Functions by Default

• Left-Handed Wire Tool

Applies To

Functions and function blocks

Location

Tools menu > TriStation 1131 Options > FBD Editor tab

Field Maximum Power

For Trident, the Field Maximum Power property specifies the maximum range for power, based 
on volts on the Pulse Input Module. The default is 33 volts.

Applies To

Pulse Input Module

Location

Trident Controller tree > Configuration > Hardware Allocation > Pulse Input Setup

Field Minimum Power

For Trident, the Field Minimum Power property specifies the minimum range for power, based 
on volts for the Pulse Input Module. The default is 0 volts.

Applies To
Pulse Input Module

Location
Controller tree > Configuration > Hardware Allocation > Pulse Input Setup
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Field Power

For Trident, the Field Power property specifies whether field power is connected to the Pulse 
Input Baseplate for use by the field sensors. The default is cleared, which means that field power 
is absent.

Applies To
Trident Pulse Input Setup

Location
Trident Controller tree > Configuration > Hardware Allocation > Pulse Input Setup

Field Power Monitoring

For Tricon, the Field Power Monitoring property specifies whether the module should monitor 
the 24V field power (also known as loop power) at the external termination panel. When field 
power monitoring is on, the module will report when field power at the term panel goes in or 
out of range. 

Available only with the 3720 and 3721 analog input modules. Applicable only if you are using a 
term panel that passes field power to the module.

If you are not using a term panel that passes field power to the module, you must select Off. If 
you select On, and the term panel does not support field power monitoring, you will see Field 
Power faults on the module.

The default is Off.

Applies To
AI Modules

Location
Tricon Controller tree > Configuration > Hardware Allocation > Single-Ended and Differential 
AI Setup

Setting Description

Field Power Absent Select if field power is not connected to the PI Baseplate. This setting is 
typically chosen if all the field sensors are passive.

Field Power Present Select if field power is connected to the PI Baseplate. This setting is 
typically chosen if some or all the sensors are active. 
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Find In Application Command

The Find In Application command finds the specified text by searching through the entire 
application (project). Click the Options button to further narrow the search. 

Applies To

Application elements

Location

Edit menu

Find Text Command

The Find Text command finds the specified text in the current program, function, or function 
block. Click the Options button to narrow the search. 

Applies To

Application elements

Location

Edit menu

Find Text Options

The Find Text Options dialog box allows you 
to narrow the search for text on a specific 
element or in an application. 

Applies To

Application elements

Location

Find Text button, or View menu
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Formatted Name

The Formatted Name property specifies a pattern to use when naming variables. The pattern 
includes:

• Text: The text used as the base for the name.

• Macro: The numbering scheme to use as an increment.

— For theater numbering (A to Z, and AA to ZZ), use %A.

— For normal numbering, (0-nnn), use %0.

For example, ALARM_%0 would result in names of ALARM_1 through ALARM_nnn. 
ALARM_%A would result in ALARM_A ... ALARM_Z, depending on the start and increment 
value, and the number of variables.

Applies To

Comments and variables in user documents 

Locations
Item Properties > Auto Name > Auto Name button
Tools menu > Auto Name Selected Items

Font Size

The Font Size property specifies the size of the font displayed for Structured Text code.

Applies To

ST Language

Location

View menu > Set Editor Options

FP Ordering

The FP Ordering property specifies which 16-bit section of a floating point number is read first. 

• High 16 Bits First: the 16 most significant bits of the floating point number are read first. 

• Low 16 Bits First: the 16 least significant bits of the floating point number are read first.

The default value is Low 16 Bits First.

Applies To

Modbus communication

Location

Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Serial 
Ports and Modbus TCP tabs
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Function Variables
See Default Macros or Text on page 337.

Full Name

The Full Name property specifies the name of the user. 

Applies To

User Security

Location

Project menu > Security > Users tab > Modify button

Function Block Command

The Function Block command allows you to add multiple function blocks at the same time to a 
program. If a function block has not been selected, a dialog box allows you to select the function 
block

Applies To

Programs

Location

Function Block button, or Tools menu > Select Tool > Function Blocks

General Monitor Colors

The General Monitor Colors property specifies the colors to display for the value of BOOL 
variables and wires.

The default for True is red.

The default for False is green.

Applies To
Tagnames

Location
Project menu > Project Options > Monitor Colors tab
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Global Positioning System Installed

For Tricon, the Global Positioning System Installed property specifies whether a GPS interface 
is installed. The default is cleared, which means GPS is not installed.

Applies To
Tricon communication, Time Synchronization

Location
Tricon Controller tree > Configuration Panel > NCM Setup

Go To Cell Command

The Go To Cell command allows you to go to a specific row and column in the matrix. 

Applies To
CEM programs

Location
Application tree > User Documents > Programs > open a CEM program > Edit menu

Group 1 and Group 2

The Group 1 and Group 2 properties specify group names to use for tagnames. Group names 
allow you to categorize tagnames by a name you define. Group 2 is subordinate to group 1. All 
the tagnames in a group must be of the same data type. The name can be a maximum of 63 
characters.

Applies To
Tagnames

Location
Tagname Declarations > Declaration tab

Halt Command

The Halt command stops the execution of an application in the controller or emulator. In Halt 
mode, tagnames retain the values they had in the scan during which the application was halted.

For Tricon, the Halt command is used. For Trident, the Halt command or the SYS_APP_HALT 
function can be used.

Applies To
Application

Locations
Halt button
Configuration tree > Controller or Emulator Panel > Commands menu
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Handshake

The Handshake property specifies whether to use signals to establish a valid connection. With 
hardware handshake, a separate wire sends a signal when the receiving device is ready to 
receive the signal, which ensures that a device transmits data only when the other device is 
ready to receive it. 

• On the Tricon EICM, the switch settings determine whether handshaking is allowed.

• On the Tricon TCM, the setting is configured on the Serial Ports tab.

• On the Trident CM, the setting of the Transceiver Mode property determines whether 
hardware handshake is valid.

The default is None, which means hardware handshake is not used. 

Settings include:

Used with RS-232 Transceiver Mode

With the Handshake property set to Hardware, the Trident CM asserts the Request to Send 
(RTS) signal when it has a message to transmit. The CM begins transmission when it receives a 
Clear to Send (CTS) signal from the Modbus master. The Trident CM ignores all characters 
unless the Modbus master asserts the Data Carrier Detect (DCD) signal. This settings allows the 
Modbus master to use half-duplex modems.

With the Handshake property set to None (typically for point-to-point connections), the Trident 
CM asserts RTS at all times and ignores CTS and DCD. In other words, the CM transmits 
characters even if the receiving device is not ready. This could result in an overrun state, and the 
characters would have to be re-transmitted.

Used with RS-485 Transceiver Mode

With the Handshake property set to Hardware, the Trident CM enables its RS-485 transmit 
driver only when it is sending data. Use this setting for all single-pair networks and for slave 
ports in two-pair, multi-point networks.

With the Handshake property set to None, the Trident CM enables its RS-485 transmit driver at 
all times. Use this setting for a Modbus slave port in a two-pair, point-to-point network.

Setting Description

Hardware Select for:
• Any 2-wire configuration (required)
• A multi-point configuration that uses the RS-485 transceiver mode (required)
• A point-to-point configuration that uses an external modem with RS-232 

transceiver mode (optional)

None Select for configurations that do not allow or require Hardware Handshake.
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Applies To
Communication

Locations
Tricon Controller tree > Configuration > Hardware Allocation > EICM Setup
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Serial 
Ports tab
Trident Controller tree > Configuration > Hardware Allocation > MP Setup > Serial Ports tab
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Serial Ports tab

Hardware Allocation Command

The Hardware Allocation command displays the Hardware Allocation screen in the Controller 
tree.

Applies To
Configuration

Location

Hardware Allocation button, or View menu

Hide Causes Unrelated to Effects Command

The Hide Causes Unrelated to Effects command hides causes on a CEM program that are not 
related to an effect.

Applies To
CEM programs

Location
View menu

Hide Effects Unrelated to Causes Command

The Hide Effects Unrelated to Causes command hides effects on a CEM program that are not 
related to a cause.

Applies To
CEM programs

Location
View menu
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Horizontal Network Divider Command

The Horizontal Network Divider command allows you to place a horizontal divider on a logic 
sheet to divide networks.

Applies To
FBD logic sheets

Location

Horizontal Network Divider button, or Tools menu > Select Tool

IDLE State

IDLE is an application state which indicates that the TriStation PC is connected to a controller 
or the emulator, but the application has not been downloaded.

Applies To

Application

Location

Controller tree > Controller or Emulator Panel > Title bar

Import Command

The Import command provides a wizard that allows you to specify the fields to import, and how 
to link them to tagname properties.

Applies To

Tagnames

Location

Right-click the Tagname Declarations folder

Include Monitor Value in Annotation

The Include Monitor Value in Annotation property specifies whether to display the value of the 
variable in the annotation. The default is cleared, which means the value is not displayed in the 
annotation.

Applies To

Variables

Location

Item Properties > Annotation tab



370 Appendix A Commands and Properties

TriStation 1131 Developer’s Guide, v4.1

Initial Value

The Initial Value property specifies the beginning value assigned to a variable on the first scan 
of the application. The value can be changed with a Download Changes command, however, 
the value is not used until a first scan which is not issued with the Download Changes command. 

A first scan occurs under any of these conditions:

• The Download All and the Run command are issued

• The Halt command and the Run command are issued

• The application is restarted after a power failure

To identify whether a first scan has occurred, use the TR_SCAN_STATUS (Tricon) or 
SYS_SYSTEM_STATUS (Trident) function blocks.

In programs, only local variables are assigned an initial value. In functions and function blocks, 
all variables are assigned an initial value. The value is either the value declared for the property 
or zero.

Applies To

Tagnames, Variables

Location

Application tree > Tagname Declarations > Declaration tab

Insert Columns Command

The Insert Columns command displays a dialog box that allows you to insert columns in a CEM 
program.

Applies To

CEM programs

Location

Insert Columns button, or Edit menu

Insert From File Command

The Insert From File command displays an Open dialog box that allows you to select a file to be 
inserted in the ST program or function.

Applies To
ST programs and functions

Location
Edit menu
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Insert Input Variable Command

The Insert Input Variable command inserts an input variable to a logic sheet.

Applies To
CEM, FBD, and LD functions

Location
Input Variable Tool button, or Edit menu

Insert In/Out Variable Command
The Insert In/Out Variable command inserts an in/out variable to a logic sheet. In Structured 
Text language, VAR IN/OUT are added to the code, not inserted by a command.

Applies To

FBD and ST functions and function blocks

Location

In/Out Variable Tool button, or Edit menu

Insert Local Variable Command

The Insert Local Variable command inserts a local variable to a logic sheet.

Applies To
CEM, FBD, and LD programs

Location
Local Variable Tool button, or Edit menu

Insert Output Variable Command

The Insert Output Variable command inserts an input variable to a logic sheet.

Applies To

FBD and LD functions

Location
Input Variable Tool button, or Edit menu
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Insert Module Command

The Insert Module command displays a dialog box that allows you to select a module to add to 
the configuration. 

Applies To
Hardware configuration

Locations
Insert Module button (on Trident Configuration toolbar)
Tricon Configuration tree > Hardware Allocation > double-click slot
Trident Configuration tree > Hardware Allocation > MP/IOP1 > Tools menu

Insert Rows Command

The Insert Rows command displays a dialog box that allows you to insert rows in a CEM program.

Applies To
CEM programs

Location
Insert Rows button, or Edit menu

Insert Tagname Declaration Command

The Insert Tagname Declaration command inserts a tagname declaration to the program.

Applies To
FBD and LD programs

Location
Tagname Declaration Tool button, or Edit menu

Internal State

The Internal State setting means each function block instance may have an internal state which 
is remembered from one execution to the next and from one scan to the next. There are no 
restrictions on usage of a function block labeled internal state; that is, you can execute the 
function block instance more than once per scan, or you can skip scans.

For user-defined function blocks, you can specify this setting. For Triconex Library function 
blocks, the setting cannot be changed.

Applies To
Library and user-defined function blocks 

Location
Document Properties > Usage tab
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Intersection Functions On by Default

The Intersection Functions On by Default property specifies whether a function column is 
automatically included in the intersection when a matrix is created. The default is cleared.

Applies To

CEM programs

Location

Tools menu > TriStation 1131 Options > CEM Editor tab

Invert Input

The Invert Input property specifies whether to invert the value of a BOOL input that is 
connected to a function or function block. If selected, the value for the input is changed to the 
opposite value when the function or function block is executed. For example, if the value is True 
it is changed to False.

The default is cleared, which means the input value is not inverted. 

When an input is inverted, a small circle (referred to as a fiducial) is displayed 
on the input terminal of the function. 

Applies To

BOOL input points

Location

Function and function blocks

Invert Input/Output

The Invert Input/Output property specifies whether to invert the value of a BOOL 
input/output that is connected to a function block. If selected, the value for the input/output is 
changed to the opposite value when the function block is executed. For example, if the value is 
True it is changed to False.

The default is cleared, which means the input value is not inverted. 

When an input/output is inverted, a small circle (referred to as a fiducial) is 
displayed on the input terminal of the function. 

Applies To

BOOL input points

Location

Function blocks
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Invert Output

The Invert Output property specifies whether to invert the value of a BOOL output that is 
connected to a function or function block. If selected, the value for the output is changed to the 
opposite value when the function is executed. For example, if the value is True it is changed to 
False. 

The default is cleared, which means the output value is not inverted. 

When an output is inverted, a small circle (referred to as a fiducial) is displayed 
on the output terminal of the function. 

Applies To

BOOL output points

Location

Functions and function blocks

IP Address

The IP Address property specifies a unique 32-bit address of a computer attached to a network. 
A network uses IP addresses to route messages to their destinations. An IP address is formatted 
as four numbers separated by periods, where each number can be zero to 255. An example is 
1.160.10.240. Every client and server in a network requires an IP address which is either 
permanently or dynamically assigned at startup. The defaults are as follows:

• ACM/NCM: 192.168.1.<node number>

• TCM: 192.168.0.<node number> for NET 1; 192.168.1.<node number> for NET 2 

Applies To

Communication

Locations
Controller tree > Configuration > Communication
Tricon Controller tree > Configuration > Hardware Allocation > ACM or NCM Setup
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > 
Network, Peer-to-Peer, Modbus TCP, and Printer tabs
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Network or 
Printer tab
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IP Subnet Mask

The IP Subnet Mask property specifies a binary pattern that is matched with the IP address to 
turn part of the host ID address field into a field for subnets.

• For Tricon ACM and TCM, see the network administrator.

• For Tricon NCM, do not change the default setting which is eight zeroes.

• For Trident CM, see the network administrator.

Applies To

Communication

Locations
Tricon Controller tree > Configuration > Hardware Allocation > ACM and NCM Setup
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > 
Network and Routing tab
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Network and 
Routing tab

Item Properties Command

The Item Properties command displays an Item Properties dialog box, which varies depending 
on the item currently selected.

Applies To
Chassis, modules, tagnames, variables

Location
Item Properties button, or View menu

Language

The Language property specifies the language to be used for the program, function, function 
block, or data type. Settings include:

• Function Block Diagram

• Ladder Diagram

• Structured Text

• Cause Effect Matrix

Applies To
Programs, functions, function blocks, and data types

Location
Project menu > New Document
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LD Editor Options

The LD Editor Options include:

• Compiler Warning When Right Power Rail is Missing on page 331

• Double Space Function (Block) Terminals by Default on page 347

• Left-Handed Link Tool on page 376

Left-Handed Link Tool

The Left-Handed Link Tool specifies whether to have the link tool configured for left-handed 
use for LD programs. The default is cleared, which means the right-handed link tool is used.

Applies To
Ladder Diagrams

Location
Tools menu > TriStation 1131 Options > LD Editor tab

Left-Handed Wire Tool

The Left-Handed Wire Tool specifies whether to have the wire tool configured for left-handed 
use for FBD programs. 

The default is cleared, which means the right-handed tool is used.

Applies To
Project

Location
Tools menu > TriStation 1131 Options > FBD Editor tab

Line Width

The Line Width property specifies the number of characters per line. The default is 80.

Applies To
Project

Locations
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Printer tab
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Printer tab
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Link Command

The Link command draws a horizontal or vertical link between power rails and logic elements. 
The direction of the link determines how it is evaluated in the logic.

Applies To

LD programs

Location

Link Tool button, or Tools menu, Select Tools

List Disabled Points Command

The List Disabled Points command displays a list of all disabled points on a controller, so that 
individual points can be selected and enabled. To use this command, the application must be 
running on the controller.

Applies To
Tagnames

Location
Controller tree > Controller Panel > Commands menu

Loc

The Loc property displays the coordinates for the location of an element in terms of cause row 
and effect column in a CEM program. For example, C01 identifies cause 1 and C02E02 identifies 
the intersection of cause 2 and effect 2.

Applies To
CEM programs

Location
Application tree > open a CEM program > Variable Detail Table

Link Direction Description

Horizontal Transmits the state of the element on its immediate left to the element on its 
immediate right. The state represents the Inclusive OR of the On states of the 
horizontal links on its left side.

Vertical Intersects one or more horizontal link elements on each side. The state is copied to 
all attached horizontal links on its right, but is not copied to attached horizontal 
links on its left.

• Is Off if the states of all attached horizontal links to its left are Off.
• Is On if the state of one or more attached horizontal links to its left is On.
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Location

The Location property specifies the location of the tagname based on the position in the Tricon 
chassis or Trident system. The address is a three-part number in this format: CC.SS.PP

For example, 01.02.23 is the address for point 23, on the module in slot 2, in chassis 1.

Applies To

Tagnames

Locations
Tricon Controller tree > Configuration > Hardware Allocation > DO and PI Setup
Trident Controller tree > Configuration > Hardware Allocation > PI Setup

Log On As New User Command

The Log On As New User command allows you to save and close the current project and log on 
as a different user. You are prompted on whether to save project elements.

Applies To
Project

Location
File menu

Logon Name

The Logon Name property specifies the identifier used to log on to the TriStation 1131 project.

Applies To
User access

Location
Project menu > Security > Users tab > New or Modify button

Identifier Description

CC Stands for Tricon chassis, or Trident I/O Processor (IOP).

SS Stands for slot (Tricon), or baseplate (Trident).

PP Stands for point number.
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Macros Command

The Macros command displays macros that can be included in an annotation or comment. You 
can specify whether to display macros available by Project, Document, or Sheet.

To copy, click the macro and press Ctrl+C. To paste, close the Edit Macro dialog box, click in the 
Comment area, and press Ctrl+V.

Applies To
Comments and variables

Locations
Document, Project, and Sheets menus
Annotation tab (tagnames and variables), or Comments tab (comments)

Main Processor Connection Setup

For Trident, the Main Processor Connection Setup property specifies which MP is connected to 
the TriStation PC. The options are left, middle, and right. The default is left.

Applies To
TriStation communication

Location
Trident Controller tree > Configuration > TriStation Communication

Manage Sheets Command

The Manage Sheets command displays a screen that allows you to manage logic sheets. These 
commands are on the Sheets Manager screen.

Applies To

Logic sheets

Location

Sheets menu

Command Action

Append Adds a new sheet after an existing sheet.

Insert  Adds a new sheet before an existing sheet

Delete Delete the selected sheet.

Title Allows you to edit the title of the current sheet. The sheet title is displayed 
in the title block, the window caption bar and the Window Menu list.

Go To Click a sheet to be displayed, and then click Go To.
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Manage Views Command

The Manage Views command allows you to save, load, and remove views of a CEM program. 
These commands are on the View Manager screen.

Applies To
CEM programs

Location
View menu

Master Logical Port

The Master Logical Port property specifies the logical port number that the TriStation 
application uses with Modbus Master Functions to access the port. This property is only 
available for Modbus Master.

Applies To
Modbus Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > 
Modbus TCP and Serial Ports tabs

Maximum Number of Peer-to-Peer Receives

The Maximum Number of Peer-to-Peer Receives property specifies the maximum number of 
Receive function blocks for each TriStation application. To conserve memory and minimize scan 
time, set this number as low as possible. However, if you plan to add Receive function blocks in 
the future, specify the anticipated maximum to avoid having to perform a Download All later. 

This number set for Receive and Send does not have to be the same. The default is 0.

Applies To
Peer-to-Peer communication

Location
Application tree > Implementation > Peer-to-Peer Configuration

Command Action

Load Click a view and click Load to have it displayed.

Save Click to save the view currently displayed.

Remove Click a view and click Remove to delete the view from the list.

Restore All Defaults Click to restore the current view to show all causes and effects.

Close Click to close the View Manager screen.

Cancel Click to cancel the action.



381

TriStation 1131 Developer’s Guide, v4.1

Maximum Number of Peer-to-Peer Sends

The Maximum Number of Peer-to-Peer Sends property specifies the maximum number of Send 
function blocks for each TriStation application. To conserve memory and minimize scan time, 
set this number as low as possible. However, if you plan to add Send function blocks in the 
future, specify the anticipated maximum to avoid having to perform a Download All later.

The number set for Send and Receive does not have to be the same. The default is 0.

Applies To

Peer-to-Peer communication

Location

Application tree > Implementation > Peer-to-Peer Configuration

Maximum RPM

The Maximum RPM property specifies the revolutions per minute for the device attached to the 
Pulse Input Module. The number must be a positive floating point value.

The default is 30,000.

Applies To
Pulse Input Module

Location
Controller tree > Configuration > Hardware Allocation > Pulse Input Setup

Maximum Speed

The Maximum Speed property specifies the speed for the device attached to the Pulse Input 
Module. The number must be a positive floating point value.

The default is 30,000.

Applies To
Pulse Input Module

Location
Controller tree > Configuration > Hardware Allocation > Pulse Input Setup

Maximum Value (Max Span)

The Maximum Value (Max Span) value identifies the maximum value for the range to scale a 
REAL tagname to an integer; must be greater than the minimum value.

The maximum value and default value is 32,767. (For Honeywell, the maximum value is 9,999.)
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Applies To

Tagnames with REAL data types

Location

Application tree > Tagname Declarations > Scaling tab

Memory Address

The Memory Address property specifies where information about input, output, and memory 
tagnames is stored in the Triconex controller.

Each tagname in a section is assigned to a memory address which is shown in TriStation in the 
format <section>.<offset>. For example, MBW.0012 is the 12th memory BOOL read/write 
aliased point in the controller.

Applies To

Tagnames

Location

Application tree > Tagname Declarations > Item Properties > Point Assignment tab

Section Name Description

MBN Memory BOOL unaliased points

MBR Memory BOOL read aliased points

MBW Memory BOOL read/write aliased points

MIN Memory DINT unaliased points

MIR Memory DINT read aliased points

MIW Memory DINT read/write aliased points

MRN Memory REAL unaliased points

MRR Memory REAL read aliased points

MRW Memory REAL read/write aliased points

IBR Input BOOL read aliased points

IIR Input DINT read aliased points

IRR Input REAL read aliased points

QBW Output BOOL read/write aliased points

QIW Output DINT read/write aliased points



383

TriStation 1131 Developer’s Guide, v4.1

Memory Allocation Command

The Memory Allocation command displays the Memory Allocation screen in the Controller tree.

Applies To
Configuration

Location
Memory Allocation button, or View menu

Message Options Command

The Message Options command allows you to 
specify the type of messages to be sent between the 
TriStation PC and controller, and is generally used 
to troubleshoot problems. 

The default for all options is cleared.

Applies To
Troubleshooting problems

Location
Configuration tree > Controller Panel > Tools 
menu > Message Options

Message View Command

The Message View button displays a message area at the bottom of the TriStation 1131 screen. 
Tabs in the area allow you to display information for Application, Controller, Find Results, and 
Compare Results. You can toggle the Workspace View On or Off.
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Applies To
View

Location
Message View button, or View menu > Messages

Minimum Value (Min Span)

The Minimum Value (Min Span) value identifies the minimum value for the range used to scale 
a REAL tagname to an integer; must be less than the maximum value. The minimum value and 
default value is –32,767. (For Honeywell, the minimum value is 0.)

Applies To

Tagnames with REAL data types

Location

Application tree > Tagname Declarations > Scaling tab

Modbus (Minimum and Maximum) Range

The Modbus (Minimum and Maximum) Range property specifies the minimum and maximum 
limits of values communicated via serial ports. This property is used with the Minimum Value 
(Min Span) and Maximum Value (Max Span) to communicate REAL values using Modbus or 
Honeywell protocol.

• The minimum value is -32768; the default is 0.
• The maximum value is 32767; the default is 32767.
• For Honeywell, the minimum is 0; the maximum is 9,999.

Applies To
Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > EICM Setup
Tricon Controller tree > Configuration > Hardware Allocation >Enhanced TCM Setup > Serial 
Ports tab
Trident Controller tree > Configuration > Hardware Allocation > MP and Setup > Serial Ports tab
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Modbus Slave Address

The Modbus Slave Address property specifies the number of the Modbus slave device which is 
connected to the Modbus master. This property is only available if using Modbus slave, and 
master/slave protocols. If using Modbus master protocol, the address of the slave is specified 
in the Modbus Read and Write function blocks.

The address can be from 1 to 247; the default is 1.

Applies To
Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > EICM Setup
Tricon Controller tree > Configuration > Hardware Allocation >Enhanced TCM Setup > Serial 
Ports tab
Trident Controller tree > Configuration > Hardware Allocation > MP and Setup > Serial Ports tab

Mode

The Mode property specifies the type of communication, which can support one or more 
communication protocols.

Applies To
Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > NCM Setup
Trident Controller tree > Configuration > Hardware Allocation > MP and CM Setup > Network 
tab

Table 47 Communication Modes

Modes Supported Protocols

Open Network TriStation, TSAA, OPC, DDE, and printer protocol

Peer-to-Peer Peer-to-Peer and Time Synchronization

TriStation TriStation
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Monitor Display Options

The Monitor Display Options include properties that specify the names and colors for BOOL 
variables. 

Properties include:

• True State Name: the default is TRUE.

• False State Name: the default is FALSE.

• True Color: the default is red.

• False Color: the default is green.

Applies To
BOOL values 

Location
Application tree > Tagname Declarations > Item Properties > Display tab

Monitor Value on by Default

The Monitor Value on by Default property specifies whether to display the value of the variable 
when the program or function block is executed.

The default is cleared, which means the monitor does not display the value of the variable.

Applies To
Variables

Location
Project menu > Project Options > Annotations tab

Move Behind Logic Elements

The Move Behind Logic Elements property moves a selected comment box behind a logic 
element, which means the element is considered part of the comment and not executed with the 
logic.

The default is cleared, which means the element is not enclosed in a comment.

Applies To
Annotations and Comments

Location
Item Properties > Style tab
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Name

The Name property specifies an identifier or description for an element.

Applies To
Variables, Contacts, Coils

Location
Item Properties 

Name Order

The Name Order property specifies how automatic naming is applied to the selected variables.

Settings include:

• Rows—Names are applied vertically, from left to right.

• Columns—Names are applied horizontally, from top to bottom.

• Selection order—Names are applied based on the order in which they were selected.

Applies To

Comments and variables in user documents 

Location
Item Properties > Auto Name > Auto Name button
Tools menu > Auto Name Selected Items

Network

The Network property specifies the TCM network port—NET 1 or NET 2— that the selected 
external device is connected to. 

Applies To

Communication 

Location
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup

Feature Description

Restrictions The name must begin with an alpha character (A to Z) and can include up to 31 
alphanumeric characters (A to Z, and 0 to 9), including the underscore (_) 
character. Letters are not case-sensitive.

Version Numbers Names of documents include a version number at the end of the name. The 
number includes a major number, which is always 1 and a minor number, 
which changes when the document is changed, saved, and closed.
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New Document Command

The New Document command opens a dialog box that allows you to specify the type of 
document to create and the type of language to use.

Applies To
Application

Location
Project menu

New Project Command

The New Project command creates a new project.

Applies To
Project

Location
File menu

New Tagname Command

The New Tagname command opens a screen that allows you to specify a new tagname. 

Applies To
Tagnames

Locations
Project menu
Application tree > right-click Tagname Declarations

New Tagnames Command

The New Tagnames command opens a screen that allows you to create multiple tagnames based 
on a naming scheme. Properties include:

• Formatted Name on page 364

• Start Value and Increment on page 428

• Name Order on page 387

Applies To
Tagnames

Location
Project menu
Application tree > right-click Tagname Declarations
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NIC Index

The NIC Index property specifies the index position of the network interface card in the 
TriStation PC. 

To determine the NIC index:

1 Open the Control Panel and click the System icon. 

2 On the Hardware tab, click Device Manager, and then expand the Network Adapters tree. 

3 Starting with zero, count down the list of adapter cards to the one that is connected to the 
TriStation PC. For example, if your adapter card is fifth in the list, its index position is 4.

Applies To
Communication

Location
Controller tree > Configuration > TriStation Communication

Node Name

The Node Name property specifies the name for a Triconex controller, which can be a default 
name or a user-defined name. The default names are TRINODE01 through TRINODE31.

Applies To
Communication

Location
Controller tree > Configuration > TriStation Communication 

Node Number

The Node Number property specifies a number for a Triconex controller, which must be the same 
as on the switch setting (Tricon) or the address plug (Trident). The numbers can be from 1 to 31.

Applies To
Communication

Location
Controller tree > Configuration > TriStation Communication 

Number of Extended Block

For Tricon, the Number of Extended Block property specifies a pair of HIM blocks consisting of 
a base block and a secondary block (which is offset from the six-bit block address by 32). The 
default is 4. For more information, see the HIM User’s Guide.

Applies To
Tricon HIM

Location
Tricon Controller tree > Configuration > Hardware Allocation > HIM Setup
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Number of Gear Teeth

For Trident, the Number of Gear Teeth property specifies the number of gear teeth that are 
counted in each revolution for the Pulse Input Module. The PI Point Options property must be 
specified as RPM to enable this property. The default is 60.

Applies To
Trident Pulse Input Module

Location
Trident Controller tree > Configuration > Hardware Allocation > Pulse Input Setup

Number of Inputs

The Number of Inputs property specifies the number of inputs to include with the function. 
Only extensible functions, which are functions that can include additional inputs, have this 
property.

For more information, see the TriStation 1131 Libraries Reference.

Applies To
Functions

Location
Item Properties > Function tab

OFFLINE State

The OFFLINE state is an application state which indicates the application is not connected to the 
emulator or to a controller.

Applies To
Application

Location
Controller tree > Controller or Emulator Panel > Title bar

On NET 1 Enable Time Synchronization
See Time Synchronization on page 433

On NET 2 Enable Time Synchronization
See Time Synchronization on page 433.
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Only Once

The Only Once setting means each instance of a function block should be executed only once 
per scan, but does not need to be executed every scan. This means the function block has internal 
data that does not need to be updated on every scan, but should not be updated more than once 
per scan.

For user-defined function blocks, you can specify this setting. For Triconex Library function 
blocks, the setting cannot be changed.

Applies To
Library and user-defined function blocks 

Location
Document Properties > Usage tab

Open Document Command

The Open Document command opens an existing document.

Applies To
Application

Location
Project menu

Open Point Alarm Threshold

The Open Point Alarm Threshold property specifies the number of ohms above which values 
are alarmed as an open load. This option is only available if the points are supervised.

Typical threshold values are 480 to 3200 ohms. The available range is 0 to 65,535 ohms. The 
default is 2400 ohms.

Available only with the model 3625 digital output module.

Applies To

Tricon DO points

Location
Tricon Controller tree > Configuration > Hardware Allocation > DO Setup

Open Project Command

The Open Project command allows you to specify an existing project to open.

Applies To
Project

Location
File menu
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Operation Type

The Operation Type property specifies whether the security selection is for controller operations 
or TriStation 1131 operations. Depending on the selection, different operations are displayed.

Applies To
Project

Location
Project menu > Security command > Privileges tab

Operations

The Operations property specifies TriStation and controller operations that can be assigned a 
security level. These tables describe the operations and default settings for security levels.

Table 48 Controller Operations

Panel Operation Description Default
Level

 Controller Change point values Permits use of the Set Value command for 
variables in the Controller and Emulator Panels.

1

Download All Permits use of the Download All command in 
the Controller and Emulator Panels. 

1

Download Changes Permits use of the Download Changes command 
in the Controller and Emulator Panels. 

1

Enable and disable 
points

Permits points to be disabled in the Controller 
Panel. 

1

Change state to 
Download All

Permits state to be changed from Download 
changes to Download All.

1

Halt and run 
mismatched application

Permits use of the Halt, Download All, and Run 
commands when the project executing in the 
controller does not match the application that is 
currently open in TriStation.

1

Halt application Permits use of the Halt command in the 
Controller and Emulator Panels.

1

Modify configuration Permits use of the Configuration editor and the 
Build Element, Build Configuration, and Rebuild 
Configuration commands.

1

Modify Controller Panel Permits use of the Controller Panel. 1

Open Configuration Permits the Configuration editor to be opened. 1

Open Controller Panel Permits use of the Controller Panel. 1–2

Pause and Single Step 
application

Permits use of the Pause and Single Step 
commands in the Controller or Emulator Panel.

1
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Run Application Permits use of the Run command in the 
Controller or Emulator Panel.

1

Set Operating 
Parameters

Permits the operating parameters to be set. 1

Emulator Open Emulator Panel Permits use of the Emulator Panel. 1–3

Table 49 TriStation Operations

Type Operation Description Default
Level

Elements Change Access 
Attributes

Permits changes to Access Attributes property, 
which allows Read Only, Read/Write, or Lock 
status. 

1–3

Change Owner Permits using the Change Owner command to 
change the owner of a document.

1–3

Modify control elements Permits creating, modifying, and deleting 
programs, functions, and function blocks which 
are defined for control applications.

1–5

Modify safety elements Permits creating, modifying, and deleting 
programs, functions, and function blocks which 
are defined for safety applications.

1–5

View elements Permits viewing of programs, functions, and 
function blocks.

1–9

Libraries Export Permits exporting project documents to a 
shared library.

1–2

Import Permits importing shared libraries. 1–2

Printing Print reports Permits printing of reports. 1–9

Update report database Permits use of the Update Data command. 1–5

Project Change Project Options Permits changes to properties in Project 
Options.

1–3

Change state to 
Download All

Permits use of Change State to Download All 
command.

1–2

Clear history logs Permits use of the Clear History command. 1–2

Security Add/Modify Users Permits adding, modifying, and deleting users 
if the user has equal or higher privileges than 
the selected user. 

1–2

Change level 
descriptions

Permits changes to the names associated with 
security levels.

1–2

Table 48 Controller Operations (continued)

Panel Operation Description Default
Level
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Applies To
Security

Location
Project menu > Security > Privileges tab

Organize Command

The Organize command allows you to organize the data types, functions, and function blocks 
in the TriStation 1131 Libraries in these ways:

• By Library: Organizes by the library where the elements are located.

• By Type: Organizes by Functions and Data Types.

• By Category: Organizes by the typical usage. For example, Arithmetic, Data Type, 
Counter, and so on.

• By Name: Organizes alphabetically by name.

The default is By Type.

Applies To

TriStation 1131 Library data types, functions, and function blocks

Location

Application tree > right-click the Library Documents folder

Parity

The Parity property indicates whether to use parity checking, which is a way to detect data 
communication errors on the transmitted data.

Odd and Even parity counts the number of 1 bits in a one-byte data item then sets the parity bit 
(9th bit) to 0 or 1 to result in an Odd or Even total number of 1 bits. Mark and Space parity (also 
called high/low parity) set the parity bit to 1 or 0 regardless of the number of 1 bits in the data 
item.

Settings include:

• Odd sets the parity bit to 0 or 1 to make the total number of 1 bits odd.

• Even sets the parity bit to 0 or 1 to make the total number of 1 bits even.

Change level privileges Permits changes to the privileges associated 
with security levels if the user has equal or 
higher privileges than the selected user.

1–2

Workbench Change TriStation 
Options

Permits changes to properties in TriStation 
Options.

1–2

Table 49 TriStation Operations (continued)

Type Operation Description Default
Level
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• Mark sets the parity bit to 1 for each data item.

• Space sets the parity bit to 0 for each data item.

• None deletes the parity bit.

The default is Odd.

Applies To
Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Serial 
Ports tab
Tricon Controller tree > Configuration > Hardware Allocation > EICM Setup
Trident Controller tree > Configuration > Hardware Allocation > Trident MP or CM Setup > 
Serial Ports tab

Password

The Password property specifies a code required to access the project or to perform certain 
operations in the project.  The default is PASSWORD.

Applies To
Security

Location
Controller tree > Configuration > Operating Parameters
Project menu > Security command > Users tab > Add or Modify button

Password Required for Connection

The Password Required for Connection property 
specifies whether a password is required to 
connect to the controller. If selected, you must 
enter a password. This setting takes effect after 
the application is downloaded to the controller. 

The default is cleared, which means a password is 
not required. 

If selected, a dialog box displays that requires the 
password to be entered before the connection can 
be attempted.

Applies To
Security

Location
Controller tree > Configuration > Operating Parameters
Project menu > Security command > Users tab > Add or Modify button
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Paste Command

The Paste command puts the current contents of the clipboard onto the current sheet.

Applies To

Editing

Location

Paste button, or Edit menu

Pause Command

The Pause command pauses the execution of an application in the controller or the emulator. If 
an application is paused, the Run command must be used to resume execution.

Applies To
Application

Location
Pause button
Configuration tree > Controller or Emulator Panel > Commands menu

Peer-to-Peer Time Synchronization Enabled

The Peer-to-Peer Time Synchronization Enabled property determines whether the Triconex 
Time Synchronization protocol is used to synchronize time with controllers on the network.

Applies to TCM models 4351 and 4352 only. 

Applies To
Communication

Location

Tricon Controller tree > Configuration > Hardware Allocation > TCM Setup > Peer-to-Peer tab
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Permission

The Permission property specifies the level of access to the TCM for the selected client IP 
address. If the application includes safety-critical outputs, you should not set this property to 
Read/Write.

Applies only to a model 4351A or 4352A Tricon Communication Module (TCM).

Applies To
Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Access 
List tab

Physical Address

The Physical Address property specifies the physical point location on an input or output 
module. The address is a three-part number in this format: CC.SS.PP

For example, 01.02.23 is the address for point 23, on the module in slot 2, in chassis 1.

Applies To

Input and output tagnames

Location

Application tree > Tagname Declarations > Item Properties > Point Assignment tab

Setting Description

Deny Access Prevents all access to resources provided by the TCM. Connections to the 
Tricon are not allowed.

Read Allows client to connect to the Tricon and view information provided via 
the TCM. Does not allow the client to change any settings or perform 
certain commands.

Read/Write Full access. Allows client to view information provided by the TCM, 
change settings, and perform all commands (including Download 
Changes or Download All for TriStation). This access level should only be 
provided to trusted clients.

Identifier Description

CC Stands for Tricon chassis, or Trident I/O Processor (IOP).

SS Stands for slot (Tricon), or baseplate (Trident).

PP Stands for point number.



398 Appendix A Commands and Properties

TriStation 1131 Developer’s Guide, v4.1

Pickup Command

The Pickup command picks up all the elements enclosed by the comment box so they are 
considered part of the comment and ignored by the compiler.

To pick up, move the comment box so it entirely covers the elements to be captured. Resize the 
box if needed.

To drop, double-click the comment box, click the Pickup/Drop tab, and click Drop.

Applies To
Comments

Location
Item Properties > Pickup/Drop tab

PI Point Options

The PI Point Options properties specify options on the Pulse Input Module. Settings include:

• Maximum RPM on page 381

• Maximum Speed on page 381

• Scale Factor on page 413

Applies To
Pulse Input Setup

Location
Controller tree > Configuration > Hardware Allocation > Pulse Input Setup

Point Assignment

The Point Assignment properties specify whether the point uses an alias, and whether the point 
has a physical or local address.

Properties include:

• User alias: A number that can be assigned if the point is a Read or Read/Write Alias.

• Default alias: A number is automatically assigned if the point is a Read or Read/Write 
Alias.

• No alias: Means the point is input, output, or an unaliased memory point.

Applies To
Tagnames

Location
Tagname References > Item Properties > Point Assignment tab
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Point Type

The Point Type property specifies the type of tagname. Settings include:

• Input

• Output

• Memory

Applies To

Tagnames

Location

Item Properties > Point Assignment tab

Port Selection

The Port Selection property specifies the port to be configured. The default is port 1 or Left.

Applies To
Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > EICM Setup
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Serial 
Ports tab
Trident Controller tree > Configuration > Hardware Allocation > MP Setup > Serial Ports tab
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Serial Ports tab

Table 50 Protocols Available with Specific Ports

Module Selections

Tricon EICM Ports 1–4 and 6–9: TriStation, Debug, Modbus Slave, Modbus Master, 
and Modbus Master Slave.
Ports 5 and 10: Printer.

Tricon TCM Ports 1–3 and 6: Modbus Slave RTU, Modbus Slave ASCII, Modbus 
Master, and GPS.
Ports 4 and 9: Modbus Slave ASCII, Modbus Slave RTU, Modbus Master, 
and TriStation.
Ports 5 and 10: Printer.

Trident MP Left, middle, and right: Modbus Slave RTU.

Trident CM Ports 1–3 and 6–8: Modbus Slave ASCII, Modbus Slave RTU, Modbus 
Master, Modbus Master/Slave.
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Port Write Enabled

The Port Write Enabled property provides a fast and easy way to manage port security if you 
don’t want to configure a user access list (see Controlling Access to the TCM on page 267). 

Select this property to allow TriStation, TSAA, or Modbus writes to the selected port. The 
default value is cleared, meaning the port is read-only.

Projects converted from earlier versions of TriStation will have the default value automatically 
set for this property, so that ports configured for TSAA, Serial Modbus Slave, and TCP Modbus 
Slave will be read-only until selected otherwise. 

Applies only to a model 4351A or 4352A Tricon Communication Module (TCM).

Applies To
Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > 
Network, Serial Ports, and Modbus TCP tabs

Precision

The Precision property specifies the number of decimals to use with a REAL point that has been 
scaled. The default is 0.

Applies To
Tagnames with REAL data types

Location
Application tree > Tagname Declarations > Item Properties > Scaling tab

Previous Sheet Command

The Previous Sheet command displays the previous logic sheet.

Applies To

Logic sheets

Location

Previous Sheets button, or Sheets menu
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Print Command

The Print command prints the logic sheets or reports displayed in the current window.

Applies To

Logic Sheets, Reports

Location

Print button, or Edit menu

Print Preview Command

The Print Preview command displays the sheets to be printed.

Applies To

Logic Sheets, Reports

Location

Edit menu

Print Report Command

The Print Report command allows you to print the selected report.

Applies To

Reports

Location

Print Report button, or Edit menu

Printer Number

The Printer Number property specifies the number used in the Printer parameter declared for 
the print function blocks in the TriStation 1131 project. The value must be from 1 to 10.

Applies To

Project

Location
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Printer 
tab
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Printer tab
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Privilege

The Privilege property specifies whether Read or Read/Write access is allowed by external 
devices. You should set this property to Read, if the application includes safety-critical outputs.

Applies To

Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > ACM Setup
Tricon Controller tree > Configuration > Hardware Allocation > NCM Setup
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Network tab

Program Execution List

The Program Execution List property identifies the programs included in the application. 
Programs can be added, deleted, or moved up and down in order. 

Applies To

Application

Location

Application tree > Implementation > Execution List

Program Command

The Program command allows you to implement or change an application in these ways:

• Perform a Download All or Download Changes

• Disable points

• Change the values of points

For Tricon, the Program command is set by turning the keyswitch to PROGRAM.

For Trident, the Program command is set with the Set Programming Mode command in the 
Controller Panel, or the SYS_SET_APP_LOCK function in a program.

Setting Description

Read An external device cannot write to any point, regardless of the settings for other 
properties.
This is the default for Tricon ACM.

Read/Write Other properties may need to be set to enable write access. See Disable Remote 
Changes to Outputs on page 343.
This is the default for Tricon NCM and Trident CM.
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Applies To
Application, controller

Location
Tricon keyswitch on PROGRAM
Trident Configuration tree > Controller Panel > Set Programming Mode command
Trident Application tree > Programs > SYS_SET_APP_LOCK function

Prohibit Writes

For Tricon, the Prohibit Writes property specifies whether to deny Honeywell workstations 
from writing to the application running on the Tricon controller.

The default is cleared, which means Honeywell workstations can write to memory and output 
tagnames.

Applies To
Tricon HIM Module

Location
Tricon Controller tree > Configuration > Hardware Allocation > HIM Setup

Project Description Command

The Project Description command displays information about the project including the file 
name and location, current and downloaded version, and controller type.

Applies To

Project

Location

Project menu

Project Files

The Project File property specifies the path name for documents including projects and related 
files. The default path name and file extension is: 

C:\My Documents\Triconex\TriStation 1131 4.1\Projects

Applies To

Project

Location

Tools menu > TriStation 1131 Options > Directories tab
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Protocol

The Protocol property specifies the communication protocol used with the port. This table 
describes the protocols available with specific communication modules. 

Applies To

Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > EICM and NCM Setup
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Serial 
Ports and Modbus TCP tabs
Trident Controller tree > Configuration > Hardware Allocation > MP and CM Setup

Table 51 Communication Module Available Protocols

Protocol Description Communication Module

GPS Controller receives time synchronization 
via the Global Positioning System. 

Tricon TCM

Modbus Slave Controller acts as a slave to a Modbus 
master.

Tricon EICM

Modbus Slave ASCII Controller acts as a slave to a Modbus 
master with data sent in pairs of ASCII 
characters.

Tricon TCM, Trident CM

Modbus Slave RTU Controller acts as a slave to a Modbus 
master with data sent in 8-bit binary 
characters.

Tricon TCM, Trident MP 
and CM

Modbus TCP Slave Net Controller acts as a slave to a Modbus 
master on an open network.

Tricon TCM

Modbus Master Controller acts as a Modbus master. Tricon EICM and TCM, and 
Trident CM

Modbus TCP Master Controller acts as a Modbus master on an 
open network.

Tricon TCM

Modbus Master/Slave Controller acts as a Modbus master or 
slave.

Tricon EICM and Trident 
CM

Peer-to-Peer Controller communicates with other 
controllers on an open network.

Tricon NCM, TCM and 
Trident CM

TriStation 1131 Controller communicates with a TriStation 
PC. The NCM/TCM communicates on an 
open network. The EICM/TCM connect on 
a serial port.

Tricon EICM, NCM, TCM 
and Trident CM
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Pulses Per Revolution

For Trident, the Pulses Per Revolution property specifies the number of pulses per revolution 
of the measuring shaft for the Pulse Input Module. The default is 1.

Applies To
Trident Pulse Input Module

Location
Trident Controller tree > Configuration > Hardware Allocation > Pulse Input Setup

Rate Type

The Rate Type property specifies how the Pulse Input Module is to measure pulse inputs. 
Settings include:

• Speed: Used for pulses measured in seconds, minutes, or hours.

• RPM: Used for pulses measured in the number of revolutions per minute of the shaft 
that connects a gear to the rotating equipment.

The default is Speed.

Applies To
Pulse Input Module

Location
Controller tree > Configuration > Hardware Allocation > Pulse Input Setup

Read Only Command

The Read Only command toggles between read only and edit in Structured Text programs and 
functions.

Applies To
ST programs and functions

Location
Read Only button, or View menu

Rebuild Application Command

The Rebuild Application command builds an application by compiling all documents required 
by the programs in the execution list, then linking all the object code, library routines, and 
configuration information to form an executable application.

Applies To
Application

Location
Project menu
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Redo Command

The Redo command reverses the last Undo command. You must use this command before other 
editing is done or the changes cannot be redone.

Applies To
Programs, functions, and function blocks

Location
Edit menu

Reduce Font Size Command

The Reduce Font Size command reduces the size of the font for the entire ST program or 
function.

Applies To
ST programs and functions

Location
Reduce Font Size button, or View menu

Redundant Mode

For Tricon, the Redundant Mode property specifies whether there is a redundant Tricon ACM 
module in the installation. The default is cleared, which means not redundant.

Applies To
Tricon ACM Module

Location
Tricon Controller tree > Configuration > Hardware Allocation > ACM Setup

Refresh Command

The Refresh command replaces the data on a report that is currently displayed with data from 
the reports database. If project changes are made, you must first update the report database, and 
then click Refresh.

Applies To
Reports

Location
Refresh button on Project tree > Reports folder
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Remote Access to Aliased Tagnames

The Remote Access to Aliased Tagnames property specifies whether external devices using the 
TSAA client/server protocol can write to output tagnames (points) that have aliases. (Read 
access is always allowed for input, memory, and output points.)

This property must be used for DDE communication and can be used for OPC, TSAA, and Peer-
to-Peer communication.

In addition to setting this property, these properties must be set:

• The Disable Remote Changes to Outputs property on the Trident MP Operating 
Parameters screen must be cleared. The default is selected.

• The Privilege property must be set to Read/Write on the Trident CM.

Applies To
Tagnames for outputs

Location
Trident MP > Item Properties > Module tab

Remote Access to All Tagnames

The Remote Access to All Tagnames property specifies whether external devices using the 
TSAA client/server protocol have read/write access to all tagnames (points) whether or not 
they have aliases.

This property can be used for OPC, TSAA, and Peer-to-Peer communication.

In addition to setting this property, these properties must be set:

• The Disable Remote Changes to Outputs property on the Trident MP Operating 
Parameters screen must be cleared. The default is selected.

• The Privilege property must be set to Read/Write on the Trident CM.

Applies To
Application

Location
Trident MP > Item Properties > Module tab

Remote Mode

The Remote mode enables external (remote) devices to have read/write access to aliases in an 
application running on a controller.

• For Tricon, Remote mode is set by turning the keyswitch to REMOTE.

• For Trident, Remote mode is set programmatically by enabling write access with the 
SYS_SET_REMOTE_WRT_ENBL function block in a program.
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The default is not enabled, which means external devices are not allowed to write to aliases.

Applies To

Application, controller, tagnames

Location
Tricon keyswitch set to REMOTE
Trident Application tree > Library Documents > Functions

Remove Invalid Items (Red X’d)

The Remove Invalid Items (Red X’d) command removes, from all test sheets, any invalid 
elements (each marked with a red X) that may be left over from previous builds or editing.

Applies To
Test sheets in the emulator and controller

Location
Configuration tree > Controller or Emulator Panel > Tools menu

Replace Command

The Replace command searches and 
replaces specified text in programs, 
functions, or function blocks. 

Applies To
Editing

Location
Replace Text button, or File menu

Resolution Type

The Resolution Type property specifies the resolution for the Single-Ended and the Differential 
AI Modules (models 3720 and 3721 only). The Single-Ended AI uses unipolar input.

Types include:

• Standard Resolution: Data resolution is 12 bits.

• High Resolution: Data resolution is 14 bits.

The default is Standard Resolution.

The value returned is based on the input voltage, the resolution type, and the module type. This 
table identifies the ranges and returns.
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Applies To

AI Modules

Location

Tricon Controller tree > Configuration > Hardware Allocation > Single-Ended and Differential 
AI Setup

Restart on Power Up

For Trident, the Restart on Power Up property specifies whether the controller automatically 
restarts on power up. The default is cleared, which means the controller is not automatically 
restarted on power up.

Applies To
Trident MP

Location
Trident Controller tree > Configuration > Hardware Allocation > MP > Setup > Operating 
Parameters tab

Table 52 Resolution Type Ranges and Returns

Input 
(volts)

Standard Resolution 
(Unipolar Input)

High Resolution
(Unipolar Input)

High Resolution 
(Bipolar Input)

<-5.3 32767
(out-of-range under)

-32767
(out-of-range under)

-32767
(out-of-range under)

-5.3 32767
(out-of-range under)

-32767
(out-of-range under)

-17366
(under-range)

-5 32767
(out-of-range under)

-32767
(out-of-range under)

-16383
(minimum range)

< 0 32767
(out-of-range under)

-32767
(out-of-range under)

—

0 0
(minimum range)

0
(minimum range)

0
(minimum range)

5 4095
(maximum range)

16383
(maximum range)

16383
(maximum range)

5.3 4341
(over-range)

17366
(over-range)

17366
(over-range)

>5.3 32767
(out-of-range over)

32767
(out-of-range over)

32767
(out-of-range over)
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Restore Command

The Restore command returns the previous settings for the item, if the Apply command has not 
been used. For example, if you changed the default values for a property such as the Initial 
Value, you can go back to the defaults by clicking Restore.

Applies To

Project elements

Location

Item Properties

Restore Project Command

The Restore Project command allows you to open a backup file named <project_name>.BT2. 
You can then save the file to a name with a project file extension, such as <project_name>.PT2.

Applies To

Project

Location

File menu

Restore Project To Last Download Command

The Restore Project To Last Download command restores the project that was last successfully 
downloaded to the controller. When a download is successful, a backup file of the project is 
automatically created with the major version, minor version, time stamp, and the extension 
DWLD. For example, PEER_333_1_4120e077.DWLD.

Applies To

Project

Location

File menu

Retentive

The Retentive property specifies whether the value of a memory point is retained if a power 
failure occurs. If selected, when the system is powered up the memory point uses the value it 
had prior to the power failure. Only memory points can be specified as retentive. For input and 
output points, the value retained after a power failure is either zero or the value set for the Initial 
Value property. The default is cleared, which means the value is not retained.

Applies To
Memory points

Location

Application tree > Tagname Declarations > Item Properties > Declaration tab
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Right Power Rail Command

The Right Power Rail command allows you to place a right power rail on a logic sheet to delimit 
the LD network. The right power rail has an undefined status, and can be explicit or implicit. 

The left power rail is automatically included when a new logic sheet is created. The first element 
in every network must be linked to the left power rail, which is considered On at all times. 

To change the height of the rail, double-click the rail and use the + or – buttons.

Applies To
LD logic sheets

Location
Right Power Rail button, or Tools menu > Select Tools

Roll Backward or Forward Command

The Roll Backward or Forward command 
displays all the project changes made 
since the last save, and allows you to roll 
backward or forward to a specific change. 

After the project is saved, the changes are 
incorporated and the listing is cleared.

Applies To
Project

Location
Edit menu

Routing Configuration

The Routing Configuration property displays the Destination IP Address, IP Subnet Mask, and 
Default Gateway IP Address for the node. 

Applies To
Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > 
Routing tab
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Run Command

The Run command executes an application in the controller or emulator. Programs to be 
executed must be included on the Program Execution List.

• For Tricon, the Run command is only available when the keyswitch is set to the RUN or 
PROGRAM mode. The Run command is unavailable if the keyswitch is set to STOP or 
REMOTE.

• For Trident, the Run command is unavailable if the SYS_APP_HALT function is set to 
halt execution programmatically.

Applies To
Application, programs

Location
Run button
Configuration tree > Controller or Emulator Panel > Commands menu

RUNNING State

The RUNNING state is an application state which indicates the application is downloaded and 
running in the controller or emulator.

Applies To
Application

Location
Controller tree > Controller or Emulator Panel > Commands menu or Title bar

Save Element Command

The Save Element command saves an open element.

Applies To
Project

Location

Save Element button, or File menu

Save Project Command

The Save Project command saves an open project.

Applies To
Project

Location
Save Project button, or File menu
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Save As Command

The Save As command saves a project under a different name or folder.

Applies To
Project

Location
File menu

Save Implementation

The Save Implementation command saves the changes made to the Implementation area, which 
includes the Execution List, SOE Configuration, and Peer-to-Peer Configuration. 

Applies To
Project

Location
File menu

Save View Command

The Save View command saves a view of a matrix, which is a display of a selected portion of the 
matrix. You can create a view by hiding or showing columns and rows on the matrix, either by 
using menu commands or by dragging columns and rows on the matrix. Saving the view allows 
you to load it anytime.

Applies To
CEM programs

Location
Application tree > open a CEM program > View menu

Scale Factor

The Scale Factor property specifies how to convert pulse input signals into engineering units. 
The default is 1. The number must be a positive real number.

This table shows the correct scale factor to use for converting pulse input signals into seconds, 
minutes, and hours.

To Convert Set Scale to

Pulses per second  0.016667

Pulses per minute 1.000000 (default)

Pulses per hour 60.000000
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Speed Measurement

This formula converts speed measurement to different engineering units. The default is pulses 
per minute.

Speed =(Pulses /Minute) x Scale

RPM Measurement

This formula scales RPM measurements under special circumstances. For example, the Scale 
Factor property can be used to adjust the RPM measurement when the measuring shaft rotates 
at a different rate from the output shaft.

Speed =((Pulses /Minute)/Number of Gear Teeth) x Scale

Applies To
Pulse Input Configuration

Location
Controller tree > Configuration Panel > Hardware Allocation > Pulse Input Setup

Scan Time

The Scan Time property specifies the requested number of milliseconds for a scan (execution of 
the application) on the controller. The number is requested before an application is built. After 
the application is built and downloaded, the controller determines an actual scan time range 
and uses the specified scan time if it falls within these limits.

The controller determines a valid range for the scan time based on these operations:

If the application is running, the scan time can be set to a number different from the requested 
number without downloading the application. To determine what the actual, requested and 
surplus scan times are, see the Enhanced Diagnostic Monitor (sold separately). 

• For Tricon (3006 MP), the maximum scan time is 500 milliseconds.
• For Tricon (3008 MP), the maximum scan time is 450 milliseconds.
• For Trident, the maximum scan time is 450 milliseconds.

For Tricon and Trident, the default is 200 milliseconds.

CAUTION
When a Download Changes command is issued, the scan time is doubled 
for one scan immediately following the command. For example, if the 
normal scan time is 100 ms, the scan following a Download changes 
would be 200 ms.

• Reads inputs

• Executes the application

• Processes messages

• Writes outputs
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Applies To
Application

Location
Application tree > Implementation > Execution List

Search Text Command

The Search Text command allows you to search for text in a report.

Applies To
Reports

Location
Search Text button

Security Command

The Security command opens the Security dialog box, which allows user access to be created 
and modified.

Applies To
User security

Location
Security button, or Project menu

Security Level

The Security Level property specifies the level of security for the user.

Settings include:

• Level 01 is the highest security level

• Level 10 is the lowest security level

Each level allows access to its own operations and the operations associated with all lower 
levels. For example, a user with security level 03 has access to operations for security levels 04, 
05, 06, 07, 08, 0,9 and 10.

Applies To
Security

Location
Project menu > Security command > Users tab
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Select Function Block Command

The Select Function Block command displays a dialog box that allows you to select a function 
block to add to a program.

Applies To
Programs

Location
Select Function Block Element button
Tools menu > Select Tool > Function Block

Select Network Contents Command

The Select Network Contents command selects all the elements in a network for the current 
document. You must select at least one element (input, output variable) before using this 
command.

Applies To
Editing

Location
Edit menu

Select Sheet Contents Command

The Select Sheet Contents command selects all the elements on the current logic sheet. 

Applies To
Editing

Location
Edit menu

Selection Tool

The Selection Tool command changes the cursor to a selection tool, which allows you to select 
elements.

Applies To
Logic sheets in user documents, test sheets in emulator and controller 

Location
Selection Tool button, or Tools menu > Select Tool 
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Serial Port

The Serial Port property specifies the port on the TriStation PC that is connected to the controller.

Applies To
Communication

Location
Tricon Controller tree > Configuration tree > Communication

Set Calendar Clock Command

The Set Calendar Clock command sets the controller clock to the TriStation PC time. Before 
using the Set Calendar Clock command, you should ensure the PC is set to the correct local time.

When you download and run a TriStation application, the controller automatically sets its clock 
to the TriStation PC time. If the accuracy of the controller clock degrades over time, you can reset 
the clock while the application is running, without having to download again.

Procedure

1 On the TriStation PC, right-click the time icon in the message bar or open the Date/Time 
dialog box from the Control Panel.

2 Ensure the PC is set to the correct local time.

3 Open the TriStation project that is running in the controller.

4 On the Configuration tree, double-click the Controller or Emulator Panel.

5 On the Commands menu, click Connect, and then click Set Calendar Clock.

6 Click Yes when asked whether to set the calendar clock to the current configuration.

Applies To
Controller

Location
Configuration tree > Controller or Emulator Panel > Commands menu

Set Editor Options Command

The Set Editor Options command specifies how to set tabs, font size, and auto-scroll delay. 
Properties include:

• Tabs on page 430
• Font Size on page 364
• Auto Scroll Delay on page 321

Applies To
ST Language

Location
View menu



418 Appendix A Commands and Properties

TriStation 1131 Developer’s Guide, v4.1

Set Programming Mode Command

For Trident, the Set Programming Mode command specifies whether changes to the application 
are allowed. To use this command, the application must be downloaded to the controller.

The Set Programming Mode command is unavailable if the SYS_SET_APP_LOCK function has 
been set to prohibit (lock out) changes programmatically.

The default setting is Enable Programming and Control.

Applies To
Application, controller

Location
Trident Controller tree > Controller Panel > Commands menu

Set Scan Time Command 

The Set Scan Time command specifies, in milliseconds, how often the emulator or controller 
performs a scan. Changing the scan time on the Set Scan Time screen does not change the scan 
time for the project. To change the time for the project, you must set the time on the Execution 
List.

The minimum time is determined by the controller after the application is downloaded. The 
maximum time is determined by the type of controller. The scan time must be within the 
minimum and maximum range. 

• For Tricon 3008 MPs, the maximum time is 450 milliseconds.

• For Tricon 3006/3007 MPs, the maximum is 500 milliseconds.

• For Trident systems, the maximum is 450 milliseconds.

For Trident, you can set the scan time between the minimum and maximum times. The scan 
time must be larger than the AI and DI poll times. 

Applies To
Application

Location
Configuration tree > Controller or Emulator Panel > Commands menu

Setting Description

Enable Programming and Control Allowed changes include: Download Changes and Download 
All commands, changing the values of variables, changing scan 
time, and changing the operational mode. 

Disable Programming and Control Prohibits all changes to the application.
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Set Value

The Set Value property specifies the value for the variable during testing on the controller or 
emulator. To ensure the value is valid for the data type, click Confirm when specifying the value 
on the Variable tab.

Applies To
Variables on test sheets in the Controller and Emulator Panels

Location
Item Properties > Variable tab

Shared Read

The Shared Read property specifies whether a program can read a tagname that is a different 
Application type. For example, if the tagname is a Control type, it cannot be read by a Safety 
program unless Shared Read is checked. The default is cleared, which means that programs can 
only read tagnames that have the same Application type.

Applies To
Tagnames

Location
Application tree > Tagname Declarations > Item Properties > Declaration tab

Sheets Menu

The Sheets menu includes commands that allow you to change the properties of logic sheets, 
which provide the workspace for developing programs, functions, and function blocks. The 
Sheets menu includes these commands.

Command Description

Sheet Title Edits the title of the current sheet. The sheet title is displayed in the title block, 
the window caption bar, and the Window Menu list.

Edit Sheet Macros Allows you to change the text associated with macros which are identified by a 
pencil icon.

Next Sheet Displays the next sheet. 

Previous Sheet Displays the previous sheet. 

Append Sheet Adds a new sheet after an existing sheet.

Insert Sheet Adds a new sheet before an existing sheet.

Delete Sheet Deletes the selected sheet.

Organize Sheets Allows you to append, insert, and delete sheets. Also allows you to change the 
sheet title and to display (go to) the selected sheet.
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Applies To

Logic sheets in user documents, test sheets in Controller and Emulator Panels

Location

Sheet Manager button, or Sheets menu

Shorted Point Alarm Threshold

The Shorted Point Alarm Threshold property specifies the number of ohms below which values 
are alarmed as a shorted load. This option is only available if the points are supervised.

Typical threshold values are 10 to 48 ohms. The available range is 0 to 65,535 ohms. The default 
is 10 ohms.

Available only with the model 3625 digital output module.

Applies To

Tricon DO points

Location

Tricon Controller tree > Configuration > Hardware Allocation > DO Setup

Show Causes for Selected Effect Command

The Show Causes for Selected Effects command displays the causes of all selected effects in a 
CEM program.

Applies To
CEM programs

Location
View menu

Select Sheet 
Template...

Includes the following sheet templates:
Sheet A — 8.5" x 11"
Sheet B — 11" x 17" (default)
Sheet C — 17" x 22"
Sheet D — 22" x 34"

Command Description
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Show Effects for Selected Causes Command

The Show Effects for Selected Causes command displays the effects of all selected causes in a 
CEM program.

Applies To
CEM programs

Location
View menu

Show Grid Command

The Show Grid command toggles on and off to show or hide dotted grid lines.

Applies To
FBD and LD programs and functions

Location
View menu

Show IEC Representation

The Show IEC Representation command toggles between displaying the IEC (International 
Electro-Technical Commission) representation and the TriStation 1131 graphical view.

Applies To
FBD and LD programs and functions

Location
View menu

Show Network Numbers Command

The Network Number command toggles on and off to show or hide network numbers.

Applies To
FBD and LD programs and functions

Location
View menu
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Show Line Numbers Command

The Show Line Numbers command toggles to display or show line numbers in a ST program or 
function.

Applies To
ST programs and functions

Location

Line Numbers button, or View menu

Show Zones Command

The Zones command toggles on and off to show or hide network zone lines.

Applies To
FBD and LD programs and functions

Location
View menu

Signal Delays

The Signal Delays property adjusts the timing of data transmission to Modbus devices that use 
hardware handshake, which is a method of ensuring devices are ready to receive data. Signal 
delays adjust the timing for CTS and RTS signals for Modbus devices that have slow throughput 
or other limitations.

The RTS (Request to Send) signal opens and closes the data transmission channel. The RTS pre-
delay setting specifies the number of milliseconds to wait before the data is transmitted.

The CTS (Clear to Send) signal indicates the transmitting station that it is ready to receive data. 
The CTS Pre-delay setting specifies the number of milliseconds to keep the channel open after 
data is transmitted.

The settings can be from 0 to 10,000 milliseconds; the default is 0.

Setting Signal Delays for Tricon EICM

Signal delays are set by using the MBWRITE function blocks in a program. 

RTS
Post-delay

CTS
Pre-delay

RTS

Data

40001 40004
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Procedure

1 Set the Handshake property to Hardware on the Tricon EICM Setup screen.

2 Add an MBWRITE function block for each type of delay (CTS and RTS) you want to 
specify.

3 Specify these parameters in the function block.

Applies To
Modbus Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > EICM Setup
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Serial Ports tab

Single Step Command

The Single Step command executes a single scan of the application in the controller or emulator.

Applies To
Application

Location
Single Step button
Configuration tree > Controller or Emulator Panel > Commands menu

Parameter Action

Alias For CTS, enter 40001.
For RTS, enter 40004.

Port Enter the EICM port number.

Station Enter the slave station address.

D01 Enter the delay in milliseconds; 0 to 10,000.
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Size/Alignment Command

The Size/Alignment command includes commands that specify whether to increase or decrease 
the size of the element and how to align the element. The commands apply actions to the other 
elements using the currently selected element as the reference. For example, the Same Width 
command changes all other elements to the same width as the selected element.

The subcommands include:  

Applies To
Comments, constants, variables

Location
Right-click an element

Size/Hide Columns Command

The Size/Hide Columns command displays a dialog box that allows you to specify the font size 
and hide or unhide the columns.

Applies To
CEM programs

Location
Size/Hide Columns button, or View menu

Size/Hide Comment Column Command

The Size/Hide Comment Column command displays a dialog box that allows you to specify the 
font size and hide or unhide the comment.

Applies To
CEM programs

Location
View menu

• Same Width • Align Left • Align Bottom • Space Across
• Same Height • Align Right • Center Horizontally • Space Down
• Same Size • Align Top • Center Vertically
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Size/Hide Rows Command

The Size/Hide Rows command displays a dialog box that allows you to specify the font size and 
hide or unhide the rows.

Applies To
CEM programs

Location
Size/Hide Rows button, or View menu

Slot Selection

The Slot Selection property specifies the slot to be configured on the communication module.

Applies To
Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup 
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Network and 
Routing tabs

SNTP Master IP Address

The SNTP Master IP Address property specifies the IP Address for the master node using the 
Simple Network Time Protocol.

Applies To

Time synchronization

Location

Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Time 
Sync tab

SNTP Master Network

The SNTP Master Network property specifies the network on which the master node is located.

Applies To

Time synchronization

Location

Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Time 
Sync tab
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SOE Block

The SOE Block property identifies a data structure in the MP memory. The block header 
contains the block type, the buffer size, and a list of the event variables assigned to the block. 
The buffer stores the event entries, each containing a time stamp and one or more data entries.

There are 16 SOE blocks. For more information, see the SOE Recorder User’s Guide.

Applies To
Sequence of Events (SOE)

Location
Application tree > Implementation > SOE Configuration
Controller tree > Configuration > Hardware Allocation > HMM Setup

SOE Block Assignments

The SOE Block Assignments property specifies the SOE blocks that the tagname is assigned to 
for purposes of collecting SOE data. For more information, see the SOE Recorder User’s Guide.

Applies To
Sequence of Events (SOE)

Location
Application tree > Implementation > SOE Configuration > double-click the row for the tagname

SOE Block Name

The SOE Block Name property specifies the name of the SOE block. For more information, see 
the SOE Recorder User’s Guide.

Applies To
Sequence of Events (SOE)

Location
Application tree > Implementation > SOE Configuration tree > double-click a block

SOE Block Type

The SOE Block Type property specifies how the events are saved, discarded, or cleared from the 
buffer. Types include: External, First Out, Modified External, and Unassigned. For more 
information, see the SOE Recorder User’s Guide.

External

The External Block Type setting is typically used when an external device, such as a Foxboro or 
Honeywell DCS or PC running SOE Recorder, is retrieving events from a controller on a 
continual basis. When events are collected by the external device, event data is cleared from the 
block. When the buffer is full, new event entries are discarded.
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First Out

The First Out Block Type setting is typically used to retrieve the first and subsequent events that 
led to a trip. When the buffer is full, the Main Processors change the block’s status from 
collecting to stopped. New events are discarded.

Historical

The Historical Block Type setting is typically used to monitor current events in SOE Recorder 
application. An external device can collect events at any time, however, the collection does not 
clear the block. If the TriStation application does not clear and restart recording, the oldest event 
entries are overwritten when the buffer is full.

Modified External

The Modified External Block Type setting is used for event retrieval with the Safety Manager 
Module (SMM). The SMM is the Triconex communication interface with the Honeywell 
Universal Control Network (UCN), which is one of the principal networks of the Honeywell 
TCD 3000 Distributed Control System. Only blocks 15 and 16 can be specified as Modified 
External.

The default is Unassigned.

Applies To
Sequence of events (SOE)

Location
Application tree > Implementation > SOE Configuration tree > Blocks

SOE Buffer Size

The SOE Buffer Size property specifies the size of the buffer based on the number of events.

The maximum is 20,000; the default is 0.

Applies To
Sequence of Events (SOE)

Location
Application tree > Implementation > SOE Configuration tree > Blocks
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Space Saver

The Space Saver property means a single instance can be executed more than once per scan to 
reduce memory usage and increase performance.

Note If a function block is not a space saver, using the same function block instance more than 
once on a function block diagram results in a WF0031 warning—whereas there is no 
such warning for a space saver function block.

• For user-defined function blocks, you can specify this setting.

• For Triconex Library function blocks, the setting cannot be changed.

Applies To
Library and user-defined function blocks

Location
Function Blocks > Document Properties > Usage tab

Start Value and Increment

The Start Value property specifies the beginning letter or number to use when naming multiple 
variables. The Increment property specifies the number to increase each time a variable is 
named. 

The default value is 1 for both properties.

Applies To

Comments and variables in user documents 

Location
Item Properties > Auto Name > Auto Name button
Tools menu > Auto Name Selected Items

Stop Bits

The Stop Bits property specifies whether to transmit 1 bit or 2 bits after each character to notify 
the receiving computer that the transmission of a byte of data is complete. The default is 1 bit.

Applies To
Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > EICM Setup
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Serial 
Ports tab
Trident Controller tree > Configuration > Hardware Allocation > MP and CM Setup > Serial 
Ports tab
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Stop Mode

Stop mode stops the TriStation application from reading field inputs and forces non-retentive 
digital and analog outputs to zero. Retentive outputs retain the values they had before the 
application was halted.

Stop mode is useful for installation and service of external equipment, but is not required for 
service of the controller. Before using the stopping the application, the Halt command should 
be used to halt the application.

• For Tricon, Stop mode is set by turning the keyswitch to the STOP position.

• For Trident, Stop mode is set by using the SYS_APP_HALT function in a program.

Applies To
Application, controller

Location
Tricon keyswitch set to STOP
Trident Controller tree > Controller Panel > Commands menu
Trident Application tree > Library Documents > Functions

Supports Application Defined States

The Supports Application Defined States property specifies whether to allow user-defined 
functions to include a variable that stores application states. 

If included, the variable stores application states and is evaluated in the same way as the cause, 
intersection, and effect internal variables. The default is cleared, which means not enabled.

Application state inputs and outputs must be a DWORD data type 32-bit string.

Applies To

Functions, function blocks

Location
Document menu > Item Properties > Attributes tab

Supports Use in Cause Rows with... Inputs

The Supports Use in Cause Rows with... Inputs property specifies whether a specific user-
defined function can be used in a cause row. Triconex-supplied functions do not have to be 
enabled. 

The default is cleared, which means not enabled.

Applies To
Functions, function blocks

Location
Document menu > Item Properties > Attributes tab
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Supports Use in Effect Columns With... Outputs

The Supports Use in Effect Columns with... Outputs property specifies whether a specific user-
defined function can be used in an effect column. Triconex-supplied functions do not have to be 
enabled. The default is cleared, which means not enabled.

Applies To
Functions, function blocks

Location
Document menu > Item Properties > Attributes tab

Supports Use in Intersections

The Supports Use in Intersections property specifies whether a specific user-defined function 
can be used in an intersection. Triconex-supplied functions do not have to be enabled. The 
default is cleared, which means not enabled.

Applies To
Functions, function blocks

Location
Document menu > Item Properties > Attributes tab

Tabs

The Tabs property specifies the number of tab settings used in the Structured Text code. The 
default is 8.

Applies To
ST Language

Location
View menu > Set Editor Options

Tagname

The Tagname property specifies the name of an input, output, or memory point. The name 
comes from the use of tags tied to field points. In TriStation, it generally refers to points.

Tagnames can include up to 31 alphanumeric (A to Z and 0 to 9) characters and the underscore 
(_) character. Tagnames cannot begin with an underscore. 

Applies To
Input, output, and memory points

Location
Application tree > Tagname Declarations > Declaration tab
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TCP Port Number

The TCP Port property specifies a port number used by a network device. 

• For the Tricon TCM, the default is 502.

• For the Trident CM, the TCP Port property specifies a port number specified by a 
printer manufacturer. This information should be available with the printer 
instructions.

• An HP JetDirect print server with one port uses port number 9100.

• An HP JetDirect print server with three ports uses port numbers 9100, 9101, and 9102.

The default is blank.

Applies To
Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Printer 
and Modbus TCP tabs
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Printer tab

Temporary Files

The Temporary Files property specifies the path name for documents which include temporary 
files created by TriStation 1131 or other utilities. The default path name is: 

C:\My Documents\Triconex\TriStation 1131 4.1\Temp

Applies To
Project

Location
Tools menu > TriStation 1131 Options > Directories tab

Terminal

The Terminal property displays the names of the input and output terminals for the function or 
function block included with the selected cause, intersection, or effect. Extensible functions do 
not have terminal names.

Applies To
CEM programs

Location
Variable Detail Table
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Terminals
See Double Space on page 347 and EN/ENO on page 352.

Termination Options

The Termination Options property specifies whether resistors are used to terminate the Modbus 
cable connections. This option is only available with RS-485 Transceiver Mode.

Options include:

• None: The cables are not terminated. 

• Resistor: Resistors are used at each end of the cables. 

• Pull-Up/Pull-Down Resistors: Pull-up/pull-down resistors are used. 

• All: Both pull-up/pull-down and standard resistors are used.

The default is None.

Applies To
Modbus communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Serial 
Ports tab

Text Size

The Text Size property specifies the point size for the text; from 3 to 24 points. 

The defaults are: A=6, B=8, C=10, and D=10.

Applies To
Comments

Location
Properties > Comment tab
Project menu > Project Options > Annotations tab

Time After Trip

The Time After Trip property specifies the number of minutes after the trip to continue 
collecting events for the trip snapshot. 

The minimum is 2 minutes; the maximum is 10 minutes. The default is 2 minutes.

Applies To
SOE

Location
Application > Implementation > double-click SOE Configuration branch
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Time Before Trip

The Time Before Trip property specifies the number of minutes before the trip to begin 
collecting events for the trip snapshot.

The minimum is 2 minutes; the maximum is 10 minutes. The default is 2 minutes.

Applies To
SOE

Location
Application > Implementation > double-click SOE Configuration branch

Time Synchronization

The Time Synchronization properties specify whether and how time is synchronized for the 
controller. Depending on the controller, the following properties can be specified. The default 
is cleared, which means time synchronization is not used.

Applies To
Controller

Location
Tricon Controller tree > Configuration > Hardware Allocation > ACM, NCM, SMM, Enhanced TCM 
Setup
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Network tab

Controller Property

Tricon ACM On NET 1 enable time synchronization with external source

Tricon ACM On NET 2 enable time synchronization with Tricon Master Node

Tricon NCM On NET 1 enable time synchronization with Tricon Master Node

Tricon SMM Enable time synchronization with external source

Tricon TCM See Time Synchronization Configuration on page 434.

Trident CM On NET 1 enable time synchronization with Trident Master Node

Trident CM On NET 2 enable time synchronization with Trident Master Node
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Time Synchronization Configuration

The Time Synchronization Configuration property specifies the type of synchronization to be 
done by the TCM. These options are available.

Applies To
Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Time 
Sync tab

Toggle Terminal Inverter Command

The Toggle Terminal Inverter command toggles the inversion state of an input or output 
terminal on the selected function or function block. When the terminal is inverted, a small circle 
appears at the terminal connection.

Applies To
CEM programs

Location
Application tree > open a CEM program > right-click in the FBD Network

Transceiver Mode

The Transceiver Mode property specifies the type of physical connection.

For Ethernet ports, settings include:

• Auto-Negotiate (TCM will connect at either 10 Mbps or 100 Mbps, depending on the 
speed of the connection)

• 10 Mbps Half Duplex

• 10 Mbps Full Duplex

• 100 Mbps Half Duplex (Tricon TCM only)

• 100 Mbps Full Duplex (Tricon TCM only)

Option Description

None No time synchronization.

GPS Time synchronization based on the GPS interface and one TCM module.

GPS Redundant Time synchronization based on the GPS interface and two TCM modules.

SNTP Redundant Simple Network Time Protocol with two TCMs.

SNTP Simple Network Time Protocol with one TCM.

Peer-to-Peer Triconex Time Synchronization based on the master node in the Peer-to-
Peer network.
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Note If you have a model 4352A TCM with fiber connectors, you must select 100 Mbps as the 
communication mode. The 4352A module cannot connect at 10 Mbps.

For Serial Ports, settings include:

•  RS-232 for point-to-point communication over distances up to 50 feet

•  RS-485 for multi-point communication over distances up to 4,000 feet

RS-232 Transceiver Mode with Handshake

Hardware handshake is a method for controlling the flow of serial communication between two 
devices which uses a separate wire to send a signal when the receiving device is read to receive 
the signal. Hardware handshake can be used with Tricon TCM and Trident CM.

With the Handshake property set to Hardware, the communication module asserts the Request 
to Send (RTS) signal when it has a message to transmit. The communication module begins 
transmission when it receives a Clear to Send (CTS) signal from the Modbus master. The 
communication module ignores all characters unless the Modbus master asserts the Data 
Carrier Detect (DCD) signal. This settings allows the Modbus master to use half-duplex 
modems.

With the Handshake property set to None (typically for point-to-point connections), the 
communication module asserts RTS at all times and ignores CTS and DCD. In other words, the 
communication module transmits characters even if the receiving device is not ready. This 
could result in an overrun state, and the characters would have to be re-transmitted.

RS-485 Transceiver Mode with Handshake

With the Handshake property set to Hardware, the communication module enables its RS-485 
transmit driver only when it is sending data. Use this setting for all single-pair networks and for 
slave ports in two-pair, multi-point networks.

With the Handshake property set to None, the communication module enables its RS-485 
transmit driver at all times. Use this setting for a Modbus slave port in a two-pair, point-to-point 
network.

RS-485 cannot be used for a TriStation serial connection on TCM port 4.

Applies To
Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > 
Network and Serial Ports tabs
Trident Controller tree > Configuration > Hardware Allocation > MP Setup > Serial Ports tab
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Network and 
Serial Ports tab
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Transceiver Port

For Trident, the Transceiver Port property specifies the type of connection to be used for the 
port. Settings include RJ-45 and MAU. The default is RJ-45.

Applies To
Communication

Location
Trident Controller tree > Configuration > Hardware Allocation > CM Setup > Network tab

Triggering Mode

For Trident, the Triggering Mode property specifies where the input signal is triggered. For 
asymmetrical waveforms, select the option that corresponds to the sharper edge. Settings 
include Rising Edge and Falling Edge.

The default is Rising Edge.

Applies To
Trident Pulse Input Module

Location
Trident Controller tree > Configuration > Hardware Allocation > Pulse Input Setup

Trip State

The Trip State property specifies the value on which to begin collecting events.

Applies To
SOE

Location
Application tree > Implementation > SOE Configuration

Trip Tagname

The Trip Tagname property specifies the tagname (variable) that identifies whether a trip has 
occurred.

Applies To
SOE

Location
Application tree > Implementation > SOE Configuration
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TriStation Port Number

The TriStation Port Number property identifies the UDP port number used for the TriStation 
connection to the TCM. The default number is 1502.

Applies To
Communication

Location
Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Network tab

TSAA Port Number

The TSAA Port Number property identifies the UDP port number used with TSAA 
client/server network communication. The default number is 1500.

Applies To
Communication

Location
Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > Network tab

Type Over Command

The Type Over command toggles between typing over and inserting characters in a Structured 
Text program or function.

Applies To
ST programs and functions

Location
Type Over button, or View menu

UCN Node Number

For Tricon, the UCN Node Number property specifies an number on the Tricon SMM, which 
can be any odd number from 1 to 63. Even numbers are used for hot-spare module 
communication.

The default is 1.

Applies To
Tricon SMM

Location
Tricon Controller tree > Configuration > Hardware Allocation > SMM Setup
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UDP Base Port Number

The UDP Base Port Number property specifies the UDP port number for the controller where 
the TriStation application is to be run. This number identifies the controller in a Peer-to-Peer 
network. Entering 0 as the UDP port number disables Peer-to-Peer over UDP/IP on the 
network. The following values are reserved:

Also see TriStation Port Number on page 437 and TSAA Port Number on page 437.

Applies To
Communication

Location
Tricon Controller tree > Configuration > Hardware Allocation > Enhanced TCM Setup > 
Network tab
Tricon Controller tree > Configuration > TriStation Communication

Undo Command

The Undo command reverses the last action performed when editing a program, function, or 
function block.

Applies To
Editing

Location
Edit menu

Update Reports Database Command

The Update Reports Database command copies project information to a database used when 
reports are generated. 

Applies To
Reports

Location
Project tree > right-click the Reports folder

Reserved 
Value(s) Protocol Notes

1500 TSAA Can be changed via configuration

1502 TriStation Can be changed via configuration

1503–1504 Peer-to-Peer Can be changed via configuration

1505–1508 Firmware 
download

Cannot be changed; for Triconex use only

1–1023 — Reserved by the Internet Assigned Numbers 
Authority (IANA)
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Update Selected Function Cells Command

The Update Selected Function Cells command updates selected out-of-date elements which are 
marked with a red X in the active window.

Applies To
CEM programs

Location
Tools menu

Usage

The Usage property specifies how function blocks can be used in a function or function block.

For library function blocks, the options determine the usage and cannot be changed. For user-
defined function blocks, the settings can be specified.

Settings include:

• Exactly Once on page 359

• Only Once on page 391

• Space Saver on page 428

• Internal State on page 372

Applies To
Library and user-defined function blocks 

Location
Document Properties > Usage tab

Use Local Time

The Use Local Time property specifies whether to use local time or universal time. The default 
is selected, which means local time is used.

Applies To

Application

Location

Trident Controller tree > Configuration > Hardware Allocation > MP > Setup > Operating 
Parameters tab
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Value

The Value property specifies the value for the constant. To ensure the value agrees with the Data 
Type, click Apply.

Applies To
Constants

Location
Properties > Constant tab

Value Range to Scale an Integer

The Value Range to Scale an Integer properties specify how a REAL number is scaled to an 
integer so it can be transmitted using Modbus protocol, which does not use REAL numbers. The 
values set for the scale range are used with the Modbus minimum and maximum range to 
derive an integer value that represents the real value.

Properties include:

• Minimum Value (Min Span) on page 384

• Maximum Value (Max Span) on page 381

• Precision on page 400

• Disable Scaling on page 344

Applies To

Points with REAL data types

Location

Application tree > Tagname Declarations > Scaling tab

Var/Const

The Var/Const property displays the names of the variables connected to the terminals of the 
function or function block in a CEM program. Only user-defined variables are displayed. 
Internal variables are hidden.

Applies To
CEM programs

Location
Application tree > open a CEM program > Variable Detail Table
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Var Type

The Var Type property specifies the type of variable. Types include:

Applies To
Variables

Location
Properties > Declarations tab

Verify Last Download to the Controller Command

The Verify Last Download to the Controller compares the application that was last downloaded 
to the controller with the application running on the controller. If there is a difference, you 
should contact Triconex Technical Support. 

Applies To

Application

Location
Controller tree > Controller Panel > Commands menu

Verify Password

The Verify Password property allows you to enter the password a second time to verify it is the 
same as entered for the Password property.

Applies To

User access, Security

Location
Project menu > Security command > Users tab > Add or Modify button

Type Description

Input A variable which provides a value to a program, function, or function block. Must be 
connected to a point. 

Output A variable which returns the result of a program, function, or function block. Must be 
connected to a point.

In/Out A variable which is used as both an input and output variable. Must be connected to a 
point.

Local A variable used for internal logic. Cannot be connected to a point.

Tagname A variable that references a point.
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Verify Version Command

The Verify Version command compares the version of the selected library in the project with the 
most current version available. If the version in the project is out of date, you are prompted to 
update it. 

Applies To
Libraries

Location
Application tree > right-click Library Documents > Manage command

Vertical Network Divider Command

The Vertical Network Divider command allows you to place a vertical divider on a logic sheet 
to divide networks. 

Applies To
FBD logic sheets

Location
Vertical Network Divider button, or Tools menu > Select Tool

View Download History Command

The View Download 
History command 
displays version 
information for each 
download for the current 
project, which is a list of 
the elements affected for 
the last Download All 
and subsequent 
Download Changes 
commands. The history 
is cleared and restarted 
with each Download All 
command. 

These properties are 
displayed on the 
Download History 
screen.
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Applies To
Project

Location
Project menu

View Intermediate FBD Command

The View Intermediate FBD command displays source code that is generated in the Function 
Block Diagram language when the CEM program is compiled.

Applies To
CEM programs

Location
Document menu

View Intermediate ST Command

The View Intermediate ST command displays source code that is generated when the program 
is compiled. You can copy the source code by using the Write to File command on the Edit 
menu.

Applies To
Programs, Functions, and Function Blocks

Location
Document menu

Property Description

St An icon that indicates the status of the element. An arrow indicates that the 
element was included in a Download All; an ellipsis (...) means it was included in a 
Download Changes.

Element Name The name of the program, function, or function block.

ID# A system-generated identification for the program or function.

Ver The version of the element. 

Size The size of the element in bytes.

Library The library the element is included in. 
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View Manager Command

The View Manager command allows you to save, load, or remove views of a CEM matrix.

Applies To
CEM programs

Location
View menu

View Project History Command

The View Project History 
command displays an 
audit trail of user access 
and modification of the 
project. 

This history is 
automatically generated 
during project 
development.

Applies To
Project

Location
Project History button, or 
Project menu

Width

The Width property specifies the width (horizontal space) of the variable or constant symbol. 
By selecting either the plus (+) or the minus (-) buttons, you can expand or shrink the width of 
the variable symbol so you can use a longer name or fit the symbol into a smaller space.

Applies To
Variables

Location
Properties > Selected tab
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Wire Tool Command

The Wire tool command provides a pointer tool to a connect logic elements in FBD programs. 

Settings include:

• Normal: Represented by a solid line. 

• Feedback: Represented by a dashed line. 

The default is Normal. To set, double-click the wire and select either Normal or Feedback.

Applies To
FBD programs

Location
Wire Tool button, or Tools menu > Select Tool

Wire Type

The Wire Type property specifies the type of wire used for serial communication.

Settings include:

• 2-Wire (half duplex) if using one pair of wires for Modbus reads and writes. (Only 
available when the Transceiver Mode property is set to RS-485.) 

• 4-Wire (full duplex) if using two pairs of wires—one pair for Modbus reads and the 
other pair for Modbus writes. (Trident MP serial ports must use this setting.)

The default is 4-Wire.

Applies To
Serial ports

Location
Trident Controller tree > Configuration > Hardware Allocation > MP or CM Setup > Serial Ports 
tab

Workspace View Command

The Workspace View command toggles to display or hide the Application and Controller 
workspace tree.

Applies To
TriStation 1131 workspace

Location
Workspace View button, or View menu
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Write To File Command

The Write To File command displays a dialog box that allows you to specify a file name and 
location to save ST code as a text file.

Applies To
ST programs, ST functions, and intermediate ST for all programs and functions

Location
Edit menu

Zoom Command

The Zoom command enlarges or decreases the 
view of an element. 

Standard settings are: 50%, 75%, 100%, and 
200%. You can also enter a number or click 
Zoom To Fit to size the elements to fit the 
current window.

You can enlarge the view of elements on a logic 
sheet by:

• Using the Zoom button or Zoom 
command from the View menu

• Double-clicking an empty area to see a 
Zoom Selection view.

Applies To
Logic sheets for user documents, test sheets for Controller and Emulator Panels

Location
Zoom button, or View menu, or double-click an empty area in a logic sheet

Zoom To Fit Command

The Zoom To Fit command toggles between a large and small view of the logic sheet.

Applies To
Logic sheets for user documents, test sheets for the Controller and Emulator Panels

Location

Zoom To Fit button, or View menu, or double-click an empty area in a logic sheet
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Zoom To Region

The Zoom To Region command allows you to zoom into a region of the sheet.

Procedure

1 On the View menu, click Zoom to Region.

The cursor changes to a cross-bar.

2 Select the region to view by dragging the cross-bar across the area.

The region is magnified.

Applies To
FBD and LD editors

Location
View menu
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Overview
Data types, which adhere to the IEC 61131-3 standard, specify the type of data used for the 
following:

• Constants

• Tagname declarations and references

• Local, input, output, and I/O variables
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Elementary Data Types
An elementary data type specifies the size and characteristics of most data used in a program, 
function, or function block and the operations that can be applied to the data.

This table describes the elementary data types and how they can be used.

Only three data types can be declared as controller points: BOOL, DINT, and REAL. These 
variables point to hardware addresses in the controller and are accessible to all programs in a 
project.

Table 53 Elementary Data Types and Usage

Data Type Description Tagnames Constants and 
Local Variables

BOOL A Boolean, 1 bit in length

DATE A specific date

DINT A double integer, 32 bits in length

DT A specific date and time

DWORD A double word, 32 bits in length

INT An integer, 16 bits in length

LREAL A long real number, 64 bits in length

REAL A real number, 32 bits in length

STRING A sequence of up to 132 alphanumeric 
characters delimited by single quotes

TIME A period of time (duration) expressed in days, 
hours, minutes, seconds, or milliseconds

TOD A specific time of day
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BOOL Data Type

A BOOL data type is one bit in length and has two possible values: false (0) or true (1).

Application Notes

• Can be used in Safety or Control applications.

• Can be used in CEM Cause, Effect, and Intersection cells.

DATE Data Type

A DATE data type refers to a specific date expressed as the year, month, and day.

Application Notes

• Can be used in Safety or Control applications.

• Can be used in CEM Cause, Effect, and Intersection cells.

Attribute Description

Keyword/type BOOL

Description Boolean 

Size 1 bit

Default value False (0)

Lower limit False (0)

Upper limit True (1)

Result if intermediate value is less than lower limit N/A

Result if upper limit is less than intermediate value Intermediate Value MOD 2

Attribute Description

Keyword/type DATE

Description Date

Size 64 bits

Syntax D#CCYY-MM-DD

Default value D#1970-01-01

Lower limit D#1970-01-01

Upper limit D#2029-12-31

Result if intermediate value is less than lower limit Invalid date

Result if upper limit is less than intermediate value Invalid date
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DINT Data Type

A DINT data type is a double integer, 32 bits in length.

Application Notes

• Can be used in Safety or Control applications.

• Can be used in CEM Cause, Effect, and Intersection cells.

DT Data Type

A DT data type represents a date and time of day. To specify the time of day, you can use 
fractions (FFF) of a second. Values are stored internally in microseconds and displayed in the 
TriStation 1131 Controller Panel in milliseconds.

A DT data type cannot be used as a program input or output. 

Attribute Description

Keyword/type DINT

Description Double integer

Size 32 bits

Default value 0

Lower limit –2**31

Upper limit 2**31–1

Result if intermediate valuea is less than lower limit

a. If the intermediate conversion value is out of range (for example, when converting LREAL to DINT), 
the return value is the smallest or greatest double integer.

–2**31 or V modulo 2**32

Result if upper limit is less than intermediate valuea 2**31–1 or V modulo 2**32

Attribute Description

Keyword/type DT

Description Date and time of day

Size 64 bits

Syntax DT#CCYY-MM-DD-HH:MM:SS
or

DT#CCYY-MM-DD-HH:MM:SS.FFF
or

DATE_AND_TIME#CCYY-MM-DD-HH:MM:SS

Default value DT#1970-01-01-00:00:00

Lower limit DT#1970-01-01-00:00:00



454 Appendix B Data Types

TriStation 1131 Developer’s Guide, v4.1

Application Notes

• Can be used in Safety or Control applications.

• Can be used in CEM Cause, Effect, and Intersection cells.

DWORD Data Type

A DWORD data type is a double word, 32 bits in length. The result is always in the range from 
0 to 16#FFFFFFFF. If the intermediate value is out of range, then the result is the least-significant 
32 bits of the intermediate value. For example, if you shift 16#FFFFFFFF to the left once, the 
intermediate value is 16#1FFFFFFFE and the result is 16#FFFFFFFE. 

A DWORD data type cannot be used as a program input or output.

Application Notes

• Can be used in Safety or Control applications.

• Can be used in CEM Cause, Effect, and Intersection cells.

Upper limit DT#2029-12-31-23:59:59.999

Result if intermediate value is less than lower 
limit

Invalid date

Result if upper limit  is less than intermediate 
value

Invalid date

Attribute Description

Attribute Description

Keyword/type DWORD

Description Double word

Size 32 bits

Default value 0

Lower limit 0

Upper limit 16#FFFFFFFF

Result if intermediate value is less than lower limit N/A

Result if upper limit is less than intermediate value V and 16#FFFFFFFF
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INT Data Type

An INT data type is an integer, 16 bits in length. Arithmetic operators ADD, SUB, and MUL are 
implemented with 32-bit arithmetic and the container for INT is 32 bits. The ADD, SUB, and 
MUL operations do not check the range of results and can have resultant values out of the 
specified range (–32768 and +32767). For example, using the SUB function to subtract 1 from 
-32768 results in –32769 (clearly out of range) without clearing ENO or reporting a BADPARAM 
error. However, an out-of-range value does display “Inv INT” on the Controller Panel. 

To verify that output values from these functions are within range, connect the output terminal 
to the INT_TO_DINT function, which converts the integer output to double integer and does a 
range check for the integer output.

An INT data type cannot be used as a program input or output.

Application Notes

• Can be used in Safety or Control applications.

• Can be used in CEM Cause, Effect, and Intersection cells.

LREAL Data Type

An LREAL data type is 64 bits in length and has 15 decimal digits of precision. In TriStation 
1131, the LREAL data type follows the IEC-559 Standard floating-point format.

An LREAL data type cannot be used as a program input or output.

Attribute Description

Keyword/type INT

Description Integer

Size 32 bits

Default value 0

Lower limit –2**15

Upper limit 2**15–1

Result if intermediate value is less than lower limit InvINT

Result if upper limit is less than intermediate value InvINT

Attribute Description

Keyword/type LREAL

Description Long-real number

Size 64 bits

Default value 0.0

Most positive number 1.7976931348623158 e +308
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Gradual Underflow for LREAL Data Types

In PCs and controllers, the floating-point implementation includes a standard feature called 
gradual underflow that extends the range for an LREAL number and gradually changes the 
precision as values approach zero.

This table compares the values obtained when gradual underflow is not present, to the values 
obtained when it is present.

This table shows how the precision changes as LREAL numbers approach zero.

Least positive number 4.9406564584124654 e –324

Least negative number – 4.9406564584124654 e –324

Most negative number –1.7976931348623158 e +308

Result if intermediate value is less than lower limit –Infinity or HUGE

Result if upper limit is less than intermediate value +Infinity or HUGE

Without Gradual Underflow With Gradual Underflow

The smallest positive number that can be 
stored in an LREAL variable is:

2–1022 = 2.2250738585072014E–308.

The smallest positive number that can be stored in 
an LREAL variable is:
   2–1074 = 4.9406564584124654E–324.

The precision changes abruptly from 17 digits 
to 0 digits when the value changes from a 
number greater than 2–1023 to a number less 
than 2–1023.

The precision changes gradually from 17 digits to 1 
digit as the value changes from 
2–1023 to 2–1074.

The maximum relative error changes abruptly 
from 2–53 to 1 when the value changes from a 
number greater than 2–1023 to a number less 
than 2–1023.

The maximum relative error changes gradually from 
2–53 to 1 as the value changes from 2–1023 to 2–1074.

For values from 2–1075 to 2–1022, the maximum 
absolute error equals the value.

For values from 2–1075 to 2–1022, the maximum 
absolute error is a constant 2–1075.

If |x| Is Greater Than: Then the Precision Is Greater Than:

5.0E–308 17 digits

5.0E–309 16 digits

5.0E–310
   .
   .
   .
5.0E–322

15 digits
   .
   .
   .
3 digits

5.0E–323 2 digits

Attribute Description
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Absolute error is the absolute value of x – a, where x is the exact value and a is the actual value 
stored.

Relative error is the absolute value of (x – a)/x, where x is the exact value and a is the actual value 
stored.

This table shows how gradual underflow affects absolute error and relative error as LREAL 
numbers approach zero.

Application Notes

• Can be used in Safety or Control applications.

• Can be used in CEM Cause, Effect, and Intersection cells.

REAL Data Type

A REAL data type is 32 bits in length and has 6 decimal digits of precision. In TriStation 1131, 
the REAL data type follows the IEC-559 Standard Floating-Point format.

5.0E–324 1 digits

0.0 0 digits

Range Maximum  
Absolute Error

Maximum Relative 
Error

0 < |x| ≤ 2–1075 |x| 1

2–1075 < |x| ≤ 2–1022 2–1075 2–1075 / |x|

2–1022 ≤ |x| < 21024 – 2972 2–53 * |x| 2–53 

If |x| Is Greater Than: Then the Precision Is Greater Than:

Attribute Description

Keyword/type REAL

Description Real number

Size 32 bits

Default value 0.0

Most positive number 3.402823466 e +38

Least positive number 1.401298464 e –45

Least negative number –1.401298464 e 45

Most negative number –3.402823466 e +38

Result if intermediate value is less than lower limit –Infinity or HUGE

Result if upper limit is less than intermediate value +Infinity or HUGE
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Gradual Underflow for REAL Data Types

In PCs and safety controllers, the floating-point implementation includes a standard feature 
called gradual underflow. This feature extends the range of a REAL number and gradually 
changes the precision as values approach zero. 

This table compares the values obtained when gradual underflow is not present, to the values 
obtained when it is present.

This table shows how the precision changes as numbers approach zero.

Absolute error is the absolute value of x – a, where x is the exact value and a is the actual value 
stored.

Relative error is the absolute value of (x – a)/x, where x is the exact value and a is the actual value 
stored.

This table shows how gradual underflow affects absolute error and relative error as REAL 
numbers approach zero.

Without Gradual Underflow With Underflow

The smallest positive number that can be stored 
in a REAL variable is:
   2–126 = 1.175494351E-38.

The smallest positive number that can be stored in 
a REAL variable is:
   2–149 = 1.401298464E–45.

The precision changes abruptly from 7 digits to 0 
digits when the value changes from a number 
greater than 2–127 to a number less than 2–127.

The precision changes gradually from 7 digits to 1 
digit as the value changes from 2–127 to 2–149.

The maximum relative error changes abruptly 
from 2–24 to 1 when the value changes from a 
number greater than 2–127 to a number less than 
2–127.

The maximum relative error changes gradually 
from 2–24 to 1 as the value changes from 2–127 to 
2–149.

For values from 2–150 to 2–126, the maximum 
absolute error equals the value.

For values from 2–150 to 2–126, the maximum 
absolute error is a constant 2–150.

If |x| Is Greater Than: Then the Precision Is 
Greater Than:

1.5E–39 7 digits

1.5E–40 6 digits

1.5E–41 5 digits

1.5E–42 4 digits

1.5E–43 3 digits

1.5E–44 2 digits

1.5E–45 1 digits

0.0 0 digits
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Application Notes

• Can be used in Safety or Control applications.

• Can be used in CEM Cause, Effect, and Intersection cells.

STRING Data Type

A STRING data type is an alphanumeric sequence, up to 132 characters in length, which is 
delimited by single quotation marks ( ' ). The count of 132 characters does not include the null 
terminator or the single quotation mark. 

A STRING data type cannot be used as a program input or output. 

Application Notes

• Can be used in Safety or Control applications.

• Can be used in CEM Cause, Effect, and Intersection cells.

Range Maximum  
Absolute Error

Maximum 
Relative Error

0 < |x| ≤ 2–150 |x| 1

2–150 < |x| ≤ 2–126 2–150 2–150 / |x|

2–126 ≤ |x| < 2128 – 2103 2–24 * |x| 2–24 

Attribute Description

Keyword/type STRING

Description Character string

Size 136 bytes

Default Value Empty string (two single quotation marks not 
separated by any characters)

Lower limit 0 characters

Upper limit 132 characters

Result if intermediate value is less than lower 
limit

Truncated string

Result if upper limit is less than intermediate 
value

N/A
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TIME Data Type

A TIME data type refers to a period of time (duration) in days, hours, minutes, seconds, and 
milliseconds. The range is ± 9999 years and the precision is 0.1 milliseconds.

A TIME data type cannot be used as a program input or output. 

Application Notes

• Can be used in Safety or Control applications.

• Can be used in CEM Cause, Effect, and Intersection cells.

Attribute Description

Keyword/type TIME

Description Duration

Size 64 bits

Syntax TIME#11d
or

TIME#22.2h
or

TIME#33.3m
or

TIME#44.4s
or

TIME#55.5ms
or

TIME#11d22h33m44s55.5ms
or

T#11d22h33m44s55.5ms
or

T#44.4s

Default value TIME#0S

Lower limit TIME#-3652134d

Upper limit TIME#3652134d

Result if intermediate value is less than lower limit Inv Time

Result if upper limit is less than intermediate value Inv Time
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TOD Data Type

A TOD data type refers to a specific time of day expressed in hours, minutes, seconds, and 
fractions (FFF) of a second. The precision is 0.001 seconds. 

A TOD data type cannot be used as a program input or output. 

Application Notes

• Can be used in Safety or Control applications.

• Can be used in CEM Cause, Effect, and Intersection cells.

Attribute Description

Keyword/type TOD

Description Time of day

Size 64 bits

Syntax TOD#HH:MM:SS
or

TOD#HH:MM:SS.FFF
or

TIME_OF_DAY#HH:MM:SS

Default value TOD#00:00:00

Lower limit TOD#00:00:00

Upper limit TOD#23:59:59.999

Result if intermediate value is less than lower limit V modulo 24 hours

Result if upper limit is less than intermediate value V modulo 24 hours
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Generic Data Types
Generic data types, identified by the prefix ANY, are used exclusively in the functions and 
function blocks that are available in the TriStation Standard Library. 

If a function specifies a generic data type for an argument, then the argument type must be one 
of the data types represented by that generic data type. If a function specifies one generic data 
type for more than one argument, then all such arguments must have the same data type. 

For example, the function ADD specifies type ANY_NUM for all arguments and the return 
value. You can add two double integers, or two integers, or two long real numbers, or two real 
numbers, but you cannot add a real number to a long real number.

The TriStation generic data types are based on the IEC 61131-3 standard. The hierarchy for them 
is shown in this figure.

Figure 41 Generic Data Types Hierarchy

This table lists the meaning of each generic data type and the standard data types it represents.

Table 54 Generic Data Types

Data Type Standard Data Type Represented

ANY Any of the standard data types: BOOL, DATE, DINT, DT, DWORD, INT, LREAL, 
REAL, STRING, TIME, TOD, or Derived

ANY_NUM Any number: DINT, INT, LREAL, or REAL

ANY_REAL Any real number: LREAL or REAL

ANY_INT Any integer: LREAL or REAL

ANY_BIT Any bitwise data type: BOOL or DWORD

ANY_DATE Any date or time of day or both: DATE, DT, or TOD

ANY_NOTE1 Any elementary data type: BOOL, DATE, DINT, DT, DWORD, INT, LREAL, 
REAL, STRING, TIME, or TOD. Note that each of these types is ordered so that 
values of the same type can be compared (see functions EQ, GE, GT, LE, LT, NE, 
MIN, and MAX).
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Overview
If you have an older model 4351 or 4352 TCM installed in your system, some of the 
configuration options are different than those for the model 4351A or 4352A TCM. 

The procedures in this appendix apply specifically to configuring the ports on the model 4351 
or 4352 TCM, and should be followed in place of the TCM configuration procedures provided 
in Chapters 3 and 4 of this guide.

Note If you have a newer model 4351A or 4352A TCM, do not use the procedures in this 
appendix. You should instead use the information found in the following sections:

• Configuring TCM Ports on page 205

• Using a Tricon TCM to Synchronize Time on page 229

• Configuring a Tricon TCM Port for Printing on page 278
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Configuring TCM Ports
A single Tricon system supports a maximum of four TCMs, which must reside in two logical 
slots. You cannot mix model 4351A/4352A TCMs and 4351/4352 TCMs in the same system, 
even if they are installed in different chassis. See the Planning and Installation Guide for Tricon 
v9-v10 Systems for detailed TCM installation guidelines.

TCM models 4351 (Copper)/4352 (Fiber) support the following protocols on network and serial 
ports. 

To configure specific types of ports, see these topics:

• Configuring TCM Network Ports on page 466

• Configuring TCM Serial Ports on page 468

• Configuring TCM Peer-To-Peer Ports on page 470

• Configuring TCM Modbus TCP Ports on page 472

• Configuring TCM Routing on page 473

For additional information on configuring the TCM, see these topics:

• Using a Tricon TCM to Synchronize Time on page 475 for instructions on configuring 
the TCM to synchronize time. 

• Configuring a Tricon TCM Printer Port for Printing on page 481 for instructions on 
configuring the TCM for use with a printer.

Protocol Network Ports Serial Ports

TriStation NET 2 Port 4

TSAA (UDP/IP) NET 2 —a

a. — means the protocol is not available on this port.

Peer-to-Peer (UDP/IP) NET 1 —

Peer-to-Peer (DLC) NET 1 —

Modbus Slave (ASCII or RTU) — Any port

Modbus Master (RTU) — Any port

Modbus Master or Slave (TCP) NET 2 —

GPS Time Synchronization — Port 1

Triconex Time Synchronization via DLC or UDP/IP NET 1

SNTP Triconex Time Synchronization NET 2 —

Network Printing using Jet Direct NET 2 —
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Note Once TCM ports have been configured, but prior to downloading the configuration to the 
controller, you can change the existing TCM model to a different model TCM without 
losing your port settings (see Inserting and Removing Tricon Modules on page 186). 
Note that you can switch only from a 4351 to a 4352, or vice-versa; you cannot switch 
from a 4351 or 4352 to a 4351A or 4352A.

However, once the configuration has been downloaded to the controller, you cannot 
change the TCM model installed in the Tricon without downloading a new 
configuration. 

Configuring TCM Network Ports
This procedure explains how to configure network ports on a Tricon TCM.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The TCM Setup dialog box appears.
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3 Specify these properties on the Network tab.

4 Click OK to save your changes.

Note Changes to TCM IP addresses are not effective until the existing connection is closed and 
a new connection is opened. Once a connection is opened, it remains open until you 
close it, even if the IP address is changed via a Download Changes operation.

Property Action

Slot Selection Select the slot where the TCM module you want to configure is 
installed.

Not Installed, 
Installed

Click Installed to enable configuration of the module. Clicking Not 
Installed resets all options to their default state and makes them 
unavailable for configuration. The default is Not Installed.

Enable Network Select the check box to enable the network port to be configured.

Transceiver Mode Select the communication mode. The default is Auto-Negotiate.
If you have a model 4352 TCM with fiber connectors, you must select 
100 Mbps as the communication mode. The 4352 module cannot 
connect at 10 Mbps.

IP Address Enter the IP Address for the port. NET 1 and NET 2 cannot use the 
same IP address. The default for NET 1 is 192.168.1.0; for NET 2 is 
192.168.1.1.

IP Subnet Mask If needed, enter the IP address for the subnet. The default is 
255.255.255.0.

Default Gateway IP 
Address

If needed, enter the IP address for the default gateway. The default is 
0.0.0.0.

TriStation 
Configuration: 
UDP Port Number

The UDP port to use for the TriStation connection. The default is 1502. 
See UDP Base Port Number on page 438 for additional information.

TSAA 
Configuration: 
UDP Port Number

The UDP port to use for TSAA connections, including DDE Server, 
SOE Recorder, and OPC Server. The default is 1500. See UDP Base 
Port Number on page 438 for additional information.

Port Write Enabled Select this check box if you want to allow TSAA writes to the network 
ports. Applies to all TSAA connections on these ports. The default is 
cleared (the ports are read-only).
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Configuring TCM Serial Ports
This procedure explains how to configure serial ports on a Tricon TCM.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The TCM Setup dialog box appears.

3 Click the Serial tab.

4 Specify these properties.

Property Action

Port Selection Click the port to be configured. Ports can be configured only for a 
slot with an installed module.

Protocol Select the communication protocol for the port:
• All ports can use Modbus Master, Modbus Slave ASCII, 

Modbus Slave RTU.
• Only port 1 can use GPS. This port is automatically configured 

for GPS when you enable time synchronization. See Using a 
Tricon TCM to Synchronize Time on page 475.

• Only port 4 can use TriStation.
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5 Click OK to save your changes.

Note Even if port 4 is set to Not Configured (the default value), it can still be used to connect 
to the Tricon via TriStation. This is useful when you are unable to connect via a network 
connection.

Port Write Enabled Available only if Modbus Slave (ASCII or RTU) is selected as the 
communication protocol. Select this check box if you want to 
allow Modbus writes to this slave port. The default is cleared (the 
port is read-only).

Modbus Slave Address If you selected Modbus Slave RTU or ASCII, enter the number of 
the Modbus slave device. The default is 1.

Baud Rate Enter the communication rate for the port. The default is 9600.

Data Bits Select 8 or 7 bits. The default is 8. Available only with Modbus 
Slave ASCII.

Stop Bits Select 1 or 2 bits. The default is 1 bit. 

Parity Select the type of parity for the port. The default is Odd.

Transceiver Mode Select RS-485 or RS-232. The default is RS232. On port 4 when 
TriStation is selected as the protocol, RS-485 is not available.

Handshake Select None or Hardware; the default is None.

Termination Options Select the type of termination used with cables. Only available 
with RS-485 Transceiver Mode. The default is None.

FP Ordering Select the order to be used with floating point numbers. The 
default is Low 16 Bits First.

Modbus (Minimum and 
Maximum) Range

Enter the minimum and maximum values to be used for the 
Modbus data range. The default minimum is 0. The default 
maximum is 32,767.

Master Logical Port Enter the port number that the TCM will use in the Modbus 
Master functions to access the port. Only available for Modbus 
Master.

Property Action
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Configuring TCM Peer-To-Peer Ports
This procedure explains how to configure the IP address for controllers communicating on a 
Peer-to-Peer network through a Tricon TCM.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The TCM Setup dialog box appears.

3 Click the Peer-to-Peer tab.

4 Under Slot Selection, select the module (slot) you want to configure Peer-to-Peer ports for.

5 Select a node (controller), and specify these properties.

6 Click Update to apply the new settings for the selected node. 

7 Repeat steps 4 through 6 for each node to be included in the network. 

Note If necessary, click Reset All to reset all node settings for the selected slot to their 
default, unconfigured state.

Property Action

Destination UDP Port Enter the UDP port number for each controller to be 
communicated with on the Peer-to-Peer network. This must be 
the same number that the controller uses as its UDP Base Port 
Number.

IP Address Enter the IP address for the controller.
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8 Once all nodes have been configured, specify these properties (applicable to all nodes on 
the Peer-to-Peer network).

9 Click OK to save your changes.

Property Action

UDP Base Port Number Enter the UDP base port number for the controller. Enter 0 to 
disable Peer-to-Peer over UDP/IP on the network.
The default is 1503. UDP port numbers must be unique. See 
page 438 for reserved values.

Peer-to-Peer Time 
Synchronization 
Enabled

Select the check box to enable Triconex Time Synchronization 
across the Peer-to-Peer network. See Using a Tricon TCM to 
Synchronize Time on page 475 for more information.

Enable Communication 
with Tricon V8 and V9 
Peer-to-Peer Systems

Select the check box to enable communication with Tricon version 
8 and 9 systems. The default is cleared. Available only for a 
module installed in the left slot.
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Configuring TCM Modbus TCP Ports
This procedure explains how to configure Modbus TCP ports on a Tricon TCM, which enables 
Modbus communication through network ports.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The TCM Setup dialog box appears.

3 Click the Modbus TCP tab.

4 Under Slot Selection, select the module (slot) you want to configure Modbus TCP ports for.

5 Select a port and specify these properties.

Property Action

Protocol Select the communication protocol for the port. Options include 
Modbus TCP Master and Modbus TCP Slave Net.

Port Write Enabled Available only if Modbus TCP Slave is selected as the 
communication protocol. Select this check box if you want to allow 
Modbus writes to this slave port. The default is cleared (the port is 
read-only).

Master Logical Port Enter the number of the Modbus Master node. Available only with 
Modbus TCP Master protocol. 

TCP Port Number Enter the number for the TCP port. The default is 502. 
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6 Click OK to save your changes.

Configuring TCM Routing
This procedure explains how to configure routing on a Tricon TCM. Up to 10 different routes 
can be configured for each module.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The TCM Setup dialog box appears.

3 Click the Routing tab.

IP Address If the port uses Modbus Master protocol, enter the IP address of the 
slave node.
If the port uses Modbus Slave protocol, enter either of these:

• To accept communication from any Modbus Master, leave the 
IP address as 0.0.0.0.

• To accept communication only from a defined Modbus Master, 
enter the specific master IP address.

FP Ordering Select the ordering to use for floating point numbers.

Modbus (Minimum 
and Maximum) Range

Enter the minimum and maximum for the modbus data range. 
Available only with Modbus TCP Slave Net.

Property Action
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4 Select the module (slot) you want to configure routing for.

5 Select a destination route and then specify these properties.

6 Click Update Destination to apply the settings. If necessary, click Reset All to reset all 
destination settings for the selected slot to their default, unconfigured state.

7 Click OK to save your changes.

Property Action

Destination IP 
Address

Enter the IP address which is used if the controller is not on the same 
subnet as other devices.

Destination IP 
Subnet Mask

Enter the IP address of the subnet mask.
If the gateway address is on NET 2, then the subnet mask must be the 
same as the NET 2 subnet mask defined on the Network tab. If the 
gateway address is on NET 1, then the subnet mask must be the same as 
the NET 1 subnet mask defined on the Network tab. See Configuring 
TCM Network Ports on page 466.

Destination 
Gateway IP 
Address

Enter the IP address of the gateway to which the  controller is connected. 
The gateway address must always be on NET 1 or NET 2. 
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Using a Tricon TCM to Synchronize Time
This procedure explains how to enable time synchronization on a TCM. Time synchronization 
can be enabled using the following protocols:

• GPS

• SNTP

• Triconex Time Synchronization via DLC or UDP/IP on a Peer-to-Peer network

In a redundant network of Triconex controllers that each have two TCMs installed, you can 
implement redundant time synchronization by configuring time synchronization for both TCM 
modules (both left and right slots). Time synchronization can be enabled only for a single logical 
slot.

If the TCM is installed in the COM slot, you configure time synchronization only for the left slot 
(there is no redundancy when installed in the COM slot). 

Topics include:

• Configuring GPS Time Synchronization on the TCM on page 475

• Configuring SNTP Time Synchronization on the TCM on page 477

• Configuring Triconex Time Synchronization on the TCM on page 479

Configuring GPS Time Synchronization on the TCM
This procedure explains how to configure a TCM to enable time synchronization through the 
Global Positioning System (GPS) by using the Trimble Acutime 2000 Synchronization Kit. For 
information on installing the kit, see the Tricon Communication Guide for v9-v10 Systems.

If the TCM is in a Peer-to-Peer network, it can also be used as the master node for time 
synchronization of other controllers on the network. In this configuration, the master node TCM 
synchronizes time with the GPS, and any slave nodes on the Peer-to-Peer network synchronize 
their time with the master TCM. In this way, all nodes on the Peer-to-Peer network are 
synchronized with GPS time.

If the TCM is acting as a slave node on a Peer-to-Peer network, it cannot be configured for GPS 
time synchronization. Slave nodes synchronize their time only to the master node on the Peer-
to-Peer network, and reject all other time change requests.

GPS time synchronization uses Serial Port 1 on the TCM. 

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. The TCM 
Setup dialog box appears.

CAUTION
To ensure the accuracy of GPS time adjustments, the Tricon clock must be 
set to within 10 minutes of the correct local time.
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3 Click the Time Sync tab.

4 Under Slot Selection, click Left Slot. You must configure the module in the left slot first.

5 Under Time Synchronization Configuration, select GPS.

If you previously configured Port 1 to use a Modbus protocol, selecting GPS will reset 
Port 1 to use the GPS protocol. See Configuring TCM Serial Ports on page 468 for more 
information.

6 (Optional) If you have a redundant TCM installed in the right slot, under Slot Selection, 
click Right Slot, and then select GPS Redundant.

Note The module in the right slot can be configured only if it has been installed (see 
Configuring TCM Network Ports on page 466) and if the module in the left slot 
has already been configured for GPS time synchronization.

7 Click OK to save your changes.

Enabling the TCM as a Master Node for Triconex Time Synchronization (Optional)

If you also want the TCM to be able to act as a master node for time synchronization of other 
controllers on a Peer-to-Peer network (using Triconex Time Synchronization) do the following:

1 In the Configuration tree, click Operating Parameters (see Operating Parameters on 
page 180).

2 Select the Enable Tricon Node Time Synchronization check box. 
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Configuring SNTP Time Synchronization on the TCM

This procedure explains how to configure TCM time synchronization to an SNTP server.

If the TCM is in a Peer-to-Peer network, it can also be used as the master node for time 
synchronization of other controllers on the network. In this configuration, the master node TCM 
synchronizes time with the SNTP server, and any slave nodes on the Peer-to-Peer network 
synchronize their time with the master TCM. In this way, all nodes on the Peer-to-Peer network 
are synchronized with SNTP time.

If the TCM is acting as a slave node on a Peer-to-Peer network, it cannot be configured for SNTP 
time synchronization. Slave nodes synchronize their time only to the master node on the Peer-
to-Peer network, and reject all other time change requests.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. The TCM 
Setup dialog box appears.

3 Click the Time Sync tab.

4 Under Slot Selection, click Left Slot. You must configure the module in the left slot first.

5 Select these properties.

Property Action

Time Synchronization 
Configuration

Select SNTP. The default is None. 
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6 (Optional) If you have a redundant TCM installed in the right slot, under Slot Selection, 
click Right Slot, and then select these properties.

Note The module in the right slot can be configured only if it has been installed (see 
Configuring TCM Network Ports on page 466) and if the module in the left slot 
has already been configured for SNTP time synchronization.

7 Click OK to save your changes.

Enabling the TCM as a Master Node for Triconex Time Synchronization (Optional)

If you also want the TCM to be able to act as a master node for time synchronization of other 
controllers on a Peer-to-Peer network (using Triconex Time Synchronization) do the following:

1 In the Configuration tree, click Operating Parameters (see Operating Parameters on 
page 180).

2 Select the Enable Tricon Node Time Synchronization check box. 

SNTP Master IP Address Enter the IP address of the SNTP server to synchronize time 
with.

Property Action

Time Synchronization 
Configuration

Select SNTP Redundant.

SNTP Master IP Address Enter the IP address of the SNTP server to synchronize time 
with.

Property Action
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Configuring Triconex Time Synchronization on the TCM

In a Peer-to-Peer network, Triconex Time Synchronization can be used to synchronize time 
across controllers on a network. The controller with the lowest node number serves as the 
master node.

The master node can also synchronize its time with a GPS or an SNTP server. In this 
configuration, the master node synchronizes time with the GPS or SNTP server, and any slave 
nodes on the Peer-to-Peer network synchronize their time with the master node. In this way, all 
nodes on the Peer-to-Peer network are synchronized with GPS or SNTP time.

Note Currently, when a Trident controller is on a Peer-to-Peer network using Triconex Time 
Synchronization, with a Tricon TCM acting as a master node, the Trident will not 
correctly synchronize its time to the master node.

Configuring a Master Node

This procedure describes how to configure the TCM as a master node on the Peer-to-Peer 
network when GPS or SNTP time synchronization is not being used.

If you want the master node to synchronize to a GPS or SNTP server, use the procedures in the 
these sections:

• Configuring GPS Time Synchronization on the TCM on page 475

• Configuring SNTP Time Synchronization on the TCM on page 477

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. The TCM 
Setup dialog box appears.

3 Click the Time Sync tab.

4 Under Time Synchronization Configuration, select None.

5 Click OK to save your changes.

6 In the Configuration tree, click Operating Parameters (see Operating Parameters on 
page 180).

7 Select the Enable Tricon Node Time Synchronization check box. 

This allows the controller to participate as a master node in time synchronization across 
the Peer-to-Peer network.
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Configuring a Slave Node

This procedure describes how to configure the TCM as a slave node on the Peer-to-Peer 
network.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The TCM Setup dialog box appears.

3 Click the Peer-to-Peer tab.

4 Under Slot Selection, click Left Slot. 

5 Select the Peer-to-Peer Time Synchronization Enabled check box.

6 Click OK to save your changes.

7 In the Configuration tree, click Operating Parameters (see Operating Parameters on 
page 180).

8 Select the Enable Tricon Node Time Synchronization check box. 

This allows the controller to participate as a slave node in time synchronization across 
the Peer-to-Peer network.
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Configuring a Tricon TCM Printer Port for Printing
This procedure explains how to configure a Tricon TCM port that is connected to a Centronics-
compatible printer. You do not need the printer driver that may have come with the printer 
package. See Tricon Printing on page 273 for more information about printing from the Tricon.

Procedure

1 Expand the Controller tree, double-click Configuration, and expand Hardware 
Allocation. 

2 Double-click the slot where the TCM module is installed and then click Setup. 

The TCM Setup dialog box appears.

3 Click the Printer tab.

4 Specify these properties for the module installed in the Left Slot.

5 If a module is also installed in the Right Slot, repeat step 4 for that module.

6 Click OK to save your changes.

Property Action

Printer Number Enter the number for the printer; can only be 5 or 10. The default is 0, 
meaning a printer is not configured.

Line Width Enter the number of characters to be printed on a line. The default is 80 
characters.

TCP Port Number Enter the number of the TCP port for the print server. The default is 
9100 for an HP printer.

IP Address Enter the IP address of the printer server.
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Index

A
access

Access property 67
changing element owner 68
operations 392
to TCM, controlling 267
to Tricon, restricting 163
to Trident, restricting 168
user access 27

access levels, TCM 267
access list

see TCM access list
ACM

see Tricon ACM
Add Program to Execution List command 317
AI modules

configuring 187
Alias Number property 317
Alias Type property 318
aliases

assigning 117
special for Tricon 149

Alignment property 318
allocating memory points 183
Allow Disabling of Points property 319
AND or OR

description 358
Annotate property 319
Annotation on by Default property 319
annotations

adding in FBD and LD 137
adding macros to 139
Alignment property 318
Annotate property 319
Annotation on by Default property 319
Border property 323
default macros 338
specifying default 18
specifying in FBD and LD 110, 114
specifying properties 139
using macros 143

ANY data type 462

ANY_BIT data type 462
ANY_DATE data type 462
ANY_INT data type 462
ANY_NOTE1 data type 462
ANY_NUM data type 462
ANY_REAL data type 462
application

about Peer-to-Peer 156
about safety and control 58
access 163
Application Type property 320
Build Application command 323
change requirements 312
changing document owner 68
comparing the last download 330
definition 56
development steps 53
Download All command 348
execution order list 172
function block usage 75
parts 56
planning changes 311
run mode 412
setting scan time 307
specifying Application Type 66
Trident access 168
types defined 320
using Build command 174

Application Workspace 54
application-defined states

definition 96
enabling 97

Apply command 320
array data type definition 79
attributes of documents 66
Auto Indent command 321
Auto Name command 321
Auto Scroll Delay property 321

B
backup file

with download 302
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Backup Project command 322
Base Address property 322
Baud Rate property 322
bipolar input 188, 408
BNC connectors

terminating 250
BOOL

definition 452
specifying colors for monitoring 20

Border property 323
Build Application command 323
building an application 174

C
CASE statement 86
Category property 323
Cause and Effect Matrix, see CEM language
Cause Effect Matrix Support property 324
Cause Header Functions On by Default property 324
cells

resizing 100
selecting 99

CEM editor
FBD Network overview 91
managing views 107
matrix overview 91
overview 90
specifying colors for monitoring 95
Variable Detail Table overview 92

CEM Editor Options properties 325
CEM Element Options properties 325
CEM language

about 61
editor properties 93
editor settings 26

CEM programs
default settings 93
deleting columns 101
deleting rows 102
element options 94
inserting columns 100
inserting rows 101
intermediate FBD or ST code 174
options 96
planning 89
resizing cells 100
saving views 107
selecting cells 99
size/hide columns 103

size/hide comments 105
size/hide rows 104
title block 106

CEMPLE
overview 88

Centronics printing
setup 280
using a Tricon EICM port 273, 274

Change Colors command 326
Change Owner Command 326
Change State to Download All command 326
changes

application requirements 312
chassis

adding or deleting for Tricon 185
power usage for Tricon 184

Choose Another Tagname command 327
Clear History command 327
Client IP Address property 271, 327
Client IP Subnet Mask property 271, 328
Client Protocols property 272, 328
clock

setting for controller 417
Close Project command 328
code, intermediate FBD or ST 174
Coil Tool Command 329
Coil Type property 329
colors

Change Colors command 326
Default Colors command 336
Drawing Item property 350
Enable Color Monitoring property 353
specifying for monitoring 20

columns
deleting 339
inserting 100
size and hide 103

comment column
size and hide 105

Comment Tool 330
comments

adding in FBD and LD 140
Alignment property 318
Border property 323
Comment Tool 330
dropping elements 142, 350
editing macros in 143
enclosing logic 386
picking up elements 142
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style 141
using macros 143

communication
Default Connect property 336
verifying connection 367

Communication command 330
Compare Project to Last Downloaded command 330
Compile All User Documents command 331
Compile command 331
Compiler Warning When Right Rail is Missing 

property 331
compiling programs 173
configuration

changing Tricon modules 186
inserting Trident modules 194
NGAI modules 187
NGDO modules 188
Peer-to-Peer 158
removing Trident modules 195
steps 177
tree 179
Tricon operating parameters 180
Trident operating parameters 182

Connect command 331
constants

creating in FBD and LD 113
specifying in CEM 98
VAR CONSTANT 81

Contact command 332
Contact Type property 332
Continuous Refresh command 333
control application definition 320
controller

access 163, 168
adding and deleting a Tricon chassis 185
configuration checklist 177
configuring Peer-to-Peer memory 158
configuring Trident MP 218
Connect command 331
downloading to 302
replacing Tricon MP model 186
restricting access to Tricon 163
restricting access to Trident 168
testing application on 301
tree 178
Tricon chassis power usage 184
using for testing 304
workspace 178

controller modes
Stop 429

Copy command 333
Copy Current Setup to Other Serial Ports command 333
copying documents 63
copying ST code 78
CTS Pre-Delay setting 422
Current Version property 334
custom reports 43
customer support xiv
Cut command 334

D
Data Bits property 334
Data Files property 335
data transfer time

estimating for Peer-to-Peer 157
Peer-to-Peer 156

data type
array 79
creating 62
enumeration 79
structured 80

Data Type property 335
data types

BOOL 452
DATE 452
DINT 453
DT 453
DWORD 454
elementary 451
generic 462
INT 455
LREAL 455
REAL 457
STRING 459
TIME 460
TOD 461

date and time data type 453
DATE data type 452
DCS, time synchronization 225
Declaration Tree 55
Declarations command 335
Default Colors command 336
Default Connection property 336
default gateway

specifying for Trident CM 291
Default Gateway IP Address property 337
Default Language property 337
Default Macros or Text property 337
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Default Number of Cause Rows property 339
Default Number of Effect Columns property 339
Delete Columns command 339
Delete command 339
Delete Rows command 340
Delete Unreferenced Tagnames command 340
deleting

columns 101
rows 102

description
using the %DESCRIPTION macro 340

Description property 340
Destination Gateway IP Address property 341
Destination IP Address 340
Destination IP Subnet property 341
Destination UDP Port property 341
development steps 53
Differential AI Input Type property 188, 341
digital output points

specifying fault detection 346
DINT data type 453
directories

TriStation 22
Disable OVD on All Modules command 342
Disable OVD on Module... command 343
Disable Remote Changes to Outputs property 343
Disable Scaling property 344
Disable Stop on Keyswitch property 344
disabled points, maximum 313
Disconnect command 344
Display Program Document command 345
Display Report command 345
Display Tabular View command 345
DLC protocol

installing on TriStation PC 243
DO modules

configuring 188
DO Point Options property 189, 346
Document Access property 346
Document Type property 347
documents

attributes 66
changing owner 68
copying 63
creating 62
information 65

restricting access 67
version number 9

Double Space Function Block Terminals by Default 
property 347

Double Space property 347
Download All

command 302, 348
procedure 316

Download Changes
command 349
procedure 314
steps 310

download state 326
Download Version property 350
downloading

to controller 302
to emulator 297

drawing colors
Change Colors command 326
Drawing Item property 350
properties 23

Drawing Item property 350
Drop command 350
DT data type definition 453
DWORD data type 454

E
Edit Sheet Title command 351
Edit Title Block command 351
Edit...Macros command 350
Edit/View Source command 351
editors

CEM properties 26, 93
FBD properties 24
LD properties 25
using FBD 69
using LD 70
using ST 78

Effect Cause Header Functions property 353
Effect Header Functions On by Default property 351
elementary data types 451
emulator

downloading to 297
testing 297
using for offline testing 299

EN/ENO property 352
Enable Access List command 271, 353
Enable All Disabled Points command 353
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Enable Color Monitoring property 353
Enable Communication with Tricon V8 and V9 Peer-to-

Peer Systems property 354
Enable Effect Header Functions property 354
Enable EN/ENO Terminals on Functions by Default 

property 354
Enable Floating Text in Intersection Cells property 355
Enable Intersection functions property 355
Enable Macro Editing property 356
Enable Multiple Writes property 356
Enable OVD on All Modules command 356
Enable OVD on Module... command 357
Enable Tricon Node Time Synchronization 

property 181, 234, 357, 480
Enable UCN Test Mode property 358
Enabled Features property 355
Enlarge Font Size command 358
enumeration data type

defining 79
Evaluation Options property 358
evaluation options, CEMPLE matrix 94
evaluation order

CEMPLE matrix 89
functions 71
TCM access list 270

Event Tagname property 358
event variables

assigning to SOE blocks 161
Exactly Once setting 359
Excel

import tagname file 129
execution flow, monitoring 345
execution list 172
Exit command 359
Exit statement 85
Expand Macros property 359
Export command 360
Export Destination property 360
Export Format property 360
Export Report command 361
exporting

project elements 33
reports, how to 43
tagnames, file format for 127

extensible functions
specifying 73

F
FBD Editor options 361
FBD language

about 58
adding annotations 137
adding comments 140
annotation 110, 114
creating constants 113
creating variables 108
declaring variables 109
editor 69
editor properties 24
EN/ENO property 352
intermediate code 174
selecting library elements 72
terminals 71
using macros 143

FBD Network
overview 91

fiber
communication mode, TCM 207
required cables for TCM 251

Field Maximum Power property 361
Field Minimum Power property 361
Field Power Monitoring property 188, 362
Field Power property 362
files

data file location 335
project 403

Find In Application command 363
Find Text command 363
Find Text Options 363
floating-point underflow

for LREAL data types 456
for REAL data types 458

Font Size property 364
forcing points 313
ForLoop 85
Formatted Name property 364
FP Ordering property 364
Full Name property 365
Function Block command 365
function blocks

definition 56
printing 279
properties 74
space saver setting 76

functions
creating 62
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definition 56
EN/ENO property 352
enabling for a matrix 26, 93
enabling for CEM 94
properties 73
specifying Application Type 66
using in FBD 72

G
General Monitor Colors property 365
generic data types 462
Global Positioning System Installed property 366
global variables

see Tagnames
Go To Cell command 366
GPS

property 366
synchronization with NCMG 227
synchronization with TCM 229

gradual underflow
effect on absolute and relative error 457, 458
for LREAL data types 456
for REAL data types 458

Group 1 and Group 2 property 366

H
Halt command 366
Handshake property 367
hardware allocation

exceptions 308
Hardware Allocation command 368
Hide Causes Unrelated to Effects command 368
Hide Effects Unrelated to Causes command 368
history

clearing 327
viewing 444

Horizontal Network Divider command 369
hub, using for TCM connection 251

I
I/A Series DCS 225
IBR 382
IDLE state 369
IEC 61131-3 standard 462
IEC-559 Standard Floating-Point format 457
IIR 382
implementation

overview 294
steps 295

Implementation Tree 55
Import command 369
importing

libraries 32
points 133
tagnames, file format for 127, 130

Include Monitor Value in Annotation property 369
Initial Value property 370
input

invert 373
Insert Columns command 370
Insert From File command 370
Insert Input Variable command 371
Insert Local Variable command 371
Insert Module command 372
Insert Output Variable command 371
Insert Rows command 372
Insert Tagname Declaration command 372
installing TriStation 5
instance name

described 71
INT data type 455
integers

scaling from REALs 150
intermediate FBD or ST code 174
Internal State setting 372
Intersection Functions On by Default 373
Invert Input property 373
Invert Input/Output property 373
Invert Output property 374
IOP 397
IP address

for TCM network port 207
setting default 286
setting Trident with a RARP Server 287
setting with a Tricon EICM or TCM 288
setting with a Trident CM 290
setting with a Trident MP 289
using default 286

IP Address property 374
IP Subnet Mask property 375
IRR 382

K
keyswitch



Index 489

TriStation 1131 Developer’s Guide, v4.1

disable stop 344

L
language

Default Language property 337
setting default 17

Language property 375
languages

See CEM, FBD, LD, and ST languages
LD Editor Options properties 376
LD language

about 59
adding annotations 137
adding comments 140
annotation 110, 114
Coil Type property 329
Compiler Warning When Right Rail is Missing 

property 331
Contact Type property 332
creating constants 113
creating variables 108
declaring variables 109
editor 70
editor properties 25
EN/ENO property 352
power rails 411
selecting library elements 72
terminals 71
using macros 143

Left-Handed Link Tool 376
Left-Handed Wire Tool 376
levels

user access 31
libraries

adding 38
deleting 39
exporting elements 33
importing 32
TriStation 32, 37
updating 39
version numbers of 32

library documents, copying 64
library functions

application usage 75
Line Width property 376
Link command 377
List Disabled Points command 377
Loc property 377
local variables

Data Type property 335

declaring 84
Location property 378
locking

application elements 67
Log On As New User command 378
logging in to a project 16
logic

colors for drawings 23
Logon Name property 378
long reals

precision when approaching zero 456
loop power, NGDO 362
LREAL data type 455
LREAL numbers

precision when approaching zero 456

M
macros

%TAG macros 338
adding to annotations 143
default for annotations 338
Default Macros or Text property 337
editing 350
editing text 145
enabling editing 356
expanding 359
with annotations and comments 143

Macros command 379
Main Processor Connection Setup property 379
maintenance, application 310
Manage Sheets command 379
Manage Views command 380
Master Logical property 380
master node, Triconex time synchronization 233, 479
matrix

enabling functions 97
evaluation 89
evaluation options 94
FBD Network overview 91
overview 91
planning 89
resizing cells 100
Variable Detail Table overview 92

Maximum Number of OPC Alarms/Events 
property 380

Maximum Number of Peer-to-Peer Receives 
property 380

Maximum Number of Peer-to-Peer Sends property 381
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Maximum RPM property 381
Maximum Speed property 381
Maximum Value 381
MaxSpan 381
MBN 382
MBR 382
MBW 382
media converter 252
Memory Address property 382
Memory Allocation command 383
memory points

allocating 183
Message Options command 383
Message property 383
Message View command 383
MIN 382
Minimum Value 384
MinSpan 384
MIR 382
MIW 382
Modbus

assigning aliases 147
Data Bits property 334
disabling scaling of REALs 155
scaling numbers 153
signal delays 422
TCM ports, configuring 212
Tricon and REAL numbers 148
Tricon functionality 146
Trident functionality 146

Modbus (Minimum and Maximum) Range 
property 384

Modbus Slave Address property 385
Mode property 385
modes

operational 296
modules

inserting, Tricon 186
inserting, Trident 194
removing, Tricon 186
removing, Trident 195
Tricon NGAI 187
Tricon NGDO 188
Tricon PI 190
Tricon Thermocouple 191
Trident PI 195

monitor display
with tagnames 121

Monitor Display Options 386
Monitor Value on by Default property 386
monitoring

CEM Monitor Colors property 324
colors 365
programs 345
value included in annotation 369

monitoring field power 188, 362
Move Behind Logic Elements property 141, 386
MP attribute properties 193
MPs 186
MRN 382
MRR 382
MRW 382

N
Name Order property 387
Name property 387
naming

multiple variables 111
NCM

see Tricon NCM
negative scan surplus 306
network connection

testing 292
network ports, TCM 205
Network property 387
networks

additional routing 292
New Document Command 388
new features xiii
New Project command 388
New Tagname Command 388
New Tagnames Command 388
NGAI modules

configuring 187
NGDO modules

configuring 188
NIC card

installing in a TriStation PC 242
NIC Index property 389
Node Name property 389
Node Number property 389
non-supervised DO points 189
Number of Extended Block property 389
Number of Gear Teeth property 390
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Number of Inputs property 390
numbers

REAL, scaling to integers 150
scaling for Modbus 153

O
OFFLINE state 390
Only Once setting 391
Open Document command 391
Open Project command 391
Opened Point Alarm Threshold property 391
operating parameters

Tricon 180
Trident 182

Operation Type property 392
operational modes

description 296
Operations property 392
order of evaluation

CEMPLE matrix 89
Organize command 394
output

invert 374
output points

disabling changes 343
owner

changing 68

P
Parity property 394
password

default 16
Password property 395
Password Required for Connection property 395
Paste command 396
Pause command 396
Peer-to-Peer

applications 156
configuring memory 158
data transfer time 156, 157
time synchronization with TCM 233–234, 479–480
Tricon TCM port configuration 210

Peer-to-Peer Time Synchronization Enabled 
property 328, 396

Permission property 271, 397
physical address

assigning 117

Physical Address property 397
PI Module

configuring, Tricon 190
configuring, Trident 195
field power minimum 361

PI Point Options properties 398
Pickup command 398
Point Assignment properties 398
Point Type property 399
points

allocating memory 183
Allow Disabling of Points property 319
assigning aliases 147
creating multiple tagnames 122
Data Type property 335
declaring tagnames 115
disabled, maximum number of 313
disabling 313
import options 132
overview 115
restricting access to Trident 170
scaling REAL values 120
write access to Tricon 166–167
write access to Trident 169–171

poll time 307
Port Selection property 399
Port Write Enabled property

description 165, 400
for TCM Modbus ports 212
for TCM network ports 207
for TCM serial ports 208

ports
Tricon ACM 199
Tricon EICM 201
Tricon HIM 200
Tricon NCM 203
Tricon SMM 204
Tricon TCM 205–214
Trident CM 220, 221

positive scan surplus 306
power

field maximum 361
field minimum 361
specifying 362

power usage
Tricon 184

Precision property 400
Previous Sheet command 400
Print command 401
print function blocks
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purpose 279
Print Number property 401
Print Preview command 401
Print Report command 401
print server

with Trident CM 280
PRINTER parameter 279
printing

configuring for Trident CM 283
configuring Tricon EICM port 275
configuring Tricon TCM port 278
connecting to Tricon TCM 276
connecting to Trident CM 281
scan time increases 273, 280
with Tricon 273
with Trident 280

Privilege property 402
privileges, security 30
process safety time 306
Program command

described 402
Program Execution List property 402
Program mode

described 296
programming

about languages 58
Programming Mode

see Program command
programs

compiling 173
creating 62
definition 56
maximum number of 172
order on execution list 172
specifying Application Type 66

Prohibit Writes property 403
project

adding a description 15
annotation properties 18
backing up 322
CEM monitor colors 95
changing the download state 326
Close Project command 328
Compile All User Documents command 331
Compile command 331
converting to 4.1 11
creating 14
default directory for 22
enabling features 355
exiting 359

exporting elements 33
language properties 17
logging in 16
monitor colors 20
properties 17
Roll Backward or Forward command 411
version number 9
viewing history 444

Project Description property 403
Project Files property 403
Project workspace 8
properties

annotations 139
function blocks 74
functions 73
project 17
TriStation 21

Properties command 375
Protocol property 404
Pulses Per Revolution property 405

Q
QBW 382
QIW 382

R
rails 331
Rate Type property 405
Read Only command 405
read/write

property 67
read-only

property 67
REAL data type 457
real number

precision when approaching zero 458
REAL numbers

disabling scaling 155, 344
scaling to integers 150
unscaled 154

REAL points
specifying precision 400

Rebuild Application command 405
rebuilding an application 174
red X

explained 439
Redo command 406
Reduce Font Size command 406
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Redundant Mode property 406
Refresh command 406
refreshing values of variables 333
Remote Access to Aliased Tagnames property 407
Remote Access to All Tagnames property 407
Remote mode 296, 407
remote write enabled

setting 407
Remove Invalid Items command 408
Replace command 408
replacing Tricon model 186
report database

updating 41
reports

adding custom 43
default directory for templates 22
exporting 43
updating database 41
viewing and printing 41

Resolution Type property 188, 408
Restart on Power Up property 409
Restore command 410
Restore Project command 410
Restore Project To Last Downloadcommand 410
restricting access

to Tricon 163
to Tricon points 166
to Trident 168

restrictions and limitations, CEMPLE matrix 89
Retentive property 410
Right Power Rail command 411
Roll Backward or Forward command 411
router, using for TCM connection 251
Routing Configuration property 411
rows

deleting 102
hiding and sizing 425
inserting 101
size and hide 104

RTS Pre-Delay setting 422
Run command 412
Run mode 296, 412
RUNNING state 412

S
safety and control

about 58

safety application definition 320
Save As command 413
Save Element command 412
Save Implementation command 413
Save Project command 412
Save View command 413
Scale Factor property 413
scaling

for Modbus 153
scan surplus

determining 306
negative 306
positive 306

scan time
affect of print function blocks 273, 280
defined 418
setting for running application 307

Scan Time property 414
Search Text command 415
security

Operations property 392
user access 27

Security command 415
Security Level property 415
Select Function Block command 416
Select Network Contents command 416
Select Sheet Contents command 416
Selection Tool command 416
Serial Port property 417
serial ports

Tricon TCM 208
serial ports, TCM 205
Set Calendar Clock command 417
Set Editor Options command 417
Set Programming Mode command 418
Set Scan Time command 418
Set Value property 419
Severity property 419
Shared Read property 419
sheets

Copy command 333
Cut command 334

Sheets Menu 419
Shorted Point Alarm Threshold property 420
Show Causes for Selected Effect command 420
Show Effects for Selected Causes command 421
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Show Grid command 421
Show IEC Representation command 421
Show Line Numbers command 422
Show Network Numbers command 421
Show Zones command 422
signal delays property 422
Single Step command 423
Size/Alignment command 424
Size/Hide Columns command 424
Size/Hide Comment Column command 424
Size/Hide Rows command 425
slave node, Triconex time synchronization 233, 480
Slot Selection property 425
SNTP Master IP Address property 425
SNTP Master Network property 425
SNTP time synchronization 231, 477
SOE

assigning event variables 161
blocks, defining properties 160
trip variable 162

SOE Block Assignments property 426
SOE Block Name property 426
SOE Block property 426
SOE Block Type property 426
SOE Buffer Size property 427
SOE configuration 159
Space Saver property 76, 428
spacing

double space by default 347
Double Space property 347

ST language
about 60
copying and pasting code 78
Editor 78
font size 364
intermediate code 174

Start Value and Increment property 428
STDLIB 32
Stop Bits property 428
Stop mode 296, 429
STRING data type 459
structured data type 80
subnet masks 267
supervised DO points 189
Supports Application Defined States property 429
Supports Use in Cause Rows property 429

Supports Use in Effect Columns property 430
Supports Use in Intersections property 430
synchronizing time

Tricon SMM 228
Tricon TCM 229

system requirements 4

T
Tabs property 430
Tagname property 430
tagnames

assigning aliases 117
changing multiple 124
creating multiple tagnames 122
declaring tagnames 115
deleting 123
disabling 313
enabling for multiple writes 117
export command 360
exporting to file 126
file format 127
forcing 313
import command 369
import file format 130
importing from file 133
maximum number of 108
monitor color 121
monitoring colors 365
overview 115
physical addresses 117
renaming 123
restricting access 343
scaling 120
specifying DO points 346
table

inserting columns 125
TCM

see Tricon TCM
TCM access list

access levels 267
configuring 270
controller access 30
Deny Access 267
description 165
grouping clients 267
IP addresses 267
maximum number of entries 268
order of evaluation 270
permissions 267
protocols 268
Read Only 267
Read/Write 268
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resources, defined 267
sample list 268
subnet mask, using 267

TCP Port property 431
TCP/IP protocol

installing 243
TCXLIB 32
technical support xiv
Temporary Files property 431
Terminal property 431
terminals

described 71
double space by default 347
double spacing 347
enable EN/ENO by default 354
FBD and LD 71

Termination Options property 432
testing

network connection 292
on controller 301
on emulator 297
procedure 299, 304
using controller 304
using emulator 299

Text Size property 432
Time After Trip property 432
Time Before Trip property 433
TIME data type 460
time synchronization

GPS, with TCM 229
SNTP, with TCM 231, 477
TCM master node 233, 479
TCM slave node 233, 480
Triconex, with TCM 233, 479
Trident CM 236
with external source 225
with Tricon ACM 225
with Tricon NCM 226
with Tricon NCMG 227
with Tricon TCM 229

Time Synchronization Configuration property 434
Time Synchronization property 433
title block

editing 106
TOD data type 461
Toggle Terminal Inverter command 434
TR1LIB 32
training xiv
Transceiver Mode 434

Transceiver Port property 436
transfer time

Peer-to-Peer 156
transmission speed

Baud Rate property 322
TRDLIB 32
Tricon

default connection 197
disabling OVD 342
Modbus functionality 146
modules 186–191
NGAI modules 187
NGDO modules 188
operating parameters 180
PI module 190
restricting access to 163
serial communication 246
special alias numbers 148
special aliases 149
thermocouple input module 191
time synchronization 224
write access 164

Tricon ACM
configuring connection 254
configuring ports 199
connection using media converter 252
default IP address 286
direct connection to TriStation 250
getting IP address using RARP server 287
installing NIC card for 242
time synchronization 225
TriStation Ethernet connection 249
TriStation network connection 249

Tricon EICM
configuring a printing port 275
configuring ports 201
configuring serial TriStation connection 247
connecting a printer 273, 274
setting an IP address 288
TriStation serial communication 246

Tricon HIM
Base Address property 322
ports 200

Tricon NCM
configuring connection 254
connection using media converter 252
default IP address 286
direct connection to TriStation 250
getting IP address using RARP server 287
installing NIC card for 242
ports 203
time synchronization 226
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TriStation Ethernet connection 249
TriStation network connection 249

Tricon NCMG
time synchronization 227

Tricon SMM
ports 204
synchronizing time 228

Tricon TCM
access list 267–272
configuring a printing port 278
configuring connection 254
configuring serial TriStation connection 247
connecting devices using a hub 277
connecting devices using a router or hub 251
connecting printing devices 276
connection using media converter 252
connection using router or hub 251
controlling access to 267–272
default IP address 286
direct connection to TriStation 250
fiber cables 251
fiber mode 207
GPS time synchronization 229
installing NIC card for 242
IP addresses 207
maximum number of 205
Modbus TCP ports 212
network ports 206
peer-to-peer ports 210
printing from 273
protocols supported 205
routing ports 214
serial ports 208
setting an IP address 288
SNTP time synchronization 231, 477
time synchronization 229
Triconex time synchronization 233, 479
TriStation Ethernet connection 249
TriStation network connection 249
TriStation serial communication 246

Triconex contact information xiv
Triconex Time Synchronization 229
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access 168
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disabling OVD 342
Modbus functionality 146
module properties 192
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operating parameters 182
printing devices 280
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system and module attributes 237
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configuring TriStation connection 264
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routing 223
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setting an IP address 290
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specifying default gateway 291
specifying network routing 292
time synchronization 236

Trident MP
attribute properties 193
configuring 218
configuring TriStation connection 259
direct connection to TriStation 257
hub connection to TriStation 258
serial ports 219
setting an IP address 289

Trident PI Module, field power 361, 362
Triggering Mode property 436
Trip State property 436
Trip Tagname property 436
trip variable

assigning 162
TriStation

connection to Tricon ACM, NCM, or TCM 250
connection to Tricon TCM 251
connection to Trident MP 257
converting to v 4.1 11
creating a project 14
Directories tab 22
Drawing Color tab 23
FBD Editor tab 24
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installing 5
installing protocols 243
LD Editor tab 25
libraries 32
properties 21
system requirements 4
Trident CM connection 262
Trident MP configuration 259
Trident MP using a hub 258
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uninstalling 4, 6
upgrading 4
verifying the installation 6

TriStation protocol
definition 328

TriStation UDP Port Number property 437
TSAA protocol 328
TSAA UPD Port Number property 437
TX1LIB 32
type name

described 71
Type Over command 437

U
UCN Node Number property 437
UDP Base Port Number property 211, 438
underflow
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gradual for REAL data types 458

Undo command 438
uninstalling TriStation 4, 6
unipolar input 188, 408
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upgrading TriStation 4
Usage property 439
Use Local Time property 439
user access

adding or modifying 29
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editing documents 27
level names tab 31
managing 28
privileges tab 30
see also TCM access list

user documents
copying 63

user name
default 16
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VAR

declaring 84
VAR CONSTANT

defining 81
Var Type property 441
Var/Const property 440
VAR_EXTERNALS
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VAR_IN_OUT function parameters 87
VAR_TEMP

defining 82
Variable Detail Table, CEM editor 92
variables

adding annotations 300, 305
Auto Name command 321
changing multiple 112
creating in FBD and LD 108
declaring in FBD and LD 109
declaring in ST 84
formatted name 364
initial value 370
maximum number of 108
monitoring on controller 303
monitoring on emulator 298
question mark while monitoring 303
specifying in CEM 98

Verify Last Download to the Controller command 441
Verify Password property 441
Verify Version command 442
verifying a TriStation installation 6
version number

projects 9
verifying library version 32, 40
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View Download History command 442
View Intermediate FBD command 443
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View Project History command 444
views

enlarged 446
managing 107
saving 107

W
Width property 444
Wire tool command 445
Wire Type property 445
workspace

controller 178
project 8
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Workspace View command 445
write access

by tagname or alias 115
disabling remote changes 343
restricting access to Tricon points 166
restricting access to Trident points 170
to Tricon points 166–167
to Trident points 169–171
Tricon 164
Trident 169

Write To File command 446

Z
Zoom command 446
Zoom To Fit command 446
Zoom To Region command 447
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